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 INTRODUCTION 

When I was a college student in the 1980s, I took a course called “Introduction to 

Computers.”  The first part of the class was devoted to WordPerfect, a popular word 

processing program at the time.  That part of the course was helpful, but it was the rest of 

the semester that changed my life forever.  That is when I was introduced to a 

spreadsheet program called Lotus 1-2-3.  As an Accounting major, I loved the ability to 

manipulate numbers any way I wanted on a spreadsheet.  When we got to the macros 

section of the class, I fell in love all over again.  I knew I had discovered my career. 

Over the past 30+ years of working with spreadsheets, I decided to write this course.

I have compiled in this course the material that took me years to learn, in easy-

to-understand examples, lessons, projects and code.  I will walk you through hundreds 

of formulas, functions and code examples that are designed to give you the 

experience necessary to masterfully work Excel on your own.  I explain each task or 

concept just like I was at your desk, helping you each step of the way.  However, I cannot 

teach you all of the logic that you will need in every situation you may encounter.  I 

will show you how to use Excel and I will do my best to teach you logic for many 

different situations, but it is up to you to apply that logic to your particular circumstance. 

Let me explain how this course works.  The projects, illustrations, tasks and examples 

taught in this course could be considered as on-the-job training, as it would take you 

years to gain this experience on your own. In the course, there are more than 500

screenshots helping to show you how to do the almost 1,500 tasks you will perform.  

The concepts herein are designed to teach you the basics of financial reporting and 

analysis.  These are real world examples that you could find in actual situations.  In fact,

many of the exercises are actual projects that I have done over the years in my 

experience as an auditor, tax accountant, real estate appraiser, financial analyst, 

report developer, programmer and instructor.  As you work these examples, I 

encourage you to think about the concept being taught and make up examples of 

your own, using data and situations you are familiar with.  This will greatly reinforce 

the concepts taught herein. 

This course is based on progressive learning.  When I teach a concept, I will explain 

in full detail how to do it.  Thereafter, I will not explain it in detail, but I will assume 

that you have learned that concept. If you need to refresh your memory on how 

to accomplish the task, you will have to refer back to the pages where that concept 

was originally taught.  I encourage you to try to do it on your own before referring 

back, unless you are completely lost.  In my years of experience, I have discovered that 

is the best way to learn.  The course is made up of 18 chapters, and it should take you 

between one and four hours to complete each chapter, including working the 

examples, completing the Review Questions and taking the online exam at the end of 

each chapter.  Some of the more advanced chapters may take more time, depending on 

your experience level. 
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It is important to realize that the concepts taught in this course are very versatile and there 

are many ways to do essentially the same thing.  If you have learned a concept in a way 

that is different from how it is presented in this course but it achieves the same objective, 

feel free to use it.  This course is designed to give you exposure to a variety of ways of 

doing things.  For example, most people are familiar with using the mouse to execute 

commands, but I prefer to use the keyboard whenever I can.  I find that I can move 

around a spreadsheet much faster by using keystrokes on the keyboard than I can with a 

mouse.  As much as is reasonable, I will teach how to use both the mouse and keystrokes 

on the keyboard to show you how to execute the commands.   

In developing this course, I created a company whose accounting system is complex 

enough to simulate real world activity, but simple enough to be used in the examples and 

projects.  I didn’t want the students to have to take a course just to learn the accounting 

system of this company, but I had to make it complex enough to teach the necessary 

concepts.  As such, I created a fictitious company called Nitey-Nite Mattresses.  Nitey-

Nite’s business is to operate 29 retail stores across the United States.  Nitey-Nite 

purchases mattresses, pillows and other merchandise from vendors and sells them at their 

retail stores. 

Please note that the financial data contained herein is purely fictitious and does not 

resemble the activity in any way of any similar retail store today.  The accounting 

methods used in these examples and projects do not necessarily conform with GAAP 

(Generally Accepted Accounting Principles) requirements for the industry, although the 

financial statements and accounting practices herein reflect standard double-entry 

accounting methodology. 

This course is written specifically for Excel 2010.  In Excel 2007, the Microsoft 

engineers introduced the concept of the Office Ribbon, which is located at the top of the 

program window.  All of the toolbars and menus prior to Excel 2007 have been 

reorganized into the Office Ribbon tabs and galleries.  If you are an experienced user for 

any version prior to 2007, you will initially find yourself very frustrated.  Excel 2010 

expands on the capabilities of Excel 2007, although there haven’t been many major 

changes.  If you are new to Excel, you will find it very easy to unlock the powerful data 

analysis capabilities as compared to previous versions. 

I sincerely hope that you will enjoy this course.  If you find any errors that should be 

corrected or if you would like to send me any feedback, please email me at 

Customer.Service@ExcelCEO.com.  Thank you.

Jim Cline 
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User ID and Password 

When you purchased this course, the order confirmation screen contained a Password 
to use with your email address. You will use that Email address and Password to

download the practice files, take tests and gain general access to the ExcelCEO system.

Please write down that Email and Password in the inside cover of this manual or store

in some other secure place so you can refer back to it when needed. 

Practice File Downloads 

To work the many examples illustrated in this course, you need to download the Practice 

Files from the ExcelCEO website.  To download the practice files, log in to the

ExcelCEO website with you Email and Password, and click on the Download link on

the Main Menu.  Follow the instructions in the dialog boxes and on the website

to properly download the practice files on to your computer.  We recommend you 

download the files exactly as the instructions indicate. 

Review Questions 

As you work through the course manual, you will periodically be instructed to sign on to 

the ExcelCEO website and complete the Review Questions.  Review Questions

are questions that are formatted in the same way as the actual examination questions, but 

are provided for review purposes only.  Review Questions are not graded even though 

the program will indicate whether or not the chosen answer is correct or incorrect.  If 

you choose a wrong answer, a message will pop up indicating why the chosen 

answer is wrong and the program will allow you to choose another answer.  You must 

choose the correct answer before continuing to the next question.  You should log on to 

the website to review the Review Questions when you see this paragraph in the manual: 

Review Questions:  It is now time to complete the hands-on Review

Questions. Log on to www.ExcelCEO.com with your Email and Password,

click on the Excel 2010 Review Questions, Chapter 1, Section 1 of 3
option and complete the review questions. 

The program will guide you to the correct Review Questions section or Test based on the 

sections you have already completed.  Each chapter (except Chapter 18) contains 

from one to four sections of review questions. 

Chapter Examinations 

There are 18 chapters in the course, contained in four sections (Beginning, Intermediate, 

Advanced, and Master.  At the end of each chapter, you will be instructed to go 

to ExcelCEO.com, log in and take an exam.  After you log in with your User ID and

Password and complete the Review Questions, you will click on the Take a Test (Excel 

http://www.ExcelCEO.com/
http://www.ExcelCEO.com/
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2010) link which will navigate you to the appropriate test.  All tests are administered 

sequentially after you successfully pass the previous exam.  The exam uses questions 

from a database of hundreds of possible questions, so it is highly unlikely that any two 

people will get the same exam.  Some of the exam questions are based on the examples in 

the practice files, so I would encourage you to complete all of the exercises in the course.  

For example, if you complete an exercise that calculates net income by store, one exam 

question may ask you “What is the 2010 Net Income for Store 1002 if you change Other 

Revenue to $25,000?”  Each question is in a multiple choice format, and you will have 

four choices from which to choose.   

The only recorded score for each exam is the passing grade.  After obtaining a passing 

grade, you will be able to print out a Certificate of Completion as proof that you’ve read 

the material, worked the examples, completed the review questions and passed the exam.  

You must score a 70% or above on each exam to pass. 

CPE (Continuing Professional Education) Credits 

ClineSys is registered with the National Association of State Boards of 

Accountancy (NASBA) as a sponsor of continuing 

professional education on the National Registry of CPE Sponsors.  

State boards of accountancy have final authority on the 

acceptance of individual courses for CPE credit. Complaints 

regarding registered sponsors may be submitted to the National 
Registry of CPE Sponsors through its website: 
www.learningmarket.org

To claim CPE credits under NASBA guidelines, the CPA must successfully complete this 

course within one year from the date of purchase.  The CPE credits for each chapter 

in this manual are listed below.  Upon completion of a chapter, sign on 

to www.ExcelCEO.com with your email address and password and click on the 
Certificates link to print a copy of the certificate of completion.  As of December 

31, 2010, the student can take up to two retests on final exams that were failed.  After 

the second retest (or the third time to take the chapter exam), the student cannot

receive CPE credits for the chapter.
Chapter CPE Credits Chapter CPE Credits Chapter CPE Credits 

1 3.0 7 2.0 13 2.0 

2 2.0 8 3.5 14 2.5 

3 2.0 9 3.0 15 2.0 

4 2.0 10 2.0 16 3.0 

5 1.5 11 2.5 17 2.0 

6 2.0 12 3.0 TOTAL 40.0 

Note:  There is no CPE credit given for completing Chapter 18.  The completion

of Chapter 18 is required to earn an ExcelCEO Excel Master certificate.

http://www.learningmarket.org
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New in 2010! 

As you work through the course and I introduce a concept that is new to Excel 2010, I 

will indicate it.  As I stated previously, there haven’t been many new changes from Excel 

2007, as the major changes were made from Excel 2003 to Excel 2007.  The following 

table summarizes the most significant enhancements to Excel 2010: 

Item Excel 2003 Excel 2007 and 2010 

Columns in a worksheet 256 16,384 

Rows in a worksheet 65,536 1,048,576 

Number of conditional 
formats applied to a cell 3 

Limited only by the 
available memory 

Sorting levels in a table 3 64 

Items displayed in a Filter 
list 1,024 32,768 

Characters displayed in a 
cell 1,024 32,768 

Unique cell styles in a 
workbook 4,000 65,536 

Number of nested levels in 
a formula 7 64 

Maximum arguments in a 
formula 30 255 

Number of columns 
allowed in a PivotTable 255 16,384 

Number of fields displayed 
in the PivotTable Field List 255 16,384 

Other enhancements in Excel 2010 covered in this course include sparklines, slicers, 

repeating data in PivotTable rows, enhanced search filters, search fields in PivotTables, 

and the SUMIFS(), COUNTIFS(), AVERAGEIFS() functions. 

Keyboard Shortcuts 

Keyboard shortcuts are keyboard strokes that execute functionalities without having to 

choose the options from the Office ribbon with the mouse.  Keyboard shortcuts generally 

include the use of the [Ctrl], [Alt], and/or [Shift] keys.  For those of you who liked to use 

keyboard shortcuts in Excel 2003, you’ll be happy to know that the same shortcuts exist 

in Excel 2007 and 2010.  To get a complete list of keyboard shortcuts available in Excel, 

go to the Excel Help menu, search for “keyboard shortcuts” and click on “Excel shortcut 

and function keys”. 
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Conventions Used In This Course 

The basis behind this course is learning by example.  As such, I have included hundreds 

of tasks, examples and projects.  Steps to complete a task are numbered and are shown in 

italicized and bold text.  Here is an example: 

1. Click on Cell B12.

2. Type =SUM(B2:B11) and press [Enter].

To further assist you, I have included hundreds of screen shots and pictures of the icons 

used in the examples, such as this Save icon:  

Action keys (keys that do something other than type a character on the screen) on the 

keyboard are referred to in brackets, such as the Enter key [Enter] and the F2 key [F2].  

Sometimes it is required to hold down one or more keys on the keyboard to perform a 

certain action.  For example, to make a cell bold, you press and hold the Control key 

[Ctrl] and then type the “b” key.  I will refer to this action as [Ctrl]+b.  Action keys can 

also be sequential, by typing one key at a time.  For example, to execute the process to set 

a column width using action keys would be to press the [Alt] key, then the o, c, and w 

keys, each separated by a comma.  I will refer to this action as [Alt], o, c, w.  These work 

in Excel 2010 just as they do in Excel 2003, so if you are accustomed to using action 

keys in Excel 2003, you’ll feel at home with Excel 2010. 

Prerequisites 

Prerequisites for taking the Excel series of this course include a basic knowledge of a 

Windows operating system, and knowing how to use the keyboard and mouse.  This 

course is written specifically for people with accounting or financial training, so I will 

assume you know the basics of income statements and the transactions (the debits and 

credits) that make up the statements.  Familiarity and prior experience with Excel is 

helpful, but not essential.  With that said, let’s get started. 

Jim Cline 
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 SECTION I:  BEGINNING EXCEL 

The first section of this course is designed to teach you the basics of Excel 2010.  I 

realize that you may already have some Excel experience and may even consider yourself 

to be an Excel expert.  As such, you may think this material is insulting your intelligence 

by asking you to complete the examples.  However, please understand that I have 

designed this course as one that builds on concepts taught in previous lessons.  I expect 

for you to continue your education beyond Excel to other topics I teach, including Access 

and SQL.  The ideas and concepts I teach in the Excel course serve as a foundation for 

concepts you will learn in later courses, and I must be assured that you have reviewed 

and understand the basics.  I will therefore ask you to work all of the examples in these 

exercises.  So please bear with me while I may bore you with the easy stuff.  Who 

knows?  You may even learn a trick or two.  Additionally, you will need to complete the 

exercises in their entirety in order to answer some of the questions in the exams. 

If you are a former Excel 2003 (or previous version) user and tried to use Excel 2007 or 

2010 with no instruction, you have probably become very frustrated.  The new Excel 

interface is vastly different from previous versions, and you have probably 

asked questions like “How in the blazes do I open the Find dialog box?”  Rest assured

you are not alone.  I will point out those differences in many of the exercises herein, 

which gives you even more of a reason to work ALL of the exercises. 
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CHAPTER ONE – EXCEL 2010 BASICS 

In this chapter, you will: 

 Navigate within a workbook.

 Work with Office Button and Office Ribbon.

 Enter basic data.

 Move cell contents.

 Use Excel Options.

 Underline, bold, italicize, align text and format cells.

 Execute Keyboard Shortcuts.

 Create a Cell Style.

 Resize column widths.

 Use the Merge and Center functionality.

 Create simple formulas, including using the SUM() function.

 Copy and Paste.

 Work with the Align icons.

 Insert columns and rows.

 Work with dates.

 Use Data Fill.

 Delete rows and text.

 Use the Freeze Panes and Split Windows commands.

 Insert Comments

 Work with File Properties.

 Email a file from Excel as an attachment.
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Excel 2010 Basics 

Excel is an electronic spreadsheet.   It allows you to organize data into lists, filter, sort, 

summarize, compare, rank, add, subtract, multiply, divide, and do just about anything you 

want to do with those numbers.  In the information age of today, time is money, and 

Excel helps you get and analyze information very quickly.  You can calculate the average 

days outstanding on your receivables.  You can calculate the total sales figures for each 

region of your company.  You can calculate the average age of your customers.  You can 

present it all in graphs that allow upper management to see trends.  And the more you 

know how to organize and manipulate those numbers, the more valuable you become to 

your company. 

In this chapter, you will learn the basics of Excel.  Please note that it is not my goal to 

insult your intelligence by making you do some seemingly easy tasks, as you may have a 

great deal of experience with Excel.  However, I have included in this chapter a few 

tricks that not many Excel users know about, so it will definitely be worth your while to 

work every example in the chapter, and in the whole book for that matter.  Let’s first 

discuss what is new in Excel 2010. 

The Office Ribbon 

When you first open a new Excel workbook, you will see the Office Ribbon at the top of 

the screen that looks like this: 

Figure 1.1 

Note that the Office Button in Excel 2007 has been replaced with the File tab in Excel 

2010.  In the next few exercises, we’ll go through how to navigate within the ribbon. 

1. Open Excel 2010 (Assuming you have Windows 7, click

on the Start button, All Programs, Microsoft Office, Microsoft Excel

2010). For Windows 10, click the Cortana bar, type Excel 2010 and
click the Microsoft Excel 2010 Desktop App option.
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Figure 1.2 

(Note:  If Excel doesn‟t open to a blank worksheet, click on the File tab, then on

New, Blank Workbook, then Create.) 

When you open Excel 2010, it should open to a blank workbook as shown in Figure 1.2. 

Let’s review the different sections of the Excel 2010 ribbon.  

In the upper left corner of the Excel screen, just to the right of the Microsoft Excel button 

is the Quick Access Toolbar .  We’ll discuss the Quick Access 

Toolbar a little later.  Along the top and center of the spreadsheet is the Title Bar 

.  It shows the name of the file.  In the upper right corner of 

the spreadsheet are the standard Minimize, Restore Down, and Close buttons 

.  Just below the Title Bar of the spreadsheet are eight tabs (File, Home 

Insert, Page Layout, Formulas, Data, Review, and View).  All of these tabs, with the 

exception of the File tab, are the same as in Excel 2007.  The File tab in Excel 2010 

replaced the Office Button in Excel 2007.  When you click on any tab, the Office Ribbon 

will change to show the icons associated with that tab.  If you hold your cursor over 

almost any icon or menu item, a screen tip will appear.  The screen tip tells you what the 

icon or menu item does.  Hold your cursor over the Format Painter icon and you will see 

the following screen tip. 
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Figure 1.3 

If you click on the File tab, you will see the following screen. 

Figure 1.4 

We’ll go through the menu items on the left in future exercises.  If you have experience 

with previous versions of Excel, you should already be familiar with some of the icons, 

like Save, Save As, Open, Close and New.  You make each choice active by clicking on 

it.  For example, if you click on the Info tab, it shows information about the spreadsheet 

that you currently have open.  We’ll go through each of the various options as needed 

throughout the course.  The section to the right in the dialog box gives more information 

and choices within the selected tab.  The Options button allows you to create and 

customize certain options within Excel.  The Exit button will close Excel. 

When you open Excel 2010, it opens to a blank workbook with three tabs located along 

the bottom of the screen.  Each tab contains a worksheet, also called a spreadsheet.  You 

select an individual worksheet by clicking on the tab.  The main body of the worksheet is 

divided into columns (indicated by alphabetic characters across the top of the 

spreadsheet) and rows (indicated by numeric characters located along the left side of the 

spreadsheet).  The box at the intersection of a column and row is called a cell.  The 

location of a cell is referred to by its column letter and row number.  Cell A1, for 
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example, is the first cell on the spreadsheet.  Cell A6 is located in Column A, Row 6, Cell 

F19 is located in Column F, Row 19 and so forth.  The body of the spreadsheet looks like 

Figure 1.5: 

Figure 1.5 

When you open a new workbook, Excel gives you three worksheets by default within the 

workbook.  You can add more worksheets or delete worksheets, and I’ll show you how to 

do that in this and later chapters.  Each worksheet or tab is named by default Sheet1, 

Sheet2, Sheet3 and so forth and are shown in tabs at the bottom of the screen. 

Figure 1.6 

You make a tab current by simply clicking on the tab.  You can use the tab selectors 

 to select the tabs at the beginning , one tab to the left , one tab to the right 

, or the last tab .  Unless you have numerous tabs on the workbook, you can usually 

see all of them at the bottom of the screen.  Typically, data in each tab should relate to 

other data in the workbook.  For example, the first tab may contain a list of vendors and 

the second tab could contain invoices payable to each vendor.  If you right-click on any 

of the tab selectors, a dialog box pops up that shows you all of the tabs in the workbook.  

If you have more than 16 tabs in a workbook, a “More Sheets” option will appear. 
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Entering and Editing Data 

Let’s start by typing some data onto a blank spreadsheet.  That is one of the beautiful 

things about Excel – anyone can open a spreadsheet and start typing data into cells and 

make Excel do something.  There are basically two ways to type data onto a spreadsheet:  

typing directly into the cell and entering it using the Formula Bar.  Let’s first enter data 

directly into the spreadsheet. 

2. Click on the Home tab.

3. With the Sheet1 tab selected, click on Cell A1 and type Nitey-Nite Mattress and

press the [Enter] key.

Figure 1.7 

Pressing the [Enter] key inputs the typed characters onto the spreadsheet.  However, we 

find that we’ve made a mistake.  The name of the company is Nitey-Nite Mattresses.  We 

will now edit the name to include the extra “es”. 

4. With your mouse, click on Cell A1.

The Formula Bar is the box located just above the column lettering at the top of the 

screen with “fx” or Insert Function button to the left.  We will discuss the use of the 

Insert Function button later.  The Formula Bar should look like this:  

. 

5. Click inside the Formula Bar.

Once you click inside the Formula Bar, you will see an “X” and a check mark to the left.  

  If you click on the X, it will undo any changes you 

made to the cell before they were entered.  The check mark accepts the changes.  It is 

similar to the [Enter] key, except the mouse will not move down one cell. 

6. Edit the text to read Nitey-Nite Mattresses and click the check mark on the

Formula Bar.

The Formula Bar and spreadsheet should now look like this: 
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Figure 1.8 

Moving a Cell 

Moving a cell is very easy.  Let’s suppose that you wanted the Nitey-Nite Mattresses text 

in Cell C1 instead of Cell A1.  All you have to do is drag the text over.  Let’s try it. 

7. Place your cursor over the bottom or side line of Cell A1.  Your cursor

will turn to a pointing arrow with a cross of arrows.

8. Click, hold, and drag the cell over to Cell C1 and release.

Figure 1.9 

The Nitey-Nite Mattresses text is now in Cell C1.  Alternatively, you can Cut and Paste 

the cell.  When you cut and paste the cell, you are cutting the cell contents into memory 

then pasting those contents to another cell location.   

When you open a new workbook, Excel 2010 selects the Home tab by default.  Let’s now 

cut and paste the contents of Cell C1 using the icons in the Home tab. 

9. With the Home tab selected and with your cursor on Cell C1, click on the Cut

icon . 

Cell C1 is now surrounded by a moving dotted line, indicating that the cell is either 

copied or cut. 

10. Click on Cell A1 and click the Paste icon .  (Note:  You can click on 

either the icon or the drop down arrow then click on the Paste icon.  This 

is a little different from Excel 2007.) 
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Figure 1.10 

The text is now back in Cell A1. 

Excel Options 

When you press the [Enter] key, your cursor may skip down one cell.  Personally, that 

bugs me, because I usually want the cursor to stay where it is after I press [Enter].  The 

only exception is when I am entering in data, but I can make the cursor automatically 

jump to the next cell in other ways.  So for now I want to turn off the automatic skipping 

down of one cell.  You can do this using Excel Options.  Steps 11 through 14 show how 

to turn that off.  If you don’t want to turn it off, just skip those steps.  However, you 

should read over the instructions in case you need to do it someday.  

11. Click on the File tab and then click on the Options button near the bottom of the

left section of the dialog box.

Figure 1.11 
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Figure 1.12 

The Excel Options dialog box opens.  There are MANY options you can change in this 

dialog box.  I encourage you to click on the menu items to the left to find out which 

options are contained in each.  In this exercise, we’ll turn off the functionality that moves 

the cursor down when you press [Enter]. 

12. Click on the Advanced menu item on the left side of the dialog box.

13. If necessary, uncheck the After pressing Enter, move selection box (the first box

under Editing Options).
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Figure 1.13 

14. Click OK.

The dialog box disappears and you return to the worksheet.  Now you will input some 

more data on to the worksheet. 
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1. Type the following data into the indicated cells:

Cell A3:  Three Year Sales Summary 

Cell A5:  Sales 

Cell A6:  Mattresses 

Cell A7:  Pillows 

Cell A8:  Total Sales 

Cell B5:  2010 

Cell C5:  2009 

Cell D5:  2008 

Cell B6:  33415463 

Cell B7:  14682832 

Cell C6:  31583481 

Cell C7:  13422897 

Cell D6:  29574225 

Cell D7:  11244335 

Your spreadsheet should now look like Figure 1.14: 

Figure 1.14 

Formatting Cells 

Not to be disrespectful, but your spreadsheet looks kind of, uh, bland.  Fortunately, we 

have some tools at our disposal to make the report look more attractive.  Most of the 

formatting tools you need to make the report look nicer are found in the Home tab.  There 

are seven standard groups in the Home tab:  Clipboard, Font, Alignment, Number, Styles, 

Cells, and Editing.  The formatting tools you’ll need are found in the Font, Alignment, 

and Number groups.  Take a few moments to look at those icons.  Hold your cursor over 

each icon and read the screen tip to see what that icon does.  Let’s clean up the report a 

little by using some formatting. 

2. Click on Cell B5.

3. Click the Underline icon  in the Font group. 
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Now Cell B5 is underlined.  You want to underline the other years in Cells C5 and D5 as 

well, but you don’t have to do it one cell at a time. 

4. Left-click on Cell C5 and hold.

5. Drag the cursor over to Cell D5 (to select both cells).

6. Release the left click on the mouse (this process is called selecting cells).

7. Click the Underline icon.

Figure 1.15 

Now Cells B5, C5 and D5 are underlined. 

Keyboard Shortcuts 

If you prefer to use the keyboard to select multiple cells, you can click on Cell C5, hold 

down the [Shift] key and press the right arrow key on your keyboard to select both cells.  

With those cells selected, you can press and hold the [Ctrl] key and type the letter “u” to 

underline the cells.  The [Ctrl]+u trick is the same in all Microsoft Office programs.  

These are called keyboard shortcuts.  A keyboard shortcut is the keyboard version of 

executing commands (or choosing options) that could also be done with a mouse.  There 

are many other keyboard shortcuts in Excel.  One easy way to find out what they are is to 

hold your cursor over the icon and read the screen tip.  If a keyboard shortcut is available, 

it will tell you what it is.  For example, if you hold your cursor over the Copy icon in the 

Clipboard group of the Home tab, you will see the following screen tip: 

Figure 1.16 
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To the right of the Copy choice you see (Ctrl+C).  This means that you can type Ctrl+C 

and the Excel will copy whatever you have selected.  The Ctrl+C reference is the 

shortcut.  It is a little deceiving in that the C in the reference is capitalized, and the 

shortcut works when [Caps Lock] is on or when you type Ctrl+c (lower case c).  If you 

type Ctrl+Shift+c (to put the c in upper case), it will not work.  If you prefer to use the 

keyboard to do many commands (like me), these keyboard shortcuts can save you a lot of 

time. 

Let’s now return to our spreadsheet.  Our file is starting to look a little better, but those 

numbers need some formatting.  The years look good, as years are typically shown with 

no formatting, but the sales numbers need to have some formatting, so let’s do that now. 

8. Select Cells B6 through D7.

9. In the Number group of the Home tab, click on the Number Format

drop down arrow .

Figure 1.17 
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This is a short list of commonly used number formats.  We want to format our sales 

figures with commas with no decimal places, and such a format is not included in this 

list.  In this and previous versions of Excel, you could use the Format Cells dialog box.  

To display the Format Cells dialog box in Excel 2010, click on the Dialog Expander, 

located at the lower right corner of the Number group. 

Figure 1.18 

10. Click anywhere outside the Number Format list (to make the list

disappear).

11. Click on the dialog expander, located in the lower right corner of the

Number group of the Home tab.
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Figure 1.19 

The Format Cells dialog box opens.  Another way to open the Format Cells dialog box is 

to  right-click anywhere in the spreadsheet and choose Format Cells. 

12. In the Format Cells dialog box, make sure the Number tab is selected.

13. In the Category: field, click on Number.

14. Check the Use 1000 Separator (,) box.

15. Click on the down arrow in the Decimal places: box until it reaches 0.
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Figure 1.20 

16. Click OK.

Figure 1.21 

You should spend some time experimenting with the different cell formatting options in 

the Format Cells dialog box.  You will most likely use many of the formats available. 
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Review Questions:  It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 1, Section 1 of 3 
option and complete the review questions. 

Cell Style 

When creating reports, it’s nice to have a standard format for the numbers.  I like to use a 

cell format of Number with the comma separator with zero decimal places.  Sometimes it 

can be tedious to remember the different formats of all the possible styles.  Excel 

provides a great tool for you to store the formatting style and use it again and again.  This 

functionality is called a Cell Style.  Let’s set up a style. 

1. With Cells B6 through D7 selected, click on the Cell Styles icon in the

Styles group of the Home tab.

Figure 1.22 

You can use one of these styles provided by Excel 2010, or you can create one of your 

own.  One great feature about Excel 2010 is that you can hover your cursor over a 

formatting style and see what it would look like on your spreadsheet without having to 

click on the style.  Let’s try it. 

2. Place your cursor over the 60% - Accent1 box (located under Themed

Cell Styles, first column, third row), but don‟t click on it.
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When you place your cursor over the style, watch how the formatting for Cells B6 

through D7 change.  Play around with it a bit.  Place your cursor over different styles and 

see which one you like best. 

Let’s suppose that you don’t want any of the styles provided in the dialog box.  You can 

create your own style. 

3. In the Cell Styles dialog box, click on the New Cell Style… icon.

Figure 1.23 

The Style dialog box appears.  Note that it is already pre-populated with the style for 

which the cell range is currently formatted.  If you like, you can change the formatting by 

clicking the Format… button.  Clicking the Format…button will make the Format Cells 

dialog box appear, and you can make any change you want. 

4. In the Style name: box, type ClineSys1 and click on the Format…

button.

5. In the Number tab, make sure Number is chosen under the Category

group, the Use 1000 Separator (,) box is checked, and 0 is in the Decimal

places box.

6. Click on the Font tab.

7. Under Font Style, choose Bold, then click OK.

8. Click OK in the Style box.

Nothing happened to the formatting of Cells B6 – D7.  Why?  You created a new cell 

style but you haven’t applied it to the range yet.  Let’s do that now. 
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9. Click on the Cell Styles icon.

Figure 1.24 

You should now see the ClineSys1 style listed under the Custom group. 

10. With the range B6 – D7 selected, click on the ClineSys1 custom style.

Figure 1.25 

The range is now formatted with the custom style you created. 
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Column Widths 

Do you see how the last “s” in the word Mattresses in Cell A6 is cut off?  That is because 

Column A isn’t wide enough.  A standard Excel column measures 8.43 characters, but 

can be increased to 255 characters or decreased down to zero (hidden).  These sizes 

represent the number of characters that can be displayed in a cell that is formatted with 

the standard font.  There are a number of ways you can resize a column.  Let’s explore 

some of those ways. 

1. Place your cursor on the column margin (the line between Columns A

and B) above Row 1 and your cursor will become a vertical line with left

and right arrows.

2. Double-click on the column line.

Column A is automatically resized to fit the cell containing the longest text string in the 

column, which would be Cell A3 (Three Year Sales Summary).  We don’t need for the 

column to be that wide.  All we want to do is to adjust it so it is just to the right of the 

word “Mattresses” in Cell A6. 

3. Place your cursor on the column line between Columns A and B where

your cursor turns to a vertical line with left and right arrows.

4. Click, hold, and drag the column line to the left.

As you drag the line to the left, you will see a ScreenTip box.  This box tells you the 

width of the column as you drag it. 

5. Drag the column line until the screen tip reads Width: 10.00 (75 pixels)

and release.

Trick:  You can also set a column width by using the keyboard.  With your

cursor placed in the column(s) you want to adjust, type the [Alt] key and

then type the letters “o”, “c” and “w”, then input the desired column

width.  (These are the commands to set column widths in Excel 2003, but it

also works in Excel 2007 and 2010.)

At this point, you should be able to see all of the word “Mattresses” in Cell A6. 
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Figure 1.26 

Merge and Center 

It really would be nice if we could have the title centered over the report.  What’s that 

you say?  Can we do that?  Sure we can.  Just about every time I think of a question that 

begins with “I wonder if Excel can …”, it usually can.  It just takes a little investigation 

on how to get it done.  In this case, you can use the Merge and Center icon. 

6. Select Cells A1 through D1.

7. Click the Merge and Center icon  in the Alignment 

group of the Home tab.

This action combines the four cells as one and centers the text “Nitey-Nite Mattresses” 

over the report.  You can use the Merge and Center icon to merge and center, merge 

across, merge cells or unmerge cells.  To see these choices, simply click on the drop 

down arrow located on the right side of the Merge & Center icon.  Let’s do some more 

formatting. 

8. Click on the Font Size box  in the Font group of the Home tab and 

choose 14.

9. Click on the Italics button . 

This increases the size of the text to a size 14 font and italicizes the text. 

10. Select Cells A3 through D3 and use the Merge and Center icon to center

that text over the report.

11. Change the font size to 12.
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Figure 1.27 

Simple Formulas 

Now we will calculate the Total Sales.  This is the meat of Excel – calculations and 

formulas.  When typing formulas, you must always begin the formula with an equal sign 

“=”.  Let’s begin with the most basic of Excel formulas: adding two cells together. 

12. Click on Cell B8, type  =B6+B7  and press [Enter].

Figure 1.28 

Trick:  To input this formula, you can also type “=” then click on Cell B6, 

then type the “+” sign and click on Cell B7.  Alternatively, type “=” then 

scroll to Cell B6 with the arrow keys on your keyboard, type the “+” sign, 

then scroll to Cell B7. 
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The SUM() Function 

This is one of the easiest calculations in Excel.  But what if you want to add a bunch of 

numbers together?  Answer: use the SUM() function.  Even though we don’t have a lot of 

numbers to sum, I’ll show you how it works.  I will cover other helpful functions in later 

chapters. 

13. Click on Cell C8 and type the following partial formula:  =SUM(   then

click on Cell C6 and drag the cursor down to Cell C7, release the mouse,

type the closing parenthesis ) and press [Enter].

Trick:  You can also type =SUM(  then scroll to Cell C6 with the arrow

key on your keyboard, press and hold the [Shift] key and then the down

arrow key to select Cell C7, type the closing parenthesis and press

[Enter].  Alternatively, you can click on Cell C8 and double-click the

AutoSum icon  in the Editing group of the Home tab.  BUT BE 

CAREFUL!  If you do that, the icon automatically inputs the formula 

adding up all contiguous cells above it, including the Year heading 

(2009).  Because of that, I prefer not to use that icon much. 

The formula in Cell C8 should read “=SUM(C6:C7)”.  Whenever you type a formula into 

a cell, the result appears in the cell.  The formula itself appears in the Formula Bar as 

shown in Figure 1.29: 

Figure 1.29 

To the left of Cell C8, you should see a caution icon.  This icon will appear when 

formulas that are next to each other are not consistent.  The formula in Cell B8 reads 

“=B6+B7”, which is not consistent with the formula in Cell C8, even though they are 

basically the same.  For now, click on the caution icon and choose Ignore error.  We will 

explore those messages in more detail in later chapters. 

14. Click on the caution icon next to Cell C8 and choose Ignore error.
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Copy and Paste 

It appears that you will be using the same basic formula for the summation of sales in 

Column D, and Excel has provided the functionality where you can copy a formula and 

paste it in other cells. 

1. With your cursor on Cell C8, press the Copy icon  in the 

Clipboard group of the Home tab.

You will see a moving dotted line around Cell C8.  This is the indication that the cell is 

copied and is in memory. 

2. Click on Cell D8 and click the Paste icon in the Clipboard group of the

Home tab.

3. Press the [Esc] key to take the Copy command out of copy mode.

4. Ignore the error on Cell D8.

Trick:  You can also type [Ctrl]+c to copy and [Ctrl]+v to paste.  I like to

use the keyboard commands much more than the icons.

When you use the Copy command (either from the icons or the keyboard), Excel assumes 

that the cell references will change in the direction of the Copy and Paste commands.  For 

example, when you copied the formula “=SUM(C6:C7)” over one column to Cell D8, 

Excel assumed you will use the cells above Cell D8 and accordingly changed the formula 

to “=SUM(D6:D7)”.  Wasn’t that nice of Mr. Gates? 

Trick:  To copy a formula over, down or up without the cells changing, 

copy the formula in the Formula Bar, press [Esc] (to exit out of Edit 

mode), click on the cell you want to copy the formula to, and press 

[Ctrl]+v to paste it. 

Now all we have to do is to clean it up a little more and we will have a working report. 

5. Select Cells B7 through D7 and click the Underline icon  in the Font 

group of the Home tab. 

6. Select Cells A5 through D5, then press and hold the [Ctrl] key, select

Cells A8 through D8, release the [Ctrl] key and click the Bold icon .

7. Select Cells B6 – D7 and click the Bold icon.

Since the selection B6 – D7 was already bolded, by clicking the bold icon again removes 

the bold.  By pressing and holding the [Ctrl] key, you can select a non-contiguous range 

of cells. 
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Trick:  A keyboard shortcut to Bold, Italicize or Underline is to select the 

cells you want to format, press and hold the [Ctrl] key and press the “b” 

key (for Bold), the “i” key (for Italics) and/or the “u” key (for Underline). 

When we bolded some of the cells, it may have increased the size of the text a bit, so it 

may be a good idea to resize all the columns to give the numbers a little more breathing 

room.  Excel 2010 usually does a good job of resizing columns as data is entered, but 

sometimes it’s a good idea to resize everything just for grins.  Here’s a trick on how to 

resize all of the columns in the spreadsheet at once. 

8. Click in the blank gray box that is above Row 1 in the spreadsheet and to

the left of Column A.

This highlights or selects the contents of the entire spreadsheet. 

9. Place your cursor over any column line above Row 1 where the cursor

turns to a vertical line with right and left arrows, and double-click on the

column line.

10. Click on any cell in the spreadsheet to deselect the entire spreadsheet

selection.

When you double-click the column line, you should see the columns automatically adjust 

their widths. 

Figure 1.30 

Aligning Text 

Notice that all of the numbers are right-justified and all of the text is left-justified.  With 

Excel, you can change the alignment of any cell to be right, centered, or left justified by 

using the Align Text Left , Center  and Align Text Right  icons.  You can also 

align cells vertically, using the Top Align , Middle Align , and Bottom Align 

icons.  All of these icons are located in the Alignment group of the Home tab.  Let’s 

center the Years. 
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11. Select Cells B5 through D5.

12. Click the Center icon .

Figure 1.31 

13. Click the Save icon  in the Quick Access Toolbar just above the File 

tab.

By clicking the Save icon on a workbook that is not yet named will display the Save As 

dialog box. 

14. In the Save As dialog box, navigate to the Chapter1 folder under the

C:\ClineSys\Excel 2010 folder on your computer.

15. In the File name box, type myIncomeStmt.

16. Make sure the Save as type box is set to Excel workbook.

17.

18.

Click the Save button.
Close the file by clicking on the Close Window icon (the second  in the
upper-right corner of the spreadsheet).

Review Questions:  It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 1, Section 2 of 3 
option and complete the review questions. 

Let’s start another project.  In this project, you will add to your Excel skills in formatting 

a spreadsheet by creating a multiple page report. 

At Nitey-Nite Mattresses, there are ten store managers that are considered to be the best 

in the company.  Upper management wants you to develop a report that shows the daily 

sales of each of these people.  It is known as the Top Ten Report.  They want the report to 

show the daily sales for each person each month for the last three months.  You have an 

unformatted text file that gives you all of the data you need to create the report.  All you 

have to do is take that text file and format it to create the Top Ten Report.  The text file is 

located on Sheet1 of the May_Sales.xlsx file. 
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1. Click on the File tab, and then click on the Open  icon. 

2. Navigate to the May_Sales.xlsx file from the C:\ExcelCEO\Excel 2010

\Chapter1 folder and open it.

3. Click on the File tab again, click on the Save As icon. 

This opens the Save As dialog box.  

4. Click on the drop down menu in the Save as type box and review the types of files

you can save the file as (Excel Workbook (*.xlsx), Excel 97-2003 Workbook

(*.xls), etc.)

5. Make sure the Save as type Excel Workbook (*.xlsx) is selected.

6. Change the name of the file to myMay_Sales.xlsx and click the Save button.

7. Make sure you have Sheet1 selected.

Note:  Throughout this course, whenever you use an ExcelCEO-provided file,

you will open the file then save it with the word “my” at the beginning of

the file name.

Figure 1.32 

As you can see, the data is unformatted and needs a lot of work.  Each row of data 

contains the sales for each day of the month, but it has no dates.  As you scroll down in 

the file, you will see that the March data is followed by April data, which is followed by 

May data. 

The first thing we need to do is to format the sale amounts and resize the columns so we 

can more easily read the data. 



Section I:  Beginning Excel 2010 Excel 2010 Basics  1

  30 

8. Select the entire sheet.

9. Resize all columns.

10. Format all cells in Columns A through J to be Currency, two decimal

places with the dollar ($) sign (Do this from the Format Cells dialog box)

11. Place your cursor to the left of Row 1 and left of Column A and the

cursor will turn into a right arrow.  Click on Row 1 and the entire row

will be selected.

12. Underline all cells in Row 1.

Insert a Column 

Next we will add a Date field to be the first field in the spreadsheet.  To do so, we need to 

insert a column to the left of the data in which we can store the dates. 

1. Click on any cell in Column A.

2. In the Cells group of the Home tab, click on the drop down arrow below the

Insert icon.

3. Choose the Insert Sheet Columns option.

Trick:  Alternatively, to insert a column, you can right-click on any cell in

Column A and choose Insert…, choose Entire Column from the Insert

dialog box and click OK.  If you prefer to use the keyboard method, you

can type the [Alt] key and then type the letters “i” and ”c”.

4. In Cell A1, type Date

5. In Cell A3, type 3/1/2010

Figure 1.33 

Dates 

Hhhmmmm?  The cell now reads 40,238.  What’s that all about?  Let’s talk a little about 

dates.  In Excel, a date is simply a formatted number.  The number 1 represents January 

1, 1900.  The number 2 represents January 2, 1900 and so forth, one day for each whole 

number.  March 1, 2010 is 40,238, or in other words there are 40,238 days from January 

1, 1900 to March 1, 2010.  When you input a date in the Month/Day/Year format, Excel 
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will usually assume it is a date unless the cell had previously been formatted as another 

type of number.  This makes performing calculations on dates very easy. 

To further illustrate, let’s suppose you have a birth date in one cell, say February 7, 1961, 

and another date, use June 13, 2011, in another cell.  If you subtract February 7, 1961 

from June 13, 2011 and format the result as a number, you get 18,388, or the number of 

days from February 7, 1961 to June 13, 2011.  To get the age, simply divide 18,388 by 

365.25 (the 0.25 is to account for the leap year day every four years) which results in 

50.34 years.  The time of the day is stored in numbers less than 1.  For example, 

40,707.46 formatted as date and time is June 13, 2011 at 11:02 AM.  We’ll do those and 

more complex date calculations in future exercises and projects, but for now let’s just 

input the dates we need. 

6. Format Cell A3 as Date, in a mm/dd/yyyy format (choose  *3/14/2001 in

the Date category, Number tab in the Format Cells dialog box)

Figure 1.34 

Data Fill 

Cell A3 should now read “3/1/2010”.  If you were to type in the date for every line item, 

it would take quite awhile, as you have three months of data.  Excel provides a way to 

make this much easier.  It is called Data Fill.  Using Data Fill, you can fill in the data 

below (up or to the side) beginning with the cell that is currently selected.  When you use 

Data Fill with dates, Excel assumes you want to increase each date by one day.  Let’s try 

it. 

7. With Cell A3 selected, place your cursor over the small black box located

in the bottom right corner of the cell.

Your cursor will turn to bold plus sign “+”.  This activates the Data Fill button. 

8. Click and drag the Data Fill button down to Cell A33 and release.
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As you drag the cell down, you will notice a screen tip appears on every cell the cursor is 

dragged to, increasing the date by one day.  You can also double-click the Data Fill 

button and Excel will automatically fill in the dates for every cell beneath.  Double-

clicking on Data Fill works only when you want to fill in data BELOW the cell you are 

currently on.  When you do this, all cells below must be contiguous (i.e., no blank cells) 

and the data in the rows must reflect data that is one day apart.   

Deleting 

Our data is not quite in the right format, as three rows of data (currently Rows 2, 34 and 

65) contain the name of the month but no daily sales data.  Let’s delete those rows so we

can use Data Fill properly.  I will show you three ways of deleting rows in the steps

below.

1. Click on Cell A2 (or any cell in Row 2).

2. In the Cells group of the Home tab, click on the drop down arrow below

the Delete icon and choose Delete Sheet Rows.

Figure 1.35 

Row 2 is deleted and all of the rows beneath Row 2 move up.  BE CAREFUL!  If you 

click the Delete icon itself (not the drop down arrow), Excel will delete the cell and move 

the other cells in that column up one row.  That can really make a mess of your 

spreadsheet if you’re not careful. 

3. Click on Cell A33.

4. On your keyboard, type [Alt], e, d, r, [Enter]

This is the keyboard method of deleting rows.  Watch the commands on the screen 

execute as you type the various keys.  Now we’ll do the right-click method of deleting a 

row. 

5. Right-click anywhere on Row 63.

A series of choices pops up in a short menu. 
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6. Choose Delete…

7. Click on the Entire row radio button and click OK.

Remember, right-click is your friend.  If you want to do something and can’t remember 

where it is, try a right-click and see if the correct choice pops up. 

If you want to delete only the contents of the cells but not the rows themselves, you can 

select the range and press the [Delete] key on your keyboard or use the Cut icon .  

Using the [Delete] key or the Cut icon will delete only the contents of the cells, but it will 

not delete the formatting.  One difference between the two is that the Cut icon will keep 

the deleted selection in memory, while using the Delete key will not. 

Now that your data is all contiguous, you can add dates for every row of data in one easy 

step. 

8. Click on Cell A32 (the last date we populated with a date).

9. Double-click the Data Fill box.

The dates are filled in through Row 93, which is exactly what we wanted to do. 

Figure 1.36 
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Freeze Panes and Split Windows 

Notice that the names in Row 1 are the same for the three months of data.  As you scroll 

down the page to see April and May data, the names of the managers disappear.  When 

you scroll down, you would like to fix or freeze the first row of names.  Let’s do that. 

1. On your keyboard, press [Ctrl]+[Home] (this takes you to Cell A1).

2. Click on the View tab.

3. In the Window group, click on the Freeze Panes icon.

Figure 1.37 

4. Click on the Freeze Top Row item.

The first row of names will now remain in place while you scroll down through the rest 

of the records.  If you want to freeze column(s) on the left, simply position your cursor in 

the cell to the immediate right of the last column you want to freeze and choose Freeze 

Panes.  Let’s do that. 

5. Click on the Freeze Panes icon and choose Unfreeze Panes.

6. Click on Cell B2.

7. Click on the Freeze Panes icon and choose the Freeze Panes item.

Now you can scroll up and down, to the right and to the left and the titles and dates are 

frozen.  You can also use the Split  functionality under the Window group of the View 

tab.  The split window differs from the freeze panes option in that a split window allows 

you to scroll independently in each window. 

Insert a Row 

In looking at this data, I think we really need totals by person.  That way, upper 

management can see monthly totals for each of the top ten people.  Currently, there are 

no blank rows between the monthly data, so we need to insert a couple of blank rows 

after every month end.  This is similar to inserting columns like you previously learned. 

8. Click on Cell A33 and click on the Home tab.

9. Click on the drop down arrow under the Insert icon on the Cells group

and choose Insert Sheet Rows.
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10. Repeat the previous step to insert a second row.

11. In Cell A33, type  Total

Figure 1.38 

Note:  To set the height of a row, click on the bottom line of the row and drag 

it down or up.  You can also set the row height by clicking on the Format 

icon in the Cells group and choose Row Height… and type in the height you 

want the row to be. 

12. Insert two rows at the break between April and May.

13. Type the word Total at the end of the April and May data.

Now you are ready to sum the sales numbers for each manager in each month. 

14. In Cell B33, type a formula that sums the contents of all cells above it.

(Remember how to do this?  If not, go back to the SUM() function you

used previously)

15. Copy that formula to Cells C33 through K33.

16. Bold Cells A33 through K33

17. Underline Cells B32 through K32.
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Figure 1.39 

18. Do the same for April and May totals.

Comments 

In scrolling through the report, you notice that Lee Underwood had kind of a low month 

in April where he sold only $41,722.92.  When you called him to see what happened, he 

explained that he had some sickness in his family and was unable to come to work for a 

number of days during the month.  You decide you would like to communicate this 

information to upper management, and you want to put it somewhere in the file, but 

where?  Excel provides a nifty little tool called Comments.  In any cell, you can type any 

comment you want.  Let’s try it here. 

1. Right-click on Cell I65 and choose Insert Comment.

Your computer name should show up as the first part of the comment. 

Figure 1.40 

2. In the Comment box, type  Lee had some family sickness this month.

3. Press the [Esc] key twice to exit Insert Comment mode.
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Figure 1.41 

When you escape out of design mode for the comment, the comment will either remain 

visible or it will disappear, depending on if you have used the Comment functionality 

previously.  If it remains visible, you can right-click on the cell and choose Hide 

Comment.  The commented cell is tagged with a red triangle in the upper right corner of 

the cell.  It will remain displayed until you hide it.  Let’s do that now. 

4. Right-click on Cell I65 and choose Hide Comment (if necessary).

The comment will now remain hidden until the user moves the cursor over the cell.  You 

now decide you want it to remain visible so upper management can immediately see it 

when they open the report. 

5. Right-click on Cell I65 and choose Show/Hide Comments.

Again, this makes the comment visible whenever the user is looking at the spreadsheet.  

Note that the displayed comment will not print when you print the report.   

6. Insert a comment in Cell I69 that reads Lee returned to work today.

You can also use the Comments group of the Review tab to manage all comments in the 

spreadsheet.  I typically find that I don’t need that group much as I can use the right-click 

functionality to manage all the comments I have.  To remove a comment, you can right-

click on the commented cell and choose Delete Comment.  You can remove all 

commented cells at once by using the Go To dialog box. 

7. Click on any cell that does not contain a Comment.

8. Press the [F5] key on your keyboard.
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Figure 1.42 

The Go To dialog box appears.  The Go To functionality helps you to find text, numbers, 

formulas and formatting. 

9. In the Go To dialog box, click on the Special… button.

Figure 1.43 

10. In the Go To Special dialog box, make sure the Comments radio button

is selected and click OK.

Excel will select the commented cells I65 and I69. 
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11. To delete the Comments, right-click either Cell I65 or I69 and choose

Delete Comment.

Both comments are deleted.  To edit a comment, right-click the cell where the comment 

is and choose Edit Comment. 

File Properties 

You will probably save this file on the hard drive of your computer, but many people 

save files on network drives.  Sometimes, particularly if you create a lot of files, you may 

store them in places that you can’t remember.  In Excel, you can search for files based on 

certain criteria, like name, size, author, and keywords.  This type of information is stored 

in the file’s properties.  It is good practice to put in keywords into a file to make it easier 

for you or your colleagues to find it later.  Let’s use “Top Ten” as the keyword for this 

file. 

1. Click on the File tab and make sure the Info icon to the left is selected.

2. In the panel to the far right, click on the Properties  icon (it‟s 

not real apparent so you may not see it right away). 

3. Click on Show Document Panel.

Figure 1.44 

The Document Properties panel appears at the top of the spreadsheet. 

4. In the Keywords: box, type  Top Ten.

5. Click on the Close icon (x) to close the Document Properties panel.

Review the other boxes in the Properties group to familiarize yourself with the types of 

file properties that are available. 

Send File as Email Attachment 

You know how sometimes you want to send the file you’re working on as an attachment?  

Most people save the file, then open Outlook (or some other email management 

program), create a new email and attach the file to the email.  In Excel, all of this can be 

done in three clicks while you still have the file open. 

1. Click on the File tab, click on Save & Send.
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Figure 1.45 

2. With Send Using E-mail selected, click on the Send as Attachment icon.

Outlook opens up a new email with the file attached.  Now all you have to do is to type in 

the email address and your message, and click Send.  If you haven’t saved the file, that’s 

OK.  Excel will save a temporary copy of the file as it was when you clicked the Send as 

Attachment icon. 

3. Close the email without sending it to anyone.

4. Save and close the file.

Review Questions:  It is now time to complete the hands-on Review
Questions. Log on to www.ExcelCEO.com with your Email and Password,
click on the Excel 2010 Review Questions, Chapter 1, Section 3 of 3
option and complete the review questions.

Conclusion 

In this chapter, you learned the basics of Excel.  You learned what a spreadsheet looks 

like, how to work the navigation, how to use the various tabs and the Office Ribbon, and 

how to enter basic data on a blank spreadsheet.  You learned how to move the contents of 

a cell to another location and how to turn off the skipping down of the cursor when you 

press [Enter].  You cut and pasted data within cells, and formatted data and text by using 
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the underline, bold, italicize icons (and keyboard functions), you aligned text to be 

centered, left-justified and right-justified, and formatted cells using the Format Cells 

dialog box.  You learned how to use keyboard shortcuts, resize column widths and row 

heights, and used the Merge and Center icon to center text across multiple columns.  You 

created your own Cell Style.  You created simple formulas and inserted rows and 

columns.  You wrote a formula using the SUM() function, worked with dates, used the 

Data Fill functionality, and learned how to delete cell contents.  You can make a row 

and/or column stay fixed by using Freeze Panes and/or the Split Window functionality.  

You deleted rows and text, and can now insert comments in any cell of a spreadsheet.  

Finally, you learned about File Properties and how to send a workbook as an email 

attachment. 

Chapter Exam 

You can now go to www.ExcelCEO.com, click on Sign In, log in and take the

exam.  Make sure that you take the exam on the same computer that you completed the 

sample files on, as some of the questions on the exam may refer to some of the 

completed examples. 

http://www.ExcelCEO.com/
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_____________________________________

Excel 2010
Complete Self-study Course
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CHAPTER TWO – FORMATTING 

 

 

In this chapter, you will: 

 

 Use the Underscore character. 

 Use Format Painter. 

 Use different types of cell formats. 

 Copy and Paste formulas. 

 Use AutoSum. 

 Use Custom Formatting. 

 Handle errors in formulas. 

 Use Absolute, Mixed and Relative references. 

 Indent text within a cell. 

 Use Fill Color and Font Color. 

 Draw borders around and within a report. 

 Use the Undo and Redo buttons. 

 Import, move and resize graphics. 

 Create a template file. 
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Formatting 

In one of my previous jobs as a real estate appraiser, I was assigned numerous tasks using 

my computer skills to create complex discounted cash flow analyses.  Sometimes, my 

manager would ask me to analyze a property and not give him a report, but simply “a 

number” along with the supporting calculations.  He would tell me not to worry about 

formatting a report – just give him one sheet of paper with the supporting calculations 

and the value of the property.  And that is exactly what I gave to him.  Every time I did 

this, he would take that sheet of paper and begin to mark it up with his infamous red pen 

and write “Center this title”, “Format this as a number with two decimal places”, “Make 

these numbers right-justified”, etc, etc, etc.  I got so upset when he did that, especially 

when he specifically told me not to format the report.  He said that the report can’t be 

right on the first try, so he HAD to edit something.  I then decided that I was going to 

take the time to format ALL of the reports and analyses I gave him, even if he said not to 

do it.  That taught me a great lesson – whenever you create a report, format it so that the 

person you give it to can review it, understand it, make no corrections, and send it along 

to the next person who needs to see it.   

In this chapter, we’ll be exploring more formatting options. 

1. Open Excel 2010 and navigate to the file located at C:\ExcelCEO
\Excel 2010\Chapter2\Sls_Jrnl.xlsx.

2. Save the file as C:\ExcelCEO\Excel 2010\Chapter2\mySls_Jrnl.xlsx. 

Figure 2.1 
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This is a file of the individual sales made in the month of May 2010 for Store No. 1026.  

Fields included are the store number (which is the same for all records as we are looking 

only at Store No 1026), the Sale Date, Ticket Number, Item Code, Quantity Sold, Sale 

Price per Item, the Discount percent given on the sale, Warranty Charge (if any) and a 

Delivery Charge (if any). 

 

The Underscore Character 

 

There is one thing I need to mention here that will save you a lot of headaches in your 

programming career.  You may have noticed that many field names, like Sale_Date, 

Ticket_No and Item_Cd have an underscore (_) character in place of the space.  There is 

a reason for this.  The underscore character is a commonly accepted symbol to use in 

place of a space, as computer languages read an underscore character much easier than 

spaces.  Particularly when you use those column names in a PivotTable (to be discussed 

later) or in other applications like Access or SQL Server, it will be much less confusing if 

you use the underscore character in place of the space.  Depending on the program, field 

names sometimes are required to be all contiguous (no spaces) as spaces can greatly 

confuse programming languages.  No, it’s not real pretty, but you should get used to it. 

 

To make it easier for us to read the data in the file, we need to clean it up a bit. 

 

3. Resize all columns to fit. 

4. Click on Column F (the entire column should be selected), hold down the 

[Ctrl] key and click on Columns H and I, release the [Ctrl] key, and click 

on the Accounting Number Format icon  in the Number group of 

the Home tab. 
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Figure 2.2 

 

Format Painter 

 

Oops.  It looks like the headings in Cells F1, H1 and I1 went away.  However, if you 

click on any one of those cells, you will see in the Formula Bar that the words are still 

there.  The cell has been formatted in a way that is not recognized, so the cells appear to 

be blank.  The other column headings are is still readable, so you just need to format 

Cells F1, H1 and I1 the same way.  You can do that by using the Format Painter icon.  

This tool allows you to copy the formatting, but not the text of a cell and “paint” another 

cell with the same format. 

 

5. Click on Cell G1 (In actuality, you can click on any of the column headers 

except the ones we‟re going to format). 

6. Click the Format Painter icon  in the Clipboard group of 

the Home tab. 

7. Click and hold on Cell F1 and drag to select Cells F1 through I1, and 

release. 

 

The heading for Cells F1, H1 and I1 should now reappear. 
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Figure 2.3 

Trick:  If you want to use the Format Painter to format multiple cells that 

are not in a contiguous range, double-click the Format Painter icon.  

When you click on each cell, the Format Painter will remain activated.  To 

deactivate it, simply left-click on the Format Painter icon. 

Formatting Cells 

In Columns F, H and I, do you see how the “$” sign is left justified and the rest of the 

numbers are right justified?  I don’t like that.  I want the “$” to be next to the numbers.  

Also, I don’t like the dash (-) when there is a $0 dollar amount.  I want it to appear as $0.  

There is another Currency option in the Format Cells dialog box, so let’s try that one and 

see if it works better. 

8. Select Column F.

9. Navigate to the Format Cells dialog box and choose Currency, two

decimal places with the  $  symbol.

10. Apply the same formatting to Columns H and I.

Increase and Decrease Decimal Icons 

That looks much better.  But now that I’m looking at it, all of the sale prices are in dollars 

with two decimal places.  I really don’t need two decimal places because there are no 

cents on any of the sale prices.  Instead of going into the Format Cells dialog box, you 

can use the Increase Decimal  and Decrease Decimal  icons to do it a little 

quicker.  These icons are located in the Number group of the Home tab. 

11. Select Columns F, H and I.

12. Click on the Decrease Decimal  icon twice. 

You can use the Increase and Decrease Decimal icons for other formats as well.  Let’s 

format Column G for Percent. 



Section I:  Beginning Excel 2010 Formatting  2

  48 

13. Select Column G and click on the Percent Style icon  in the Number 

group of the Home tab. 

14. Click on the Increase Decimal icon  to increase the decimal place to 

one.

15. Resize all columns.

16. Freeze Row 1 of the table.

Using the formatting icons is a quick and easy way to format lots of data. 

Figure 2.4 

Would you like to see how many sales we made?  We’ll write the formula for that, but 

first let’s review some of the data’s field definitions.  The Qty field is the quantity of 

items sold.  The Unit_Sale_Amt field is the sale price per item sold.  The Disc_Pct is the 

percentage amount of discounts that were given on the total sale excluding warranty and 

delivery charge.  The Warranty charge is a flat $50 per ticket no matter how many 

mattresses were sold (if purchased) and the Delivery charge is a one-time charge of $55, 

if purchased.  So the total sale price of the ticket is the quantity times the unit sale price 

times (1-Disc_Pct) plus warranty and delivery charges.  Let’s do that calculation. 

17. In Cell J1 type Total_SP (for sale price).

18. In Cell J2 input the following formula: =E2*F2*(1-G2)+H2+I2

19. Make sure Cell J2 is formatted as Currency with two decimal places.
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Figure 2.5 

Now we’re starting to get into some more complex formulas.  Multiplication in Excel is 

done by using the asterisk “*” and division is done by the slash “/” key.  The result in 

Cell J2 should be $1,607.00.  Now all you have to do is to copy that formula down for all 

rows in the spreadsheet.  You’ve done that before by clicking the Copy and Paste icons, 

but this time you have 93 rows of data to copy to.  You don’t want to do it one at a time, 

so let me show you two ways to do a “mass copy” job.  You learned how to do this in 

Chapter 1 with dates, but I want to make absolutely sure you understand this concept, so 

we’ll walk through it again. 

20. With the cursor on Cell J2, place the mouse pointer over the small black

box in the lower right corner of the cursor.  The pointer will change to a

small plus sign “+” (Remember?  This activates Data Fill.)

21. Click, hold, and drag the pointer down to Cell J7 and release.

The formula is copied down and the total sale price is calculated for every row of data.  

Now, you still have a bunch of rows to copy to, so let’s do it the REAL EASY way. 

22. Click on Cell J7.

23. Place the mouse pointer over the small black box in the lower right corner

of the cursor where the pointer changes to a small plus sign “+”.

24. Double-click on the plus sign.
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Figure 2.6 

Pretty cool, huh?  Just like it did for dates in Chapter 1, Excel copies this formula down 

to all rows in the table.  It knows to stop copying when it runs out of rows.  For that 

reason, it is very important to maintain all of your tables with contiguous rows and 

columns.   

AutoSum 

Now let’s add up all of the ticket sale prices in the whole table.  You already know how 

to do a SUM() function.  All you have to do is to go below the last cell in Column J and 

write the SUM() function.  But there is another way to quickly look at the total sales.  

That is by using AutoSum in the Status Bar. 

25. Select Cells J2 through J9.

Figure 2.7 

Look at the bottom right portion of your screen and you should see a box that contains 

the script “Average $852.25    Count 8    Sum=$6,818.00” (or something similar, 
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depending on the settings).  This area of your screen is called the Status bar.  If you 

right-click on the Status Bar, you will see the following list of options: 

Figure 2.8 

In this list, you can turn off and on any of the options available.  It allows you to select 

any range of numbers and automatically sum, average and count them.  You see the 

results in this box without having to write any formulas. 

26. Select all of Column J.  The AutoSum box should read Sum= 81060.7.

Notice that the AutoSum box reads the formatting of the first cell in the range (in this 

case, Cell J1).  To make the formatting of the AutoSum box be the same as the data, 

format all of Column J as Currency, zero decimal places. 

27. Save and close the file.
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The next exercise is to learn how to make reports pretty (or “purdy” as we say in Texas).  

Excel has provided a number of formatting icons that will help you with that.  For 

this exercise, we will use the Net_Inc.xlsx file located in C:\ExcelCEO\Excel 2010

\Chapter2. 

1. Open the file located at C:\ExcelCEO\Excel 2010\Chapter2

\Net_Inc.xlsx.

2. Save the file C:\ExcelCEO\Excel 2010\Chapter2\ myNet_Inc.xlsx 

Figure 2.8 

This workbook has only one sheet called Net_Inc_Stmt.  It is a skeleton financial 

statement with no numbers in it.  This is the general format in which upper management 

likes to see the Summary Income Statement for each store.  Your job is to input the 

numbers and make it look nice by using the various formatting tools.  You will populate 

the numbers, perform the calculations and then make it look “purdy”.  Let’s get started. 

3. Resize Column A to be a little wider than General Admin Expenses on

Row 28.

4. Select Cells B8 and C8.
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Custom Formatting 

Management likes to see headings above the numbers in the Month Year format, like 

“July 2011”.  If you look in the Date category of the Format Cells dialog box, there is no 

such format.  Therefore, we need to create that format using the Custom Format feature. 

5. Open the Format Cells dialog box.

6. In the Category: field of the Number tab, select Custom.

7. In the Type: field, delete the existing text, type mmmm yyyy   and click OK.

Figure 2.9 
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Figure 2.10 

The cells change formatting to July 2011 and July 2010 respectively.  When using the 

Custom formatting, four “m’s” returns the full month name (January, February and so 

on).  Three “m’s” returns the abbreviated month (Jan, Feb), two “m’s” returns the month 

number with the leading 0 (01, 02) and one “m” returns the simple month number 

without the leading 0 (1, 2).  On the Year, one or two “y’s” returns the two-digit year (07, 

08) and three or four “y’s” returns the four-digit year.  You can also use the day (“d”)

format in the Custom type.  One “d” returns the day number, two “d’s” returns the day

number with the leading 0, three “d’s” returns the abbreviated day of the week (Mon,

Tue, etc.) and four “d’s” returns the full name of the day of the week (Monday, Tuesday,

etc.).

Trick:  Excel offers special formatting to format numbers as zip codes, 

phone numbers and US Social Security numbers.  Try it.  In and blank 

cell, type 7134816515 (the ExcelCEO phone number).  Right-click on the 

cell, choose Format Cells, on the Number tab under Category choose 

Special, under Type choose Phone Number, and click OK.  This is useful 

when you want to store the phone number as a number but make it 

appear in a phone number format. 
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8. Input the following values for each line item on the financial statement:

July 2011 July 2010 

Revenue 

Mattresses: 80311 68585 

Pillows: 3466 3554 

Services: 3509 3421 

Discounts: -3689 -2137

Variable Expenses 

Cost of Merchandise: 21358 18543 

Selling Expense: 10786 9287 

Fixed Expenses 

Salary Expense: 8397 7864 

General Admin Expense: 4838 5709 

Building Expense: 1632 1712 
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Figure 2.11 

9. Format all numbers below Cells B9 and C9 to be Number, zero decimal

places, with the 1000 separator.

10. Center the text on Rows 1, 3, 4 and 5 over the entire report (Note: You

can use the Merge and Center icon for only one row at a time).

11. Go to Cell B12 and create a formula to sum the two cells above it.

12. Copy Cell B12 over to Cell C12.

13. Create a formula to calculate Total Merchandise+Services+Discounts in

Cell B15.

14. Copy that formula to Cell C15.

As a check, the result in Cell B15 should be 83,597 and Cell C15 it should be 73,423. 
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Figure 2.12 

15. Underline Cells B8 through E8, B11, C11, B14, and C14.

16. Bold Cells A9, A15, B15 and C15.

In Column D, we want to calculate the dollar difference in each Revenue line item, and 

we want to calculate the percentage difference in Column E. 

17. In Cell D10, calculate the dollar difference between the July 2011

Mattress revenue number and the July 2010 Mattress revenue number.

18. Copy that formula down for all revenue line items.  Format the cells as in

Columns B and C.

19. In Cell E10, type  =B10/C10   (which is B10 divided by C10)

20. Format Cell E10 as Percent, one decimal place and copy Cell E10 down

to all revenue line items, using similar bold and underline formatting as in

the other columns.
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Figure 2.13 

Your file should look like Figure 2.13.  In looking at the Revenue section of this 

statement, it looks like things are going well.  Total Revenue at this store is up 13.9% 

over the previous year.  The only revenue line item that is down is Pillow revenue, and 

it’s only down by $88, or 2.5% from the previous year.  Overall, it looks like this store is 

having a good year, in terms of revenue.  Now let’s work on the Expense section of the 

report. 

21. In Cell B22, calculate the sum of Cells B18 and B20.  (Note: Do NOT use

the =SUM() function.)

22. Copy the formula in Cell B22 to Cell C22.

23. Calculate the appropriate formulas in Columns D and E.

24. Bold the cells on Row 22.



Section I:  Beginning Excel 2010 Formatting  2

  59 

Figure 2.14 

Review Questions:  It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 2, Section 1 of 2 
option and complete the review questions.  

Now we’ll get into a formula that’s a little tricky.  I’m going to walk you through a few 

steps and we’ll calculate the wrong formula just so you can see why it’s wrong.  Then 

we’ll do it the right way. 

1. In Cell B19, type  =B18/B15

2. Format it as Percent, one decimal place.

Formatted as a percent, the result should be 25.5%.  This number reflects the Cost of 

Merchandise as a percentage of Total Revenue.  Now copy that formula down to Cell 

B21 and see what happens. 

3. Copy the formula in Cell B19 to Cell B21.
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Figure 2.15 

Handling Errors 

You should get a #DIV/0! (divide by zero) error.  This happens when you try to divide a 

number by zero, which is mathematically impossible.  There are numerous kinds of errors 

you can get when developing an Excel file.  The table below lists the most common types 

of errors and what they mean. 

Error Description 

##### The column isn’t wide enough to show the entire number. 

#VALUE! There is an error in writing the formula (like you put a text string where a 

number is required) 

#NAME? The formula includes a function or range name that Excel doesn’t 

recognize. 

#REF! The formula is referring to a cell that doesn’t exist. 

#DIV/0! The formula is trying to divide a number by zero. 

Absolute, Mixed, and Relative References 

Let’s take a closer look at the formula.  If you click on Cell B21, you will see that the 

formula reads “=B20/B17”.  In our spreadsheet, we want to divide all of the expense 
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numbers by the Total Revenue line for each respective MTD number.  You did that in the 

formula you wrote in Cell B19, but when you copied it to Cell B21, the denominator 

changed from B15 to B17.  You need to make the denominator remain static, or fixed, 

and let the numerator (the number on top) move as you copy the formula.  You do this by 

using Absolute, Mixed and Relative references.  In our case, we want the formula in 

Cell B19 to always divide by Cell B15.  An Absolute reference means that cell reference 

(both the row and column) will remain fixed no matter where you copy it to.  This is done 

by placing a dollar sign (“$”) in front of the Column and Row references.  A Mixed 

reference is used when you want to allow the column OR row to remain fixed during the 

copy routine. A Relative reference is when there is no dollar on either the row or column 

reference. 

Let’s try it. 

4. Edit the formula in Cell B19 to  =B18/$B$15

5. Copy Cell B19 to Cell B21.

Figure 2.16 

The result in Cell B21 should be 12.9% and you will see the formula:  =B20/$B$15.  It 

now appears to be working.  Now let’s copy the formula to Column C. 

6. Copy Cell B19 to Cell C19.
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Figure 2.17 

Is it working?  Let’s see.  The formula in Cell C19 returns 22.2%.  Is that the right 

number?  Well, the calculation would be 18,543 divided by 73,423, which is 25.3%.  

Why did we get a different number?  Take a look at the formula.  When you copied it 

over, it is still using B15 as the denominator (because of the absolute reference) whereas 

it should be using C15.  So in this case we need to make the row stay fixed and allow the 

column to change.  This is a good lesson to learn – check and re-check your calculations 

to make sure they are working as expected. 

7. Edit the formula in Cell B19 to be  =B18/B$15

8. While on Cell B19, press [Ctrl]+c (to copy the formula into memory),

click on Cell B21, hold down the [Ctrl] key, click on Cells C19, C21, B23

and C23, release the [Ctrl] key and press [Enter].

Trick:  While typing a formula, you can toggle between an Absolute,

Mixed and Relative references by typing the [F4] key.  Try it.  In a blank

cell, type =A1, but don‟t press [Enter] yet.  While in Edit mode with the

blinking cursor at the end of A1, press the [F4] key a number of times and

you will see it toggles between $A$1, A$1, $A1 and A1.
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Figure 2.18 

9. Bold Cell A17.

10. Perform similar calculations in the Fixed Expense section of the Net

Income Statement to calculate Fixed Expenses.

11. Calculate Total Expenses (Variable Expenses + Fixed Expenses) and

Net Income (Total Revenue less Total Expenses) and the appropriate %

of Revenue calculations.

12. Input the appropriate formulas in the $ Diff and % Diff columns.

13. Bold the rows for Fixed Expenses, Fixed Expenses Total, Total

Expenses and Net Income.

14. Copy Cell B19 to all of the % of Revenue cells.

15. Italicize all % of Revenue rows.

16. Center all of the % of Revenue calculations so they don‟t appear to be

right-justified with the other numbers.
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Figure 2.19 

Indenting 

Sometimes you will want to offset, or indent, text within a cell to make the report a little 

more readable.  You do this by using the Increase and Decrease Indent icons. 

1. Click on Cell A19 and click on the Increase Indent icon .  

2. Indent all % of Revenue references in Column A.

3. Bold the Nitey-Nite Mattresses title and increase the font size to 14.
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4. Italicize Cells A3 and A4 and increase the font size to 12.

Figure 2.20 

Fill Color and Font Color 

Let’s pretty it up a little more by adding some color.  With Excel, you can change the 

color of the font (the text) by using the Font Color icon or you can add color to the 

background of the cell by using the Fill Color icon. 
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1. Select Cells A1 through E5.

2. Click on the drop down button beside the Fill Color icon in the Font

group  and choose Yellow.

3. Click on the drop down menu beside the Font Color icon in the Font

group  and choose Dark Blue.

4. Select every even-numbered row starting at Row 10 (Rows 10, 12, 14 and

so forth through Row 38).

5. From the Fill Color icon, choose White, Background 1, Darker 15%.

Figure 2.21 

Borders 

One feature of Excel that I really like and use a lot is the ability to draw lines or borders 

around or within a report. 

1. Select Cells A1 through E39 (the entire report).
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2. Click on the drop down arrow beside the Borders icon in the Font group 

 and choose Outside Borders. 

 

Notice that the Borders icon is now changed to be the last border type used, which is the 

Outside Border.  The same holds true for the Fill Color and Font color icons (they have 

changed to be the last color you used).  Using the Borders icon, you can draw all kinds of 

borders and lines around any cell you want. 

 

3. Select Cells A1 through E5. 

4. Click on the Outside Borders icon. 

5. Select Cells A7 through E39. 

6. From the Borders drop down arrow, choose the All Borders icon. 

 

Undo and Redo Buttons 

 

Now that I look at it, I really don’t like the All Borders in the whole report.  I believe the 

shading every other line is enough to break up the monotony of the report. 

 

7. Click the Undo icon  (in the Quick Access Toolbar, which we‟ll 

discuss later) to undo the All Borders. 

 

I use Undo and Redo  icons all the time.  As implied, these icons will undo and redo 

the previous action(s) performed.  Notice that there is a drop down arrow next to each of 

those icons.  You can use this drop down arrow to go backward or forward to a specific 

action you performed.  Note that if you choose a previous action from the menu, it will 

undo or redo all actions up to that point. 
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Figure 2.22 

 

Now we are ready to analyze this store’s performance.  Total Revenue is up 13.9% over 

the prior year, which is the right direction.  Variable Expenses are also up, but at a 

slightly higher rate (15.5% over prior year).  Both Cost of Merchandise and Selling 

Expenses have increased more than revenue, which may be an area of concern.  Fixed 

Expenses, however, are lower than in the prior year, which may mean that fixed expenses 

are under control, or at least we are improving year over year.  Store management may 

not have the ability to alter Cost of Merchandise, as that is something that is determined 

by the vendors or by management.  In our case, retail prices are also mandated by the 

home office, so the primary means by which store management can affect business is 
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through increased sales and managing Fixed Expenses.  Total Expenses are up in 

comparison to the prior year, but they are not up in terms of percent as high as Total 

Revenue, which is good.  That leads to a favorable year over year Net Income amount.  

Net Income is up 20.7% over the prior year, and it now represents 43.8% of Revenue.  

Last year, Net Income represented 41.3% of Revenue, which seems to be reflective of 

improving financial management. 

Working with Graphics 

Another topic I want to review with you in this chapter is working with graphics and 

images.  In Figure 2.22, you can see that we typed the name of the company, Nitey-Nite 

Mattresses, at the top of the spreadsheet.  You can also import a graphic, like a logo, onto 

a spreadsheet.  Once it’s imported, you can move it to any position in the spreadsheet and 

resize it as well as change it in other ways.  Let’s import the Nitey-Nite logo (a jpeg file 

which you will actually create in a later chapter) to work with as an example. 

1. Place your cursor on Cell G1 and click on the Insert tab.

2. In the Insert tab in the Illustrations group, click on the Picture icon

Figure 2.23 

3. Navigate to C:\ExcelCEO\Excel 2010\Chapter2, click on the logo.jpg file

and click the Insert button.
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Figure 2.24 

 

The image should import as in Figure 2.24.  When the image is imported, you will see a 

new contextual tab appear called Picture Tools, Format.  A contextual tab appears 

when certain objects are selected that need a unique set of tools.  The Picture Tools, 

Format contextual tab appears whenever an image is selected.  It allows you to use 

special tools to work with images. 

 

You can now drag the graphic to anywhere on the spreadsheet you want.  You know the 

graphic is selected when the small circles appear around the graphic.  The small circles 

are called handles.  Let’s drag the image over the Nitey-Nite Mattresses text. 

 

4. Click and drag the image and position it over the blue Nitey-Nite 

Mattresses text. 
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Figure 2.25 

 

As you can see, the graphic is real close to the “Summary Net Income Statement” text, 

but not to worry.  We can resize the graphic to make it a little smaller by clicking the 

handles. 

 

5. Click the bottom right handle and drag the graphic to the left and up. 

6. Resize it until it is big enough to fit over the Nitey-Nite Mattresses text 

but not too big to cover the text below it. 

7. Reposition the image to where it is centered over the report. 

8. Click anywhere outside the graphic to deselect it. 
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Figure 2.26 

 

9. Save the file. 

 

Templates 

 

You’ve spent a lot of time working on this file, haven’t you?  And I must admit, that’s a 

pretty good looking report.  Your manager also thinks it’s a great report, and he decides 

that he wants to use this format for ALL the summary financial statements from here on 

out.  You suggest to him that you save this file as the standard, or template, for all future 

financial statements.  He thinks that is a great idea, and you proceed to do so. 

 

A template is simply a pattern that is saved where you have all of the formatting and 

formulas designed just like you want them.  A template should contain no data -- just the 

format and formulas.  To save an existing file as a template, you should first delete all of 

the data (NOT the formulas) and save it as a file type of template.  Let’s use the 

myNet_Inc file as the base for the template. 

 

1. With the myNet_Inc.xlsx file open, take out the shading to the right of the 

statement (Hint: Select all cells to the right of Column E and choose No 

Fill from the Fill icon). 

2. Delete all of the hard-coded numbers in the file (NOT the formulas). 

3. Change Cell A4 to be As of ??/??/???? 
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4. Change Cells B8 and C8 to be mm yy.

The statement should now look like this: 

Figure 2.27 

The #DIV/0! error message will appear until there are numbers in the appropriate cells. 

5. Click on File, Save As, and in the Save As dialog box, click on the Save

as type drop down menu and choose Excel Template (*.xltx).
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Figure 2.28 

Notice that when you choose Excel Template (*.xltx), the directory is automatically 

changed to the default Roaming Microsoft Templates directory.  It is a good idea to store 

templates in this directory so they will be available through the Templates dialog box. 

6. Change the name of the file to myNet_Inc_Tmpl and click Save.

7. Close the template file.

After you closed the file, you realized that you still have Store No 1026 hard-coded.  

Changing a template is easy – just open it up and change it. 

8. Click on the File tab, Recent icon.

9. Under the Recent Workbooks section, click on myNet_Inc_Tmpl (it 
should be the first file in the list)

10. Change Cell A5 to Store No. ????, save and close the myNet_Inc file. 

Your changes are now saved to the template.  

Review Questions:  It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 2, Section 2 of 2 
option and complete the review questions. 
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Conclusion 

In this chapter, you learned about the importance of the underscore character in 

field/column names.  You learned more about formatting icons that are available in the 

Home tab.  You used the Format Painter icon and different types of cell formats.  You 

reviewed how to copy cells and performed a “mass” copy job.  You learned how to use 

the AutoSum feature (many experienced Excel users don’t even know about that one).  

You learned how to use Custom Formatting for special formats that aren’t already 

available in the standard formatting choices.  You learned about the various kinds of 

errors and what they mean.  You saw how to use Absolute, Mixed, and Relative 

references in formulas.  You learned how to indent text within a cell.  You added color 

and lines to a report using the Fill Color, Font Color and Borders icons.  You learned how 

to undo your mistakes and redo actions by using the Undo and Redo buttons.  You used 

all of these tools to format an existing file to make it look much more presentable and 

you created an income statement almost from scratch.  The end result was a report that 

you could be proud to present to any level of management.  We even took a little time to 

analyze the final report.  You ended the chapter by importing, moving and resizing a 

graphic and you created a template file. 

Chapter Exam 

You can now go to www.ExcelCEO.com, click on Sign In, log in and take the 

exam.  Make sure that you take the exam on the same computer that you completed the 

sample files on, as some of the questions on the exam may refer to some of the 

completed examples. 

http://www.ExcelCEO.com/
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_____________________________________ 

 Excel 2010
Complete Self-study Course
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CHAPTER THREE – SIMPLE GRAPHICS AND FLOWCHARTS 

In this chapter, you will: 

 Customize the Quick Access Toolbar.

 Create a new folder from the Open dialog box.

 Create Shapes and Objects.

 Create, resize, move, and format a Text Box.

 Use WordArt to create pictures and graphics.

 Create a Flowchart using Shapes.
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Quick Access Toolbar 

There are many useful icons available in Excel 2010.  Most of the icons are the same as 

the ones in Excel 2007.  You can also customize Excel 2010 to make it friendlier to the 

way you work.  One of the customization features I like that makes things easier is the 

Quick Access Toolbar.  The Quick Access Toolbar is located above the File and Home 

tabs and is where you can place the icons that you use most frequently.  By default, the 

Quick Access Toolbar comes with the Save, Undo and Redo icons.  A picture of the 

Quick Access Toolbar is illustrated in Figure 3.1.   

Figure 3.1 

If you hold your cursor over the drop down menu to the right of the Quick Access 

Toolbar, you will see a screen tip that reads Customize Quick Access Toolbar.  In this 

next exercise, we will add icons to the Quick Access Toolbar using two different 

methods. 

1. Open a blank spreadsheet in Excel 2010 (click on the File tab, then New,

Blank Workbook, Create).

2. Click on the drop down arrow to the right of the Quick Access Toolbar.

Figure 3.2 

The Customize Quick Access Toolbar menu appears.  Twelve options appear in the first 

section.  These are the standard options that Excel allows you to add to the Quick Access 

Toolbar.  Let’s add a few icons that I use most frequently. 
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3. Click on the Open option.

Figure 3.3 

The menu disappears and the Open icon is displayed in the Quick Access Toolbar. 

4. Using the same method, add the New icon.

You can also add icons that don’t appear as standard options in the first menu. 

5. Click on the drop down arrow next to the Quick Access Toolbar, and

click on More Commands…

Figure 3.4 

The Excel Options dialog box appears.  This dialog box is also available by clicking on 

the File tab and choosing Options, and then by clicking on Quick Access Toolbar.  On the 

right side of the dialog box, you see the icons you’ve already added.  Let’s add the Print 

Preview and Find icons.  The Print Preview functionality will be discussed in more detail 



Section I:  Beginning Excel 2010 Simple Graphics and Flowcharts  3

  80 

in Chapter 5.  The Find icon allows you to find a text string or value in the spreadsheet or 

selection. 

6. Click on the Print Preview and Print icon on the left section of the dialog

box (you‟ll have to scroll down to find it), then click the Add>> button

between the two sections.

7. Click on the drop down arrow that currently reads Popular Commands

and choose Home Tab.

8. Scroll about half way down the list of available icons and click on the

Find… icon.

9. Move it over to the section on the right.

10. Click OK.

The Print Preview and Print and Find icons are now added to the Quick Access Toolbar.  

Notice the Move Up and Move Down arrows to the right-most section of the dialog box.  

These arrows allow you to reposition the icons in the Quick Access Toolbar.  Take some 

time to explore this dialog box and discover some of the available options that could 

make your Excel life a little easier.   

Create a Folder from the Open Dialog Box 

To prepare for the next exercise, you need to create a folder.  You can easily create a 

folder from the Open dialog box. 

1. Click on the Open icon on the Quick Access Toolbar and navigate to the

C:\ClineSys\Excel 2010 folder.
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Figure 3.5 

As you can see, there is no Chapter3 folder.  To create the folder, simply click on the 

New Folder icon. 

2. In the Open dialog box, click on the New Folder icon, name the new

folder Chapter3, and click OK.
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Figure 3.6 

The Chapter3 folder is now created. 

3. Click Cancel in the Open dialog box.

Creating Shapes and Objects 

One toolbar that I really liked in Excel 2003 was the Drawing toolbar.  In Excel 2010, 

the Drawing Toolbar functionalities are found in the Insert tab.  There are many more 

icons available in Excel 2010 in the Insert tab than in the Excel 2003 Drawing toolbar.  If 

you’re an artsy kind of person (which I am definitely NOT) these icons can be a lot of fun 

to use.  Even for people like me, having these icons can significantly compensate for my 

lack of artistic ability.  Let’s create a simple text box to show you how some of these 

functionalities work. 

Text Boxes 

Let’s begin our experimentation of creating objects by drawing a text box. 

1. Click on the Insert tab on the Office ribbon.

2. In the Text group, click on the Text Box icon.

3. Move your cursor to bottom right corner of Cell B2, and click and drag to

the bottom right corner of Cell C4.  This action draws the text box.
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4. Release the mouse.

Figure 3.7 

You are now in the Edit mode for a text box.  The text box doesn’t appear to be big 

enough for what we will do, but don’t worry.  Increasing the size of the text box is easy. 

5. Place your cursor over the handle at the bottom right corner of the text

box.

When you place your cursor over any corner handle, it will turn to a diagonal arrow.  

When you click and drag on the corner handles, you adjust the height AND width of the 

text box at the same time.  If you use the handles in the middle of the text box’s outside 

edges, your cursor will turn to horizontal or vertical arrows so you can adjust either the 

height OR the width. 

6. Drag the bottom right handle to the bottom right corner of Cell D5 and

release.

7. Click inside the text box and type:  Nitey-Nite Mattresses

8. To exit out of Edit mode, press the [Esc] key twice.

Figure 3.8 

Let’s format the text and move the text box up a little.  You can use the icons on the 

Formatting toolbar to format the text and background of text boxes. 
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9. Click inside the text box (this puts the text box into Edit mode).

10. Select the text with your mouse.

11. Bold and italicize the text and change the size to a font 14.

12. Drag the right edge of the text box to the right until the text fits on one

line.

13. Drag the bottom edge of the text box up to better align with the bottom of

the text.

14. In the Home tab in the Font group, click on the down arrow on the Fill

Color icon and choose Yellow.

15. Click anywhere on the line around the text box (but not on the handles)

and drag the text box to the upper left portion of the spreadsheet, with the

upper left corner of the text box somewhere in Cell A1.

16. Click on any cell outside of the text box (to exit out of Edit mode).

Figure 3.9 

You can now move this text box to anywhere in your spreadsheet and it will maintain its 

same format.  You can also copy this text box for use in other spreadsheets. 

17. Click anywhere in the text box to select it (it automatically put the text box 
in Edit mode), then click anywhere on the edge of the text box (this selects 
the text box without being in Edit mode).

18. Copy the text box (using the [Ctrl]+c key or use the Copy icon) and paste 
it ([Ctrl]+v, or the Paste icon) somewhere on Sheet2.

19. Save the file as C:\ExcelCEO\Excel 2010\Chapter3\myArt.xlsx.

Review Questions:  It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 3, Section 1 of 2 
option and complete the review questions. 

WordArt 

One of the things I like about writing courses like this is the opportunity I have to 

criticize Microsoft.  WordArt is a fun tool to create more advanced graphics, but they 

changed it a little bit in Excel 2007  from Excel 2003.  I was all ready to slam Microsoft 

on their “enhancement” of Excel 2007’s version of WordArt, but I was disappointed in 

that effort.  When I first looked at WordArt in Excel 2007, I didn’t like it.  But then when 

I started working with it, I liked it MUCH better than the WordArt in Excel 2003.  
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WordArt in Excel 2010 is identical to its 2007 version.  WordArt in Excel 2003 and in 

some other Office 2007 programs like Word and Publisher displays the WordArt Gallery 

dialog box as in Figure 3.10.  

Figure 3.10 

When you click on the WordArt in the Text group of the Insert icon in Excel 2010, you 

get the following: 
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Figure 3.11 

It doesn’t automatically show you the cool kinds of styles available like in the previous 

versions.  However, let’s use it a little and explore some of the enhancements. 

1. Click on the Sheet3 tab.

2. Click on the WordArt icon in the Text group of the Insert tab.

3. Click on the letter A in the third row, four letters from the left.
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Figure 3.12 

Once you click on the letter A, you see the beginning of an object with the text “Your 

Text Here”.  Additionally, the Drawing Tools, Format contextual tab appears in the 

Office Ribbon that contains a number of tools you can use to modify the WordArt 

graphic.  We will use several of those tools just to show you how they work.  You can 

explore other icons on your own. 

4. Replace Your Text Here with Nitey-Nite Mattresses

5. With your cursor, select the text Nitey-Nite Mattresses

6. When you finish selecting the text, release the mouse without moving it.

When you finish selecting the text and release the mouse (without moving it after 

releasing it), you should see a faint image of miscellaneous controls as in Figure 3.13.

Figure 3.13 

7. Move your cursor over the faint image and it will become clearer.

8. In the Font Size box, replace the existing size with 20.

9. Italicize the selection.

10. Click anywhere outside the graphic to deselect it.
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Figure 3.14 

 

The floating graphic is now formatted and can be moved to any part of the spreadsheet by 

simply clicking on it and dragging it to its new location just like you did with text boxes.  

When you click on the graphic to place it in Edit mode, you will see round handles on the 

corners and square handles on its sides.  When you click and drag the round handles, it 

adjusts the height and width of the graphic.  The square handles adjust the height or the 

width, whichever one you choose.  The green handle above the graphic controls its 

rotation.  Click and drag these handles back and forth to see what they do.  Click on the 

Text Effects button in the Format tab and click on the Transform button to give it some 

more pizzazz.  Play around with it as much as you want.  Feel free to explore this feature 

by using different WordArt styles, fonts and colors, as most of the selections in the 

Format tab are self-explanatory.  But now we’re going to explore one of my favorite 

utilities of using shapes, flowchart objects. 

 

Flowcharts 

 

There are many stand-alone flowcharting programs out there, but I have yet to see any of 

them that are easier to use as Excel.  Excel flowcharting is basically putting a bunch of 

text boxes and other objects on a worksheet and connecting them with lines.  You access 

the flowcharting tools from the Illustrations group of the Insert tab. 

 

In this next exercise, we will document in a flowchart an accounting process for 

submitting a journal entry to the General Ledger.  The process is as follows:  1) The 

Senior Accountant creates a journal entry, 2) The Senior Accountant emails the journal 

entry to the Accounting Supervisor, 3) The Accounting Supervisor reviews it and either 

sends it back to the Senior Accountant for rework or, if approved, emails it to the 

Accounting Clerk, 4) The Accounting Clerk uploads the journal entry into the General 

Ledger system.  It’s a straightforward process and easy to put into a flowchart.  To start, 

we need to insert a new worksheet. 

 

1. Click on the Insert worksheet tab next to the Sheet3 tab to insert a new 

worksheet. 

2. Click on the Insert tab, and then click on the Shapes icon in the 

Illustrations group. 
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Figure 3.15 

The Shapes dialog box appears with several choices from which to choose.  You can try 

others later, but for now we’ll concentrate on the Flowchart options. 

3. Click on the Flowchart: Preparation figure . 

4. With your cursor appearing as a “+” sign, draw a rectangle from the

upper left corner of Cell B4 to half way through Cell D7, and release the

cursor.

5. In the Preparation box, type:  Senior Accountant creates/reworks

journal entry.

6. While in Edit mode, click the Center icon on the Alignment group on the

Home tab (to center the text) and click outside the Preparation box.

7. Resize the box using the handles if necessary to look like Figure 3.16.
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Figure 3.16 

 

8. Choose the Flowchart: Process graphic  from the Shapes icon. 

9. Draw the Process box to the right of the Preparation box, beginning at 

about Cell F4. 

10. In the Process box, type:  Senior Accountant emails journal entry to 

Accounting Supervisor.  This is Process Box 1. 

11. Make sure the text is centered, resized and or repositioned the box as 

necessary to appear as in Figure 3.17, and exit the box. 

12. From the Shapes list, under the Lines section, choose Arrow . 

13. Move your cursor (now in the shape of a “plus” sign) over the 

Preparation box and all connection points will turn red.  Position your 

cursor over the right-most red connection point on the Preparation box 

and click and hold. 

14. Now move your cursor over Process Box 1 and all connection points will 

turn red.  Click on the left-most red connection point. 

15. Click outside the flowchart. 

16. Reposition Process Box 1 where the connecting arrow is a straight line 

from the Preparation box to Process Box 1.  The arrow will remain 

connected to Process Box 1 as you move it.  

 

 
Figure 3.17 
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You can also move any of the objects with the arrow keys on your keyboard while the 

object is selected. 

17. Choose the Flowchart: Decision icon  from the Shapes icon, and 

draw the box to the right of Process Box 1.

18. In the Decision box, type:  Approval?

19. Connect Process Box 1 to the Decision box with an Arrow.

Figure 3.18 

At this point, look at Figure 3.19.  You should be able to create the rest of the flowchart 

on your own.  You can create the Yes and No boxes by using a Text Box and taking out 

the border.  Try it on your own and see how close you can get to the end product.  If you 

need a little help, follow steps 20 – 32. 

20. Below Process Box 1, create another Process box that reads: Accounting

Supervisor emails journal entry back to Senior Accountant for

rework.  This is Process Box 2.

21. Connect the bottom connection point on the Decision box to the right side

of Process Box 2 by using an Elbow Arrow Connector .

22. Connect the Process Box 2 to the bottom of the Preparation box by using

an Elbow Arrow Connector.

23. Below and slightly to the left of the Decision box, insert a text box with the

word No in it.

24. Resize the text box to be small and take out the line around it (Right-click

on the No text box and click on the drop down menu beside the line color

icon and choose No Outline).

25. Create another Process box to the right of the Decision box.  In it, type:

Senior Accountant emails journal entry to Accounting Clerk.  This is

Process Box 3.

26. Connect the Decision box to Process Box 3 using an Arrow.

27. Copy and paste the No text box.  In the copied text box, change the text to

Yes and move it to be positioned above the connecting line between the

Decision box and Process Box 3.

28. Below Process Box 3, create another Process box that reads: Accounting

clerk uploads journal entry to General Ledger.  This is Process Box 4.
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29. Connect the two using an Arrow.

30. Below Process Box 4, create a Magnetic Disk object  and label it:  

General Ledger. 

31. Connect the two with an Arrow.

32. Make sure the text in all text boxes is centered.

Your flowchart should look like Figure 3.19: 

Figure 3.19 

33. Save and close the file.

One note on using shapes – if you hold down the [Shift] key while drawing a shape, it 

will keep the shape’s proportions constant.  For example, if you click on the Oval shape 

and draw it with your mouse, you will almost always get an oval shape.  But if you hold 

down the [Shift] key while drawing the oval, it will be a circle. 

In this course, we will use many icons in most of the tabs.   The Shapes objects are just 

one example of the many functionalities available with Excel.  I encourage you to explore 

other tools as you come across them. 

Review Questions:  It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 3, Section 2 of 2 
option and complete the review questions.  

Conclusion 

In this chapter, you learned how to create a folder from within the Open dialog box.  You 

customized the Quick Access Toolbar by clicking on its drop down arrow and choosing 

icons to be included in it.  Next, you learned how to create and format shapes and objects, 
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starting with text boxes.  You discovered how to create graphics using WordArt.  Finally, 

you created a Flow Chart by using the Flow Chart objects in the Shapes dialog box. 

Chapter Exam 

To take the examination for this chapter, you must have successfully completed 

the examination for the previous chapter.  You can now go to www.ExcelCEO.com, 

click on Sign In, log in and take the exam.  Make sure that you take the exam on 

the same computer that you completed the sample files on, as some of the questions on 

the exam may refer to some of the completed examples. 

http://www.ExcelCEO.com/
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_____________________________________ 

 Excel 2010
Complete Self-study Course
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CHAPTER FOUR - SORTING, SUBTOTALING AND FILTERING 

In this chapter, you will: 

 Open and work with multiple files.

 Use the Sort Ascending and Sort Descending icons.

 Perform Custom Sorts.

 Use the Subtotaling feature.

 Perform multiple subtotals.

 Use Filters.

 Customize a Filter.

 Use the Top Ten filter.

 Perform Advanced and Search Filtering.
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Once I had an assignment to take over a report that someone else had developed.  That 

employee had the responsibility of calculating incentive travel.  She created reports 

showing who won the various trips the salespeople could earn.  The top X number of 

salespeople who sold the most over their budget won an all expense paid trip, and 

EVERYONE wanted to win.  My job was to see how this employee created the report, 

and take over the maintenance of the report.  I was expecting to see sophisticated 

calculations, databases, and spreadsheets, as we were doing these calculations for literally 

thousands of sales people.  I discovered she was simply taking a spreadsheet that 

someone in the Accounting department had given her, summing each sales person’s sales 

and sorting it in descending order by the amount sold.  The top producers were the first 

ones on the list, and they got to go on the trip.  We spent a lot of money to take those 

people on the trip, and it was almost scary how easy it was to determine who got to go. 

Excel provides many wonderful tools that allow you to sort, summarize and filter your 

data, without having to do ANY complex calculations.  Sorting data is very useful, 

particularly if you need to rank the data from top to bottom, or if you want to identify 

some type of trends that may exist in the data.  After you’ve sorted your data, you may 

want to calculate subtotals to see sums of certain groups of numbers.  Then you can filter 

out what you don’t need or display only what you want to see.  All of this is done by a 

few simple clicks of the mouse.  This chapter will teach you how to do all of this in just a 

few easy steps.   

Working with Multiple Files 

To begin this chapter, however, I’d like to talk about combining files.  Often, you will not 

be able to control the format or manner in which files or data are sent to you.  When 

people give you information, it is usually in the format that they are more comfortable 

with.  Sometimes it comes to you in different files and you have to put it together.  In the 

next exercise, you will open three files at once and combine them into one file. 

1. Open Excel 2010.

2. Click on the Open icon and navigate to C:\ExcelCEO\Excel

2010\Chapter4.

3. Click on the Aug_Sales.xlsx file, hold down the [Ctrl] key and click on the 

Jul_Sales.xlsx and the Sep_Sales.xlsx files, release the [Ctrl] key and 
click Open. 
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Figure 4.1 

All three files open at once.  You can see all files that are currently open by clicking on 

the View tab and choosing the Switch Windows icon. 

Figure 4.2 

4. If necessary, activate the Jul_Sales file.

5. Save the Jul_Sales.xlsx file as myQ3_Sales.

We will combine the data in each of the files into one file called myQ3_Sales.xlsx.  Now 

that you have the files open, there are various options you have to better organize the 

view to help you work with them.  Let’s arrange them in a cascading order. 

6. Click on the Arrange All icon in the Window group of the View tab.
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Figure 4.3 

The Arrange Windows dialog box appears.  In this box, you can tell Excel how to arrange 

the view of the files. 

7. Click on the Cascade radio button and click OK.

Figure 4.4 

You now see all of the open files in one screen.  The July file does not appear because 

you saved it as myQ3_Sales.xlsx.  To make a file active, just click on the name of the 

file. 

8. Click on the Aug_Sales file to make it active.

Now we will copy the Aug_Sales tab into the myQ3_Sales file. 
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9. In the Aug_Sales file, right-click on the Aug_Sales tab and choose Move

or Copy…

Figure 4.5 

The Move or Copy dialog box appears. 

10. Click on the drop down menu under To book: and choose

myQ3_Sales.xlsx.

11. Click on (move to end) in the Before sheet list, check the Create a copy

checkbox and click OK.

Now the myQ3_Sales file has two tabs:  Jul_Sales and Aug_Sales. 

12. Copy the Sep_Sales tab in the Sep_Sales file over to the myQ3_Sales file.

The myQ3_Sales file should now contain three tabs of data:  Jul_Sales, Aug_Sales and 

Sep_Sales. 

13. Click on the Maximize button on the myQ3_Sales file (to take off the

Cascade view).

14. Save and close the three files.

Sorting 

The next topic is sorting.  Let’s suppose that you want to see how many manufacturers 

you purchase products from.  This is very easy to do, and you can do this by using the 

Sort Ascending and Sort Descending icons.  In the next exercise, you will open the Item 

file and perform sorts on it. 



Section I:  Beginning Excel 2010 Sorting, Subtotaling and Filtering  4

  100 

1. Open the file at C:\ExcelCEO\Excel 2010\Chapter4\Item.xlsx.

2. Save the file as C:\ExcelCEO\Excel 2010\Chapter4\myItem.xlsx. 

Figure 4.6 

This file is the master list of all items that Nitey-Nite Mattresses stocks in their inventory.  

You can see that there are 69 rows of data in the list, with the first row being the column 

names.  That means there are 68 items in the list.  The fields include Item_Number, 

Manufacturer, Product, Size, Quality, Series, Retail_Price and Cost.   

3. Resize all columns so you can see the complete field name and contents of

each cell.

4. Underline the cells in Row 1.

5. Click on the Freeze Panes icon in the Window group of the View tab and

click on Freeze Top Row.

This is one minor functionality that I like better in Excel 2010 than in Excel 2003 – the 

ability to freeze the top row or left column without having to actually click on it.  It’s not 

a big deal, but it can be a time saver. 

6. Right-click on Cell B1, point to Sort and choose Sort A to Z

Note:  There are other ways you can sort data in an Excel 2010 table. One

way is to click on the Data tab and use the Sort A to Z (ascending) and

Sort Z to A (descending) icons in the Sort & Filter group.  If you want to
sort on multiple fields or on formatting options like cell color or font

color, you can use the Sort icon in the Sort & Filter group.

Pay attention to the various options available on the Sort option in the right click menu, 

like sorting by the Cell Color and Font Color options.  Using those options are beyond 
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the scope of this chapter, but they come in handy when you need to sort on cells that 

contain conditional formatting (covered in Chapter 14).   

This list is now sorted in ascending order by Manufacturer.  As you scroll down the list, 

you can see that there are four manufacturers whose names are repeated on numerous 

lines:  Cama, Dream, Leavan and Sleepwell.  Now you want to see all of the items sorted 

by Retail Prices from highest to lowest. 

7. Click on Cell G1 (In actuality, you can click on any cell in Column G, but

DO NOT SELECT the entire column as doing so will sort the data only

that column).

8. Click on the Sort Z to A icon  in the Sort & Filter group of the Data

tab.

Figure 4.7 

The highest price item you have appears at the top of the list, which sells for $1,699.00.  

It is the King size Diamond series mattress from Sleepwell.   

9. Save and close the myItem.xlsx file.

Custom Sorting 

You can also sort on custom lists, like days of the week or months of the year. 

1. Open the file at C:\ExcelCEO\Excel 2010\Chapter4\Aug_Sales.xlsx.

2. Save the file as C:\ExcelCEO\Excel 2010\Chapter4

\myAug_Sales.xlsx. 
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Figure 4.8 

This is a listing of daily sales totals for all of Nitey-Nite’s stores.  It shows the date, the 

weekday and the total sale amount.  Your job is to find out the best and worst sales days 

of the week.  You can do this in a number of ways.  For the purposes of this exercise, we 

will sort the list by weekday beginning with Sunday. 

3. Freeze Row 1.

4. Right-click on Cell B1, point to Sort and choose Custom Sort…

Figure 4.9 
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The Sort dialog box appears.  In this dialog box (which differs significantly from the 

Excel 2003 Sort dialog box), you can sort on many levels.  Excel 2003 offered only three 

sort levels, but in Excel 2007 and 2010 you can sort on as many fields as you have in the 

table, up to 64.   

5. Make sure the My data has headers checkbox is checked.

6. In the Sort by drop down menu, choose Weekday.

7. Leave the Sort on option on Values, and in the Order drop down menu,

choose Custom List…

Figure 4.10 

This is the dialog box that allows you to sort your data using various lists. 

8. In the Custom lists section, click on Sunday, Monday, Tuesday, Wed…

and click OK.

9. Click OK in the Sort dialog box.

Your data is now sorted by Weekday.  To analyze the data, you could write some 

formulas, but you can also look at it on the fly.  Scroll up and down the list and you can 

clearly see that Wednesdays have the lowest total sales.  All Wednesday totals are less 

than $100,000, and all of the other days’ totals are over $100,000 per day. 
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Subtotals 

To find out what the totals for each day are, you typically have to do some type of 

calculation.  In this case, I would usually use a PivotTable (discussed later in this course), 

but for now we’ll use Excel’s quick and clean subtotaling feature. 

10. With the data sorted by Weekday, click on the Data tab, and click on the

Subtotal icon in the Outline group.

Figure 4.11 

There are various sections included in the Subtotal dialog box.  The At each change in: 

box allows you to specify the field you want to subtotal.  In our case, we want a subtotal 

for each change in Weekday.  You can choose Sum, Count, Average, Max, Min, and 

other functions in the Use function: box, depending on the type of subtotal you want.  

Typically, you perform calculations on numbers (sales, quantity, etc.) and you count non-

numbers (weekdays, contracts, names, etc.).  You check the fields you want to create 

subtotals for in the Add subtotal to: list.  By default, Excel checks the last box.  The next 

three check boxes allow you to replace subtotals that may currently be in the list, insert a 

page break between subtotal groups, and summarize groups below the data.  Finally, you 

can remove all subtotals by clicking the Remove All button. 

11. Choose Weekday in the At each change in: list.

12. Make sure Sum is chosen in the Use function: list.

13. Make sure the Amt field in the Add subtotal to: list is checked.

14. Leave the Replace current subtotals and Summary below data boxes

checked.
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Figure 4.12 

15. Click OK.

Figure 4.13 
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16. Resize all columns if necessary.

Your data now contains subtotals after every change in weekday.  With the Subtotaling 

tool, you can organize your data into levels.  Look to the extreme left of the spreadsheet 

and you will see grouping level boxes .  You can change the view of the data by 

simply clicking on the desired level box. 

17. Click on Level Box 1.

Figure 4.14 

The data is now summarized at a Grand Total level. 

18. Click on Level 2.

Figure 4.15 

The data is now summarized at the weekday level.  With the data summarized at the 

Weekday level (Level 2), you can easily see that Monday’s total of $837,964 is clearly 

the highest sale day for the month of August.  Sundays and Tuesdays appear to be the 

next highest days, but wait.  August has 31 days and there are five Sundays, Mondays 

and Tuesdays in August.  It would probably be better if we looked at the average daily 

sale instead of the total daily sales in August.  Let’s change up our subtotaling to do that. 

19. With any cell in the subtotals selected, click on the Subtotal icon.

20. In the Subtotal dialog box, change the Use function from Sum to Average and

click OK.
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The Subtotal list expands out to show all data and the Total for each day changes to 

Average. 

21. Click on the Level 2 box.

22. Expand the column widths if necessary to see all the data.

Figure 4.16 

We see that Mondays is still the highest average sale day, followed by Tuesday and 

Friday.  Wednesday and Saturday appear to be lackluster days, so you may want to 

suggest that Nitey-Nite Mattresses hold specials on Wednesdays and/or Saturdays to help 

boost sales on those days.  You can display and hide further detail or subtotals by 

clicking on the Show Detail  or Hide Detail  buttons. 

23. Click on the Show Detail icon  next to Wednesday (Row 24). 

Figure 4.17 
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Now you see the detail and aveage for Wednesday. 

24. Click on the Level 3 box.

Figure 4.18 

The data returns to showing the subtotals for all data. 

25. Save and close the file.

Multiple Subtotals 

The Subtotaling feature also allows you to perform subtotals on multiple levels of data. 

1. Open the file at C:\ExcelCEO\Excel 2010\Chapter4\2009_Sales.xlsx.

2. Save the file as C:\ExcelCEO\Excel 2010\Chapter4\my2009_Sales.xlsx. 
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When using Subtotals, it is important to remember to FIRST sort the data in the same 

order you want to subtotal for, THEN perform the subtotals.  In this spreadsheet, monthly 

sales for each store are listed.  The fields we have to work with are Region, State, 

Store_No, Year, Month, Sales and Cost.  We want to analyze Sales at ALL levels of the 

company, so we have to sort by Month, Store_No, State and Region.  To perform a 

cumulative sort on multiple levels of data, you must first sort by the field that contains 

the lowest level of data and work your way up to the highest.  In this example, the lowest 

level is by Month, and the highest level is by Region. 

3. Sort the table on the Month field in ascending order.

4. Continue to sort the data in ascending order in this order: Store_No,

State, Region.

Figure 4.19 

Now that the data is sorted appropriately, let’s perform our multiple subtotals. 

5. With your cursor on only one cell on the spreadsheet, click on the

Subtotal icon in the Outline group of the Data tab.

6. In the Subtotal dialog box, make sure that Region is chosen under At

each change in:, Sum is selected under Use function:, Sales and Cost

are both checked under Add Subtotal to:, and the Replace current

subtotals and Summary below data boxes are checked.
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Figure 4.20 

7. Click OK.

Subtotals are now added at the Region level.  Now we will add another level of subtotals 

at the State level.  To do this, you will change the At each change in: box to State and 

uncheck the Replace current subtotals box. 

8. Resize the columns if necessary.

9. Click on the Subtotal icon.

10. Under At each change in: change Region to State.

11. Uncheck the Replace current subtotals box and click OK.
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Figure 4.21 

Subtotals at the State level are added. 

12. Add another level of subtotals at the Store_No level.
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Figure 4.22 

Now you have five levels of subtotals. 

13. Click on the 1, 2, 3, 4 and 5 level boxes and the Show Detail  and Hide Detail 

 buttons to see the detail or summary levels you want. 

Review Questions:  It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 4, Section 1 of 2 
option and complete the review questions.  

Filters 

While subtotaling is a very useful feature, sometimes you just want to filter the data 

without subtotaling.  One option to get that accomplished is to use the Filter 

functionality. 

1. Click on the Subtotal icon and click on Remove All.

2. On the Data tab, click on the Filter icon.
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Figure 4.23 

Drop-down arrows, or the filter arrows, appear to the right of each field in the table. 

3. Click on the State drop-down arrow.
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Figure 4.24 

A list of all the states available in the State field appears.  In this list, you can choose as 

many or as few options as you want.   

4. Uncheck the (Select All) box (all options are deselected), check the IN

box and click the OK button.
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Figure 4.25 

The table is now filtered for only the data where State = “IN”.  Notice that the Row 

numbers turned to blue (indicating they are filtered rows) and the State drop down arrow 

has a small filter icon in it. 

5. Click on the Region drop-down menu.

You see that only the North region appears.  When you choose one filter, the remaining 

fields are also filtered for that selection, so when you picked State = “IN”, which is in the 

North Region, only North appears under Region. 

6. Click Cancel in the Region filter list.

7. Click on the State filter and choose GA in addition to IN, and click OK.

Now you have a filtered list containing all records where the state is either IN (Indiana) 

or GA (Georgia).   

Number Filters 

You can custom filter a list based on a number of criteria.  If you click on any filter, you 

will see different options based on the data type in the field.  For example, if you click on 

the State field filter, you’ll see the Sort A to Z, Sort Z to A and Text filters options.  If 

you click on the Sales field filter, you’ll see a different set of filter options, as the Sales 

field contains numbers, not text.  In this next exercise, we’ll filter the entire list to see the 

top 20 stores in terms of sales per month. 

8. On the State drop-down menu, choose (Select All) (to take off the custom

IN and GA filter) and click OK.
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9. On the Sales drop-down menu, point to Number Filters and choose Top 10…

Figure 4.26 

The Top 10 AutoFilter dialog box appears.  In this box, you don’t have to choose only the 

Top 10.  You can choose Top or Bottom, and you can use the spinner button in the box 

that reads 10 to change the number. 

10. Click on the up arrow in the box that reads 10 and scroll up until it shows

20 (or you can just type 20 in the box).

11. Click OK.

Figure 4.27 
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You now have a list of all the top 20 stores and the months when they were in the top 20.  

Notice it doesn’t sort the data, but it simply chooses the top 20. 

12. Click on the Sales drop down menu and choose (Select All) (to take off the

Top 20 filter) and click OK.

Search Filters 

Excel 2010 added a new feature called Search filters.  When you click on a filter drop 

down arrow, a Search box appears.  As you start to type the characters of the string or 

number you’re looking for, Excel filters the items displayed in the filter list for those 

characters.  This comes in very handy especially when you have a list with hundreds or 

thousands of items.  Let’s try an example using the Items file. 

1. With the my2009_Sales.xlsx file still open, open the Item.xlsx file.

2. Resize all columns so you can read the headings and the data.

3. Click on the Filter icon to apply an AutoFilter to the data.

4. Click on the AutoFilter for Series.

Figure 4.28 
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Notice that a Search box appears under the Text Filters option.  You use this Search box 

to further filter the list. 

5. In the Search box, type the letter o (upper or lower case – it doesn‟t

matter), but don‟t click OK yet.

Figure 4.29 

The list is filtered for all items that contain the letter “o”.  As you type more characters, 

the list is further filtered.  This same feature exists when we explore PivotTables in 

Chapters 11 and 12.  I’m not going to spend any more time on the Search filter, but it is a 

cool thing to know. 

6. Click Cancel.

7. Close the Item.xlsx file without saving it.

Advanced Filtering 

Another nifty function is Advanced Filtering.  With Advanced Filtering, you can set up 

a criteria range and query data that meets that criteria.  Let’s try an example. 
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1. On the my2009_Sales.xlsx file, click on the Filter icon to turn off the AutoFilter.

2. Select Rows 1 through 5 and then click on the Insert icon (not the drop down

arrow next to it) in the Cells group of the Home tab.

3. Copy Cells A6 through G6 and paste the range to Cell A1.

The range A1 through G1 will be the headings for your criteria range. 

4. In Cell E2, type 5.

Figure 4.28 

This setup will query all sales in the table where the month is equal to 5. 

5. Click on the Advanced icon in the Sort & Filter group of the Data tab.

6. Make sure the Filter the list, in place option under Action is selected.

7. In the List range box, type or select $A$6:$G$354 (if it‟s not already there)

8. In the Criteria range box, type or select $A$1:$G$2.
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Figure 4.29 

9. Click OK.

Figure 4.30 

The records below the criteria range are now filtered for all sales in Month 5.  You can 

also query on multiple criteria and use wildcard characters in your criteria.  When you do 

this, however, you must be careful.  Remember that when you input criteria on more than 

one line, Excel will filter records that match EITHER criteria.  Let’s suppose you want to 

filter for all records in May or June where the sales are greater than or equal to $100,000. 
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10. In Cell E3, type 6.

11. In Cells F2 and F3, type >=100000.

12. Click on the Advanced button in the Sort and Filter group.

13. In the Advanced Filter dialog box, change the Criteria range to

$A$1:$G$3 (to add one more row in the criteria).

Figure 4.31 

14. Click OK.
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Figure 4.32 

The list is now filtered for sales equal to or greater than $100,000 in May or June. 

Filtering for Unique Values 

With the Advanced Filter dialog box, you can query a table and extract a dataset of 

unique values.  Let’s suppose you want to extract a list of unique store numbers from the 

2009_Sales table.  In that table, the store numbers are repeated 12 times, one time for 

each month.  All we want is a simple list of all the store numbers (we may need those 

numbers in another analysis we are doing).  With Advanced Filtering, it’s a snap. 

1. Click on the Clear icon in the Sort & Filter group of the Data tab to turn

off the Advanced Filter.

2. Click on the Advanced icon.

3. In the Advanced Filter dialog box, choose the Copy to another location

radio button.

4. Edit the List range: to read $C$6:$C$354 (Column C contains the store

numbers).
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5. Delete the range in the Criteria range box.

6. In the Copy to box, type I1 (This is where we want to put the filtered list.).

7. Check the Unique records only box.

Figure 4.33 

8. Click OK.

Figure 4.34 

You now have a list of unique store numbers in Column I.  Pretty easy, huh? 
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9. Save and close the file.

Review Questions:  It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 4, Section 2 of 2 
option and complete the review questions. 

Conclusion 

In this chapter, you opened and worked with multiple files, arranged them in Cascading 

order and copied tabs from one file to another.  You learned how to use the Sort A-Z 

(Ascending) and Sort Z-A (Descending) icons.  To re-emphasize, when using these icons, 

click on only ONE CELL in the column you want to sort.  DO NOT SELECT THE 

ENTIRE COLUMN.  You also learned how to perform custom sorts on the data.  You 

worked a few examples using the Subtotal feature, which comes in handy when analyzing 

tables with many rows of data.  You performed multiple subtotals on various levels of 

data.  You also learned how to filter data on a spreadsheet including using Filter, custom 

filtering, Top 10 filtering, Search filters and explored Advanced Filters. 

Chapter Exam 

To take the examination for this chapter, you must have successfully completed the 

examination for the previous chapter.  You can now go to www.ExcelCEO.com, click 

on Sign In, log in and take the exam.  Make sure that you take the exam on the 

same computer that you completed the sample files on, as some of the questions on the 

exam may refer to some of the completed examples. 

http://www.ExcelCEO.com/
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CHAPTER FIVE - PRINTING 

 

 

In this chapter, you will: 

 

 Use the Print and Print Preview dialog boxes. 

 Print a multiple page report. 

 Work with Page Breaks and Margins. 

 Insert Headers and Footers. 

 Print using Non-Contiguous Ranges. 

 Hide Rows and Columns. 

 Group columns of data. 

 Use the Page to Fit Functionality. 

 Save a file as a PDF document. 
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Printing 

“The paperless office will never exist.”  At least in my lifetime it won’t.  You can quote 

me on that one.  Excel gives you a wide variety of tools to create, organize, manipulate, 

slice and dice your data, but many people will want to see a printed report or 

presentation.  It will always be necessary to share information with others, and printing a 

report, graph, or table is essential in a working office environment, and more particularly 

in an accounting environment. 

When considering how you want your report to look, it’s best to begin with the end in 

mind.  By that I mean think about how you want your report to look.  How far from the 

edges (top, bottom, right, left) do you want the report?  Do you want it on one page or 

multiple pages?  Landscape or portrait?  Large or small font?  Color or black and white?  

If you can picture in your mind how you want the report to look, you’re half-way there.  

Let’s start off with designing a simple one-page report. 

1. Open the file at C:\ExcelCEO\Excel 2010\Chapter5\Inc_Stmt.xlsx.

2. Save it as C:\ExcelCEO\Excel 2010\Chapter5\myInc_Stmt.xlsx. 
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Figure 5.1 

 

The file is similar to the financial statement you created in Chapter 1. 

 

Print Preview 

 

In Excel 2010, there are a number of ways to display the various print features.  We’ll 

explore those methods in the next few exercises.  To preview how the report will look 

when it is printed, you first need to set the print range.   

 

3. Select the area of the report (Cells A1 through E39). 

4. Click on the Page Layout tab, click on the Print Area icon in the Page Setup 

group, and select Set Print Area. 
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The print area is now set, so you can now preview the report by clicking on the Print 

Preview icon.  If you don’t set the print area, Excel 2010 usually does a good job of 

figuring out what your print area should be, unless there are a lot of blank rows and/or 

columns, so most of the time you don’t even need to set the print area.  I do a lot of non-

contiguous ranges, so I use the Set Print Range functionality quite a bit.  On my 

computer, I have the Set Print Area icon as one of the icons in my Quick Access Toolbar.  

Another icon we placed in the Quick Access Toolbar in Chapter 3 is the Print Preview 

icon.  Print Preview allows you to look at a graphic of the report as it will print 

 

5. Click on the Print Preview icon  in the Quick Access Toolbar. 

 

 
Figure 5.2 

 

Since we haven’t set any of the margins or centered the report yet, it appears at the top of 

the page and over to the left. 

 

In Print Preview mode, there are a number of buttons at the top of the screen.  Some of 

them are not activated if they do not apply.  The Print button prints the document.  The 

Printer status button allows the user to choose a different printer.  Under the Settings 

section are several icons that allow the user to change various settings, such as print area 

selections, page orientation, paper size, margins, and scaling.  The Page Setup link below 

the Settings section is a link to the old Page Setup dialog box that many people used in 

previous versions of Excel.  In the lower right corner of Print Preview view are two 

icons:  Show Margins and Zoom to Page.  You use the Show Margins button to see the 

lines where the margins are set.  The Zoom to Page button allows you to see a larger and 

smaller view of the page as it will print out.  In the lower center section of Print Preview 

mode are navigation buttons that allow you to scroll to the previous page or next page in 

multiple page reports.  To close out of Print Preview view, just click on the Home tab (or 
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any of the tabs along the top of the Office Ribbon).  In the past, I used the Page Setup 

dialog box to perform all of my printing functions, and there are some functionalities in 

the Page Setup dialog box that are necessary to use, so let’s explore using that dialog box. 

 

6. Click on the Page Setup link and the Page Setup dialog box opens. 

7. Make sure the Page tab is selected. 

 

 
Figure 5.3 

 

On the Page tab, you can do things like change the orientation of the page (make it 

Portrait or Landscape) reduce or enlarge it, make it fit within a specified number of 

pages, and change the paper size.  For now, we will accept the default values (Portrait, 

100% of normal size, using Letter size paper). 

 

8. Click on the Margins tab. 
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Figure 5.4 

 

In this tab, you can set the left, right, top, bottom, header, and footer margins.  You can 

also center the report horizontally and/or vertically. 

 

9. Check the Horizontally and Vertically boxes and click OK. 

 

You should now see a full page preview of how your document should appear before it is 

printed, centered horizontally and vertically.   

 

10. Click the Zoom to Page icon. 
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Figure 5.5 

The document increases in size (i.e., it zooms in).  Click the Zoom to Page icon again to 

return the print preview to it full size. 

11. Click the Zoom to Page icon again.

12. Click the Home tab (to get out of Print Preview view and return to the

worksheet).

13. Save and close the file.

Multiple Page Reports 

Let’s open another report for a more complex printing exercise.  In this example, you will 

set up a report to print on multiple pages. 

1. Open the file at C:\ExcelCEO\Excel 2010\Chapter5\ 
Top_Ten_May_10.xlsx.

2. Save the file as C:\ExcelCEO\Excel 2010\Chapter5\ 
myTop_Ten_May_10.xlsx. 

This file is similar to the Top Ten file you completed in Chapter 1.  We will work with it 

to prepare a printed report. 

3. Open the report in Print Preview.
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Figure 5.6 

 

By default, Excel sets up your report in a Portrait format.  In our report, we have 11 

columns of data, consisting of one column of dates and 10 columns of people, and it 

doesn’t appear to all fit in a Portrait mode, as there are only eight fields of data that 

appear in this first page of the report.  If you click on the Next Page button a few times, 

you’ll see that the column headings don’t repeat and that there is partial data on some of 

the pages.  One option to make it fit appropriately is to make the report appear with a 

Landscape orientation. 

 

4. Click on the Orientation button in the center section of the screen and 

change it to Landscape Orientation. 
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Figure 5.7 

 

The report looks better, but still needs some work.  If you click the Next button a few 

times, you will see that the report is now eight pages long (we want it to be three pages 

long – one page for each month) and that the last person, Evan Thurston, is on a page by 

himself.  To make Evan Thurston fit on the same page as the other people, we need to 

adjust the margins of the report.   

 

5. Click on the Page Setup link and choose the Margins tab. 

6. Reduce the Left: and Right: boxes down to .25, and the Top and Bottom 

margins down to .50, check the Horizontally and Vertically boxes and 

click OK. 

 

 
Figure 5.8 
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Page Breaks 

 

The report is now down to three pages, but there is some data from April that is still on 

the first page.  We want to display only one month on each page.  One option is to play 

with the Top and Bottom margins until the months all fit on one page each, but in this 

example we will use a Page Break. 

 

1. Click on the Page Layout tab. 

2. Click on Cell A36 (where the date changes from March to April). 

3. On the Page Layout tab in the Page Layout group, click on Breaks and 

choose Insert Page Break. 

4. Insert another Page Break on Cell A69 (where the date changes from 

April to May). 

5. View the report in Print Preview mode. 

 

Print Titles 

 

As you scroll through the report in Print Preview mode, notice how the titles do not 

repeat on the second or third pages.  You will now format the report where those titles 

repeat on every page.  In Excel 2010, you set the titles for each page from the Page 

Layout tab. 

 

1. Click on the Page Layout tab 

2. Click on the Print Titles icon in the Page Setup group of the Page 

Layout tab. 

 

This opens the Page Setup dialog box with the Sheet tab selected. 

 

3. Click in the Rows to repeat at top: box. 

4. With your cursor, choose Row 1 on the spreadsheet and click OK. 
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Figure 5.9 

In this dialog box, you can also make columns to the left repeat on subsequent pages by 

clicking in the Columns to repeat at left: box and then choose on the columns you want to 

repeat.  Now if you click on Print Preview, you will see the three pages on the report with 

the title row repeating on each page.   

Review Questions:  It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 5, Section 1 of 2 
option and complete the review questions. 

Headers and Footers 

Let’s add a header and footer to the report.  In Headers and Footers, you can make text, 

dates, numbers and even images appear at the top or bottom, respectively, on every page 

of the report. 

1. Click on Print Preview, review the report, and click on the Page Setup

link.

2. Click on the Header/Footer tab.



Section I:  Beginning Excel 2010 Printing  5

  136 

3. Click on the Custom Header… button.

4. Click in the Center section and type:  TOP TEN REPORT  and press

[Enter].

5. On the second line, type:  As of May 31, 2010

6. With your cursor, select the TOP TEN REPORT text.

Figure 5.10 

You can change the font in a header or footer section just like you can on a spreadsheet. 

7. Click on the Format Text button in the Header dialog box (the 

Font dialog box appears).

8. Under Font style: choose Bold.

9. Under Size: choose 16 and click OK.
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Figure 5.11 

Now that I see it, I don’t want for the header to be that big, so let’s change it a little. 

10. In the Header dialog box, select TOP TEN REPORT and click the

Format Text button.

11. Under Font style, choose Bold Italic, choose 12 under Size and click OK

twice.

12. In the Page Setup dialog box, click on the Custom Footer… button.

13. Click in the Right section box.

14. Type  Page  and click the Page Number button . 

15. Type  of  and click the Total Pages button  and type  Pages  and click 

OK in each dialog box as you exit Page Setup. 

Note:  You will have to type a space after “Page”, before and after ”of” 

and before “Pages”. 
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Figure 5.12 

Figure 5.13 

Hmmmmmm.   What happened there?  On the Margins tab of the Page Setup dialog box, 

the Header and Footer margins are set to .50 and the Top and Bottom margins are also set 

to .50.  One way to rectify this is to reduce the Header and Footer a bit until they appear 

above the titles.   

16. Click on the Page Setup link and click on the Margins tab.

17. Reduce the Header and Footer margins to 0.25, make the Top margin

0.75 and click OK.
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Figure 5.14 

Figure 5.15 
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Now you can click on the Next and Previous buttons in Page Preview mode to see how 

the report will print.  I encourage you to click on the other buttons in the Header and 

Footer dialog boxes to see what they do.  Note that in these dialog boxes you can insert 

and format a picture (or image). 

Tip:  You can insert a header or footer without opening up the Page 

Setup dialog box.  To do this, click on the Header & Footer icon in the 

Text group of the Insert tab.  This opens the worksheet in Page Layout 
view and creates the Header & Footer Tools Design contextual tab.  

Note that if there frozen panes in the worksheet, the Page Setup dialog 

box will open. 

Non-Contiguous Ranges 

Sometimes you want to print sections of a report that are not located next to each other.  

These are non-contiguous ranges.  There are a few ways to handle this.  One way is to 

hide the rows and/or columns you don’t want to print.  Hiding a row or column is just 

that – hiding.  It does not delete the data.  Another way is to select only the range you 

want to print.  Let’s try both methods.  Let’s suppose that you want to print the report 

only for the months of March and May. 

Hide Rows 

1. Click on the Home tab.

2. With your cursor, select Rows 36 through 68.

3. On the Home tab, click on the Format button in the Cells group.

4. Point to Hide & Unhide and choose Hide Rows.

Figure 5.16 
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Rows 36 through 68 are now hidden.  If you click on Print Preview, you will see 

the rows are also hidden in that view of the report.  However, it’s kind of ugly 

because Page 2 appears with just the column names and no data. 

5. Click the Print Preview button and click the Next button (to see that the

rows are hidden).

6. Click on the Home tab.

7. Click the Undo icon to bring back the hidden rows back into view.

8. With your cursor, select Cells A2 through K35, release the mouse, hold

the [Ctrl] key down and select Cells A69 through K101, and release the

[Ctrl] key and mouse.

9. Set that range as the print area (by clicking on the Page Layout tab,

Print Area icon, Set Print Area) and click Print Preview.

Now only those selections appear in Print Preview. 

Hide Columns 

You can also hide columns.  Let’s suppose that you don’t want to show the data for Lee 

Underwood. 

10. Click on the Home tab.

11. Select Column I.

12. On the Home tab, click the Format icon in the Cells group, point to Hide

& Unhide, and choose Hide Columns.

13. Click Print Preview.

Figure 5.17 

Lee Underwood’s data is now hidden.  But since we took out one individual, it is really 

now the Top Nine report. 
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14. Click on the Home tab and unhide Column I (you use the same procedure

to unhide as to hide).

Grouping 

Another way to hide and unhide rows is to group the data.  Grouping is similar to 

subtotals, which you already learned in Chapter 4, but Grouping does not calculate 

subtotals.  It simply groups the data.  Using Grouping is a great alternative when you 

want the user to be able to easily hide and unhide rows and/or columns.  Let’s take a 

minute to revise the spreadsheet before we do grouping.   

1. In Cell L1 type Total.

2. Calculate the total sales for each day of sales for each row, as well as the

monthly totals.

3. Include Column L in the print range.

4. Select Columns B through K.

5. On the Data tab, click on the Group icon (not the dropdown arrow) in the

Outline group.

Figure 5.18 

The Level boxes (like you saw when you used subtotals) appear in the upper left corner 

of the spreadsheet with a long line centered over Columns B through K, and a Hide 

Detail button over Column L.   

6. Click the Hide Detail button.
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Figure 5.19 

The columns are now hidden and can be easily unhidden or expanded by clicking the 

Show Detail (+) button.  You can also click on the Level boxes (1 and 2) to hide the 

detail (Level Box 1) or show the detail (Level Box 2).  You can group and ungroup rows 

of data using the same methodology. 

7. Click the Show Detail button to expand out the columns.

Page to Fit 

Excel also has a Page to Fit feature that I find very useful.  Typically I use this feature 

when I don’t want to mess around with the margins and font sizes trying to get a report to 

print on just one or a few pages.  Let’s explore that feature. 

8. Click on the Print Preview button.

You see that there are now six pages in the report.  By clicking the Next Page button a 

few times, you will see that pages 4, 5, and 6 contain only one column of data, the Total 

column.  We want the report to be contained to three pages. 

9. Click on the Page Setup link.

10. Click on the Page tab.

11. In the Scaling section, click on the Fit to: radio button, and change the

options to one page wide by three pages tall, and click OK.
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Figure 15.20 

The report is now contained to three pages, with a bit smaller font.  Excel needed to 

reduce the font in Print Preview to fit the report to only three pages.  Notice that the page 

breaks do not work when using the Page to Fit feature.  To get the report to appear 

correctly, we need to play around with it a bit. 

12. Click on the Page Setup link.

13. In Page Setup, change the Top margin to 1 and click OK.

14. Click on the Home tab.

15. In the spreadsheet, insert a row at Row 68.

16. Click Print Preview.

Now that the report is formatted correctly, you can let other people see it.  

Save as PDF 

Sometimes, you want to send a file to someone who just wants to print it out.  Other 

times, you’ll want to save an Excel report out on the Internet.  There is a way to save an 

Excel report to another format where everyone can see it, whether or not they have Excel.  
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It is called a PDF file.  PDF stands for Portable Document Format, and is a non-

proprietary file format, meaning all you need to have to read it is a viewer.  The Adobe 

Corporation has a free PDF reader that is downloadable for free and is called Adobe 

Acrobat Reader.  It is also the most common reader of PDF files.  To create a PDF file 

from Excel, simply save the workbook in a PDF format.  Before you create the PDF file, 

however, you need to make sure the worksheet is formatted exactly as you would if the 

report were to be printed out, as that is how it will appear in the PDF file. 

17. Click on Save As.

18. Click on the Save as type drop down menu, and choose PDF (*.pdf).

19. Make sure the Open file after publishing checkbox is checked and click

Save.

After a second or two, the PDF file will appear.  It is saved in the C:\ExcelCEO
\Excel 2010\Chapter5 folder.  If need be, you can save the PDF file on any drive that 

you can navigate to in the Save As dialog box. 

20. Close the PDF file and save and close the myMay_Sales.xlsx file.

Review Questions:  It is now time to complete the hands-on Review
Questions. Log on to www.ExcelCEO.com with your Email and Password,
click on the Excel 2010 Review Questions, Chapter 5, Section 2 of 2
option and complete the review questions.

Conclusion 

Printing a report and setting up the print properties is probably one of the easiest things to 

do with Excel, and it is something that could get you brownie points or big time black 

marks (if it’s not done properly).  It is good practice to always set a print range and make 

the report look presentable before you send the file to anyone, particularly inexperienced 

Excel users.  Lots of management personnel like to open a file and automatically click 

Print.  You could look bad if they print a report when the print properties are not 

formatted correctly.  It is such an easy thing to do, so why not format ALL of your 

reports BEFORE you send them out?  If you don’t do it, it could result in others having 

less confidence in your abilities.  Trust me – been there, done that, and I’ve got the battle 

scars to prove it. 

In this chapter, you learned how to use the Print dialog box.  You used the Print Preview 

icon numerous times.  You set up a report to print on one page and another report to print 

on multiple pages.  You worked with page breaks to begin a new page at certain places in 

the spreadsheet.  You worked with margins, inserted headers and footers, and printed 

non-contiguous ranges.  You learned how to hide rows and columns without deleting the 

data.  You worked an exercise where you grouped and ungrouped columns of data.  You 

also used the Page to Fit feature, which allows you to automatically fit the text of a 

spreadsheet within certain page parameters without having to adjust margins.  Finally, 

you saved your report as a PDF file. 
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Chapter Exam 

To take the examination for this chapter, you must have successfully completed 

the examination for the previous chapter.  You can now go to www.ExcelCEO.com, 

click on Sign In, log in and take the exam.  Make sure that you take the exam on 

the same computer that you completed the sample files on, as some of the questions on 

the exam may refer to some of the completed examples. 

http://www.ExcelCEO.com/
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 SECTION II:  INTERMEDIATE EXCEL 

I believe writing formulas is the lost art of Excel, as many Excel users have become 

overly dependent on the nifty buttons and icons.  Writing formulas is the foundation of 

Excel, so we will spend a significant amount of time in this course writing formulas and 

using functions.  The entire intermediate section is therefore dedicated to writing 

formulas and understanding how to use functions.  A function is a predefined word in 

Excel that performs a task or calculates a number based on one or more criteria or 

arguments.  A function is always followed by an opening parenthesis, typically with a 

series of arguments and ends with a closing parenthesis.  In many years of working with 

Excel, I have used numerous functions, and I have compiled in this section a list of the 

ones that I use most frequently.  In the following chapters, we will explore each of these 

functions individually and you will work many examples to better familiarize yourself 

with these powerhouses of analysis tools. 

We start off in Chapter Six by learning the basics of operators (Arithmetic, Comparison 

and Text), and learning how to write simple IF statements.  You will review all of the 

major categories of functions in Chapter Seven, as well as learning about Text functions.  

Chapter Eight is the longest chapter in the course, and in that chapter you will learn about 

Financial and Math functions.  Additionally, you will learn about methods of estimating 

value and use the Find and Replace functionality.  In Chapter Nine, you will learn about 

Date, Statistical and Lookup functions. You will take also a brief tour of database 

functions.  Chapter Nine ends with a discussion of Data Validation and using the Text to 

Columns functionality. Chapter Ten is an expansion of Chapter Nine, where you will 

learn some of the advanced uses of Lookup functions.  In this chapter, you will also learn 

about Logical functions, and you’ll finish the chapter by building a complex spreadsheet 

that calculates bonuses based on numerous criteria. 
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_____________________________________ 
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Complete Self-study Course
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CHAPTER SIX - INTRO TO FORMULAS AND FUNCTIONS 

In this chapter, you will: 

 Write basic formulas.

 Use Arithmetic, Comparison and Text Operators.

 Write formulas using the IF() Function.

 Use the Insert Function dialog box.

 Nest IF() Functions.

 Develop an Assumptions Page that contains variables used in your analysis.

 Create formulas without hard-coding values.

 Create a Named Range.

 Concatenate a calculated and formatted number within a text string.

 Use the TEXT() Function.



Section II:  Intermediate Excel 2010 Intro to Formulas and Functions  6

  150 

Introducing Formulas and Functions 

Soon after graduation from college in the 1980s, I began working at a Big 8 accounting 

firm.  I quickly became the spreadsheet guy in the office.  There weren’t too many people 

at the time that had significant spreadsheet experience, and I was very lucky to be one of 

the few who knew my way around a computer.  Many people asked me to put their data 

into a spreadsheet.  Most of the time was spent just inputting their data in Lotus 1-2-3 and 

summing it up, and maybe a few sorts.  One day a manager came to me with a fun 

project.  He had mailed out surveys to some clients and the completed surveys were 

coming back in.  He wanted a program written where a clerk could enter the data from 

the survey onto a spreadsheet and press a button that would copy the data into a database 

and refresh the screen to be ready to enter a new survey.  It sounded real interesting, so I 

took it on.   

I spent about a day programming it and came up with the greatest spreadsheet ever 

created!  It took about 180 keystrokes to enter in all of the information from one survey.  

I was so proud of that program!  I took the 5 ¼” floppy disk to him (which tells you how 

long ago that was) and proudly gave it to him.  I felt like I had really accomplished 

something great that day.  After about an hour, he came back, gave me the diskette 

and said, “I made some changes to it. You may want to look them over.”  My first 

thought was “YOU made changes to MY spreadsheet?  How dare you mess with 
perfection!”  I slapped in the floppy diskette to see what he had done and got the 

education of a lifetime.  He had completely torn apart my spreadsheet and built it back 

up again, and it was SO much more efficient.  Instead of 180 keystrokes, it now took 

only about 90.  He had formulas and functions that I had never heard of before.  

Truly, this man was the spreadsheet god!   

In the following chapters, I will introduce you to many functions – and how to use them 

in writing some very useful formulas.  A formula is an equation that performs 

calculations on the spreadsheet.  A formula always begins with an equal sign (=), and 

may or may not include one or more functions.  But before we get into a in-depth 

discussion of functions, let’s talk about operators.  Operators are critical in writing 

formulas, and it is imperative that you understand them.  Operators are special characters 

that specify the type of calculations performed in formulas.  Excel offers three types of 

operators:  Arithmetic, Comparison, and Text. 
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Arithmetic Operators 

Arithmetic operators perform basic mathematical operations, such as addition, 

subtraction, multiplication, division and exponentiation. 

Arithmetic Operators Definition (Example) 

+ (plus sign) Addition (3+3, 3 plus 3) 

- (minus sign) Subtraction (3-1, 3 minus 1) or Negation (-5, negative 

5) 

* (asterisk) Multiplication (3*5, 3 times 5) 

/ (back slash) Division (6/3, 6 divided by 3) 

^ (caret) Exponentiation (3^2, or 3 squared) 

In formulas, the precedence of arithmetic operators (or the order in which they work) 

work just like you learned in high school algebra: 

1. ^,  Exponentiation

2. * and /, Multiplication and Division

3. + and -, Addition and Subtraction

Let’s try an example. 

1. Open Excel to a blank worksheet.

2. Input the following numbers in the corresponding cells:

A1: 5; A2: 3; A3: 4; A4: 8; A5: 2; A6: 2 

3. Write the following formula in Cell B1:  =A1+A2*A3-A4/A5^A6

Figure 6.1 

The result of this formula is 15.  You can change the order of precedence by putting 

parentheses () around the part of the formula you want calculated first: 

4. Edit the formula in Cell B1 to include parentheses around A1+A2.
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Figure 6.2 

The result changes to 30.  In some formulas, parentheses aren’t necessary, but sometimes 

it helps to include them to help you organize your logic, particularly in long, complex 

formulas. 

5. Close the file (no need to save it).

Comparison Operators 

Now let’s talk about Comparison operators.  Comparison operators are used to compare 

two values to each other. 

Comparison Operators Definition (Example) 

= (equal sign) Equal to (A1=B1, A1 is equal to B1) 

> (greater than sign) Greater than (A1>B1, A1 is greater than B1) 

< (less than sign) Less than (A1<B1, A1 is less than B1) 

>= (greater than or equal to) Greater than or equal to (A1>=B1, A1 is greater 

than or equal to B1) 

<= (less than or equal to) Less than or equal to (A1<=B1, A1 is less than 

or equal to B1) 

<> (not equal to) Not equal to (A1<>B1, A1 is not equal to B1) 

The IF() Function 

When using comparison operators, it is helpful to understand how to use the IF() 

function.  In my opinion, Excel is the best “what-if” tool available, and the IF() function 

is central to “what-if” scenarios.  In this and later chapters, you will see many examples 

using the IF() function.  According to Microsoft Excel Help, the IF statement “Returns 

one value if a condition you specify evaluates to TRUE and another value if it evaluates 

to FALSE.  Use IF() to conduct conditional tests on values and formulas”.  The IF() 

function is a statement that is written to check whether or not a condition is met, and has 

one condition and two arguments.  First is the condition.  Next is the argument if the 

condition is true, followed by the result if the condition is false.  Arguments and 
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conditions in all functions are separated by commas (,).  Let’s work some examples of 

how to use the IF() function and comparison operators. 

1. Open the file C:\ExcelCEO\Excel 2010\Chapter6\June_Sales.xlsx.

2. Save the file as C:\ExcelCEO\Excel 2010\Chapter6\myJune_Sales.xlsx. 

Figure 6.3 

This file contains the sales by store for the month of June 2010.  It includes fields for 

Region, State, Store_No, Year, Month, Sales and Budget.  The Budget is the amount of 

sales that each store is supposed to sell.  If the store reaches or surpasses 100% of 

Budget, the store manager gets a bonus of 1% of the sales for that store.  Stores are 

categorized by small, medium and large stores.  Management calls these levels Paper 

(small), Scissors (medium) and Rock (large) stores.  Your job is to create a schedule 

using this data that identifies: 

 The percent of Budget the store attained (call this column %_Budget,

calculated as the Sales divided by the Budget, formatted as percent, one

decimal place),

 An indication if the manager receives a bonus (call this column

Qual_Bonus, calculated as “Yes” if the store is at least 100% of Budget

and “No” if it is not),

 The amount of bonus the store manager receives (call this column

Bonus_Amt, calculated as 1% of Sales if the previous column is “Yes”,

otherwise 0, formatted as number with two decimal places), and

 The type of store it is: Paper, Scissors, or Rock (call this column

Store_Type, calculated as:  Paper if the Budget is less than or equal to
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$50,000, Scissors if the Budget is $70,000, Rock if the Budget is 

$100,000). 

3. In Cell H1, type:  %_Budget

4. In Cell I1, type:  Qual_Bonus

5. In Cell J1, type:  Bonus_Amt

6. In Cell K1, type:  Store_Type

7. Underline all titles and resize all columns as necessary.

8. In Cell H2, type the formula:  =F2/G2

This formula tells Excel to divide the Sales (Cell F2) by the Budget (Cell G2). 

9. Format Cell H2 as Percent with one decimal place, and copy the formula

down to all cells below.

Figure 6.4 

It worked very well, at least most of it.  In Cell H14, the formula returned #DIV/0!, 

which is the divide by zero error message.  This error occurs when you try to divide a 

number by zero, which is mathematically impossible.  To correct this, you need to edit 

the formula to reflect the following logic: if the Budget (or the number on the bottom) is 

zero, return a zero, otherwise divide Sales by the Budget.  We can do that by using an 

IF() function. 

Insert Function Dialog Box 

There are basically two ways to write an IF() statement: 1) Type the formula directly into 

the Formula Bar, and 2) Use the Insert Function dialog box.  In this course, you will be 

writing a lot of formulas directly into the Formula Bar, but sometimes it helps to use the 
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Insert Function dialog box, particularly when using complex functions.  In the next 

exercise, you will write an IF() statement using the Insert Function dialog box. 

1. Delete the formula in Cell H2.

2. Click on the Insert Function button  to the left of the Formula Bar. 

Figure 6.5 

The Insert Function dialog box appears.  

3. In the Search for a function box, replace the existing text with IF and

click GO.
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Figure 6.6 

The Select a function box below is now filtered for all functions that are similar to an 

IF() function, including lots of logical functions. 

4. Make sure IF is selected in the Select a function box and click OK.

Figure 6.7 
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At this point, the Function Arguments dialog box appears.  In this box, you can type in 

the arguments, conditions and criteria for the function to work.  The text boxes in the 

Function Arguments box change according to the function you chose, as the arguments, 

conditions and criteria are different for most every function.  In our case, we’re using the 

IF() function. 

5. In the Logical_test box, type (or click on) G2=0.

6. Press the [Tab] key to move to the next box.

Figure 6.8 

The first logical test sees if the value in Cell G2 is equal to zero.  In the case of Cell G2, 

it’s not zero (the value in Cell G2 is 70,000), so the condition tested FALSE, hence the 

FALSE reference to the right of the Logical_test box.  The next two boxes return the 

value if the condition is TRUE or FALSE, respectively. 

7. In the Value_if_true box, type 0 (as we want the formula to return a zero

if the Budget or denominator is 0) and press [Tab] to move to the next

box.

8. In the Value_if_false box type F2/G2 and press the [Tab] key.
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Figure 6.9 

Now the dialog box returns the right answer for the formula at the bottom left of the 

dialog box where it reads “Formula result =       93.9%”. 

9. Click OK.

Review Questions: It is now time to complete the hands-on Review
Questions. Log on to www.ExcelCEO.com with your Email and Password,
click on the Excel 2010 Review Questions, Chapter 6, Section 1 of 2 option
and complete the review questions.

Figure 6.10 
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You now return to the spreadsheet where the formula in Cell H2 reads 

“=IF(G2=0,0,F2/G2)”.  The formula says if the denominator (Cell G2) is zero, then 

return a zero as the result.  If the denominator is not zero, then perform the calculation 

F2/G2.  That is exactly what we want, so you can copy the formula to the cells below. 

10. Copy the formula down for all cells below.

The result in Cell H14 now reads 0.0%, which is correct. 

Now that we have all of the %_Budget numbers calculated correctly, we can write a 

formula in Column I that will calculate if the manager of that store receives a bonus or 

not.   

Note: For the remainder of the course, you will type the formulas into the 

cell or Formula Bar without using the Insert Function dialog box.  I 

want you to do this to get used to typing the formulas and functions as it is 

important for your future programming experience.  If you think you need 

to use Insert Function dialog box to help you better understand the 

function, feel free to use it. 

11. In Cell I2, type the following formula:  =IF(H2>=1,”Yes”,”No”)

This formula says that if the result in Cell H2 is greater than 1 (meaning if the sales was 

more than 100% of budget), return the word “Yes”, indicating the store manager 

qualified for a bonus.  Otherwise, return “No”. 

12. Copy the formula down to all cells below.

Figure 6.11 
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As shown in this example, an IF() function can return text strings as well as numbers.  

Whenever you want to type a text string like “Yes”, “No”, “Gold”, “Blue”, or “01ABC” 

within a formula or function, you must put that string between quotes.  Now let’s 

calculate the bonus. 

13. In Cell J2, write the following formula: =IF(I2="Yes",F2*0.01,0)

This formula means that if the store qualifies for a bonus, take the amount in the Sales 

column and multiply it by 0.01, or 1%.  Otherwise, return a zero.  Alternatively, you 

could have written a formula like  =IF(H2>=1,F2*0.01,0).  Either one would work. 

14. Format Cell J2 for Number, two decimal places, with 1000

Separator(,) and copy down.

Figure 6.12 

Nesting IF() Functions 

In this next exercise, you will determine the store type, which is a little trickier.  Instead 

of just one condition, there are three conditions.  Luckily, you can use multiple IF() 

functions within one formula.  In Excel 2003, you were limited to seven functions in one 

formula.  But in Excel 2007 and 2010, you can write up to 64 functions in a single 

formula.  I don’t recommend using that many functions in one cell unless you want to 

drive a first year auditor to the funny farm.  Using multiple functions in one formula is 

called nesting functions.  Excel evaluates functions within a formula from left to right, so 

the first IF() function you write is evaluated first, the second is evaluated next, and so on.  

When writing multiple functions in a formula, you have to remember to place the 

parentheses in the right places.  Let’s try it. 
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15. In Cell K2, write the following formula:

=IF(G2<=50000,"Paper",IF(G2<=70000,"Scissors","Rock"))

The first argument in the formula says if the number in the Budget column (Column G) is 

less than or equal to 50,000, then return “Paper”.  If it is not less than or equal to 50,000, 

then we’ll write another test, which is if the Budget column is less than or equal to 

70,000, return “Scissors”.  For everything else, return “Rock”.  All numbers will fall into 

one of these three categories.  Sometimes it is confusing doing the condition in the 

middle, which could also be phrased as if the Budget is between 50,000 and 70,000 then 

return “Scissors”.  But since Excel evaluates conditions from left to right, we’re OK. 

16. Copy the formula down to all cells below.

Figure 6.13 

17. In Cell A31 type:  TOTALS

18. Write formulas in Row 31 that sum the Sales, Budget, and Bonus Amt

columns, and copy the formula that calculates the % Budget to Row 31.

19. Bold Row 31 and resize the columns as necessary.

The Total Bonus should be $20,832.30.  Pretty cool analysis, huh?  Do you want to make 

it even better?  Stay with me for a little while longer.   

Assumptions Page 

One thing I like to do in my spreadsheets, particularly if the variables I’m using could 

change, is to include all variables on one page called an Assumptions Page.  An 

Assumptions page is simply a tab or sheet that contains any possible variable that may 

change.  Let’s do that now. 
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1. Double-click on the Sheet2 tab and rename it Assumptions.

2. Click and drag the Assumptions tab to the left of the June_Sales tab and

release.

This repositions the Assumptions tab to the left of the June_Sales tab.  I prefer to have the 

Assumptions tab as the first tab in the workbook. 

3. Right-click on the Assumptions tab, point to Tab Color and click on Red.

Sometimes I like to make a tab a different color so it will stand out. 

4. Right-click the Sheet3 tab and choose Delete (since we don‟t need that

sheet).  Click on Delete in the warning box.

5. On the Assumptions tab, in Cell A1 type:  Bonus Percent

6. In Cell A3, type:  Total Bonus Payable

7. Resize Column A to fit.

8. Input 0.01 into Cell B1 and format it as Percent, one decimal place.

9. Click on Cell B3.  Type the = sign, then click on the June_Sales tab and

click on Cell J31 and press [Enter].

10. Make sure Cell B3 is formatted as a Number, two decimal places.

Figure 6.14 

The formula in Cell B3 of the Assumptions tab should now read:  =June_Sales!J31.  This 

is Excel’s way of linking to cells in other tabs.  Note the exclamation point (!) separates 

the cell reference (J31) from the tab named June_Sales. 

11. Click on the June_Sales tab, Cell J2.

The formula in Cell J2 of the June_Sales tab currently reads: =IF(I2="Yes",F2*0.01,0).  

The “0.01” reference is hard-coded, meaning that it is a number, value or text string that 

is written into the formula and cannot change, unless someone changes or retypes the 

formula.  It is my heartfelt belief that numbers in a formula should NEVER be hard-

coded.  I always set up another tab, like the Assumptions page, where I can store all of 

the variables.  If your manager asked you to change that number to 0.015 just to see how 

much bonus would be paid out, you would have to go into each cell and make that change 

(or at least change it in one cell and copy it to all others).  We want to make it REAL 

EASY for the manager to change any variable he wants and immediately see the results.  
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That is why I believe that Excel is the best “what if” tool available today -- it is SO 

EASY to set up these kinds of analyses. 

12. In Cell J2 of the June_Sales tab, select 0.01 with your mouse, click on the

Assumptions tab, click on Cell B1, press the [F4] key to make Cell B1 an

absolute reference and press [Enter].

Figure 6.15 

The formula in Cell J2 of the June_Sales tab should now read:  

=IF(I2="Yes",F2*Assumptions!$B$1,0) 

13. Copy the formula down for all cells except the last cell that contains the

total summation.

This formula means that if Cell I2 is “Yes”, then multiply Cell F2 by whatever value is in 

Cell B1 on the Assumptions tab.  When you copy the formula down, the 

Assumptions!$B$1 remains the same in all formulas, hence the use of the absolute 

reference.  The total Bonus_Amt column should still be 20,832.30. 

14. Click on Assumptions tab, Cell B1.

15. Change the Bonus Percent cell (Cell B1) to 0.015 (or 1.5%) and press

[Enter].

Figure 6.16 

Instantaneously, the Total Bonus Payable changes to $31,248.45.  Now your manager can 

use any bonus percent he wants and can instantly see the change in the total bonus 

payable.   
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Named Ranges 

Sometimes while writing formulas, it is confusing looking at a reference like 

Assumptions!$B$1.  If you wanted to see what value is contained at Assumptions!$B$1, 

you would have to click on that tab and find the cell.  Excel has a way that you can 

rename a cell or a range of cells to something that makes a little more sense and easier to 

program and audit in formulas.  This is called a Named Range or a List Range.  A 

Named Range is a word or string of characters that represents a cell, range of cells, 

formula or constant value.  It’s a good idea to use easy-to-understand names when 

naming ranges.  In the next exercise, we will create an input called Bonus Entry Point 

and create a named range called EntryPoint and refer to it in the formula. 

Let’s suppose your manager wants to know how much would be paid if the entry point to 

start earning a bonus was raised to 110% instead of 100%?  That’s easy, since we know 

how to do it. 

1. On the Assumptions page, insert two rows below Row 1.

2. In Cell A3, type:  Bonus Entry Point

3. In Cell B3, type  110%

4. Format Cell B3 as Percent, zero decimal places.

5. With your cursor on Cell B3, click in the Name Box just above Column

A (it should read B3) and type  EntryPoint and press [Enter].

Figure 6.17 

Typing EntryPoint in the Name Box creates a name for that cell.  Note that you cannot 

use spaces or wildcard characters (*, ? or ~) in a named range name.  You can also create 

Named Ranges for multiple groups of cells, which we will do in later chapters. 

Since the Bonus_Amt field in the June_Sales tab refers to the Qual_Bonus field to 

determine if the store earned a bonus or not, all we have to do is modify the Qual_Bonus 

formulas and the bonus calculation should be correct.  Let’s try it. 

6. Click on Cell I2 of the June_Sales tab.

7. Replace the formula:   =IF(H2>=1,"Yes","No")   with

=IF(H2>=EntryPoint,"Yes","No")
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Notice there are no quotes around EntryPoint.  This is because it is not a text string, but a 

named range, which Excel recognizes just like a value. 

8. Copy the edited formula down to all cells below.

9. Click on the Assumptions tab.

The Bonus Payable is now $26,550.11.  At this point, you can change the Bonus Percent 

and/or the Bonus Entry Point to anything you want and it will immediately calculate the 

Bonus Payable. 

10. Change the Bonus Percent to 1.2% and the Bonus Entry Point to 105%

(Answer: $22,516.28)

By using Comparison Operators and the IF() function in writing formulas, you are limited 

only to your creativity. 

Text Operators 

Now let’s take a look at Text Operators.  The most useful Text operators are the 

Ampersand sign (&) and the quote (“). 

Text Operators  Definition (Example) 

& (ampersand) and 

   “ (quote) Connects or concatenates two values to produce 

one contiguous text string. 

Example: Assuming Nitey-Nite is in Cell A1 

and Mattresses is in Cell B1, =A1&" "&B1 

produces Nitey-Nite Mattresses 

Concatenation 

Let’s try an example using text operators on the Assumptions tab.  In this example, you 

will write a sentence that contains the amount of the Bonus Payable concatenated within 

the phrase. 

1. On the Assumptions tab, Cell A7, type:

="The Total Bonus Payable is "&B5 
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Figure 6.18 

The TEXT() Function 

The number for the Total Bonus Payable is correct, but it’s not formatted.  To format a 

number within a concatenation string like this, you need to use the TEXT() function.  

The TEXT() function formats text into almost any kind of format.  In our case, we want 

to format the result in a currency format.  This is how to do it: 

2. Edit the formula in Cell A7 to be as follows:

="The Total Bonus Payable is "&TEXT(B5,"$0,000.00") 

Figure 6.19 

Notice that the TEXT() function has two arguments: the cell reference or string you want 

to format, and the format type.  The format type is surrounded by quotes.  I encourage 

you to play around with this function and try to create some of your own formats.  To 

create a Percent format with one decimal place, the format type would be “0.0%”.  To 

concatenate more text at the end of the formula, simply type the & sign followed by a 

quote and the text you want.  If the formula ends with a function, you can simply end the 

formula with the closing parenthesis.  Otherwise, you need to end the formula with an 

ampersand sign and a quote.  Let’s suppose you want to end the sentence with a period 

and then a statement that says “Please forward to the Accounts Payable department.” 

3. Edit the formula in Cell A7 to be as follows:
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="The Total Bonus Payable is "&TEXT(B5,"$0,000.00")&". Please 

forward to the Accounts Payable department." 

Figure 6.20 

4. Now change the Bonus Percent to be 1.5%.

The Total Bonus Payable AND the Bonus sentence change when the Bonus Percent is 

modified. 

5. Save and close the file.

Text Operators make it simple to put data in an English sentence which makes it easy for 

people who don’t do well with numbers on a spreadsheet.  You will find this very useful 

for putting two or more strings of data together in one cell. 

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 6, Section 2 of 2 
option and complete the review questions. 

Conclusion 

In the chapter, you learned the basics of writing formulas.  Behind the basics are 

Arithmetic, Comparison and Text Operators, which you should now know very well.  

You were introduced to the IF() function, which is one of the most common 

functions you will use in Excel.  To help you write an IF() function (or any other 

function), you were exposed to the Insert Function Dialog Box.  You learned how to 

use multiple IF() functions in a formula, which is called nesting functions.  You 

developed an Assumptions Page where you stored all of the variables used in your 

analysis.  Using an Assumptions Page makes it useful to avoid hard-coded numbers 

into formulas.  You also created a Named Range, which makes writing and auditing 

formulas much easier.  Finally, you concatenated a calculated number and formatted it 

using a TEXT() function within a text string, making an accurate, easy-to-understand, 

and updatable sentence. 

Chapter Exam 

To take the examination for this chapter, you must have successfully completed 

the examination for the previous chapter. You can now go to www.ExcelCEO.com, 

click on 

http://www.ExcelCEO.com/
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Sign In, log in and take the exam.  Make sure that you take the exam on the same 

computer that you completed the sample files on, as some of the questions on the exam 

may refer to some of the completed examples. 
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CHAPTER SEVEN – TEXT FUNCTIONS 

In this chapter, you will: 

 Write formulas using TEXT functions, including:

o FIND()

o LEFT()

o RIGHT()

o MID()

o UPPER()

o LOWER()

o PROPER()

o LEN()

o TRIM()

o VALUE()
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I LOVE writing formulas.  Here are two of my favorites: 

=IF(ISERROR(VLOOKUP(MATCH(G5,Assumptions!$E$3:$E$10,1),Assumptions

!$D$3:$F$10,3,FALSE)*D5),0,VLOOKUP(MATCH(G5,Assumptions!$E$3:$E$10,1

),Assumptions!$D$3:$F$10,3,FALSE)*D5) 

This one calculates a bonus based on a criteria table.  It’s similar to the one we did in 

Chapter 6 but it does everything in one cell. 

=MID(B2,FIND(",",B2)+2,100)&" "&LEFT(B2,FIND(",",B2)-1) 

This formula takes a name which is formatted as “LastName, FirstName” in Cell B2 and 

switches it to a “FirstName LastName” format.  You will become an expert at this 

formula in this chapter. 

This is what the meat of Excel is all about – writing formulas.  In this and the three 

following chapters, you will work examples using the most popular and useful functions. 

Listed on the next page are the most common functions I have used.  There are many 

other functions in Excel.  However, in my work as an accountant and financial analyst, 

these are the ones I’ve found to be most useful. 



Section II:  Intermediate Excel 2010 Text Functions  7

  171 

Common Functions 

TEXT FINANCIAL DATE & TIME 

FIND() FV() DATE() 

LEFT() IRR() DAY() 

LEN() NPV() MONTH() 

LOWER() PMT() NOW() 

MID() PV() TODAY() 

PROPER() WEEKDAY() 

RIGHT() MATH YEAR() 

SEARCH() ABS() 

TEXT() INT() STATISTICAL 

TRIM() RAND() AVERAGE() 

UPPER() RANDBETWEEN() AVERAGEIFS()* 

VALUE() ROUND() COUNT() 

SUM() COUNTIF() 

LOOKUP & REFERENCE SUMIF() COUNTIFS()* 

HLOOKUP() SUMIFS()* MAX() 

INDEX() MEDIAN() 

LOOKUP() LOGICAL MIN() 

MATCH() AND() MODE() 

VLOOKUP() CELL() RANK() 

IF() 

ISERROR() 

OR 

*New in Excel 2010

Text Functions 

Let’s first talk about Text Functions.  Text functions are basically things you can do with 

text strings. 

1. Open the file C:\ExcelCEO\Excel 2010\Chapter7\Employees.xlsx.

2. Save it as C:\ExcelCEO\Excel 2010\Chapter7\myEmployees.xlsx.

3. Click on the Employee tab. 

This file is a list of the employees at Nitey-Nite Mattresses.  Note that the names in this 

tab are in Last Name, First Name format.  We’ll use this list of names as the example 

behind your lesson on TEXT functions.  In the next few pages, you will write a formula 

in one cell that will turn these names from a Last Name, First Name format into a First 

Name Last Name format.  To accomplish this, you will write a series of formulas using 

only TEXT functions to break apart the first and last names, and then write a formula to 

put it back together again. (We WILL do better than all the king’s horses and all the kings 
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men).  The trick is to write one formula that will accomplish all of this.  We will use 

some of the TEXT functions listed above, as well as our experience in working with 

concatenating strings you learned in Chapter 6 to accomplish it.  But first, let’s go over 

each function. 

The FIND() and SEARCH() Functions 

The first text functions we’ll learn how to use is the FIND() and SEARCH() functions.  

The FIND() function finds a text string (find_text) within another text string 

(within_text), and returns the number of the starting position of the find_text, from the 

first character of the within_text.  You can use the SEARCH() function to find one text 

string within another, but unlike SEARCH(), FIND() is case sensitive and doesn't allow 

wildcard characters.  Following is the list of wildcard characters used in Excel. 

Character Using SEARCH() Finds: 
? (question mark) Any single character 

For example, sm?th finds  

"smith" and "smyth" 

* (asterisk) Any number of characters 

For example, *east finds 

"Northeast" and "Southeast" 

~ (tilde) followed by A question mark, asterisk, or tilde 

?, * or ~ For example, fy91~? finds "fy91?" 

The FIND() and SEARCH() functions have two required arguments and one optional 

argument.  The first argument is the find_text, or the text you want to find.  The second 

argument is the within_text, or the string in which you want to search.  The optional 

argument is the start_num argument.  You use this optional argument when you don’t 

want to start at the first character in the string.  The functions return the number position 

of the text string you’re searching for.  In the next example, you’ll use the FIND() 

function, although either function would work. 

In this example, we want to find the number position of the comma (,) in the cells that 

contain the employees’ name.  The comma is the common character in all of the names.  

You may not understand why we do this right now, but humor me for a few minutes and 

follow along. 

4. In Cell E1, type:  Find

5. In Cell E2, type:  =FIND(“,”,B2)
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Figure 7.1 

 

The result of this formula is 8, meaning that the comma in Cell B2 is in the eighth 

character from the left in the string: Goodson, Virgetta. 

 

6. Copy the formula in Cell E2 down to all cells below. 

 

You see that the comma in the next few cells is found as the sixth character, the ninth 

character, and so on.  It is a very simple function that returns a simple value. 

 

The LEFT() Function 

 

The LEFT() function returns the left-most characters in a text string, based on the 

number of characters you specify.  This function has two arguments: first is the text 

where you want to extract the string from.  Second is the number of characters you want 

to extract, starting from the first character on the left.  Let’s work an example. 

 

7. In Cell F1, type:  Last Name 

8. In Cell F2, type the following formula:  =LEFT(B2,7) 
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Figure 7.2 

 

This formula tells Excel to return the left 7 characters in the text string in Cell B2.  The 

result is “Goodson”.  In this manner, we can extract that last name of the names in 

Column B.  However, the last name won’t always be 7 characters long, like we 

programmed into the function.  How can we calculate the length of the last name?  Well, 

we’ve already calculated where the comma is, and the last name will always end one 

character before the comma.  For “Goodson, Virgetta”, the comma is the eighth 

character, so the last name should be at the comma (or the eighth place) less one.  Let’s 

modify our formula to see if that works. 

 

9. Edit the formula in Cell F2 to the following:  =LEFT(B2,E2-1) 

10. Copy down to all cells below and resize Column F as needed. 

 

 
Figure 7.3 

 

That seems to work.  All we’re doing here is taking the number in Column E less one. 
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The RIGHT() Function 

The RIGHT() function operates in the same way as the LEFT() function, except that it 

returns characters from the right. 

11. In Cell G1, type:  First_Name

12. In Cell G2, type the following formula:  =RIGHT(B2,8)

Figure 7.4 

Again, hard-coding the “8” in this formula will work for the first name, and it will work 

for all first names with eight characters, but it won’t work for all names.  In this case, we 

could use a nested left/right function to extract the correct value, but it’s a lot easier to 

use the MID() function. 

The MID() Function 

The MID() function operates in the same manner as the LEFT() and RIGHT() functions, 

with one additional argument – it requires you to tell the formula which character to start 

on. 

13. In Cell G2, delete the previous formula and type this formula:

=MID(B2,10,8)
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Figure 7.5 

 

This formula tells Excel to return the eight right-most characters starting from the 10
th

 

character from the left.  When we analyze all names, there are two variables we need to 

calculate: first, the character to start on, and second, how many characters are in the first 

name.  Since we’ve already calculated the position of the comma, we know that the 

beginning character of the first name is always going to be at the comma plus two 

(remember to include the space after the comma as a character).  I usually put 100 as the 

number of characters in the first name, as I don’t know ANY first names with more than 

100 characters.  This way, Excel will return all of the characters in the first name.  Let’s 

try it. 

 

14. Edit Cell G2 to the following:  =MID(B2,E2+2,100) 

15. Copy down to all cells below and resize the column as necessary. 

 

 
Figure 7.6 

 

Since you already know how to concatenate cells, all you have to do now is to write a 

formula in Cell H2 to put the first name and last name together. 
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16. In Cell H1, type:  Full Name

17. In Cell H2, type the following formula:  =G2&" "&F2

18. Copy down to all cells below and resize the column as necessary.

We now have the full name, but we would like to put the formula in ONE cell.  So far, 

we used use four columns to come up with the full name.  To put it all in one cell, all we 

have to do is some copying and pasting. 

19. Click on Cell G2.

20. With your cursor, highlight the entire formula in the Formula Bar without

the “=” sign, press [Ctrl]+c to copy the formula into memory, then press

[Esc] to take the action out of copy mode.

Figure 7.7 

All we did here was to put the formula in Cell G2 (without the “=” sign) into memory. 

21. With the formula in Cell G2 now in memory, click on Cell H2 and

highlight G2 in that formula and press [Ctrl]+v (to paste the G2 formula)

and press [Enter].

The formula in Cell H2 should now read as follows:  

=MID(B2,E2+2,100)&" "&F2 

All we did was to replace G2 with the formula in Cell G2.  Let’s do the same for F2. 

22. Click on Cell F2.

23. With your cursor, highlight the formula (without the “=” sign), press

[Ctrl]+c to copy the formula into memory, and press [Esc] (to take the

action out of edit mode).

24. With the formula in Cell F2 in memory, click on Cell H2 and highlight F2

in the formula and press [Ctrl]+v (to paste the F2 formula) and press

[Enter].

The formula in Cell H2 should now read as follows:  

=MID(B2,E2+2,100)&" "&LEFT(B2,E2-1) 
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Figure 7.8 

Come to think of it, the two occurrences of E2 in this formula are also calculated, so we 

can replace those references as well. 

25. Click on Cell E2.

26. With your cursor, highlight the formula (without the “=” sign) and press

[Ctrl]+c to copy the formula into memory, and press [Esc] (to take the

action out of edit mode).

27. With the formula in Cell E2 in memory, click on Cell H2 and highlight the

first occurrence of E2 in the formula and press [Ctrl]+v (to paste the F2

formula), then do the same for the second occurrence of E2 and press

[Enter].

The formula in Cell H2 should now read as follows:  

=MID(B2,FIND(",",B2)+2,100)&" "&LEFT(B2,FIND(",",B2)-1) 

28. Copy down to all cells below.

Figure 7.9 

At this point, you don’t need Columns E, F, and G, so you can delete them. 

29. Delete Columns E, F, and G.
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Figure 7.10 

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 7, Section 1 of 2 
option and complete the review questions.

The UPPER(), LOWER() and PROPER Functions 

There is another thing that we can do to clean up the formula just a little more.  Look at 

Cell E25.  The first name Blair is in caps, whereas all other names are in upper and lower 

case.  Excel has a formula to change text to upper case, lower case or proper case.  Proper 

case is where the first letter of each word is capitalized and the remaining letters are 

lower case.  Let’s enclose our formula with the UPPER(), LOWER(), and PROPER() 

functions. 

30. Edit Cell E2 to input UPPER(  just to the right of the “=” sign and close

the formula with an ending parenthesis.

The formula in Cell E2 should now read as follows: 

=UPPER(MID(B2,FIND(",",B2)+2,100)&" "&LEFT(B2,FIND(",",B2)-1)) 

The name is now shown as VIRGETTA GOODSON. 

31. In the formula in Cell E2, replace the word UPPER with LOWER.

The name is now shown as virgetta goodson. 

32. In the formula, replace the word LOWER with PROPER.

33. Copy down to all cells below.

The PROPER() function capitalizes the first letter in a text string and any other letters in 

the text that follow any character other than a letter.  It then converts all other letters to 
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lower case.  Using the PROPER() function in this formula now converts the name to 

Virgetta Goodson.   

Note: When you use the PROPER() function, names like Jim McGowen 

and Joe Smith III will appear as Jim Mcgowen and Joe Smith Iii.  

Although this function is very useful in some cases, there are still some 

quirks to using it. 

Work this example as many times as you need to lock it in your memory.  You will 

find MANY uses for formulas similar to this one.   

The LEN() and TRIM() Functions 

Now we’ll discuss the LEN() and TRIM() functions.  These functions are very useful 

when analyzing data that may not quite be in the right format.  Sometimes when data is 

copied or imported from one database to another, numbers are copied over as text strings 

and vice-versa.  This sometimes happens when databases are not programmed correctly 

and sometimes it may add characters to the data that are almost invisible to the user. 

1. Click on the Stores tab of the myEmployees.xlsx file.

Figure 7.11 

This is a listing of the stores that Nitey-Nite Mattresses owns.  It was copied directly 

from a SQL Server database and has not been cleaned up yet.  Let’s suppose we want to 

create a formula in one cell that concatenates the Address, City, and State. 

2. In Cell I1 of the Stores tab, type:  Location

3. Format Cell I1 as the other headings.

4. In Cell I2, type the following formula:  =D2&", "&E2&", "&F2
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Figure 7.12 

This formula puts the Address, City and State into one cell, separated by commas.  After 

you type the formula, you see there is a long string of spaces after the address.  It also 

appears there are some spaces before the address, as the address appears to be indented 

from the left.  This adding of spaces happens frequently when data is copied from a 

database into Excel.  Let’s play around with the Address field and see what is there. 

5. In Cell J2, type the following formula: =LEN(D2)

Figure 7.13 

The LEN() function counts the number of characters in the text string in Cell D2 (the 

address).  The string “1082 Glynn Court” has only 16 characters (including two spaces), 

so the result of the formula should be 16, but we see the LEN() function returned 30.  

This indicates that there are additional spaces before, after and/or between the words in 

the address.  You can solve the issue by enclosing the address with a TRIM() function.  

The TRIM () function removes all spaces from a text string except for one space between 

each word. 

6. Delete the contents of Cell J2.

7. Edit the formula in Cell I2 to be the following:

=TRIM(D2)&", "&E2&", "&F2

8. Copy the formula down for all cells below and resize the column.

Now the concatenation of the Address, City and State appears correctly. 
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Figure 7.14 

 

The VALUE() Function 

 

Another useful function is the VALUE() function.  This function turns numbers that are 

shown as text strings into numbers.  For example, sometimes US ZIP codes contain five 

digits and sometimes ten digits (a five and four digit code separated by a dash).  In this 

example, when the data was copied over from a database, Excel recognized the five digit 

codes as numbers and the ten digit codes as text, as you can’t have a dash character in a 

number.  Let’s suppose that we really don’t care about the four digit extension – all we 

really want is the five digit ZIP code formatted as a number. 

 

9. In Cell J1, type ZIP 

10. Format the heading like the others. 

11. In Cell J2, type the following formula:  =LEFT(G2,5) 

 

 
Figure 7.15 

 

When you use a text function like LEFT(), Excel turns the result into a text string.  To 

make that text string a number, you must first be sure there are only numbers in the 

string.  Then you can use the VALUE() function. 

 

12. Edit the formula in Cell J2 to be as follows: =VALUE(LEFT(G2,5)) 

13. Copy down for all cells. 
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Figure 7.16 

Now you have a clean column with five-digit ZIP codes, all in a number format.  You can 

usually tell if a number is formatted as text or as a number by 1) seeing if the number is 

left or right justified (a left-justified number usually indicates it is text); 2) if you can add 

the number(s) (if you can’t add them, they are formatted as text), or 3) if the number(s) 

contains a leading zero (leading zeros indicate a text field). 

Trick:  A quick and dirty way to turn a text string containing only numbers 

into a number format is to just add 0 at the end of the formula.  (Actually, 

any mathematical calculation will work.)  In this example, you would use 

this function:  =LEFT(G2,5)+0.  However, don‟t tell this to programmers.  

Being the purists they are, they will tell you I‟m crazy, but guess what?  It 

works!  Try it. 

14. Save and close the file.

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 7, Section 2 of 2 
option and complete the review questions.

Conclusion 

In this chapter, you learned about the most common functions, and we explored in depth 

the various types of Text functions.  You split apart a name in a last name, first name 

format using the FIND(), LEFT(), and MID() functions.  You also worked an example 

using the RIGHT() function.  You then concatenated the first name and last name fields 

in one impressive formula.  You saw how to change the case sensitivity of text by 

working examples using the UPPER(), LOWER(), and PROPER() functions.  You 

learned how to use the LEN() function to find out how many characters are in a cell.  You 
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used the TRIM() function to take out spaces before and after a text string.  Finally, you 

learned how to use a VALUE() function to turn a number formatted as text into a 

number. 

Chapter Exam 

To take the examination for this chapter, you must have successfully completed 

the examination for the previous chapter.  You can now go to www.ExcelCEO.com, 

click on Sign In, log in and take the exam.  Make sure that you take the exam on 

the same computer that you completed the sample files on, as some of the questions on 

the exam may refer to some of the completed examples. 

http://www.ExcelCEO.com/
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CHAPTER EIGHT –FINANCIAL AND MATH FUNCTIONS 

In this chapter, you will: 

 Create formulas using Financial Functions, including:

o PMT()

o PV()

o FV()

o IRR()

o NPV()

 Create an amortization schedule.

 Work with Scenario Manager.

 Create a Proforma Income Statement.

 Estimate the value of a business, investment or income-producing property

by using the Direct Capitalization and Discounted Cash Flow (DCF)

methods.

 Work with the Find and Replace functionality.

 Write formulas using Math Functions, including:

o RAND()

o INT()

o ROUND()

o ABS()

o SUMIF()

o SUMIFS()
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Financial and Math Functions 

I just LOVE math.  My idea of a good time is solving algebraic problems on the white 

boards in my office.  I do realize, however, that some people don’t share my enthusiasm 

for math.  I’ll assume if you’ve made it this far in the course, you either share my 

enthusiasm or someone is forcing you to take it (hopefully the first). 

Financial Functions 

If you’ve ever taken a Finance class, you should remember the discussions on calculating 

a payment (PMT), Present Value (PV), Future Value (FV), Internal Rate of Return (IRR) 

and Net Present Value (NPV).  With Financial functions, Excel makes it easy to 

calculate those values.  Let’s begin with the PMT() function. 

The PMT() Function 

The PMT() function is one of the most commonly used functions for financial people.  

We always want to know what the payment is, particularly when we are analyzing our 

own home loan or applying for some other type of loan.  The PMT() function has three 

required arguments: interest rate, number of periods and present value.  You can also 

include two optional arguments: future value and type.  Future value is the cash balance 

you want to have after the last payment is made.  A type of one means payments are 

made at the beginning of the period, and a type of zero means payments are made at the 

end of the period.  If the future value and type arguments are left out, Excel assumes a 

zero for each.  In this first exercise, you will calculate the mortgage payment for a 

$200,000 loan. 

1. Open Excel to a new workbook.

2. Save the new workbook as C:\ExcelCEO\Excel 2010\Chapter8\myAmort.xlsx.

3. Type data onto the spreadsheet to look like Figure 8.1. 

Figure 8.1 

4. In Cell B4, type  =PMT(B1/12,B2*12,B3)

5. Format Cell B4 as Currency, two decimal places.
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Figure 8.2 

 

Let’s discuss the different parts of the formula.  The interest rate in our analysis is 8%, 

which is an annual interest rate.  To calculate a monthly payment, we have to convert the 

annual interest rate to a monthly interest rate.  We do that by dividing Cell B1 by 12.  

The number of periods is 30, or 30 years.  That is a common number of periods for a 

home loan.  Again, this is an annual number that we need to convert into a monthly 

number, and we do that by multiplying the number of periods by 12.  Finally, we input 

the present value of the loan, or $200,000.  Note that we input that loan amount and not 

the sale price of the house.  You can buy a $250,000 house and put $50,000 down for a 

loan amount of $200,000, or you can buy a $300,000 home with $100,000 down and you 

would have the same loan amount and payment.  The payment is calculated on the loan 

amount, not the purchase price of the home. 

 

Notice that the formula returns a negative number.  If the present value of the home is a 

positive number, then the payments should be negative to support that payment.  One 

value is a cash inflow (the present value of the home) and the other is the cash outflow 

(the payments).  You can make the payments be a positive number by simply putting a 

minus sign in front of the formula or the reference to Cell B3, but not in both places. 

 

6. In the formula in Cell B4, put a minus sign before the reference to Cell 

B3. 

 

 
Figure 8.3 

 

Create an Amortization Schedule 

 

Whenever you purchase a home, the lending institution will give you an amortization 

schedule.  An amortization schedule shows the loan balance after every payment, as well 
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as the interest amount and principal applied to each loan payment.  In this next exercise, 

we will create an amortization schedule for the home loan we’ve modeled.   

7. Type the labels in Cells A6 through F6 as follows:

Figure 8.4 

8. In Cell A7, type:  1

9. In Cell A8, type: 2

10. With your mouse, select Cells A7 and A8.  Using the AutoFill box in the

lower right corner of the selected range, drag the AutoFill box until the

ScreenTip reads 360 and release.

This action creates a column of payment numbers. 

11. Freeze the panes at Cell A7.

12. In Cell B7, type:  1/15/2011

13. Format Cell B7 as Date in the format M/YYYY

14. In Cell B8, type:  =B7+(365.25/12)

15. Format Cell B8 as Date in the format M/YYYY.

16. Copy Cell B8 down to all cells below ending at Payment No. 360.
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Figure 8.5 

 

The last date in the range should be 12/2040.  I like to begin using the 15
th

 of the month 

and add 365.25/12 (the .25 accounts for a leap year day every four years) for each month 

to get the next month.  Trust me, if you start with the first day of the month, you will end 

up with some complications in February.  Next you will create names for the various cells 

to make it easier to write your formulas.  We did an example of this in Chapter 6. 

 

17. Name the following cells with the following names: 

Cell Name 

B1 rate 

B2 no_pds 

B3 pv 

B4 payment 
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Figure 8.6 

 

It’s easier to audit formulas when you have logical names for the variables in the 

formulas.  Notice the word “payment” in the Name box in the upper left corner of Figure 

8.6. 

 

18. In Cell C7, type:  =payment 

19. Format Cell C7 as Number, two decimal places, Use 1000 Separator(,) 

and copy down to all cells below. 
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Figure 8.7 

So far it’s been relatively easy, but here comes the tricky part.  We now need to calculate 

the interest attributed to the first payment.  That is done by taking the interest rate 

multiplied by the balance of the loan divided by 12 (since it is a monthly payment). 

20. In Cell D7, type:  =pv*rate/12

21. Format Cell D7 as Number, two decimal places, Use 1000 Separator (,).
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Figure 8.8 

 

We can’t copy this formula down yet because the balance of the loan will change with 

each payment.  Now we will calculate the principal portion of the payment by simply 

subtracting the interest payment from the total payment.  We will then calculate the 

ending balance of the loan by reducing the beginning balance by the principal paid. Let’s 

model it. 

 

22. In Cell E7, type:  =C7-D7 

23. In Cell F7, type:  =pv-E7  (to calculate the loan balance) 

24. Format both Cells as Number, two decimal places, Use 1000 Separator (,). 

 

 

 
Figure 8.9 
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Now that we have the balance of the loan after the first payment, we can write formulas 

that will calculate the interest, principal and new balance of the loan after each payment. 

25. In Cell D8, type:  =F7*rate/12  (which calculates the interest paid on the

new balance)

26. Copy the formula in Cell E7 to Cell E8.

27. In Cell F8, type: =F7-E8

28. Format Cells D8, E8 and F8 as Number, two decimal places, Use 1000

Separator (,).

29. Copy Cells D8, E8 and F8 down to all cells below.

Figure 8.10 

If you did it right, the first few rows will look like the above schedule.  Scroll down to the 

last cell in Column F (Cell F366) and you will see the balance of the loan is zero.  Now 

you can play around with the interest rate, number of periods and loan amount (present 

value) numbers.  If you change the interest rate to 10%, the new payment will 

automatically calculate at $1,755.14.36.  Change the number of periods to 20 and the 

payment changes to $1,930.04.  The amortization schedule also changes with every 

change in the input. 

30. Save the file but don‟t close it yet.

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 8, Section 1 of 4 
option and complete the review questions.

Scenario Manager 

As I have said previously, it is my opinion that Excel is the best “what-if” analysis tool 

on the market today.  One of the features to help users manage various analyses is called 



Section II:  Intermediate Excel 2010 Financial and Math Functions  8

  194 

Scenario Manager.  Within Scenario Manager, Excel allows you to create various 

scenarios, or alternative values for cells in the spreadsheet.  You can add, edit, delete, and 

summarize these scenarios.  In this next exercise, you will build on the skills you learned 

using the PMT() function to analyze various interest rates, number of periods, and loan 

amounts of a prospective loan. 

For this exercise, let’s use the home loan example.  You live in an area where home 

prices average around $300,000 for the type of home you want to purchase.  You have 

about $75,000 in cash for the down payment on the home, but you don’t know if you 

want to spend all of that money on the down payment.  Alternatively, you could put part 

of that money into a money market fund, or just have it in a savings fund for 

emergencies.  With more money paid down on the loan, however, you could get a lower 

annual interest rate on the home loan.  Therefore, you will build an analysis that shows 

the monthly payment, total money paid into the loan and the total interest paid under each 

scenario. 

1. Open up a new workbook.

2. Save it under the C:\ExcelCEO\Excel 2010\Chapter8 folder 

as myScenario.xlsx.

3. Create the analysis as show in Figure 8.11. 

Figure 8.11 

4. The formulas for Cells B5, B9, B10 and B11 are as follows:

Cell B5: =B3-B4

Cell B9:  =PMT(B6/12,B7,-B5)

Cell B10:  =B9*B7

Cell B11:  =B10-B5

5. Round the dollar cells to zero decimal places (except for the Monthly

Payment cell) and format all other cells as shown.
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6. Name the following cells with the indicated ranges:

B4:  down_payment 

B6:  annual_interest_rate 

B7:  number_of_months 

B9:  monthly_payment 

B10:  total_payments 

B11:  total_interest 

This is the first, or base, scenario.  It assumes you will purchase a home for $300,000 and 

pay $75,000 down.  As such, you can get a 30 year (360 month) loan at a 6.25% APR.  

The monthly payment calculates to be $1,385.36.  The Total Payments to be made over 

the life of the loan is $498,731, and the total interest paid over the life of the loan is 

$273,731.  The questions you want answered are 1) what would the monthly payment, 

total payments and total interest figures be if you were to pay only $50,000 down and 

have a higher interest rate; 2) what would the same amounts be if you were to pay a 

higher down payment of $100,000 and get a lower interest rate, and 3) what would the 

numbers be if you were to get a 20 year loan which would qualify you for a slightly lower 

interest rate?  All of these assumptions can be managed by Scenario Manager.  Let’s start 

off by creating the base scenario in Scenario Manager that analyzes the purchase and loan 

if we paid $75,000 down over 360 months (30 years) at an interest rate of 6.25%. 

7. On the spreadsheet, select Cells B4, B6 and B7.

8. Click on the Data tab, then click on the What-If Analysis button in the

Data Tools group, and choose Scenario Manager.

Figure 8.12 
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The Scenario Manager dialog box appears.  

9. Click the Add… button.

Figure 8.13 

10. In the Scenario name box, type Base Scenario and click OK.

Figure 8.14 

The Scenario Values dialog box appears. 

11. Click OK in the Scenario Values box to accept the current assumptions.
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Figure 8.15 

The Scenario Manager now has one scenario listed, the Base Scenario.  To add more 

scenarios, just click Add and follow the same procedure while changing the assumptions 

in the Scenario Values box for each scenario. 

12. Click Add in the Scenario Manager box to add another scenario.

13. Call the next scenario Low down, high interest rate and click OK.

14. Change the values in the Scenario Values box to be consistent with the

following values and click OK.

Figure 8.16 

15. Create another scenario called High down, low interest rate with

$100,000 down at a 5.5% interest rate over 360 months.

16. Create the last scenario with $75,000 down at 6.00% interest rate over 20

years (240 months).  Call it Average down, low terms.
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Figure 8.17 

The Scenario Manager should look like Figure 8.17.  To display the assumptions in each 

scenario in the Excel spreadsheet, simply click the Show button. 

17. Click on the Low down, high interest rate scenario and click the Show

button.
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Figure 8.18 

If you move the Scenario Manager dialog box to the right of the My Home Analysis, you 

will see that the down payment changed to $50,000 and the Annual Interest Rate changed 

to 7.00%.  The Monthly payment went up to $1,663.26 and all of the other numbers in 

the analysis changed according to the changes. 

18. Click on the Average down, low terms scenario and click the Show

button.

Figure 8.19 
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The My Home Analysis changes according to the assumptions in the Average down, 

lower terms scenario.  But what if you wanted to see all scenarios next to each other?  

You can do that too. 

19. Change the current scenario back to the Base Scenario and click the

Summary button.

20. Select Cells B9 to B11.

Figure 8.20 

21. Make sure the Scenario summary radio button is checked and that the

Result cells reads =$B$9:$B$11 and click OK.

Figure 8.21 

Excel creates another tab with the Scenario Summary on it. 

22. Delete Column D (Current Values) in the Scenario Summary tab and

resize columns as necessary.
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Figure 8.22 

Now you have a scenario summary anyone can be proud of.  Personally, I don’t use 

Scenario Manager often.  I send most of my reports and analyses to users who need to 

understand and know how to use them.  Scenario Manager is more of an advanced tool 

that most Excel users don’t know how to use, but it can be very useful for experienced 

users. 

23. Save and close the file.

The PV() Function 

The Present Value function, or PV() function, returns the present value of an investment.  

The present value is the total amount that a series of future payments is worth in today’s 

dollars, discounted back at a certain discount rate.  This function has three required 

arguments and two optional arguments.  The three required arguments are rate (interest 

rate or discount rate), number of periods, and payment.  The optional arguments are 

future value (or a cash balance you want to attain after the last payment is made) and 

type, which indicates when the payments are due.  A type of 0 represents payments at the 

end of the period and a type of 1 represents payments made at the beginning of the 

period.  If the optional arguments are omitted, 0 is assumed for both.  Note that the PV() 

function requires the payment to be in equal amounts, like an annuity. 

Let’s assume you took the advice of the fortune cookie you had at lunch and chose the 

numbers 2, 5, 17, 26, 35 and 49 in the state lottery and you won $20,000,000!  I assume if 

that happened, you wouldn’t be taking this course.  That aside, the state says you can take 

your winnings in 20 annual payments of $1,000,000 per year for the next 20 years, or you 

can take a one-time lump sum payment of $10,000,000.  The lump sum payment 

represents the present value of the 20 annual $1,000,000 payments.  Is that a good deal or 

not?  Which one would you take?  The answer lies in the discount rate.  Let’s suppose 

that you read in the paper that investors were paying an 8% discount rate on lottery 

winnings.  All you have to do is calculate the lump sum payment (or the present value) at 

an 8% rate and compare that with the $10,000,000 the state is offering, and you choose 

the larger of the two.  Let’s do it. 



Section II:  Intermediate Excel 2010 Financial and Math Functions  8

  202 

1. Click on Sheet2 of the myAmort.xlsx file.

2. Rename Sheet2 as PV.

3. Input the following values in the indicated cells:

Figure 8.23 

4. In Cell B4, type this formula:  =PV(B1,B2,B3,0,1)

5. Format Cell B4 as Number, zero decimal places, Use 1000 Separator (,).

6. Resize Columns A and B.

Cell B3 needs to be a negative number as if we were making payments so the present 

value will calculate as a positive number.  I included the optional arguments of 0 as the 

future value (as the state will not make any payments after the last payment) and a 1 for 

the type, assuming you will receive the first $1,000,000 payment immediately.  The 

answer is $10,603,599, as follows: 

Figure 8.24 

This means the investor would make you a lump sum payment of $10,603,599, which is 

higher than the $10,000,000 the state offered you.  Since your name is splattered all over 

the front page after your win, you get a letter in the mail from another investor offering 

you a 10% discount rate.  That sounds better, doesn’t it?  Just to make sure, let’s change 

our discount rate assumption. 

7. Change the Discount Rate to 10%.
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Figure 8.25 

Uh-oh!  Did we do something wrong?  The value went down to $9,364,920.  That is 

correct!  The higher the discount rate is, the lower the present value will be.  Different 

investors have different investment criteria, and a higher discount rate indicates the 

investor’s perception of the risk associated with the investment.  The higher the risk, the 

more the investor needs to make on the investment, thus the lower present value, or the 

lower the amount the investor is willing to pay for the investment. 

The FV() Function 

The Future Value, or FV() function, is similar to the PV() function except it calculates 

the future value of an investment based on periodic, constant payments and a constant 

rate of interest.  It has the same arguments as the PV() function, except it allows you to 

input a present value in place of the future value in the optional arguments.  All other 

assumptions are the same. 

Let’s do an example of a Future Value calculation.  We will assume that you will receive 

the $1,000,000 every month from the state and put it into an investment earning an 

average of 7.5% per year over the next 20 years.  What would the value of that 

investment be in 20 years, compounding the 7.5% earned? 

1. Copy the PV tab and rename the new tab FV (press [Ctrl] and click on the PV

tab and drag it to the right and release).

2. Change Cell A1 in the FV tab to be:  Interest Rate

3. Add one decimal place to Cell B1.

4. Change Cell A4 to be:  Future Value

5. Change the formula in Cell B4 to the following:  =FV(B1,B2,B3)

Figure 8.26 



Section II:  Intermediate Excel 2010 Financial and Math Functions  8

  204 

Holy Cow!  Could that be correct?  Yes, it is.  Many people don’t realize the power of 

compounded interest until they experiment with formulas like this one.  In this example, I 

didn’t use the optional arguments as they don’t apply. 

6. Save and close the file.

Review Questions: It is now time to complete the hands-on Review
Questions. Log on to www.ExcelCEO.com with your Email and Password,
click on the Excel 2010 Review Questions, Chapter 8, Section 2 of 4
option and complete the review questions.

Proforma Income Statement 

When analyzing the value of a property or business, many investors or analysts look at a 

business’ ten-year income statement.  In this next exercise, we will build a proforma (or 

projected) ten-year income statement for one of Nitey-Nite’s stores to estimate the value 

of the business.  First we will populate the proforma income statement with all of the 

appropriate numbers and then apply functions and formulas to analyze the store’s 

anticipated performance. 

1. Open the file located at C:\ExcelCEO\Excel 2010\Chapter8\Proforma.xlsx.

2. Save the file as C:\ExcelCEO\Excel 2010\Chapter8\myProforma.xlsx. 

Figure 8.27 

This file is the shell of a ten-year proforma operating statement for Store No. 1023.  The 

accountants have delivered this statement to you so you can estimate the value of the 

business.  It contains the amount of the initial investment (-$203,649, shown as a 
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negative number), the actual revenue and expense numbers for the year 2010, and 

columns for ten more years of income statement data.  In actuality, it is an 11-year 

statement, as we’ll be using the 11
th

 year Net Income number later.

There are numerous ways to estimate the value of a business, investment or income-

producing property.  Two of the more popular ways are the Direct Capitalization 

method and the Discounted Cash Flow (DCF) method.  The Direct Capitalization 

method is by far the easiest.  Using the Direct Capitalization method, you divide the Net 

Income from the investment by a capitalization rate.  In our example, let’s suppose the 

capitalization rate is 8%.  The value of the business using this method is estimated by 

dividing the net income of $57,032 by 8%, resulting in a value of $712,900, rounded to 

$713,000.  While this is an easy way to estimate the value of a business, it is sometimes 

inaccurate, particularly when the net income for the year isn’t representative of a typical 

year.  An example of an atypical year is if the store was hit by a tornado and was closed 

for a couple of months, or if it was a new store and operated for only part of the year. 

The DCF method is more complex.  This method is performed by discounting each year’s 

net income back to a present value.  If this is not making a lot of sense to you yet, just 

stay with me for a while longer.  It will make much more sense when we complete the 

proforma and you can look back to see what you’ve done. 

In applying the DCF method, the most common practice is to estimate the Net Income for 

eleven years, apply the Direct Capitalization method to the 11
th

 year Net Income and

discount each year’s net income PLUS the capitalized value of the investment in the 11
th

year (per the Direct Capitalization method) back to a present value.  Capitalizing the 11
th

year Net Income assumes we sell the business at the end of the 11
th

 year.  We do this as

we can assume the investment is operating at a stabilized rate after 11 years of 

operations.  We don’t really plan on selling it at the end of the 11
th

 year, but it is done as

a valuation technique.  We will apply this methodology in our analysis. 

Let’s suppose that this store is a relatively new store, and that it opened on January 1, 

2010.  From our experience in opening similar stores, we believe that revenue should 

increase by 20% in 2011, 10% in 2012 and should increase at approximately the rate of 

inflation thereafter.  Let’s also assume that fixed expenses should increase at the rate of 

inflation.  Variable expenses are expected to be the same percentage of revenue as they 

were in 2010, and we will use a 3% general inflation rate.  With that said, let’s modify 

the spreadsheet to include the above assumptions. 

3. In Cells A35 through B39, input the following data:

Revenue Inflation Year 1 20% 

Revenue Inflation Year 2 10% 

General Inflation 3% 

11
th

 Year Capitalization Rate 10% 

Discount Rate 7% 
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Figure 8.28 

4. Name the following cells with the following names:

Cell Name 

C18 com_pct 

C20 sell_pct 

B35 rev_infl_1 

B36 rev_infl_2 

B37 infl 

B38 cap_rate 

B39 disc_rate 

5. Copy all cells in Column C that contain formulas (not hard-coded

numbers) to Column D.

6. In Cell D9, type the following formula:  =C9*(1+rev_infl_1)
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Figure 8.29 

This formula takes the dollar amount in Cell C9 and increases it by the rate of revenue 

inflation for year 1, or 20%.  We will apply this formula to all Revenue accounts in 2011. 

7. Copy the formula in Cell D9 down to Cells D10, D12, and D13.

Figure 8.30 
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Now we have estimated the revenue for 2011.  Let’s go on to the expenses. 

8. In Cell D17, write the following formula:  =D14*com_pct

As you type the named ranges (like com_pct), notice how the intelli-sense menu appears 

that shows the name of the range or a function that has the same first letters.  For 

example, when you type =D14*com, you will see a menu with three items on it 

(com_pct, the cell that we named, and two functions, COMBIN and COMPLEX).  Press 

the tab key when com_pct is selected to input that name into your formula.   

This formula takes the total estimated revenue for 2011 and calculates the cost of 

merchandise on that revenue, using the same cost of merchandise percentage as 

calculated in 2010.  We need to do the same for the Selling Expense line, except we need 

to use the Selling Expense % of Revenue number. 

9. In Cell D19, type the following formula:  =D14*sell_pct
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Figure 8.31 

 

As a check, the Gross Margin line for 2011 should read 113,901.  Now let’s go on to 

Fixed Expenses. 

 

10. In Cell D26, type the following formula:  =C26*(1+infl) 

11. Copy the formula in Cell D26 to Cells D27 and D28. 
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Figure 8.32 

 

All we’re doing in this formula is increasing the 2010 Salary Expense, General Admin 

Expenses and Building Expenses at the rate of inflation. 

 

12. Format all cells in Column D to be the same as in Column C. 

 

Trick:  A quick way to do this is to select Cells C9 through C33, click the 

Format Painter icon, and click on Cell D9. 

 

Your spreadsheet should now look something like Figure 8.33: 
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Figure 8.33 

Now we need to copy the formulas in Column D to Column E.  We will first copy all of 

the formulas over then make the necessary changes. 

13. Copy Cells D9 through D33 to E9 through E33.

Find and Replace 

Copying those cells worked fine, except for one thing.  Remember the inflation rate that 

you used for 2011?  You’re still using it for 2012 after you did the copy.  You need to 

change it to be the revenue inflation rate for 2012, or Year 2.  You can use the Find and 

Replace functionality to quickly change it: 

14. Select Cells E9 through E13.
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15. Type [Ctrl]+f on your keyboard, and the Find and Replace dialog box

appears.

16. Click on the Replace tab.

17. In the Find what: box, type:  rev_infl_1

18. In the Replace with: box, type:  rev_infl_2

Figure 8.34 

Note:  You can also click the Find icon (the binoculars) you placed 

on your Quick Access Toolbar. 

19. Click the Replace All button.

Figure 8.35 

20. Click OK and then click Close in the Find and Replace dialog box.

Trick:  Another way you can “go to” a place in your workbook is to type

the [F5] key.  When you press the [F5] key, the following dialog box

appears:
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Figure 8.36 

 

Just type in the cell reference or named range you want to go to and click 

OK. 

 

Excel should replace four formulas.  Since that is the only change needed to the formulas, 

you can now copy everything in Column E to Column F. 

 

21. Copy all cells in Column E to Column F. 

22. Replace rev_infl_2 with infl in all Revenue cells (you should again have 

four replacements). 

23. Copy all cells in Column F to Columns G through M. 

24. Format the statement to have a dark bold line (Thick Box Border) 

surrounding the entire statement. 
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Figure 8.37 

 

The last step in creating our proforma in preparation for the IRR and NPV analysis is to 

divide the Net Income number in 2020 by the 11
th

 year capitalization rate.  You also need 

to footnote that number so it is clear in the proforma what the last year’s Net Income 

number represents. 

 

25. Edit the formula in Cell M33 to be the following:  =(M14-M31)/cap_rate 

26. In Cell N33, type:  „(1)  (the apostrophe is necessary to make the cell a 

text reference rather than a number). 

27. Italicize Cell N33. 

28. In Cell D35, type:  

 ="(1) Capitalizes Net Income of "&TEXT(M14-M31,"$0,000")&" as 

if the store was sold." 

29.  Italicize Cell D35. 



Section II:  Intermediate Excel 2010 Financial and Math Functions  8

  215 

Figure 8.38 

The IRR() Function 

And Presto!  You have built a complete proforma income statement where you can 

change any one of a number of assumptions and immediately see the result.  Now we are 

ready to analyze it using the IRR() function (Internal Rate of Return).  The IRR() 

function returns the internal rate of return for a series of cash flows represented by the 

numbers in values. These cash flows do not have to be the same, as with the PV() 

function. However, the cash flows must occur at regular intervals, such as monthly or 

annually.  The internal rate of return is the rate received for an investment consisting of 

payments (negative values) and income (positive values) that occur at regular periods.  

The IRR() function has two arguments:  the series of values (income stream, cash flows, 

whatever you want to calculate the IRR for), and a guess at what the approximate IRR 

would be. 

30. In Cell A40, type:  Internal Rate of Return

31. In Cell B40, write the following formula:  =IRR(B33:M33,0.2)
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Figure 8.39 

The range B33:M33 includes the initial investment outflow of $203,649 and all the other 

net income numbers, including the last year’s theoretical sale of the business.  For the 

second argument, I chose 0.2, or 20%.  It really doesn’t matter what you choose for the 

guess, as long as it’s reasonable.  You should have calculated an internal rate of return of 

41%. 

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 8, Section 3 of 4 
option and complete the review questions. 
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The NPV() Function 

The Net Present Value, or NPV() function returns the Present Value of the future income 

(or cash flows) of an investment net of the initial investment.  The NPV() function 

contains two arguments: rate and range.  In our example, we paid a total of $203,649 to 

set up the store and we forecast annual income of $57,032, $74,879, and so on.  The Net 

Present Value formula is written as follows: 

1. In Cell A41, type:  Net Present Value

2. In Cell B41, type the following formula:  =NPV(disc_rate,B33:M33)

3. Format Cell B41 to be Currency, zero decimal places.

Figure 8.40 

The Net Present Value formula returns a value of $855,520, meaning that if you spend 

$203,649 on the initial investment, you have a store that has a net present value of 

$855,520. 
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You can also trick the NPV() function to return a present value number.  Remember, if 

you use a PV() function, you must have equal payments, like an annuity.  In our example, 

the annual net income is different every year, so we can’t use a PV() function.  Using the 

NPV() function, you can have unequal payments to calculate the investment’s present 

value – just eliminate the initial investment number.  Let’s try it. 

1. In Cell A42, type:  Present Value

2. In Cell B42, type the following formula:  =NPV(disc_rate,C33:M33)

3. Format Cell B42 to be Currency, zero decimal places.

Figure 8.41 

The result is $1,119,055, which represents the present value of the investment.  Just 

remember, the present value does not consider the initial investment, whereas the net 

present value includes it. 

4. Save and close the file.
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Math Functions 

Math functions are very useful and easy to learn, assuming you have a relatively good 

grasp on math.  Let’s start off with the RAND() function. 

The RAND() Function 

Sometimes when creating spreadsheets, I need to input some test, or fictitious data.  One 

of the most useful math functions in creating fictitious data is the Random, or RAND() 

function.  It is a function that simply creates a random number between 0 and 1.  Let’s 

try it. 

1. Open a blank workbook.

2. Save the file as C:\ExcelCEO\Excel 2007\Chapter8\myMath.xlsx.

3. In Cell A1 of Sheet1, type:  =RAND() 

Figure 8.42 

Keep in mind that my number will be different from yours, as Excel is generating a 

random number.  Excel 2010 also provides a new function called RANDBETWEEN().  

It is a great function if you need random numbers between two ranges and are too lazy 

(like me) to write the formula inside the RAND() formula.  Let’s create random numbers 

between 1,000 and 9,999. 

4. Edit Cell A1 to be:  =RANDBETWEEN(1000,9999)

5. Copy Cell A1 down through Cell A10.
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Figure 8.43 

Again, your numbers will be different than mine.  Every time you make a change to the 

spreadsheet, or when you press the [F9] key, the RAND() or RANDBETWEEN() 

numbers change.  Try it.  Press the [F9] key several times and watch the numbers 

generated by these functions change. 

The INT() and ROUND() Functions 

The INT() function rounds a number down to the nearest whole integer, and the 

ROUND() function rounds a number up or down to a level you specify.  Normally, I use 

the ROUND() function, but I’ve found the INT() function to be very useful in certain 

situations.  To illustrate the difference, try the following: 

6. Click on Sheet2 of the myMath.xlsx file.

7. Type the following values in the corresponding cells:

Figure 8.44 

8. In Cell B2, type:  =INT(A2)

The result is 2, as the formula takes 2.2309 and rounds it down to the nearest whole 

integer, which is 2.  In other words, the INT() function truncates or deletes all numbers to 
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the right of the decimal point.  Note that the INT() function has only one argument – the 

number that you want to apply the function to. 

9. Copy the formula down for all cells through Cell B5.

Figure 8.45 

The ROUND() function allows you to specify the decimal place you want to round to.  

You make that determination in the second argument of the function. 

10. In Cell C2, write the following formula:  =ROUND(A2,2)

Figure 8.46 

You can round to as many decimal places as you want by simply changing the number in 

the second argument.   

11. In Cell C3, write the following formula:  =ROUND(A3,0)

12. Copy Cell C3 down to Cell C4.

Figure 8.47 
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You can also round a number to a significant level, such as 10s, 100s, 1000s, etc.  You do 

this by typing a negative number in the second argument.  For example, suppose you 

want to round 10,498.43 to the thousands of dollars. 

13. In Cell C5, write the following formula:  =ROUND(A5,-3)

Figure 8.48 

Changing the formula to be =ROUND(A5,-2) rounds to the hundreds of dollars and 

returns 10500. 

The ABS() Function 

The next helpful math function is the Absolute Value, or ABS() function.  An absolute 

value is simply the positive value of any number.  It has one argument, which is the 

number for which you want to calculate the absolute value.  Over the years, I’ve used this 

function in a handy little formula that calculates year-over-year performance.  Sometimes 

the year-over-year numbers get kind of weird, and the ABS() function has helped save 

the day. 

1. Click on the Sheet3 tab.

2. Create a table similar to the following:

Figure 8.49 

Typically, a percentage change formula is calculated by taking the current year number 

less the prior year number, divided by the prior year number. 
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3. In Cell D3, type the following formula:  =(B3-C3)/C3

4. Format as Percent, one decimal place.

5. Copy that formula down to Cells D4 through D6.

Figure 8.50 

The numbers calculate fine, but look at the result.  The % Change for Store No. 1 looks 

reasonable, but Store No. 2 had negative income in 2010 and positive income in 2011, yet 

the % Change calculates to be a negative percentage, which can’t be correct.  

Mathematically it is correct, but logically it is not.  You can use the ABS() function in the 

formula to correct the calculation: 

6. Edit the formula in Cell D3 to the following:  =(B3-C3)/ABS(C3)

7. Copy the formula down to the cells below.

Figure 8.51 

Now let’s look logically at the results.  Store No. 2 did much better in 2011 than it did in 

2010 and the percentage change reflects a big increase.  Store No. 3 was very positive in 

2010, but went down below zero in 2011, as reflected in the -107.4% number.  Store No. 

4 is negative in both years, but it is less negative in 2011, which indicates a positive 

trend.  Trust me – this formula works.  It is a very handy formula.  Keep it. 

8. Save and close the file.
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The SUMIF() Function 

We already introduced the =SUM() function in Chapter 1.  However, the SUMIF() 

function is very useful in extracting summary data from databases by adding cells that 

meet a specified criteria.  Let’s try an example using this function. 

1. Open the file C:\ExcelCEO\Excel 2010\Chapter8\1017_Mattresses.xlsx.

2. Save the file as C:\ExcelCEO\Excel 2010\Chapter8\my1017_Mattresses.xlsx. 

Figure 8.52 

The AP tab (AP stands for Accounts Payable) contains a detailed list of all of the 

mattresses purchased by Nitey-Nite at Store No. 1017 in August 2011.  Your job is to 

create a summary report that lists the name of the manufacturer, the total number of units 

purchased from that manufacturer and the total cost.  The Summary tab contains a shell 

of the report.  You need to write the SUMIF() formula to calculate the total units and total 

costs. 

3. Click on the Summary tab.

4. In Cell B2, write the following formula:

=SUMIF(AP!D:D,A2,AP!G:G)
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Figure 8.53 

Remember, instead of typing the formula, you can type “=SUMIF(“ then click on 

Column D in the AP tab, type a comma, click on Cell A2 in the Summary tab, type a 

comma, and click on Column G in the AP tab.  For me, that way is easier than typing in 

the formula.  As long as there are no subtotals or anything else that is inconsistent with 

the data in the referenced tab, the formula will work. 

This formula says to look at Column D in the AP tab, and for every occurrence of 

whatever is in Cell A2, sum the contents of Column G in the AP tab, or the number of 

units.  The answer is 52.  Let’s check that number. 

5. Sort the list in the AP tab by Manufacturer.

6. Select Cells G2 through G29 (which should be the Quantity sold by

Cama).

The AutoSum number should be 52. 

7. Copy the formula in the Summary tab, Cell B2, to Cells B3, B4 and B5.

Figure 8.54 

Note:  Since we selected the entire columns D and G in our formula, 

we had no problems when we copied the formula down. 

The formula indicates that Leaven sold no mattresses.  Is that correct?  If you look at the 

AP tab, you will see that is not correct, as Leavan has a number of entries.  What could be 

wrong?  In order for the SUMIF() function to work, the criteria in the database (i.e., the 
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Manufacturer name) and the criteria in the Summary tab must be exactly the same.  But 

they appear to be the same!  Remember, sometimes text comes from programs with 

spaces in screwy places.  In this case, there is a space after the letter “n” in Leavan in Cell 

A4 of the Summary tab.  Take out that space and the formula will work. 

8. Edit Cell A4 of the Summary tab to take out the space after the letter n.

Alternatively, you could surround the A5 reference in the formula with a TRIM() 

function.  Either way would work. 

9. Write a SUMIF() formula to calculate the total cost.

10. Underline Cells B5 and B6.

11. Sum the number of mattresses and the cost in Cells B6 and C6.

12. Format the values as follows:

Figure 8.55 

13. Check your answers with the AP tab.

The SUMIFS() Function 

The SUMIFS() function, which is new in Excel 2010, allows the user to use a SUMIF() 

function to input multiple criteria.  You could probably nest an AND() function 

(discussed in a later chapter) to accomplish the same purpose, but it sure is convenient to 

have the SUMIF() function be able to contain criteria. 

Let’s say you want to repeat the same cost calculation as you did in the previous exercise, 

but you want to include only the items that have a unit cost greater than $200.  

Management believes that the items with a cost lower than $200 would distort what they 

are trying to accomplish in this analysis.  I’ll give you the formula and then we’ll discuss 

it. 

14. In Cell D1, type Cost (>$200), underline the cell and resize the column.

15. In Cell D2, write the following formula and press [Enter]:

=SUMIFS(AP!I:I,AP!D:D,"=CAMA",AP!H:H,">200") 
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Let’s take a look at this formula.  It looks similar to a SUMIF() function, but it has more 

stuff in it.  The first part of the formula is the sum_range.  It says that we want to sum up 

the values in Column I of the AP tab.  Then we have to program in the criteria.  If you 

notice in the screen tip that appears when you click inside the formula in the Formula Bar 

on AP!D:D, the text criteria_range1 appears in bold.  This is the range of the first criteria.  

As it appears without brackets, it is a required field.  Our formula indicates that the range 

is in Column D of the AP tab, which shows the name of the manufacturer.  The last two 

arguments are to filter only the values in Column H for those that are greater than 

$200.  As you can see in the screen tip, you can have several additional criteria, indicated 

by the arguments in brackets ([criteria_range3, criteria3], etc.). 

In the criteria1 argument, we have “=CAMA”.  I wanted to do that to show you that this 

criteria is not case-sensitive.  Let’s change the criteria to look like Cell A2. 

16. Change the formula in Cell D2 to show Cama.

17. Copy the formula in Cell D2 to Cells D3 through D5.

Figure 8.56 

What happened there?  It should be easy to figure out.  The manufacturer Cama is hard-

coded in the formula, so no matter what the name of the manufacturer is in Column A, 

the formula will return the results for Cama.  Let’s correct that.  Now, since the name 

Cama is a text string, we need to convert this formula to read whatever is in Column A.  

To do that, we need to replace Cama with "&A2&".   

18. In the formula in Cell D2, replace Cama with "&A2&",copy to all cells below

and format the same as in Column C.
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Figure 8.56 

If you check the data in the AP tab, you’ll see that the only manufacturer with items that 

cost less than $200 is Leavan.  The cost for all of the other manufacturers is the same as 

in the SUMIF() function. 

19. Save and close the file.

Review Questions: It is now time to complete the hands-on Review
Questions. Log on to www.ExcelCEO.com with your Email and Password,
click on the Excel 2010 Review Questions, Chapter 8, Section 4 of 4
option and complete the review questions.

Conclusion 

In this chapter, you learned about the various Financial functions, including PMT(), PV(), 

FV(), IRR() and NPV().  You used the PMT() function to help in the creation of an 

amortization schedule.  You used Scenario Manager to keep track of your scenarios of a 

mortgage/home purchase analysis.  You created a Proforma Income Statement that had 

variables you could change and instantly see the results.  You learned some of the ways 

that appraisers and analysts estimate the value of a business, investment, or income-

producing property (the Direct Capitalization and the Discounted Cash Flow (DCF) 

method), and worked an example using both methods.  You created other formulas using 

the PV(), FV(), IRR() and NPV() functions.  You used the Find and Replace functionality 

to look for and replace text within formulas.  Finally, you learned about Math Functions 

and worked examples using the RAND(), RANDBETWEEN(), INT(), ROUND(), 

ABS(), SUMIF() and SUMIFS() functions. 

Chapter Exam 

To take the examination for this chapter, you must have successfully completed the 

examination for the previous chapter.  You can now go to www.ExcelCEO.com, click

on Sign In, log in and take the exam.  Make sure that you take the exam on the 

same computer that you completed the sample files on, as some of the questions on the 

exam may refer to some of the completed examples. 

http://www.ExcelCEO.com/
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CHAPTER NINE – DATE, STATISTICAL AND LOOKUP FUNCTIONS 

In this chapter, you will: 

 Create formulas using Date Functions, including:

o NOW()

o TODAY()

o MONTH()

o DAY()

o YEAR()

o DATE()

o WEEKDAY()

 Create formulas using Statistical Functions, including:

o COUNT()

o AVERAGE()

o AVERAGEIFS()

o MEDIAN()

o MODE()

o MAX()

o MIN()

o COUNTIF()

o COUNTIFS()

o RANK()

 Create a summary and an item-by-item margin analysis using Statistical

functions.

 Create formulas using Database Functions, including:

o DSUM()

o DCOUNT()

 Create formulas using Lookup Functions, including:

o VLOOKUP()

o HLOOKUP()

 Create drop-down menus using Data Validation.

 Use Validation Rules.

 Use numbers and text in VLOOKUP() functions.

 Use the Text to Columns functionality to convert text data to numbers.
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Introduction 

Back in the 1960’s, there was a game show hosted by Monty Hall called “Let’s Make a 

Deal”.  On stage, there were three doors:  Door No. 1, Door No. 2 and Door No. 3.  

Behind one of the doors was a grand prize, like a car, a living room suite, or something 

else very expensive.  Behind the other two doors were booby prizes, like a candy bar or a 

box of pencils.  The contestant would pick one of the doors and win whatever prize was 

behind it.  Before the contestant saw the prize behind the door he or she picked, Monty 

would show the contestant and the audience one of the booby prizes behind one of the 

doors not picked.  Then Monty would give the contestant a choice:  Do you want to stay 

with the original door chosen, or do you want to pick the other one?  What should the 

contestant do?  Should the contestant A) always switch to the other door; B) always stay 

with the original door they picked; or C) it doesn’t matter.  Most people would say C, as 

there appears to be a 50/50 chance.  However, if the contestant would always switch, 

he/she would have a 67% win rate.  How is that so?  Answer: The magic of statistics.  A 

statistician once argued with me about this until he was blue in the face.  He finally 

proved it to himself by writing a program that played the game and made those choices.  

He came back humbled and told me that the win rate was 68% out of 10,000 iterations if 

he always switched doors in his program. 

Date Functions 

We’ve already introduced the concepts of formatting dates in Chapter 1, but now we’ll 

review date and time functions.  Remember that a date is simply a number that is 

formatted to look like a date.  The number 1 represents January 1, 1900, 2 represents 

January 2, 1900.  March 4, 2011 is 40,606, or in other words, there are 40,606 days from 

1/1/1900 to 3/4/2011.  Sometimes you will want to perform calculations based on the day 

of the week (Monday, Tuesday, etc.) and other times you may want to split apart the 

month, day and year into separate cells.  Let’s experiment with each of those functions. 

The NOW() and TODAY() Functions 

1. Open Excel to a blank spreadsheet and make it look like the following:

Figure 9.1 
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2. Save the file as C:/ClineSys/Excel 2010/Chapter9/myDate.xlsx. 

3. In Cell A2 type:  =NOW() 

4. In Cell A3, type:  =TODAY() 

 

 
Figure 9.2 

 

The NOW() and TODAY() functions are very similar, except that the NOW() function 

returns the current date and time, whereas the TODAY() function includes only the 

current date.  Your results will reflect the date and time you performed this exercise. 

 

The MONTH(), DAY(), YEAR() and DATE() Functions 

 

You can split out the Month, Day and Year from a date using the MONTH(), DAY() and 

YEAR() functions. 

 

6. In Cell B2, type: =MONTH(A2) 

 

This formula returns the number 10, as I was writing this portion of the course on 

October 5, 2011.  You can now treat this number just like any other number. 

 

7. Edit Cell B2 as follows:  =MONTH(A2)-1 

8. Format Cell B2 as Number with no decimal places. 

 

The result in my example is now 9, which is 10 less one.  You have to be careful with the 

MONTH() function, though.  I had a student do a similar example in January and ended 

up with 0.  Just remember that this function returns a number, not a month. 

 

9. Take out the -1 in Cell B2. 

10. In Cell C2, type:  =DAY(A2) 

11. In Cell D2, type:  =YEAR(A2) 
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Figure 9.3 

The MONTH(), DAY() and YEAR() functions are very easy to understand.  Sometimes 

data can come to you in different ways, and many times dates are split up into Month, 

Day and Year columns.  You can easily put them back into one cell by using the DATE() 

function.  The DATE() function has three arguments:  Year, Month, and Day. 

12. In Cell E2, type:  =DATE(D2,B2,C2)

Figure 9.4 

The result is 10/5/2011, which is the same date as the NOW() and TODAY() functions 

we input into Column A. 

The WEEKDAY() Function 

Sometimes you need to know the day of the week (i.e., Sunday, Monday, Tuesday, etc.).  

Do you think it would be important to understand the daily highs and lows of a retail 

sales operation based on the days of the week?  You bet it’s important.  If your lowest 

sales day of the week is on Wednesday, you may want to run a “Wicked Wednesday” 

special to try and drive sales on that day.  For this, you can use the WEEKDAY() 

function. 

13. In Cell E3, type:  =WEEKDAY(E2)
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Figure 9.5 

The result is 4, meaning that 10/5/2011 falls on the fourth day of the week, Wednesday.  

To display the word “Wednesday” instead of the number four, simply format the cell. 

14. While on Cell E3, press [Ctrl]+1 (which is another way to display the

Format Cells dialog box).

15. Click on the Custom category and input dddd in the Type box.

Figure 9.6 

16. Click OK.
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Figure 9.7 

Dates in Excel can be seemingly difficult to understand, but if you’ve completed this 

simple exercise, you should now have a relatively good grasp on dates. 

17. Save and close the file.

Review Questions: It is now time to complete the hands-on Review
Questions. Log on to www.ExcelCEO.com with your Email and Password,
click on the Excel 2010 Review Questions, Chapter 9, Section 1 of 4
option and complete the review questions.

Statistical Functions 

Managers love statistics.  In many companies, statistics are the life-blood of the 

organization.  Since Nitey-Nite Mattresses is an up-and-coming company, there are 

numerous vendors who try to convince us to use their products.  We would be interested 

in using other vendors if their products made sense to the organization, both financially 

and in terms of making the product fit into our line.  In the next exercise, you will prepare 

a report that analyzes the profit margins of all the products that Nitey-Nite sells.  When 

vendors approach us, management can use this report to compare our current line with 

their products to make a first-pass decision on whether or not a relationship should be 

investigated.  To do so, we will use a number of statistical functions. 

The COUNT() Function 

Probably the easiest statistical function to understand in the COUNT() function.  The 

COUNT() function simply counts the number of cells in the selected range that contain 

any numeric value.  Let’s prepare an example to use. 

1. Open the file C:\ExcelCEO\Excel 2010\Chapter9\Item.xlsx.

2. Save as C:\ExcelCEO\Excel 2010\Chapter9\myItem.xlsx. 
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Figure 9.8 

This file is a listing of every mattress and pillow that Nitey-Nite sells.  The first thing you 

need to do is to prepare the file to return the statistics you need.  Then you will set up an 

area on the spreadsheet which will contain summary statistical information about the 

items in the list. 

3. In Cell J1, type:  Margin and underline it.

4. In Cell J2, write a formula that calculates the margin (the margin is the

inverse of the cost over the retail price, or one minus (cost / retail price) ).

5. Format Cell J2 to be Percent with two decimal places and copy to all

cells below.

Figure 9.9 

1. In Cell L1, type:  Summary Statistics

2. Using the Merge and Center icon, center Summary Statistics over Cells

L1 and M1.

3. In Cell L2, type:  Number of Items

4. In Cell L3, type:  Average

5. In Cell L4, type:  Median

6. In Cell L5, type:  Mode

7. In Cell L6, type:  Maximum

8. In Cell L7, type:  Minimum

9. Resize Column L to fit.

10. In Cell M2, type the following formula:  =COUNT($J$2:$J$69)
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11. Make the cells absolute references (with $s in front of each Column and

Row reference)

Figure 9.10 

Remember, the COUNT() function counts the number of cells in the range that contain 

numbers, not text strings.  However, the COUNT functionality of the Status Bar at the 

bottom of the screen will count all cells that are populated with numbers or text. 

The AVERAGE(), MEDIAN(), MODE(), MAX() and MIN() Functions 

With the spreadsheet set up this way, we are now prepared to use other statistical 

functions.  The AVERAGE() function is a simple average, or arithmetic mean, of the 

data range.  The MEDIAN() function is the number in the middle of a set of numbers; 

that is, half the numbers have values that are greater than the median, and half have 

values are less.  The MODE() function returns the most frequently occurring value.  The 

MAX() function returns the highest value in the selected range and the MIN() function 

returns the lowest value.  Let’s populate our example with these functions. 

1. Copy Cell M2 down to Cell M3 and change COUNT to AVERAGE in

Cell M3.

2. Copy Cell M3 down through Cell M7 and change AVERAGE to

MEDIAN, MODE, MAX, and MIN, respectively.
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Figure 9.11 

In our example, there are no duplicate margin values, so Excel returns an #N/A error for 

the MODE() function.  Since it returns an error, we don’t need that field in our summary 

statistics, so we will move the Maximum and Minimum cells on top of it.  Note:  Don‟t 

delete the row as it will delete the data in the base table to the left. 

3. Select Cells L6 through Cell M7.

4. Position your cursor over the top bold line of the selected range and your cursor

will turn to a pointer over a cross with up, down, left and right arrows

5. Click, hold and drag the selection where the word Maximum is in Cell

L5 and release.

Figure 9.12 

6. Click OK.
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Figure 9.13 

The COUNTIF() Function 

In our Summary Statistics table, we know the number of items in the table (68), but we 

don’t yet know the count of items for manufacturer.  For that, we can use the 

COUNTIF() function. 

1. Select Cells L3 to M6 and move the range down where Average is in Cell

L7.

2. In Cells L3 through L6, type the following:  Cama, Dream, Leavan and

Sleepwell.

3. Select Cells L3 through L6 and click the Increase Indent icon  in the

Alignment group of the Home tab.

4. In Cell M3, type the following formula:  =COUNTIF(C:C,L3)

This formula counts all of the cells in Column C (Manufacturer) that equal the value(s) in 

Column L.  If you had placed spaces before the manufacturer name instead of using the 

Indent functionality, the results would have been wrong.  You did a similar function in 

Chapter 8 when you wrote the SUMIF() function. 

5. Copy the formula in Cell M3 through Cell M6.



Section II:  Intermediate Excel 2010 Date, Statistical and Lookup Functions  9

  239 

Figure 9.14 

The AVERAGEIFS() and COUNTIFS() Function 

As with the SUMIF() and SUMIFS() functions, the AVERAGEIF() and COUNTIF() 

functions also has new capabilities in Excel 2010, the AVERAGEIF() and 

COUNTIFS() functions.  Like the SUMIFS() function, these functions allow the user to 

filter for multiple criteria.  The syntax for the AVERAGEIFS() function is exactly the 

same for the SUMIFS() function, so if you need to know more about that function, please 

refer to the Chapter 8.  The syntax for the COUNTIFS() function is 

COUNTIFS(criteria_range1, criteria1, [criteria_range2, criteria2], [criteria_range3, 

criteria3], etc.), with the second criteria and range forward being optional.  The only 

difference is that the COUNTIFS() function does not include a data_range argument. 

The RANK() Function 

Another statistical function I’ve found to be very useful is the RANK() function.  The 

RANK() function returns the rank of a number in a list of numbers.  The rank of a 

number is its size relative to other values in a list.  It contains two required arguments 

(the number or cell you want to rank and the range of the ranking) and one optional 

argument, order.  A zero order, or if it is omitted, means to sort the rank as if the range 

was in descending order (highest to lowest).  An optional argument of 1 means to sort the 

rank as if the reference range was in ascending order.  We will now use the RANK() 

function to rank all of the items in the list based on a descending order or margin, where 

the highest margin appears with a rank number of one. 

1. Insert a column between Columns K and L.

2. In Cell K1, type:  Rank  and underline it.

3. In Cell K2, type the following formula:  =RANK(J2,$J$2:$J$69)
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Figure 9.15 

Make sure to include the absolute references in the second argument, as you want to keep 

this range in tact when copying. 

4. Copy the formula in Cell K2 to all cells below.

5. Sort the table in ascending order (smallest to largest) on Column K.

Figure 9.16 

You can use statistical functions to really impress upper management.  You may even 

consider a new career as an actuary. 
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6. Save and close the file.

Review Questions: It is now time to complete the hands-on Review
Questions. Log on to www.ExcelCEO.com with your Email and Password,
click on the Excel 2010 Review Questions, Chapter 9, Section 2 of 4
option and complete the review questions.

Database Functions 

I’ll be the first to say that database functions are not my favorite functions in Excel.  If 

you find yourself using a lot of database functions, you are probably doing a project that 

should be done in Access or some other database, rather than Excel.  Many times, you 

can use a PivotTable (discussed in Chapters 11 and 12) to replace a database function, 

which is usually my preference.  However, knowing database functions are necessary to 

becoming an Excel master, so it is necessary to briefly review them here. 

In the Statistical Functions section in this chapter, you learned about a lot of different 

types of functions like COUNT(), MAX(), MIN(), AVERAGE() and the like.  Database 

functions work very similar to statistical functions, but you are able to define criteria with 

a database function.  One obvious difference between database and statistical functions is 

that database functions begin with the letter “D” at the beginning of the name, like 

DSUM(), DCOUNT() and DMAX().  As the syntax for most database functions is 

basically the same, we will do examples of only two database functions, DSUM() and 

DCOUNT().  If you need to use other database functions, you should be able to figure out 

the syntax easily enough. 

To illustrate, you will use the 1018_Sales file. 

1. Open the 1018_Sales.xlsx file under the C:\ExcelCEO\Excel 2010\Chapter9 

folder.

2. Save it in the same folder as my1018_Sales.xlsx. 
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Figure 9.17 

The DSUM() Function 

The file is a simple spreadsheet that contains detail sales data by ticket for Store No. 1018 

for all sales in 2010.  We will create a database function that will calculate the total sales 

amount in July 2010 using the DSUM() function.  To do this without a database 

function, you could sort and/or filter the data and sum all of the sales in July.  

Alternatively, you can write a database function to sum it for you.  To use a database 

function, you first have to set up a criteria range.  That is usually done by copying the 

titles of each column to another part of the spreadsheet and using the row under that 

range as the inputs for the criteria. 

3. Copy the range Cell A1 to F1 to Cell I1.

4. Resize the columns as necessary.

5. In Cell K2, type 7 (as we want to filter the list for sales in July).

Figure 9.18 

6. In Cell H5, type July Sales: and resize the column.
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7. In Cell I5, write the formula =DSUM(A1:F2110,"Total Sale",I1:N2)

8. In the Number group of the Home tab, click on the Number Format

drop down arrow and choose Currency.

Figure 9.19 

Let’s talk about the formula.  It has three arguments.  The first is the database, or the 

list/table where you want to pull the data from (in this case, the range is Cells A1 to 

F2110).  Next is the field, or the specific column you want to total, count, etc. (the Total 

Sale column).  Last is the criteria range (Cells I1 to N2).  The criteria range should 

include the names of the field as well as one row beneath it to include the criteria you 

want to type in.  In this example, it tells us that there was $111,301.00 in sales in July 

2010 at Store No 1018. 

The DCOUNT() Function 

To get a count of the number of sales, you can use the DCOUNT() function in a similar 

way. 

9. In Cell H6, type July Count: and resize the column.

10. In Cell I6 write the formula =DCOUNT(A1:F2110,"Total Sale",I1:N2)

11. Format Cell I6 as Number, zero decimal places.

Figure 9.20 

Another trick is to use arithmetic operators in the criteria.  Suppose you wanted to see the 

year-to-date sales and count for July, meaning all sales from January through July.  You 

can use arithmetic operators in the criteria section. 
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12. Change Cell K2 to be <=7.

Figure 9.21 

As soon as you press [Enter], the July Sales and Count numbers change.  Like I said, if 

you want to use other database functions, learn how to use the normal statistical function 

then apply the database function syntax we reviewed here.  And again, I would advise 

you to re-examine your project if you find yourself using a lot of database functions.  I 

get nervous when people use database functions in a spreadsheet, just like I’m wary of 

doing what-if analyses in a database. 

13. Save and close the file.

Lookup Functions 

In my humble opinion (although some people say there’s nothing humble about my 

opinion), there are three things that EVERY Excel user should know how to do:  a nested 

IF statement (which we talked about in Chapter 6), PivotTables (Chapters 11 and 12) and 

a VLOOKUP() function, which is the next subject.   

The VLOOKUP() Function 

The VLOOKUP() function is one of the most powerful, if not THE most powerful 

function in Excel.  It is similar to creating a join, or establishing a relationship, between 

two tables in a database.  The “V” in VLOOKUP stands for vertical, meaning that the 

data in the table must be in a vertical format (from top to bottom, or that the fields must 

be in columns, not rows).  VLOOKUP searches for a value in the leftmost column in a 

range, and then returns a value in the same row from a column you specify in the range.  

The VLOOKUP() function has three required arguments and one optional argument, 

although I contend that the optional argument should be necessary in most cases.  The 

three required arguments are: 1) the lookup value, or the value you want to find in the 

table; 2) the table, array or database range that you want to use to find the values; and 3) 

index number, or the column in the table, array or database you want to return a value 

from.   
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The optional argument, which I will tell you to ALWAYS include, is a TRUE/FALSE 

argument (Excel defines this as the range/lookup argument, but I think that definition is 

not very meaningful).  The TRUE/FALSE argument tells the function whether or not to 

return the closest value.  If the argument is set to TRUE or if it is omitted, it will return 

the largest value that is less than or equal to lookup value.  I rarely use that functionality.  

Therefore, I set the optional argument in a VLOOKUP() function to FALSE, as I want to 

return an exact match or an error when there is no exact match.  In most of your work, 

you will probably do the same. 

Let’s start with a simple example. 

1. Open a new workbook.

2. Save the file as C:\ExcelCEO\Excel 2010\Chapter9\myLookup.xlsx.

3. Starting with Cell A1, create a table with the following data. 

State Name 

AL Alabama 

AK Alaska 

AZ Arizona 

CA California 

CO Colorado 

DE Delaware 

FL Florida 

GA Georgia 

HI Hawaii 

IA Iowa 

4. Underline Cells A1 and B1 and resize the columns if necessary.

Figure 9.22 
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Next you will write a VLOOKUP() statement where the user inputs the state abbreviation 

in one cell and the VLOOKUP() statement will return the corresponding state name in the 

adjacent cell. 

5. In Cell D1, type State and in Cell E1 type Name.  Underline both cells.

6. In Cell D2, type AL.

7. In Cell E2 write the following formula:

=VLOOKUP(D2,A2:B11,2,FALSE)

Figure 9.23 

Let’s review the formula.  Cell D2 is the value you want to look up, or the value you 

want to find the state name for.  The range A2:B11 is the range of the database.  It is 

important to remember that the left-most column in your database must contain the same 

values as those contained as your formula’s lookup value argument.  If you don’t set it up 

that way, the VLOOKUP() function will not work.  The third argument, 2, tells the 

function that you want to return the value that is contained in the second column of the 

database range.  Finally, FALSE tells the function that you want an exact match.  Typing 

TRUE or omitting the argument could return an incorrect result. 

This is the basic syntax behind a VLOOKUP function.  Seems pretty simple, huh?  Let’s 

play around with our formula. 

8. In Cell D2, type: CO

Cell E2 changes to “Colorado”. 

9. In Cell D2, type:  HI

Cell E2 changes to “Hawaii”. 
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10. In Cell D2, type: TX

Figure 9.24 

Cell E2 returns an #N/A error, because TX is not contained in the left-most column of the 

database range.  So you need to include Texas in your list of states. 

11. In Cell A12, type: TX

12. In Cell B12, type:  Texas

Cell E2 still returns a #N/A error.  That is because the database range in the formula is 

still shown as A2:B11.  TX and Texas are listed in Cells A12 and B12.  Therefore, you 

need to revise the database range in your formula to incorporate the new cells. 

13. Edit the database range in your VLOOKUP formula to include the

Texas cells on Row 12.
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Figure 9.25 

Now the formula returns the correct value. 

Data Validation 

As we saw in our example, if you input a value other than those contained in Cells A2 

through A12, it will return an error message.  To force users to choose one of the values 

in the list, you can create a drop down menu.  This is done using Data Validation.  Let’s 

deviate from lookup functions for a short while and create a drop down list in our 

example to require users to choose one of the values. 

1. Click on Cell D2.

2. Click on the Data tab, then click on the Data Validation button in the Data Tools

group.

The Data Validation dialog box appears. 

3. Make sure the Settings tab is selected.

4. In the Allow: drop down menu, choose List.

5. Click in the Source box and use your mouse to select the range A2 to A12

and click OK.
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Figure 9.26 

You can use the mouse to select the range or you can type it in.  If you use the mouse to 

select the range, Excel will automatically input the range using an absolute value 

reference, with $’s around the cell references.  The absolute value reference fixes the 

range to where it will not change if it is copied to another cell. 

Cell D2 now has a drop down menu attached to it.  The drop down menu will appear only 

when the cell is selected. 

Figure 9.27 
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You can use this functionality to restrict values that can be used.  Let’s make the drop 

down menu a little more functional. 

6. While Cell D2 is selected, click on the Data Validation button to open the Data

Validation dialog box.

7. Click on the Input Message tab.

8. In the Title: box, type State and in the Input message: box type Choose a

state from the list.

Figure 9.28 

9. Click in the Error Alert tab.

10. In the Style: box, make sure Stop is selected.

11. In the Title: box, type OOPS!

12. In the Error Message box, type You must choose a state from the list.
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Figure 9.29 

13. Click OK.

By typing in a title and message in the Input Message tab, the title and message 

automatically appear whenever the cell is selected. 

Figure 9.30 

14. Click on the drop down menu in Cell D2 and choose DE.

15. Click on any cell other than Cell D2.



Section II:  Intermediate Excel 2010 Date, Statistical and Lookup Functions  9

  252 

The state name Delaware appears in Cell E2.  To see the complete name of the state in 

Cell E2, you must click on any cell outside of Cell D2 so the drop down arrow 

disappears. 

16. In Cell D2, type:  UT

You get the error message telling you that you have to choose a state from the list. 

17. Click Cancel and save the file.

Validation Rules 

You can also create validation rules on existing data.  Excel provides a nifty tool for you 

to identify cells with invalid data. 

1. Open the Item_2.xlsx file located at C:\ExcelCEO\Excel 2010\Chapter9.

Figure 9.31 

This file is simply a copy of the Item file used previously.  Let’s assume that you want to 

have a validation rule that says the size should be either King, Queen, Double, or Twin.  

Let’s create that rule. 

2. In Cells L1 through L5, create the following list:
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3. Select Cells E2 through E69, and click on the Data Validation button to open the

Data Validation dialog box.

4. Click on the Settings tab.

5. On the Allow drop down menu, choose List.

6. In the Source box, type (or select) =$L$2:$L$5 and click OK.

7. With the Range E2:E69 selected, click on the Data Validation drop down arrow

and choose Circle Invalid Data.

8. Scroll down to the bottom of the list.

Figure 9.32 

Any cell that is not King, Queen, Double, or Twin now has a red circle around it. 

9. Click on the Data Validation drop down arrow and choose Clear

Validation Circles.

10. Close the file (no need to save it).
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Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 9, Section 3 of 4 
option and complete the review questions. 

The HLOOKUP() Function 

Let’s now explore the HLOOKUP () function.  The HLOOKUP() function behaves in 

the same way as the VLOOKUP() function, except that the database or reference table is 

contained in a horizontal format rather than a vertical format.  The lookup is done in rows 

instead of columns, but everything else is the same as with a VLOOKUP().  As databases 

are typically contained in vertical formats, the HLOOKUP() function is less common 

than VLOOKUP(), but every now and then it’s necessary to use it, so let’s do an 

example. 

11. Click on the Sheet2 tab of the myLookup.xlsx file.

12. Input data in the cells as follows:

Figure 9.33 

13. In Cell F1, type:  S

14. In Cell G1, type the following formula:

=HLOOKUP(F1,A1:D2,2,FALSE)

Figure 9.34 

The formula now works using a table in a horizontal format rather than a vertical format. 

15. Save and close the file.

Text to Columns 

One of the things that make people like us very valuable is our ability to manipulate data.  

Many times, we don’t get to choose the format in which we receive data.  Sometimes, the 
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data is just flat ugly.  Data can come in multiple formats, and sometimes it’s contained all 

in one column. 

1. Open the file at C:\ExcelCEO\Excel 2010\Chapter9\Employees.xlsx.

2. Save the file as C:\ExcelCEO\Excel 2010\Chapter9\myEmployees.xlsx. 

This is a simple file of the store managers at Nitey-Nite and the stores they manage.  In 

this file, all of the data in contained in one column.  The data is actually in six columns, 

but sometimes when data was copied from one system to another, it was copied to one 

column.  In this case, you can use a Text to Columns procedure to split out the data into 

separate columns.  If you notice, the data in this spreadsheet is separated by a comma.  

The comma is known as the delimiter, or the character that separates the fields of data.  

Other common delimiters include a space, semi-colon, or a tab.  Some more sophisticated 

databases use other characters that are rarely used in text strings, like a tilde (~) or pipe 

symbol (|).  Let’s use the Text to Columns functionality to separate this data into its 

respective columns. 

3. Select Column A.

4. Click on the Data tab, then click on the Text to Columns icon in the Data

Tools group (the Convert Text to Columns Wizard opens).

5. In Step 1 of the Convert Text to Columns Wizard, make sure the

Delimited radio button is selected and click Next.

Figure 9.35 
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6. In Step 2, uncheck the Tab checkbox (or any other checkbox that is

checked), check the Comma checkbox and click Next.

Figure 9.36 

7. In the last step of the wizard, under Data preview, click on the second

column (that reads General and Empl_No on the first and second lines),

click on the Text radio button in the Column data format section, and

click Finish.
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Figure 9.37 

8. Underline the titles and make sure the column widths are set

appropriately.

The data is now separated out into six columns. 

Numbers vs. Text Strings in a VLOOKUP() Function 

Sometimes you want to use numbers instead of text strings in your lookup values.  For 

the next exercise, we need to clean up the file to be in a more useable format. 
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Figure 9.38 

9. In Cell G1, type:  Full Name and underline the cell.

10. Write a formula in Cell G2 that concatenates the first and last names to be

the full name, copy to all cells below and resize all columns.

Figure 9.39 

11. In Cell I1, type:  Empl_ID

12. In Cell I2, type:  10

13. In Cell J1, type:  Full Name

14. In Cell J2, write a formula that looks up the value in Cell I2 in the

database and returns the employee‟s full name.

15. Resize Column J if necessary.
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Figure 9.40 

Now let’s try the same VLOOKUP() using the Empl_No (not the Empl_ID). 

16. Replace the contents of Cell I1 with:  Empl_No.

17. Edit the range in the formula in Cell J2 to be:

=VLOOKUP(I2,B2:G24,6,FALSE)

In the formula, we needed to change the range to start with Column B as those are the 

values we want to base our formula on.  We also changed the 7 to a 6 because now the 

data we want to return is in the sixth column of the table if we begin with Column B.  

The formula right now should return an error, because Cell I2 still contains the number 

10 which is an employee ID and not the employee number. 

18. In Cell I2, enter:  007386

Figure 9.41 

It still returns a #N/A error.  Why?  This one problem has been the cause of hours of 

frustrations for me and many other Excel users.  When you input “007386”, Excel 

recognized that as a number and consequently changed it to a number format and 

eliminated the leading zeros.  The data in Column B is formatted as text, not numbers.  
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You can tell it is text because of the leading zeros.  Another way to tell if numbers are 

formatted as text is to select the numbers in question and look to see if the AutoSum 

feature is working.  You can also try to write a SUM() function using those numbers.  If it 

returns an error or doesn’t add up, chances are the numbers are formatted as text. 

In this case, we can do one of two things.  The fastest and easiest way (but not 

recommended by me) is to change the data in Column B (the Empl_No field) to numbers.  

You can do this very easily by selecting the entire column, and choose Text to Columns 

and walk through the Convert Text to Columns Wizard.  Let’s do that. 

1. Select Column B.

2. Click on the Text to Columns button in the Data Tools group of the Data

tab.

Figure 9.42 

3. Leave the Delimited data type checked and click Next >

4. In Step 2 of the Wizard, uncheck all boxes in the Delimiters section (if there are

no boxes checked, check and uncheck any box) and click Next >.

5. In Step 3 of the Wizard, make sure the General radio button is selected and click

Finish.

The values in Column B are changed to numbers and the formula in Cell J2 works.  

Although this way works, I do not suggest doing it.  I often set up my spreadsheets so I 

can easily update the data, and if I were to refresh this table with new data, the Empl_no 
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values would come in again as text and I would have to go through the motions again of 

converting the text values to numbers.  I try to program my spreadsheets to have as little 

human intervention as possible. 

6. Click the Undo icon . 

The Text to Columns procedure was undone and the values in Column B are now 

converted back to text. 

7. Edit the formula in Cell J2 to be as follows:

=VLOOKUP(RIGHT("000000"&I2,6),B2:G24,6,FALSE)

Now stay with me on this one.  I PROMISE you will love this trick once you understand 

the logic.  This is an example of a nested function, or a function within a function.  At 

Nitey-Nite, the Empl_No is always a six-digit number with leading zero’s.  The 

concatenation string “000000”&I2 will take the number that is in Cell I2 and add six 

leading zero’s.  RIGHT(“000000”&I2,6) will return the right six-most characters from 

that string.  Remember that whenever you use a Text function, it turns the number into a 

text string.  In this case, that is exactly what we want.   

Figure 9.43 

Sometimes you may want to go the other way and convert a text string into a number.  

Let’s add a column beside the Empl_No column which will convert the Empl_No’s from 

text strings to numbers. 

8. Insert a column after Column B.

9. In Cell C1, type:  Empl_No # and resize the column.

There are different functions that you can use for this procedure, but I found a formula 

that works perfectly.  In Chapter 6, we saw that we could use the VALUE() function to 

do this conversion, but there is another way.  I’ll ask you not to tell this trick to any 

programmers, as they will tell you it won’t work, but just between you and me, it will. 
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Note:  The formula may return the value =B2+0.  If it does that, don‟t 

worry.  It did that because it inherited the data format of Column B.  This 

happened when you inserted the column.  You may have also seen this in 

some of your spreadsheets.  To fix it, just do a Text to Columns exercise 

on that new column. 

10. In Cell C2, type: =B2+0

11. Copy the formula to all cells below.

Figure 9.44 

12. Right-align the numbers.

That’s it?  Yep, that’s it.  All you have to do is to add zero to a text string of numbers to 

convert it to a number.  Of course, there can be only numbers (no alpha characters) in the 

text string.  Since I believe LOOKUP formulas are critically important, we will continue 

the discussion of LOOKUP formulas in the next chapter and introduce the last set of 

functions, Logical Functions. 

13. Save and close the file.

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 9, Section 4 of 4 
option and complete the review questions.

Conclusion 

In this chapter, you learned about Date Functions, and used the NOW(), TODAY(), 

MONTH(), DAY(), YEAR(), DATE() and WEEKDAY() functions in many formulas.  

You learned about Statistical Functions in formulas, including the COUNT(), 

AVERAGE(), MEDIAN(), MODE(), MAX(), MIN(), COUNTIF() and RANK() 

functions.  You used these functions to create a summary and an item-by-item margin 
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analysis.  You learned about database functions and wrote formulas using the DSUM() 

and DCOUNT() functions.  You learned about one of the most important types of 

functions, Lookup Functions.  Additionally, you used the Data Validation functionality to 

create drop down menus and validation rules and you used the Text to Columns 

functionality several times.  You used the Circle Invalid Data functionality to help 

identify formulas that didn’t meet specific criteria.  Finally, you saw how to switch back 

and forth between using numbers and text strings by using the +0 trick. 

Chapter Exam 

To take the examination for this chapter, you must have successfully completed 

the examination for the previous chapter.  You can now go to www.ExcelCEO.com, 

click on Sign In, log in and take the exam.  Make sure that you take the exam on 

the same computer that you completed the sample files on, as some of the questions on 

the exam may refer to some of the completed examples. 

http://www.ExcelCEO.com/
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_____________________________________ 

 Excel 2010
Complete Self-study Course
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CHAPTER TEN – ADVANCED LOOKUP AND LOGICAL FUNCTIONS 

In this chapter, you will: 

 Use absolute references in a VLOOKUP() Function.

 Create formulas using the LOOKUP() Function.

 Create formulas using the MATCH() Function.

 Nest a MATCH() Function within a VLOOKUP() Function.

 Create formulas using Logical Functions, including:

o CELL()

o ISERROR()

o AND()

o OR()

 Find and check for errors.

 Build a complex spreadsheet that calculates a bonus based on multiple

criteria.
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Once I was teaching an Excel class to a group of accountants.  The primary purpose of 

the class was to show them how to connect an Excel file to an OLAP cube (an external 

database) and pull in data.  Once the data was in the spreadsheet, I showed them how to 

write a complex VLOOKUP() function to bring the data to different parts of the 

spreadsheet.  One of the participants was bored with the class, as she already knew how 

to do all of that.  Then I showed them the trick on how to turn a text string to a number by 

simply adding zero and nesting that formula in a VLOOKUP() function.  Her eyes almost 

popped out of her head and she said, “No way!  It CAN’T be that easy!”  She jumped up 

out of her chair, ran out of the room and into her office, and was back within two minutes 

shouting, “IT WORKS!  IT WORKS!”  Writing formulas is what Excel is all about, and I 

sincerely hope you’ve found this course to be useful so far. 

Advanced Lookup Functions 

Sometimes you will run into a situation where you need to look up a number that falls 

between a range of numbers.  In Chapter 6, I introduced you to the IF() function and 

showed you how to write this formula: 

=IF(G2<=50000,"Paper",IF(G2<=70000,"Scissors","Rock")) 

This formula tells us if the value in Cell G2 is less than or equal to 50,000, then return the 

word “Paper”.  If Cell G2 is less than or equal to 70,000, return “Scissors”, and for all 

other values, return “Rock”.  The IF() function works very well in this situation, as there 

are only three options:  Paper, Scissors and Rock.  In Excel 2003, you could nest only 

seven IF() functions in one formula.  However, in Excel 2007 and 2010, you can nest up 

to 64 IF() functions in one formula.  Honestly, I don’t know why Microsoft allowed so 

many IF() functions in one formula, because it would be a full time job just keeping track 

of all those conditions.  In the first part of this chapter, I’ll introduce you to some 

alternative methods of looking up values where many IF() statements could be used. 

Over the years, I have been given many schedules like the following on which to 

calculate bonuses: 

% of Budget Bonus % 

Below 100% 0.00% 

100% 0.50% 

105% 0.75% 

110% 1.00% 

125% 1.50% 

150% 2.00% 

200% 3.00% 

250% 4.00% 
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In this case, the Store Manager has a budgeted amount of sales he/she should attain every 

month.  If the store manager reaches 100% of that budgeted number, they begin to 

receive a bonus based on the percentage over budget on his/her actual sales.  Depending 

on the amount of their sales to budget determines their bonus amount:  the higher the 

sales, the higher the bonus amount.   

1. Open the file located at C:\ExcelCEO\Excel 2010\Chapter10\Bonus.xlsx.

2. Save the file as C:\ExcelCEO\Excel 2010\Chapter10\myBonus.xlsx. 

Figure 10.1 

Let’s review this file. On the Assumptions tab is a schedule similar to the one above.  

This schedule means that if the Store Manager (SM) is below 100% of budget, he/she 

gets no bonus.  If the SM is between 100% and 105%, he/she gets a bonus equal to 0.50% 

of actual sales.  Once the SM reaches 105%, the bonus percentage increases to 0.75%, 

going back to dollar one.  So if the SM sells $104,000 and has a $100,000 budget, his 

percent of budget is 104% (104,000 / 100,000) and he qualifies for a 0.50% bonus.  The 

bonus equates to $520, or $104,000 x 0.50%.  The Sep_10_Data tab contains the total 

mattress and pillow sales for each store in September 2010.  The Managers tab contains 

the names of the managers for each store and the Budget tab contains the Budget 

numbers for each store. 

Let’s first organize the data where it is easier to work with.  

3. Copy the Sep_10_Data tab and rename the new tab Bonus.

It’s always good practice to save the original data and perform calculations in a copied 

version of the data, just in case you need to start over. 

4. In the Managers tab, Cell E1, type:  Full Name

5. Format Cell E1 like Cell D1.

6. Write a formula in the Full Name column that creates the manager‟s full

name for all rows.  Resize column if necessary.
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Figure 10.2 

7. In the Bonus tab, Cell D1, type:  Total Sales

8. Format Cell D1 like Cell C1.

9. Calculate the total sales for each store in Column D.

10. Format the Mattress Sales, Pillow Sales and Total Sales fields as Number, no

decimal places, Use 1000 Separator (,).

Figure 10.3 

11. Insert a column between Store and Mattress_Sales.

12. In Cell B1, type:  Manager
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VLOOKUP() and Absolute References 

Remember that when you copy a formula down, up or over, the cell references shift as 

well.  This will also happen to a range in a VLOOKUP() function unless 1) the range is 

named or 2) the range is in absolute references.  As you learned in Chapter 2, you can 

press the [F4] key to toggle between absolute, mixed, and relative references.  In our case 

here, we will use an absolute reference in our VLOOKUP() function. 

13. In Cell B2, write a VLOOKUP() formula to lookup the full name of the manager

from the Managers tab, based on the store number.

14. Make the range in the VLOOKUP() function be an Absolute Reference.

15. Copy the formula down to all cells below.

16. If any of the rows grow in size, format all rows in the tab to be 15.00 in height.

17. Left-justify all manager names and adjust the column width to fit.

Figure 10.4 

Note that when you refer to cells in another tab, the name of the tab and the data range in 

the formula are separated by an exclamation point, as in this VLOOKUP() function.  If 

you refer to a different workbook, the name of the workbook appears in brackets (like 

=[Book1.xlsx]Sheet1!$A$1).  This type of a reference is called a 3-D reference, as it 

refers to the three parts of the link’s path.  If there are spaces in the name of the 

workbook or in the tab name, the name will be surrounded by apostrophes.  As such, 

when writing formulas that refer to ranges or cells in different tabs and/or workbooks, it 

is usually easier to choose the range with your mouse rather than manually typing the 

entire formula. 

18. In Cell F1, type:  Budget

19. Format Cell F1 like Cell E1.

20. In Cell F2, write a VLOOKUP() formula to look up the budget number in

the Budget tab based on the Store number.
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21. Copy Cell F1 down to all cells and format as Number, no decimal

places, Use 1000 Separator (,).

Figure 10.5 

22. In Cell G1, type:  % Budget

23. Format Cell G1 appropriately.

24. In Cell G2, calculate the percent of budget by dividing the Total Sales by

Budget.

25. Format Cell G2 as Percent, one decimal place, and copy down to all

cells below.

Figure 10.6 
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The LOOKUP() Function 

Now we’re ready to do the actual bonus calculations.  The first thing we need to do is to 

find out what bonus percentage each Store Manager qualified at.  We will do this with a 

LOOKUP() function.  The LOOKUP() function has two arguments in the way we use it:  

the value to look up and the range.  Remember, the lookup value and the left-most 

column in the range must be the same numbers.  Let’s go forward. 

26. In Cell H1, type:  Bonus %

27. Format Cell H1 accordingly.

28. Select the range A2 to B11 on the Assumptions tab and name that range

Bonus_Table.

29. In the Bonus tab, Cell H2, type the following formula:

=LOOKUP(G2,Bonus_Table)

30. Format Cell H2 as Percent, two decimal places and copy down to all cells

below.

Figure 10.7 

You should spot check some of these numbers with the Bonus Table on the Assumptions 

tab to make sure the bonus percentages are correct. 

The MATCH() Function 

Another function you can use in this scenario is the MATCH() function.  I use this 

function more frequently than the LOOKUP() function as it is more versatile.  The 

MATCH() function returns the relative position of an item in a table or array that matches 

a specified value in a specified order. You should use the MATCH() instead of one of the 

LOOKUP functions when you need to see the position of an item in a range instead of the 

item itself.  The MATCH() function has two required arguments and one optional 

argument.  The two required arguments are the lookup value and the lookup array (which 
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is the database range or table).  It is important to know that the table or array must be 

sorted by the lookup value.  Let’s try an example. 

1. In Cell I1, type:  Match

2. Format Cell I1 appropriately.

3. In Cell I2, type the following formula:

=MATCH(G2,Assumptions!$A$2:$A$11)

4. Copy to all cells below.

Figure 10.8 

The MATCH() function returns the position of the lookup value.  The first lookup value, 

72.7%, is positioned between 0% and 100% in the database range and is in the first 

position.  The next value, 155.7%, is between 150% and 200%, in the seventh position, 

and so forth.  To find the Bonus % value in the table, we need to edit the Assumptions tab 

a bit. 

5. On the Assumptions tab, insert a column to the left of the % of Budget

column.

6. In Cell A1, type:  Position

7. Underline Cell A1.

8. Type the numbers 1 – 10 in Cells A2 through A11.
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Figure 10.9 

9. On the Bonus tab, Cell J1, type:  Match Bonus %.

10. Format Cell J1 like the others in Row 1 and resize the column.

11. In Cell J2, write a formula that looks up the value of Cell I2 in the

database range A2 to C11 on the Assumptions tab, and returns the value

in the third column.

12. Format Cell J2 as Percent, two decimal places and copy to all cells

below.

Figure 10.10 

Nesting MATCH() within a VLOOKUP() 

The percentages in Column J should exactly match the percentages in Column H.  To 

make the formula take up only one column instead of two, you can nest the MATCH() 

function in Column I into the VLOOKUP() formulas in Column J. 

13. Copy the formula in Cell I2 (everything after the “=” sign) and replace

the I2 reference in the formula in Cell J2 with it.

14. Copy to all cells below.
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15. Delete Column I.

Figure 10.11 

Since we don’t need two columns with the exact same data in them, you can delete one of 

the columns.  Let’s keep the column with the MATCH() function in it. 

16. Delete Column H.

17. Rename Cell H1 Bonus % and resize the column to fit.

Figure 10.12 

Up to now, the formula is only calculating the percentage at which the SM earned a 

bonus.  Now we have to write a formula that multiplies the Bonus % by the Total Sales 

column. 

18. In Cell I1, type:  Bonus Earned

19. Format Cell I1 like the others in Row 1 and resize the columns.

20. In Cell I2, write a formula that multiplies the Match Bonus % by the

Total Sales.

21. Format Cell I2 to be Number, two decimal places, and copy to all cells

below.
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Figure 10.13 

22. In the Assumptions tab, Cell E4, type:  Bonus Earned

23. In Cell F4, write a SUM() formula that will sum the values in the Bonus

tab, Column I.

24. Format Cell F4 as Number, two decimal places.

25. Bold Cells E4 and F4.

26. Resize Columns E and F.

Figure 10.14 

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 10, Section 1 of 2 
option and complete the review questions. 

Now you can change the numbers in the Assumptions tab and see the total Bonus Earned 

number change accordingly.  Too cool! 
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Logical Functions 

Let’s talk a little about Logical functions.  Logical functions are the essence of writing 

formulas.  All of the functions and formulas that you have previously written can be 

incorporated into logical functions.  The most common logical function by far is the IF() 

function.  You have already experimented a little with the IF() function in Chapter 6.  We 

will expand on that knowledge and introduce some other logical functions in the next few 

exercises. 

The CELL() Function 

How many times have you printed a report and then months or even years later someone 

shows you the report and wants you to update it?  It happens more often than you realize.  

When I create spreadsheets, I like to put the name of the file and its path onto the report.  

There is a function you can use to help with this:  the CELL() function.  The CELL() 

function displays information about the formatting, location, or contents of the upper-left 

cell in a reference.  There is one argument in a CELL() function, info_type.  Following is 

a list of all the available info_types in the CELL() function. 
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Info_type Returns 

"address" Reference of the first cell in reference, as text. 

"col" Column number of the cell in reference. 

"color" 
1 if the cell is formatted in color for negative values; otherwise returns 0 

(zero). 

"contents" Value of the upper-left cell in reference; not a formula. 

"filename" 

Filename (including full path) of the file that contains reference, as text. 

Returns empty text ("") if the worksheet that contains reference has not yet 

been saved. 

"format" 

Text value corresponding to the number format of the cell. The text values 

for the various formats are shown in the following table. Returns "-" at the 

end of the text value if the cell is formatted in color for negative values. 

Returns "()" at the end of the text value if the cell is formatted with 

parentheses for positive or all values. 

"parentheses" 
1 if the cell is formatted with parentheses for positive or all values; 

otherwise returns 0. 

"prefix" 

Text value corresponding to the "label prefix" of the cell. Returns single 

quotation mark (') if the cell contains left-aligned text, double quotation 

mark (") if the cell contains right-aligned text, caret (^) if the cell contains 

centered text, backslash (\) if the cell contains fill-aligned text, and empty 

text ("") if the cell contains anything else. 

"protect" 0 if the cell is not locked, and 1 if the cell is locked. 

"row" Row number of the cell in reference. 

"type" 

Text value corresponding to the type of data in the cell. Returns "b" for 

blank if the cell is empty, "l" for label if the cell contains a text constant, 

and "v" for value if the cell contains anything else. 

"width" 
Column width of the cell rounded off to an integer. Each unit of column 

width is equal to the width of one character in the default font size. 

The most common argument in the CELL() function I use is filename.  Let’s use this 

function in the spreadsheet we just modified. 

1. In Cell A16 of the Assumptions tab, type the following formula:

=CELL("filename")

2. Italicize Cell A16.

3. Select Cells A15 through D15 and draw a line at the bottom of the cell

using the Border icon.
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Figure 10.15 

4. Save and close the file.

Since I create SO MANY spreadsheets, I like to use this function if for no other purpose 

to help me find the file when someone has a printout. 

Let’s open another file so we can practice with Logical Functions a little more. 

1. Open the file at C:\ExcelCEO\Excel 2010\Chapter10\Bonus2.xlsx.

2. Save the file as C:\ExcelCEO\Excel 2010\Chapter10\myBonus2.xlsx.

3. Click in the Assumptions tab. 
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Figure 10.16 

This is the same file as the Bonus.xlsx file you just worked with, except I’ve added in a 

little more data.  The first change is that there are different levels of bonus percentages.  

The levels (Paper, Scissors, Rock) are based on the Budget for each location.  I’ve 

already taken the liberty of naming the % of budget ranges appropriately (Paper, Scissors, 

and Rock).  The range name for the Budget Levels, found on the Assumptions tab Cells 

D2 through Cell E4, is Bgt_Levels, and the named range for the Budgets found in the 

Budget tab is Budget.  Your job is to complete the bonus calculations with the available 

data.  Let’s get started. 

The first thing we have to do is to bring in the Budget numbers into the Bonus tab. 

4. Click on the Bonus tab.

5. In Cell F2, write a VLOOKUP() formula that brings the Budget numbers

by store number from the Budget tab.

6. Copy down.
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Figure 10.17 

We already have a problem.  Look at Store No. 1053 on Row 25.  We’re getting an #N/A 

error message.  Why is that?  If you look in the Budget tab, you will see that there is no 

budget for Store 1053.  This is a new store that we haven’t established a budget for yet.  

Our manager tells us that if there is no budget, just make it 0.  That store manager won’t 

qualify for a bonus this month. 

The ISERROR() Function 

The ISERROR() function is one solution to error handling.  We can write a formula 

using the IF() and ISERROR () functions to make the formula that produces an error 

return something other than the ugly #N/A or #DIV/0! messages, like 0.  Let’s first write 

the formula in an adjacent cell, then we’ll combine the two. 
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7. In Cell G2, write the following formula:  =IF(ISERROR(F2),0,F2) and

copy down.

Figure 10.18 

This formula says that if the value in Cell F2 is an error, return a 0, otherwise, return the 

value of Cell F2.  Now we will incorporate the formulas in Cells F2 and G2 into one cell. 

8. Copy the formula in Cell F2 and replace both F2 references in the

formula in Cell G2.

9. Move Cell G2 to Cell F2.

10. Copy down to all cells in Column F and delete the formulas in Column

G.
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Figure 10.19 

The Budget for Cell F25 now reads “0” instead of the error message. 

11. In Cell G2, write the following formula:  =E2/F2

12. Format as Percent, one decimal place and copy down.
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Figure 10.20 

Notice in Cell G53 there is a #DIV/0! message.  As you learned previously, this happens 

when you try to divide a number by zero.  In this case, you could use an ISERROR() 

function to correct it, but I usually try to keep things simple, so we’ll use an IF() function 

to solve when the denominator is 0. 

13. Edit the formula in Cell G2 to read:  =IF(F2=0,0,E2/F2)

14. Copy down.
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Figure 10.21 

Problem solved.  Note that there are other functions like ISNA() that will help you find 

errors.  I tend to use the ISERROR() function as it will handle all errors, not just the 

#N/A error.  Let’s continue on. 

15. Write a formula in Cell H2 that brings in the Budget Levels using the named

range Bgt_Levels.

16. Copy to all cells below and resize the column.



Section II:  Intermediate Excel 2010 Advanced Lookup and Logical Functions  10

  285 

Figure 10.22 

Now comes another tricky part.  The bonus calculation depends on the level.  If the level 

is Paper, then use the Paper range.  If it is Scissors, use the Scissors range, and if it is 

Rock, use the Rock range.  Let’s try it. 

17. In Cell I2, write the following formula:

=IF(H2="Paper",LOOKUP(G2,Paper),IF(H2="Scissors",LOOKUP(

G2,Scissors),LOOKUP(G2,Rock)))

18. Format as Percent, two decimal places and copy down.

This formula says that if the Level is Paper, then do a LOOKUP() function on Cell G2 

using the range called Paper; otherwise, if the Level is Scissors, then do a LOOKUP() 

function on Cell G2 using the range called Scissors.  For everything else (only the Rock 

Level remains), do a LOOKUP() function on Cell G2 using the range called Rock.  This 

is another example of a nested IF() statement, or an IF() function within an IF() function. 

Figure 10.23 
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To complete the project, calculate the bonus. 

19. In Cell J2, write a formula that calculates the bonus by multiplying Cell I2 by

Cell E2.

20. Format as Number, two decimal places, Use 1000 Separator (,) and

copy down.

Figure 10.24 

The total bonus payable should be $33,093.47. 

The AND() and OR() Functions 

The last two logical functions we will cover are AND() and OR().  The AND() function 

returns TRUE if all of the conditions in the statement are true, and FALSE if any one of 

the statements is not true.  The OR() function behaves in a similar manner, except that it 

returns TRUE if any of the statements are true and FALSE if all of them are false.   

For example, let’s say you want to include a column of Yes/No values indicating whether 

or not the store is a “Rock” store AND they qualified for a bonus.  You can have up to 30 

logical conditions in an AND() or OR() function, but please don’t put that many in.  That 

will drive you crazy trying to find an error. 

21. In Cell K1, type:  Rock Qualifiers  and format accordingly.

22. In Cell K2, type:  =IF(AND(H2="Rock",I2<>0),"Yes","No")

23. Copy down to all cells.
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Figure 10.25 

There should be three “Yes” values: Store numbers. 1026, 1034 and 1040.  

Now let’s work on an example using the OR() function.  Upper management wants to 

send letters of congratulations to all of the Store Managers who made equal to or above 

125% of budget, and inquiry letters to all managers whose stores were below 75% of 

budget.  You want to know how many letters will be sent out, irrespective of the type of 

letter. 

24. In Cell L1, type:  Letter List and format appropriately.

25. In Cell L2, write the following formula:

=IF(OR(G2>=1.25,G2<0.75),"Yes","No")

26. Copy down to all cells below.

Figure 10.26 

27. Save and close the file.

Error Finding and Checking 

Let’s talk a little bit about errors.  Have you ever opened a workbook that was created by 

someone else and had trouble trying to follow how they created the analysis?  Hopefully, 
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the last user kept the formulas in the worksheet so other users could try to follow the 

logic.  Excel has some great error checking and auditing tools that make it visually easier 

to discover how the formulas were written and can help save a lot of time when you are 

trying to follow someone else’s logic.  You can see the cells that are active in a formula 

by tracing the cell’s precedents.  You can also find not-so-obvious errors in the 

calculations.  Let’s explore some of these tools. 

1. Open the Errors.xlsx file at C:\ExcelCEO\Excel 2010\Chapter10\.

Figure 10.27 
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The file is a spreadsheet that contains the store number, the name of the manager, the 

mattress sales, pillow sales and total sales, along with the store’s budget.  There are two 

obvious errors in the table:  Cells F25 and F32.  You can see some of the errors because 

of the #N/A error messages.  Let’s first look at which cells make up the error in Cell F32. 

2. Click on Cell F32.

3. Click on the Formulas tab and then click on the Trace Precedents button

in the Formula Auditing group.
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Figure 10.28 

A red arrow appears going from Cell F2 through F32.  These are the precedent cells for 

Cell F32.  The cell range is also encircled by a blue line.  Now you can visually see 

which cells are included in the formula, and you should see that Cell F25, which is 

included in the range, is the source of the error. 

4. Click on the Remove Arrows button.
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All arrows and the blue box are now removed.   

5. With your cursor on Cell F32, click on the drop down arrow next to the

Error Checking button and choose Trace Error.

Figure 10.29 

Excel shows you the path to the source of the errors, which first goes to Cell F25, then to 

Cell A25.  Cell F25 is a VLOOKUP() formula based on Cell A25. 

6. Click on the Remove Arrows button.

We can easily identify those two errors because of the #N/A error message.  But are there 

any other errors?  An error message is very obvious, but there may be other errors in the 

spreadsheet that you can check for.  Let’s run a formula error check on the table. 

7. With your cursor on Cell F32, click on the Error Checking button (not

the drop down menu).

Figure 10.30 
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The Error Checking dialog box appears.  In the upper left corner of the dialog box you 

will see “Error in cell F32” with the cell’s formula below it.  It tells you what kind of an 

error is occurring as well.  We won’t do anything about this error for now, so let’s 

continue. 

8. Click Next.

Figure 10.31 

The dialog box goes to Cell F8 and finds an inconsistent formula, based on the cells 

surrounding it.  The formula “VLOOKUP(A9,Budget!Budget,2,FALSE)” should be 

referring to Cell A8 instead of Cell A9. 

9. Click the Copy Formula from Above button.

Figure 10.32 

After you click the button, it takes you to another inconsistent cell, Cell E20. 

10. Click the Copy Formula from Above button again.

Next, it takes you to Cell F25, which has the VLOOKUP() error.  We’ll skip that one. 

11. Click Next.
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Figure 10.33 

12. Click OK.

13. Close the Errors.xlsx file without saving it.

I would encourage you to continue to explore all of the auditing tools available in Excel.  

We only touched on a few of them here, but it gave you a good introduction to get you 

thinking about some tools that would be helpful to you. 

Writing formulas is what Excel is all about.  We reviewed a lot of functions and formulas 

in the last five chapters.  It may have been painful, but most good medicine doesn’t taste 

real good.  I hope you will learn to use these functions in your everyday work.  They can 

make your job MUCH easier and will result in better analyses and reports.  I encourage 

you to make up some examples of your own using data in your world.  You will 

remember these concepts much easier that way. 

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 10, Section 2 of 2 
option and complete the review questions.

Conclusion 

In this chapter, you learned some of the advanced uses of LOOKUP functions.  You 

learned why and how to use absolute references in a VLOOKUP() functions.  You 

learned to use a LOOKUP() function and wrote a number of formulas using that function.  

You also learned how to use a MATCH() function.  You worked examples of nesting a 

MATCH() function within a VLOOKUP() function.  You learned about Logical 

functions and wrote formulas containing the ISERROR(), CELL(), AND() and OR() 

functions.  You saw how to find and check for errors using Formula Auditing 

functionality.  You also built a complex spreadsheet that calculates bonuses based on 

multiple criteria and set it up where the criteria could easily be changed. 

Chapter Exam 

To take the examination for this chapter, you must have successfully completed 

the examination for the previous chapter.  You can now go to www.ExcelCEO.com, 

click on Sign In, log in and take the exam.  Make sure that you take the exam on 

the same 

http://www.ExcelCEO.com/
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computer that you completed the sample files on, as some of the questions on the exam 

may refer to some of the completed examples. 
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 SECTION III:  ADVANCED EXCEL 2010 

One of my beliefs is that the developer of a report or analysis should make it as easy as 

possible for the user to manipulate.  For example, I’ve written courses to train upper 

management personnel to manipulate PivotTables and use VLOOKUP() functions.  I 

have found that some executives love the capability of manipulating PivotTables so they 

can find out the answers to the questions they have without having to ask me to run it for 

them each time.  Others, however, lack the willingness to learn.  Therefore, I try to make 

my spreadsheets very easy to use.  The easier I make it for others to use, the harder it is 

on me and my staff.  This section of the course will address various advanced topics 

whose goal it is to teach you some of the advanced tools I’ve found that are most helpful 

in making spreadsheets “user friendly”, but very powerful  We will also explore many 

procedures and functionalities that can assist you in analyzing data. 

PivotTables was the major technological breakthrough with the release of Office 95.  

Before PivotTables, users could use Data Tables, but they were clunky to program.  I 

remember thinking when I did my first PivotTable that this was the wave of the future.  

PivotTable technology has significantly improved the ease of manipulation of large 

amounts of data to the point where just about anyone can do it with minimal instruction.  

I believe that PivotTables are key to understanding grouping of data, not only in Excel, 

but in database programs like Access and SQL Server.  If you understand the concept of 

PivotTables, the concepts of the GROUP BY statement in Access and writing transact 

SQL code will come much easier.   

Chapter 11 introduces you to PivotTables.  In that chapter, you will create a simple 

PivotTable, show and hide the Field List, add rows, columns and data fields to an existing 

PivotTable, filter fields, and move or “pivot” fields around in a PivotTable.  You will 

create a calculated field, explore PivotTable Options and learn how to sort data within a 

PivotTable.  In Chapter 12, you will explore more advanced functions of PivotTables.  

You will create complex calculated fields, set up a PivotTable with drill down capability, 

and learn about formatting PivotTable and PivotChart reports.  You will start to work 

with external data sources, and finally pull external data containing hundreds of 

thousands of rows of data directly into a Pivot Table. 

This remaining chapters of this section addresses various advanced topics whose goal it is 

to teach you some of the advanced tools I’ve found that are most helpful in making 

spreadsheets “user friendly”, including charts and graphs, using graphics, analysis tools, 

protection and sharing, macros, using the Developer tab (which contains some very cool 

tools), and working with the Web.   
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CHAPTER ELEVEN – INTRO TO PIVOTTABLES 

In this chapter, you will: 

 Create a simple PivotTable.

 Show and Hide the Field List.

 Add Row, Column and Data Fields to a PivotTable.

 Format fields in a PivotTable.

 Filter fields in a PivotTable.

 Add fields to an existing PivotTable.

 Add Page Fields to a PivotTable.

 Create Calculated Fields in a PivotTable.

 Work with the PivotTable Options dialog box.

 Sort data within a PivotTable.
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Introduction to PivotTables 

With the massive databases that exist in most companies, there is a desperate need to be 

able to capture that data and present it in a meaningful format, with the ability to extract, 

summarize, sort, filter and organize the data.  Once you have captured data, you need to 

be able to create reports that analyze the data, make comparisons, detect patterns and 

relationships, and analyze trends.  All of this is possible, and very easy to do, with 

PivotTables. 

If there is any chapter in this course I want you to learn inside and out, it’s this one.  

PivotTables are a pre-cursor to “grouping”, or a “group by” statement in Access and 

SQL.  PivotTables are simply subtotaling data by using different fields and filters.  You 

can dynamically “pivot” a field as a row, column, or page filter and instantly see the 

results.   

I speak three languages (English, which is my native language, Portuguese, and Spanish).  

When I speak in English, I think in English.  When I speak in Portuguese, I think in 

Portuguese and I do the same when I speak in Spanish.  People who speak only one 

language seem to have a hard time grasping how one can “think” in a different language, 

but it comes very easy to those who speak the language fluently.  Similarly, it takes a 

change in thought pattern to understand grouping, and using PivotTables is a great way to 

introduce that concept. 

A Simple PivotTable 

There are many ways to manipulate data within a PivotTable, and data can come into an 

Excel spreadsheet in various manners, like copy and paste from an Access database, or 

link to a SQL Server table, import from a .CSV file, among other ways.  In this chapter, I 

will assume that you don’t have to worry about the source of the data.  We covered that 

in previous chapters.  We will assume the data is correct and your job is to manipulate 

and reorganize the information as necessary to present to upper management.  Let’s rock 

and roll! 

1. Open the file C:\ExcelCEO\Excel 2010\Chapter11\Annual_Sales.xlsx.

2. Save the file as C:\ExcelCEO\Excel 2010\Chapter11\myAnnual_Sales.xlsx. 
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Figure 11.1 

This file is a table of sales by store.  Fields in the table include the Store_No, City, State, 

Region, Year, Month, Merchandise Sales, Warranty Sales and Delivery Sales.  The 

Region field is a geographic assignment that Nitey-Nite has created to make groups of 

stores easier to manage.  Each Region has a Regional President.  The Regional Presidents 

report to the President of the company.  In this exercise, you will calculate the total sales 

for the Company by year.   

3. Click on Cell A2 (or any single cell within the table), click on the Insert

tab, and click on the PivotTable button (or choose PivotTable from the

drop down menu) in the Tables group.

Figure 11.2 

The Create PivotTable dialog box appears.  In Excel 2003, a similar action launched the 

PivotTable Wizard, but in Excel 2010, there is no such wizard.  For this and other 

reasons, I think you will prefer the way Excel 2010 handles PivotTables. 

4. Click OK.
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Figure 11.3 

Since you began with a table in Excel, Excel automatically assumes you want to use the 

table where your cursor is.  NOTE:  Excel chooses all of the contiguous cells (columns 

and rows) in the table.  Therefore, there should be no blank columns, rows or field names 

in the table you want to use.  The value in the Table/Range: box should read 

$A$1:$I$1074, which is the range of our data. 

The PivotTable Field List 

When the shell of the PivotTable is created, you will see the PivotTable Field List 

usually on the right side of the screen.  This list contains all of the column headings in the 

data tab (Excel automatically assumes that the first row of your database contains the 

correct headings, so it is important that the headings are appropriately named).  The 

Office Ribbon will automatically change to include a new grouping of contextual tabs 

called PivotTable Tools which contains two tabs: Options and Design.  We will be 

working extensively with these new tabs.  You can click on the Field List button to hide 

or show the PivotTable Field List.  Note that your cursor must be somewhere in the 

PivotTable (anywhere in the Page Fields, Column Fields, Row Fields or Data Fields) for 

the icons in the PivotTable Tools group to become active and useable. 

Figure 11.4 
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Row, Column and Data Fields 

Your task is to calculate the year-over-year sales for all data in this table, so let’s start 

moving fields into the row, column and data areas of the PivotTable. 

5. In the PivotTable Field List, click on the checkbox beside the Region

field.

Excel automatically assumes that you will be using the Region field as a row item, so it 

places the two values for Region (Northern Region and Southern Region) as rows.  If you 

don’t want Excel to guess where you want the fields, you can drag them to the area you 

want them. 

6. Drag the Year field down to the Column Labels group of the PivotTable

Field List.

7. Drag the Merchandise Sales field to the section in the PivotTable Field

List called Values.

Figure 11.5 

8. Click on the Sum of Merchandise Sales field in the PivotTable (it should

be on Cell A3).

9. Click on the Field Settings button in the Active Field group of the

Options tab.
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Figure 11.6 

The Value Field Settings dialog box appears.  With this dialog box, you can change the 

setting and formatting of a PivotTable field.  It is already summing the data correctly 

(i.e., we don’t want a COUNT or AVERAGE summarization), but we will format the 

field to be Number with zero decimal places. 

10. Click on the Number Format button.
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Figure 11.7 

The Format Cells dialog box appears, but unlike the typical Format Cells dialog box, this 

one has only the Number tab. 

11. Format the field to be Number with zero decimal places with the Use

1000  separator (,) and click OK.

12. Click OK in the Value Field Settings dialog box.

Your PivotTable should now look something like Figure 11.8: 



Section III:  Advanced Excel 2010 Intro to PivotTables  11

  304 

Figure 11.8 

When a field in the Field List box is used in a PivotTable, it appears bold and checked. 

Filtering Fields 

Per the PivotTable, there were Merchandise Sales of $95,602,924 for all years in the data. 

It also tells us what the corresponding Merchandise Sales for each year.  Look at the 

amount for the Year 2011.  It is significantly lower than the other years.  That is because 

the data for the sales in 2011 stopped in January 2011.  Most likely, this data was 

extracted from the system after 2010 had closed and picked up some data that had already 

been posted in 2011.  We don’t need the 2011 data in our PivotTable, so let’s exclude it.  

The filter functionality in a PivotTable works very similar to a Data Filter you learned 

previously. 

1. In the PivotTable, click on the drop down arrow next to Column Labels

and uncheck the 2011 checkbox.

2. Click OK.
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Figure 11.9 

Once you click OK, the 2011 data is filtered out of the PivotTable.  By default, the 

(Select All) option is selected when filtering Row, Column and Data fields.  Now you 

have a list of Merchandise Sales for each region in each year, excluding 2011.  That 

wasn’t too hard, was it? 

Adding Fields 

Now, upper management would like to see Merchandise Sales by state as well.  Let’s add 

in the State field in our PivotTable. 

3. In the PivotTable Field List, drag the State field down to the Row

Labels section under Region.
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Figure 11.10 

Now you have columns for the Region, State, and Merchandise Sales for 2008, 2009 and 

2010.  Are you getting the picture now?  Manipulating a PivotTable isn’t much more 

difficult than that – just clicking and dragging the fields where you want the data to be 

organized.   

Figure 11.10 shows what I consider to be one of the most significant changes from Excel 

2003 to Excel 2007 and 2010.  In Excel 2003, the State field would have shown up in its 

own column.  In Excel 2007 and 2010, multiple columns of rows appear in a compact 

view, which has the show (+) and hide (-) buttons to the left of the field values.   You can 

switch between compact, outline and tabular views of a PivotTable by clicking on the 

Report Layout button in the Layout section of the Design tab. 

4. Click on the Report Layout button in the Layout group of the Design tab

and choose Show in Outline Form.
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Figure 11.11 

Play around with the different layouts for a PivotTable.  I prefer the Compact Layout as it 

saves on space (all of the row fields are contained in one column).  Right now, our 

PivotTable includes only Merchandise Sales, but we also have Warranty Sales and 

Delivery Sales.  We want to include those fields in our PivotTable as well. 

5. Set the PivotTable to a Compact form.

6. From the PivotTable Field List, drag the Warranty Sales field and drop

it below the Sum of Merchandise Sales in the Values section.

7. Drag the Delivery Sales field and drop it below the Sum of Warranty

Sales in the Values section.

When you drag a second level of data into the Values sections, you will see the 

 field appear in the Column Labels sections.  This tells you that the 

Values in the Values section will appear as Columns.  We want the Values to appear as 

rows, so you need to move the  field into the Row Labels section.  

8. Move the  field from the Column Labels section to the 

Row Labels section of the PivotTable Field List. 

9. Click on any one of the Sum of Warranty Sales cells in the PivotTable

and set the format to Number, zero decimal places.

10. Apply the same formatting for Sum of Delivery Sales.
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Figure 11.12 

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 11, Section 1 of 2 
option and complete the review questions.

Report Filter 

As you can see, the PivotTable gets more complex each time you add a field.  Let’s 

suppose that upper management is not really interested (for this analysis) in a year-over-

year analysis, but rather they want to see each year by itself with the corresponding sales 

figures.  We can let them choose to see the year they want by making the Year field a 

Report Filter.  A Report Filter filters the entire PivotTable for a chosen item. 

1. Drag the Year field from the Column Labels section to the Report Filter

section.
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Figure 11.13 

The Year indicator changes to (Multiple Items) since we had previously deselected 2011.  

To include all years, simply click on the Year drop down menu and check the 2011 

checkbox. 

2. Click the Year drop down arrow, uncheck all boxes except for 2008 and

click OK.

All of the data now changes to reflect only the sales in 2008.  I think it’s kind of clunky 

looking at the sales fields (Merchandise, Warranty and Delivery) on top of one another.  

Let’s pivot the data around where the sales fields appear in columns rather than in rows. 

3. Move the  field over to the Column Labels section of the 

PivotTable Field List.
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Figure 11.14 

The columns are kind of wide, so let’s rename the fields to save space. 

4. Click on Cell B3, which currently reads Sum of Merchandise Sales.

5. Replace Sum of Merchandise Sales with Merchandise.

6. Replace Sum of Warranty Sales with Warranty, and Sum of Delivery

Sales with Delivery.

7. Adjust the column widths to fit.

Figure 11.15 
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Calculated Fields 

At this point, let’s talk about calculated fields.  There is not a field in the Annual_Sales 

tab or in the PivotTable that sums up all sales, so let’s do that in the PivotTable itself. 

1. Make sure your cursor is somewhere on the PivotTable, and click on the

Fields, Items & Sets button in the Calculations group of the Options tab.

2. Choose Calculated Field…

Figure 11.16 

3. In the Name: field in the Insert Calculated Field dialog box, type

Total_Sales.

4. Delete the 0 in the Formula: box

5. In the Fields: box, click on Merchandise Sales and click the Insert Field

button.

6. In the Formula: box, to the right of „Merchandise Sales‟, type the “+”

key.

7. Double-click on the Warranty Sales field in the Fields: box.

8. Type the “+” key.

9. Double-click on the Delivery Sales field in the Fields: box.
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Figure 11.17 

 

The formula should read  =‟Merchandise Sales‟+‟Warranty Sales‟+‟Delivery 

Sales‟.   

 

10. Click OK. 

 

 
Figure 11.18 

 

Now you have created a new field that calculates Total Sales.  It is called Sum of 

Total_Sales.  Again, that name is too long, so let’s change it. 

 

11. In the PivotTable, change Sum of Total_Sales to Total. 

12. Resize the column. 
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Figure 11.19 

 

Now you have an analysis that means something.  You send this to your manager and he 

loves it.  Then he asks, “You know, we really do need to look at annual sales in one table, 

but it needs to show total sales, not the individual sales categories.  Can your PivotTable 

do that?”  Your response is “Yes, but it’s REAL hard to do, and I’m the only one in the 

company who can do it.”  We’ll keep the truth just between us. 

 

To do what he requested, we need to get rid of the Merchandise, Warranty, and Delivery 

fields, keep the Total field and bring the Year field back down as a Column Label.  That 

shouldn’t be too hard, should it?  Let’s see. 

 

1. Uncheck the Merchandise Sales, Warranty Sales, and Delivery Sales 

fields from the PivotTable Field List (this takes those fields out of the 

PivotTable), but leave the Total_Sales field there. 

2. Drag the Year field from the Report Filter section to the Column Labels 

section. 

3. Click on the Column Labels drop down menu in the PivotTable and 

select all years except 2011. 

 

 
Figure 11.20 
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PivotTable Options 

 

The Grand Total column (Column E) really doesn’t add anything to our analysis, so we 

can take it out.  We do that by using PivotTable Options. 

 

1. Right-click anywhere in the PivotTable and choose PivotTable 

Options… 
 

 
Figure 11.21 

 

The PivotTable Options dialog box appears. 

 

2. Click on the Totals & Filters tab. 

3. Uncheck the Show grand totals for rows box and click OK. 

 

You can also click on the Options button in the PivotTable section of the Options tab to 

display the PivotTable Options dialog box.  After you click OK, the Grand Total column 
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in the PivotTable goes away.  Take a moment and review the various options available in 

this dialog box.  You will use many of them. 

 

Sorting within a PivotTable 

 

Now that we’ve created fields within our PivotTable and pivoted the information around 

a bit, let’s do some sorting.  Sorting a PivotTable in Excel 2003 was a bit cumbersome, 

as you had to use the Sort and Top 10 functionality.  Excel 2010 provides a cool Sort 

section for sorting within a PivotTable.  Let’s suppose you want to sort the PivotTable to 

make the States with the most Total Sales appear on top (descending order) within each 

region. 

 

4. Click on any cell under the 2010 column. 

5. Click on the Sort button in the Sort & Filter group of the Options tab. 

 

 
Figure 11.22 

 

The Sort By Value dialog box appears.  By default, the Smallest to Largest and Top to 

Bottom radio buttons are selected.  The Summary section below reads that this will sort 

the State field by the Total in ascending order using the values in the 2010 column.  Since 

we want to sort from high to low (or descending order), we need to click on the Largest 

to Smallest radio button. 

 

6. Click on the Largest to Smallest radio button. 

7. Click OK. 

 

Your PivotTable should now look like Figure 11.23: 
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Figure 11.23 

The data is now sorted by State.  Easy, huh? 

8. Rename the sheet containing the PivotTable to Pivot.

9. Save and close myAnnual_Sales.xlsx.

As you can see, PivotTables are very useful tools for organizing, slicing and dicing your 

data.  Go over the exercises in this chapter again and again until you thoroughly 

understand the concepts of PivotTables.  It will greatly ease your future understanding of 

the “group by” clause in SQL.  We’ll explore more about PivotTables in the next chapter. 

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 11, Section 2 of 2 
option and complete the review questions. 

Conclusion 

In this chapter, you began your introduction to PivotTables.  First, you created a simple 

PivotTable.  You learned how to show and hide the PivotTable Field list, and added rows, 

columns, and values to the PivotTable.  You learned how to format fields and filter fields 

within a PivotTable.  You added fields, moved fields around, added a Report Filter and 

even calculated a new field.  You learned how to work with the PivotTable Options 

dialog box.  Finally, you learned how to sort data within a PivotTable. 

Chapter Exam 

To take the examination for this chapter, you must have successfully completed 

the examination for the previous chapter.  You can now go to www.ExcelCEO.com, 

click on Sign In, log in and take the exam.  Make sure that you take the exam on 

the same 

http://www.ExcelCEO.com/
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computer that you completed the sample files on, as some of the questions on the exam 

may refer to some of the completed examples. 
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_____________________________________ 

 Excel 2010
Complete Self-study Course
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CHAPTER TWELVE – ADVANCED PIVOTTABLES 

In this chapter, you will: 

 Change a field’s settings.

 Create complex calculated fields in PivotTables.

 Set up a PivotTable with drill down capability.

 Create PivotChart Reports.

 Connect to an external data source.

 Pull external data into a PivotTable.
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Advanced PivotTables 

Once I received a phone call from a financial manager in another state.  She had a 

database of personnel information and wanted to roll it up to various management levels 

within our organization.  This manager had heard of PivotTables but understood they 

were very complex and wanted to know the name of a good consultant to do 

the PivotTable for us.  I said, “Yes. You.”  I asked why she couldn’t do the PivotTable

for herself.  Her response was that she didn’t have the time to learn how to use 

PivotTables before the report had to be ready.  I asked her to send me the database via 

email, and then I spent about 15 minutes showing her how to manipulate a PivotTable on 

the phone.  She was fascinated with how easy it was to create and manipulate 

PivotTables, as I hope you are as well. 

Now that you have a taste of PivotTables, we’ll have a little more fun with them.  Again, 

the main concept I want you to learn here is how to pivot fields within the database to 

group and summarize the data.  You can use just about any of the fields in the database 

for such a summary and you can do just about any calculation. 

Let’s suppose that your manager wants to look at annual sales activity and wants to see a 

percentage growth year-over-year, by state.  He also wants the capability to drill down to 

find out which stores are the lower performers.  Remember, sometimes you receive data 

in different ways, from different files, and in different formats.  In this chapter, I used the 

same base data as in Chapter 11, but I’ve changed it around a little, so you can experience 

the different data formats.  Instead of having a Year field and each category of sales in 

columns, the Category is one column and the Year is contained in four different columns 

with the sale amounts.  Let’s review that file. 

1. Open the C:\ExcelCEO\Excel 2010\Chapter12\Sales_Summary.xlsx file.

2. Save the file as C:\ExcelCEO\Excel 2010\Chapter12\mySales_Summary.xlsx. 

Figure 12.1 

In this file, the amount fields are called 2008, 2009, 2010 and 2011.  These are amounts 

that correspond with each Store, Month, and Category.  Note that the data under the 2011 
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column is mostly blanks, as there are no sales recorded yet for March 2011 and beyond.  

Also in this data, Store No. 1009 was closed in September 2010, and that store 

consequently has blanks from September 2010 forward in its sales data.  You will now 

create a PivotTable that shows sales by state by year from 2008 to 2010. 

3. Create a new PivotTable by clicking on the Insert tab, PivotTable

button, and click OK.

4. Drag the State field and use as a Row Label.

5. Drag the 2008 and 2009 fields and drop them in the Values section.

6. Make sure the Values field appears in the Column Labels section.

7. Double-click on the Sum of 2008 cell in the PivotTable (to display the

Value Field Settings dialog box) and format the field for Number, zero

decimal places.

8. Apply the same formatting to the Sum of 2009 field.

Figure 12.2 

9. Drag the 2010 field and place it in the Values section.
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Figure 12.3 

Change a Field’s Settings 

When you brought in the data for 2010, you got some odd results.  Since some of the 

fields within the 2010 data are blank, Excel tried to count the cells rather than sum them, 

resulting in much lower numbers than in Years 2008 and 2009.  Notice that the name of 

that column is “Count of 2010” instead of “Sum of 2010”.  Let’s fix that. 

10. Right-click on the Count of 2010 cell (it should be Cell D3).

11. On the pop-up menu, choose Value Field Settings…

Figure 12.4 

12. In the Value Field Settings dialog box, choose Sum.

13. Click on the Number Format command button and format the field as

Number, zero decimal places.
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Let’s rename the fields to something that looks better than Sum of 2008, etc.  When you 

rename a field within a PivotTable, you can’t use the exact name as it appears in the data.  

In this example, you can name the 2008 column anything except 2008. 

14. Rename the Column fields 2008 Sales, 2009 Sales and 2010 Sales.

Figure 12.5 

Complex Calculated Fields 

Now we’ll do a more complex calculation and calculate the percentage growth from one 

year to the next. 

1. In the Options tab, click on Fields, Items & Sets and create a new

calculated field.

2. Name the Calculated Field 09/08_Chg.

3. Create the formula:  =(„2009‟-„2008‟)/ABS(„2008‟)

4. Click OK.

5. Format the new field as Percent, one decimal place.

6. Rename the new field 09/08 Change.

7. Move the new 09/08 Change field to the left of 2009 Sales (click on the

09/08 Change field in the Values section and move it to between the 2009

Sales and 2010 Sales fields).

8. Create a similar calculated field for the 10/09 change.

9. Resize columns as needed.
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Figure 12.6 

Drill Down in a PivotTable 

Now there’s an analysis you can sink your teeth into.  Although we see similar changes 

between states from 2008 to 2009 (ranging from 3.5% to 5.3%), the more current data 

(2010) shows we may have concerns about at least two states, NJ and PA.  The PA data 

even shows sales are declining, when we know there was an overall price increase.  We 

need to look at more detail about these states to see if there is a problem we need to 

address with local management.  But how do you get down to the detail?  Before you get 

on the phone and start screaming at the field management, let’s analyze the data a little 

further.  We may need to drill down to the Store level and then maybe down to the 

Category and/or Month level.  Let’s set it up. 

1. From the PivotTable Field List, drag the Store_No field to below the

State field.

2. Click on the first Row Label (it should be DC in Cell A4), and click on

the Collapse Entire Field button  in the Active Field group of the

Options tab.

3. Drag the Category field below the Store_No field.

4. Drag the Month field below the Category field.
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Figure 12.7 

Clicking on the Show Detail icon (the + button) displays all of the data below it, and the 

Show Detail (+) button turns to the Hide Detail (-) button.  Since we want to see what’s 

going on in PA, let’s drill down on that state first. 

5. Click on the Show Detail (+) button next to PA.

All of the data below PA displays.  To collapse the data at the Store No level, click on 

any Store No and click on the Collapse button in the Active Field group. 

6. Click on Store No 1005 and click on the Collapse Entire Field button in

the Active Field group of the Options tab.



Section III:  Advanced Excel 2010 Advanced PivotTables  12

  326 

Figure 12.8 

You now see that Store No 1009 has a 36.9% decrease in sales in 2010 from the 2009 

levels.  Why is that?  Let’s drill down on that store. 

7. Click the + sign (or double-click on the Store number) on Store 1009 to expand

it.
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Figure 12.9 

Now we’re getting somewhere.  For the months of September through December, there is 

no data in any of the Delivery, Merchandise or Warranty categories.  Remember?  Store 

No. 1009 was closed in September 2010, so it won’t have any sales thereafter.  It looks 

kind of strange to have cells in the PivotTable with null or no values – it should at least 

have a zero.  Remember that a zero is a number, but this data has no values for this store 

from September through December, and is thus returning nothing.  There is a table option 

where you can make null values become zeros, just to make the report look better. 

8. Right-click anywhere in the PivotTable and choose PivotTable

Options…

9. In the Layout & Format tab of the PivotTable Options dialog box, make

sure the For empty cell, show:  checkbox is checked, and type 0 in the

text box.

10. Click OK.

Those cells that were null are now populated with 0s, but remember that Store 1009 was 

closed in September 2010, and as such we should probably exclude that store from our 
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analysis to get a true year-over-year picture.  Since the Store No. field is a couple of 

levels down in the PivotTable, we’ll have to find it first then filter out Store No 1009. 

11. Click on the Row Labels drop down menu, and then under the Select

Field drop down menu, choose Store_No.

12. Uncheck Store No 1009 and click OK.

The PivotTable now collapses to show only the Store numbers, and Store No 1009 is not 

there.  PA now shows a 2.2% increase over the prior year, which is much more 

reasonable than the -1.1% figure.  It looks like the state of NJ also has some issues.  Let’s 

look into that. 

13. Expand NJ.

In reviewing the data, we see that Store No. 1002 has a -1.0% change from 2010 as 

compared with 2009.  Typically, we shouldn’t see any stores with negative sales growth 

from one year to the next, so let’s drill down on that store to see what happened there.  

Remember in analyses like this, you can sort by value fields and have the best or worst 

numbers on top or bottom.  

14. Drill into Store No 1002.
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Figure 12.10 

As you can see, there were several months at Store No. 1002 that had Merchandise and 

other sales that were lower than the 2009 levels.  Now is the time to get on the phone 

with the store manager to see what’s going on.  You can continue to drill down to various 

levels – any level of data available in your database. 

PivotTable Styles 

At this point, you should get the picture on PivotTables.  You should now be able to set 

up data in a PivotTable and be able to drill down to find any level of detail available.  

Calculated fields make it very easy to analyze your data to facilitate drill down analyses.  

However, the report looks, kind of, bland.  Let’s work through some examples on making 

the PivotTable report look a little better. 

1. Hide the detail in the PivotTable by double-clicking NJ and PA.

2. Click on the Design tab under PivotTable Tools.
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3. In the PivotTable Styles group, click on the More down arrow .

Figure 12.11 

A menu appears that shows all of the pre-formatted PivotTable styles.  In addition to the 

styles provided, you can create your own style by clicking on the New PivotTable 

Style… button.  Since there are so many professionally designed styles available here, I 

like to use them. 

4. Move your cursor over any of the PivotTable Style options.

When you move your cursor over a style, you can see the style being applied to the 

PivotTable in the background.  I really like this feature in Excel 2010 as it allows you to 
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see what the PivotTable Report will look like without actually clicking on the style.  You 

can move your cursor relatively quickly through all the different styles and see in the 

background which one you like the best. 

5. Click on  PivotTable Style Medium 19.

Figure 12.12 

6. Rename the tab containing the PivotTable as Pivot.

Search Filters in PivotTables 

The last topic I want to cover in this section is Search Filters.  In Chapter Four, I showed 

you a new feature in Excel 2010 called Search Filters.  These are filters that you can use 

to limit the items that appear in the filter list.  In PivotTables, not only can you use this 

feature, but you can also toggle between different row or column fields within one filter.  

Let’s do an example of that. 

7. Click on the Row Labels filter arrow.



Section III:  Advanced Excel 2010 Advanced PivotTables  12

  332 

Figure 12.13 

The Search box here works just like the one we did in Chapter Four, but the one 

difference here is that you can use any fields that is set up as a Row Label.   

8. Click on the drop down arrow under Select Field: (it should have State currently

displayed).

9. Click on Store_No.
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Figure 12.14 

It now shows the filter items for Store_No.  Notice that Store_No 1009 is unchecked, as 

we did previously.  If you type “09” in the Search box, it will filter the list to include 

Store_No 1009.  The trick here is that the Select Field: items must already be set up as a 

Row Label in the PivotTable Field list. 

10. Click Cancel, then save and close the file.

Review Questions: It is now time to complete the hands-on Review
Questions. Log on to www.ExcelCEO.com with your Email and Password,
click on the Excel 2010 Review Questions, Chapter 12, Section 1 of 2
option and complete the review questions.

External Data Sources 

Let’s pause our PivotTable discussion for a while and talk about data sources.  Up to 

now, all of the data that you have used has been contained in spreadsheets.  In reality, 

data can come from various sources.  One time, a prestigious East Coast consulting firm I 
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was working with had an Excel model that was designed very well.  However, one of the 

things about it that bugged me was that the user had to copy data from an Access 

database and paste it into the Excel file and then run a PivotTable based on that data.  I 

showed them how to create a connection directly to that Access database (or any other 

database for that matter).  It was kind of fun consulting the consultants. 

Now we’ll do a simple example of bringing data into an Excel file from an external data 

source.  It’s actually very easy to do, IF you know the right buttons to push.  In the 

Chapter12 folder is an Access database called Data.mdb.  Access is a very good desktop 

relational database program that Microsoft created.  I strongly encourage you to continue 

to the next course in this series so you can learn about Access.  For now, we will simply 

open the Access database and view the data in the table.  The following screenshots are 

from Access 2010. 

1. Open a blank workbook in Excel.

2. Save the file as C:\ExcelCEO\Excel 2010\Chapter12\myAccess.xlsx.

3. Open Microsoft Access.

Figure 12.13 

4. In Access, click the Open icon on the left side of the screen and navigate

to C:\ExcelCEO\Excel 2010\Chapter12\data.accdb and open it.

A Microsoft Access 2007 database is stored as a .accdb file. 

Note: Depending on the version of Microsoft Office you have installed on 
your computer, you may not have Microsoft Access available. If this fits 
your situation, don’t panic! You can still follow along with the majority of 
the following exercise hands-on, and understand the concepts at very least. 
The ability to work with external databases is a powerful skill, so if you 
can find a way to use Access for this project, I would encourage you to try. 
Otherwise, you can skip to Step 13, if you don’t have Microsoft Access 
available to you.
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Figure 12.14 

5. If the Security Warning line appears, click on the Enable content.

6. Double-click on the Employee table to open it.
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Figure 12.15 

This table lists all of the current and terminated employees of Nitey-Nite.  An employee 

who is currently employed with Nitey-Nite has an End_Date of 1/1/2099.  For now, we 

want to import the data from this table into an Excel spreadsheet.  The easiest way to 

copy records from an Access table or query into an Excel file is to select all of the records 

in the table, then copy and paste them into Excel.  Let’s try that. 

7. Select all records in the Employee table by clicking in the gray box with

the white triangle to the left of the Employee_ID field.

8. Type [Ctrl]+c to copy the data into memory.

9. Toggle over to the blank Excel spreadsheet (click on the Excel window at

the bottom of your screen).

10. Click on Cell A1 of Sheet1 and type [Ctrl]+v.
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Figure 12.16 

11. Click on the Wrap Text icon in the Alignment group of the Home tab

twice.

12. Resize all columns to fit.

Figure 12.17 
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Now you have a table in Excel that contains all of the Employees at Nitey-Nite.  You can 

manipulate this table in any way you want.  However, what happens when an employee 

leaves or a new employee is hired?  The table in Access will change (assuming that table 

is the primary database for employee data), but then you have to copy it over to your 

Excel file in again and repeat the process every time the data changes, which may be 

every day or even multiple times during the day.  You can write a macro to do the 

formatting in Excel, but it would be nice if you could create a direct link to that data.  

You can do that by using an External Data Source link.   

In this next exercise, you will create a link to a Microsoft Access database.  In the Access 

course, you will learn much more about external data sources and will create a Data 

Source Name (DSN) tied to a SQL Server database.  But in the Excel course, we’ll stick 

to a simple example linking to an Access database. 

One important concept when linking to an Access database in Excel is that you should 

not have the Access file you’re linking to open at the same time with the Excel file that 

contains the link.  You should have only Excel OR Access open at the same time. 

1. Close the data.accdb database and Access. (Choose No if a warning 
messages asks if you want to keep the copied data in memory.)

2. Click on Cell A1 of Sheet2 of the Excel file.

3. Click on the Data tab, then click on the From Access button in the Get

External Data group.

4. Navigate to the C:\ExcelCEO\Excel 2010\Chapter12\ folder and

choose data.accdb and click Open.

Figure 12.18 

You want to link to the Employee table. 

5. Make sure the Employee is selected and click OK.
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Figure 12.19 

The Table radio should be selected in the Import Data dialog box. 

6. Accept the default values (Table, Existing worksheet in Cell A1) and

click OK.

Figure 12.20 

7. Save the Excel file.

Excel imports the data into Sheet2 beginning at Cell A1.  Let’s try opening the Access 

database with this link established and see what happens. 
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8. Open Access.

9. In Access, open the file at C:\ExcelCEO\Excel 2007\ Chapter12\ data.accdb.

Figure 12.21 

A security warning appears, telling you that the database has been opened in read only 

mode.  This is because the Excel file that is linked to the Access database is open.  As 

such, you can’t make any changes to the Access database.  Let’s make a change in the 

Access database, but first we have to close it. 

10. Close the data.accdb database.

11. Close the myAccess.xlsx file (it should already be saved).

12. Open the data.accdb database.

13. Open the Employee table.

14. On the first record on the Employee_ID table, change the First_Name to 
Padraic1. 

Figure 12.22 

15. Click anywhere outside of that record and close Access.

16. Open the myAccess.xlsx file.

Note: If you do not have a copy of Microsoft Access, you can skip Steps 10-19.
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Figure 12.23 

17. If you get the Security Warning, click on the Enable Content button.

18. Right-click anywhere in the table and choose Refresh.

To refresh a link, you can also use the Refresh All button on the Data tab. 

Figure 12.24 
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The data that you updated in the Access table (Padraic1) is now updated in Excel.  Again, 

you will learn more about external data connections in the Access course, but this 

exercise should at least get you thinking about what kinds of data you can connect to in 

Excel. 

19. Save and close the myAccess.xlsx file.

Let’s do another example just to make sure you’re ready to enter the PivotTable world on 

your own.  This one will be the ultimate analysis with PivotTables – you’ll see why in a 

few minutes. 

Using External Data in a PivotTable 

Having over 1,000,000 rows of data available in Excel 2010 can be a double-edged 

sword.  It would be great to have that many rows in which to work, but once you start to 

get a lot of rows of data, Excel starts to slow down.  Particularly if you have a lot of 

formulas in the spreadsheet, refreshing those formulas can take a long time.  If your 

spreadsheet seems to take a long time to calculate, I’ll suggest a couple of things.   

1) The VLOOKUP() function, although it is a very useful function, can be

a resource hog.  See if you can use another function, like SUMIF() or

INDEX() to accomplish the same thing.  Those functions take up much

less resources and work much faster than VLOOKUP().  The

VLOOKUP() function is many times the culprit of a worksheet that takes

a long time to refresh.

2) Try keeping large amounts of data in databases like Access, SQL

Server or Oracle (databases designed to hold voluminous information),

and link to them in an Excel PivotTable for your analysis.

In this next example, you will link a PivotTable to an database with almost 300,000 rows 

of data, and Excel will fly through it like it was 20 rows of data.  Before you begin this 

example, I must warn you.  If you’ve previously worked with large amounts of data and 

have found Excel to be very limiting, you may get too excited.  What I am about to show 

you could possibly cause your heart to start racing too fast, which could lead to other 

injuries, and I don’t want that on my conscience.  So, before you start this example, get a 

drink of water, take your medication, do whatever you have to do to get settled down 

before this wild ride.  Done?  Good.  Let’s get started. 

What we are going to create here is the ultimate financial statement analysis tool.  The 

data is contained in the same Access database we used in the previous example, so let’s 

open up that database again. 

1. Open the Access database at C:\ExcelCEO\Excel

2010\Chapter12\data.accdb.

2. Click Enable this content in the Security Alert (if necessary).

Note: If you do not have a copy of Microsoft Access, you can skip Steps 1-4.
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3. Open the Excel_Data table.

Figure 12.25 

Feel free to scroll up and down through the data.  Let me explain the table.  It is a table 

that was created by one of Nitey-Nite’s accountants for analysis of General Ledger 

activity for 2008 – 2010.  It actually combines three tables.  From the General_Ledger 

table, she brought in the Month, Account and the three Year columns (2008, 2009 and 

2010).  She retrieved the Store and Region fields from the Stores table and the 

Lv11_Acct_desc, Lv12_Acct_desc and Lv13_Acct_desc fields came from an account 

rollup table.  With the data in this format, it is easy to put it into a PivotTable.  Notice 

that there are 293,068 records of data in the table.  Even though it’s possible to use that 

many rows of data in Excel, it can be very slow depending on your computer.  One 

solution to analyze this data is to bring the data directly into a PivotTable without first 

dumping it onto a spreadsheet.  This way, the data is in memory behind the spreadsheet.  

You won’t be able to see all of the individual records, but you don’t need to.  All you 

want to do is to summarize the data, and that can be done in the PivotTable.  And let me 

tell you, it’s REAL EASY to do.  Let’s do it. 

4. Close the Excel_Data table and the data.accdb database.

5. Open a new workbook in Excel.

6. Save the workbook as C:\ExcelCEO\Excel

2010\Chapter12\myGL_Summary.xlsx

7. Click on the Data tab, then click on the From Access button.

8. In the Select Data Source dialog box, navigate to C:\ExcelCEO\Excel 2010

\Chapter12\data.accdb, and double-click on that file.
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Figure 12.26 

9. Click on the Excel_Data table and click OK.

Figure 12.27 

10. In the Import Data dialog box, choose PivotTable Report, leave the

Existing worksheet set to =$A$1 and click OK.
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Figure 12.28 

Note:  At the bottom of the PivotTable Field List, there is a check box 

called Defer Layout Update.  If you have a PivotTable that is connected 

to a very large database and it takes a lot of time to update the PivotTable 

each time you add or take away a field, you can check this check box and 

it will not update the PivotTable until you uncheck it.  This can be a huge 

time saver when working with large databases. 

It may take a few seconds to make the connection, and then you will see the shell of the 

PivotTable.  Let’s analyze the data. 

11. Set Region, Store and Month as Report Filters fields.
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12. Set Lvl1_Acct_Desc, Lvl2_Acct_Desc, Lvl3_Acct_Desc and Acct as

Row Label fields.

13. Bring in the Amt_2010, Amt_2009 and Amt_2008 fields in as Value

fields.

14. Rename the Value fields 2010, 2009 and 2008.

15. Format the amount data in the PivotTable to be Number, zero decimal

places and use 1000 separator (,)

16. Click on 308-0, Rent Expense and click the Collapse Entire Field icon in

the Active Field group of the Options tab.

After all of that, you should get a PivotTable that looks Figure 12.29: 

Figure 12.29 

Remember that you can click on the Expand/Collapse icons to Show or Hide any level of 

detail you want.  Keep in mind that this data comes directly from the General Ledger so 

the data carries GAAP signs (i.e., revenues are credits, or minus signs).  If you set up 

your workbook in this manner, you can now write any formula you want to analyze year 

over year changes.  Your limit depends on your imagination.   

In this PivotTable, Expenses shows up before Revenue, and in a typical Income 

Statement, Revenue appears before Expenses.  Reordering this data is easy to do – just 

click and drag.   

17. Click on the cell that contains the word Revenue.

18. Place your cursor over the top edge of the cell and it will turn to a four-

sided arrow.

19. Click on the cell and drag it above the cell containing Expenses and

release.
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You will see a gray horizontal bar appear as you move the Revenue cell.  Once you 

release it, the PivotTable is reordered to where Revenue appears on top. 

Figure 12.30 

Let’s say you now want to look only at the first quarter (January, February and March) 

data for all those years.  The Month is contained in a Report Filter, and Report Filters 

were historically (before Excel 2007) set up to handle only one filter.  In Excel 2007 and 

2010, you can select multiple values in a Report Filter field. 

20. Click on the Month drop down arrow in Cell B3.

21. Click on the Select Multiple Items checkbox (all the months will have

check boxes beside them and all are checked.)

22. Deselect the (All) checkbox, then check Months 1, 2 and 3.
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Figure 12.31 

23. Click OK.

Figure 12.32 

The Month report filter now reads “(Multiple Items)”, since it can’t display all of the 

months chosen in Cell B3. 

Slicers 

Although this feature is very cool, it has its limitations.  Just by looking at the PivotTable, 

you can’t tell which months were selected.  To help with managing multiple selected 
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items in a PivotTable, Excel 2010 offers a new feature called slicers.  A slicer is simply a 

view of what is selected in the PivotTable, or a change in the PivotTable’s state.  

Inputting a slicer is really easy – just click on the Insert Slicer icon.   

1. In the Sort & Filter group of the PivotTable Tools Options contextual

tab, click on Insert Slicer.

Figure 12.33 

2. Click on the Month checkbox and click OK.
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Figure 12.34 

 

The Month slicer appears with the months 1, 2 and 3 selected, because those are the 

selections we did previously.  To change the month, just click on the month you want in 

the slicer. 

 

3. Click on Month 4 in the slicer. 

 

 
Figure 12.35 

 

Notice that Month 4 in the slicer is selected and the Month Report Filter in the PivotTable 

reflects 4, and the data in the PivotTable changes. 

 

4. Click on Month 1 in the slicer, hold down the [Ctrl] key and click on 

Month 2 and 3, and release the [Ctrl] key. 
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Note when you selected value while holding down the [Ctrl] key, the values in the 

PivotTable don’t change, but as soon as you release the [Ctrl] key, all the values in the 

PivotTable change and the Month Report Filter reads “Multiple Items”. 

Other PivotTable Tricks 

Let me show you a few other things that you can do with PivotTables that will help out in 

certain situations.  This first exercise doesn’t apply very well to the data we have in our 

current PivotTable, but it will show you the power of right-clicking. 

1. Right-click anywhere under the 2009 field in the PivotTable, point to

Summarize Values By and click on Average.

The values for 2009 now reflect an average numbers instead of a summation.  Make sure 

to review all of the options available in the right-click menu.  It can greatly speed up your 

development of a PivotTable. 

2. Click on the Undo button.

3. Click on the PivotTable Tools Design contextual tab.

4. Click on the Banded Rows checkbox of the PivotTable Styles Options

group.

Figure 12.36 

The PivotTable now displays banded rows.  This is useful when there are many rows of 

data and you want to make it more readable. 
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Lastly, remember when you were using the old style of PivotTables and the row labels 

didn’t repeat?  That drove me nuts when I was trying to do a VLOOKUP() on data within 

a PivotTable.  Excel 2010 now has the functionality to repeat items in a PivotTable.  

We’ll first set up the PivotTable in a tabular form (the old style), then I’ll show you how 

to repeat items. 

 

5. In the PivotTable Tools Design contextual tab, Layout group, click on 

the Report Layout icon and click on Show in Tabular Form. 

6. Move the Slicer out of the way if necessary. 

 

 
Figure 12.37 

 

7. Click on the Report Layout icon again and choose Repeat All Item 

Labels. 
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Figure 12.38 

8. Save and close the file.

Whew!  Are you ready for a break?  That was an intense chapter, but one that will help 

you tremendously as you start to use PivotTables in your work.  You are now ready to 

manipulate just about any field in a PivotTable.  Please make note of a few more notes: 

1. Right-click is your friend.  If you are in a PivotTable and you want to do 
something but you don’t know how, try right-clicking within the PivotTable and 
you may find the answer to your question.

2. Double-clicking makes things fast and easy.  If you make a mistake, you can 
always use the Undo button.  Don’t worry about screwing it up.  Have fun with it!

Review Questions: It is now time to complete the hands-on Review Questions. Log 
on to www.ExcelCEO.com with your Email and Password, click on the Excel 2010 
Review Questions, Chapter 12, Section 2 of 2 option and complete the review 
questions.. 

Conclusion 

In this chapter, you changed a PivotTable field setting from Count to Sum.  You created a 

complex formula using the ABS() function in a PivotTable calculated field.  You set up a 

PivotTable to include drill down capability by using the Show Detail (+) or Hide Detail 

(-) buttons or by double-clicking on the value you want to drill down on.  You formatted 

a PivotTable Report using the available standard styles.  You connected to an external 

data source to bring data onto a spreadsheet, and you pulled data from an Access database 

directly into a PivotTable.  Lastly, you learned about Slicers and the various options 

available in the PivotTable Tools Options and Design contextual tabs. 



Section III:  Advanced Excel 2010 Advanced PivotTables  12

  354 

Chapter Exam 

To take the examination for this chapter, you must have successfully completed 

the examination for the previous chapter.  You can now go to www.ExcelCEO.com,

click on Sign In, log in and take the exam.  Make sure that you take the exam on 

the same computer that you completed the sample files on, as some of the questions on 

the exam may refer to some of the completed examples. 

http://www.ExcelCEO.com/
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CHAPTER THIRTEEN – CHARTS, GRAPHICS, AND OBJECTS 

In this chapter, you will: 

 Create a basic chart.

 Edit an existing chart.

 Position (move) and resize a chart.

 Create a Sparkline.

 Add a Trendline to a chart.

 Create a pie chart.

 Tie a PivotTable to a chart (PivotCharts).

 Create and modify diagrams.

 Import objects to and export objects from Excel.
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It is said “A picture paints a thousand words.”  Truer words have never been spoken.  

However, they can also be deceiving.  Consider the following charts:   

Chart A:  Sales 

Chart B:  Sales 

Which one would you choose for your company, Chart A or Chart B?  Most people 

would choose Chart A.  It appears that sales in Chart A are going through the roof.  The 

sales in Chart B appear to be increasing, but not by much.  However, both charts contain 

exactly the same information.  The only thing I did different was to change the scaling of 

the chart.  The bottom range of Chart A is $9,000,000 and the upper range of the scale is 

set at $13,500,000.  In Chart B, the bottom value is $0 and the top level is $30,000,000.  

Thus, the higher the range, the less dramatic the lines appear to be.  So even though 

charts can tell a lot, they can also be deceiving.  For that reason, you should design charts 

in a way that presents accurate information that allows management to make solid 

business decisions based on the underlying data. 
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$9,500,000

$10,000,000

$10,500,000

$11,000,000
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In its simplest form, a chart is a visual representation of a collection of data.  As the 

developer of the chart, you have the ultimate control over how that chart is created.  You 

can change the scale, colors, series, formatting, etc.  You can estimate future activity by 

adding a trendline.  In this chapter, you will learn how to create and customize various 

types of charts, add a trendline based on data in a spreadsheet, and tie a chart to a 

PivotTable. 

1. Open the file C:\ExcelCEO\Excel 2010\Chapter13\Annual_Sales.xlsx.

2. Save as C:\ExcelCEO\Excel 2010\Chapter13\myAnnual_Sales.xlsx.

Figure 13.1 

Basic Charts 

This is a very simple table.  It shows annual sales for each of the two regions in the 

company.  Let’s put this data into a chart to visually show the sales activity over these 

five years. 

3. Click on Cell A4 (Actually, you can click on any cell in the chart).

4. Click on the Insert tab.

Figure 13.2 

In the Charts group of the Insert tab, Excel allows you to pick the type of chart you want, 

then build it.  Excel 2003 forced you to go through a multi-step wizard to create a chart, 

but Excel 2007 and 2010 allows you to first create the chart then modify it.  Let’s create a 

basic column chart. 

5. Click on the Column button and choose the first 2-D Column called a Cluster

Column.
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Figure 13.3 

Excel does a couple of things.  First, it creates a chart and places it in the middle of the 

spreadsheet.  Second, it activates a new contextual tab called Chart Tools.  Under Chart 

Tools, there are three sub-tabs:  Design, Layout and Format.  Excel provides SO MANY 

different options when creating charts that it is impossible to explore each of the tools in 

these exercises.  As with other exercises, I encourage you to explore the different options 

on your own.   

Edit an Existing Chart 

In this next exercise, we will add a title to the chart. 

6. Click on the Layout tab under the Chart Tools tab.

7. Click on the Chart Title button and choose Centered Overlay Title.

8. Click inside the title box, replace Chart Title with Annual Sales 2006 –

2010 and click outside the chart.
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Figure 13.4 

Excel creates a title for the chart.  But, as you can see, the title appears within the chart 

itself.  To fix this, we need to resize the chart. 

9. Click in the chart‟s white space to the right of the title (to select the chart).

10. Place your mouse over the left side of the chart to the left of the title and

just right of the vertical line between the 0 – 25,000,000 values and click.

Your cursor should turn to a four-sided arrow before you click.  Just like selecting a text 

box or other object, this action selected the chart itself.  And also just like text boxes, the 

chart is identified with handles on the outer edges. 

11. Click and drag the top center handle until the chart is placed below the

title.
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Figure 13.5 

Now let’s add some titles for the horizontal and vertical axes.  In Excel 2010 charts, the 

axis on the bottom of the chart (formerly called the X axis in Excel 2003) is called the 

Horizontal or Category axis.  The axis on the left side of the chart (formerly called the Y 

axis in Excel 2003) is called the Vertical or Value axis. 

12. Click on the Axis Titles button in the Layout tab, Labels group,

point to Primary Horizontal Axis Title and choose Title below

axis.

13. In the Axis Title box, type Year.

14. Click on the Axis Title button, point to Primary Vertical Axis

Title and choose Vertical Title.

15. In the Title box, type Sales.

16. Select the chart again and resize it to where the Year and Sales

titles show up appropriately.

17. Click anywhere outside the chart to deselect it.
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Figure 13.6 

Now that our chart is done, we show it to the boss.  His first reaction is “It looks great, 

but it doesn‟t look like sales are going up much in either region.  I‟d like to see it where 

the sales growth in every year is more pronounced within the chart.  Also, I don‟t like the 

names “Northern Region” and “Southern Region” in the legend.  Make them say 

“North” and South”.  Can you do that?”  Again, your answer is, “I can do anything”, 

and you get to work.   

First, let’s change the names in the legend.  Changing the names of the regions is easy: 

1. Click on Cell A4 and change the name to North.

Since the chart is tied to the chart, the name in the cell AND the name in the chart 

automatically change to North. 

2. Click on Cell A5 and change the name to South.

3. Select the chart and expand the right side over to fill up more space.

The names are changed and the chart is reformatted to accommodate the shorter names. 
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Figure 13.7 

Making the sales more “pronounced” is a little more challenging, but we can do

it.  Probably the best thing to do is to change the Sales scale by starting the sales 

figures at say $12,000,000 instead of at zero. 

4. Right-click on any number in the Vertical axis and choose Format

Axis…
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Figure 13.8 

The Format Axis dialog box appears.  There are numerous options in this dialog box, way 

too many for us to review in this exercise.  You can explore the different options on your 

own.  For now, we will change the Minimum option to be $12,000,000 and the Maximum 

option to $22,000,000. 

5. Click the Fixed radio button next to Minimum.

6. In the text box, replace 0.0 with 12000000.

7. Change the Maximum box to be 22000000 and change the Major

Unit to be 2000000.

8. Click Close.
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Figure 13.9 
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Figure 13.10 

The columns in the chart appear a little bolder and you can see more of a change from 

year to year.  Let’s add some more customization to the chart. 

9. Right-click in a white space within the chart but outside of the

actual chart in the middle of the chart, and choose Format Chart

Area…
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Figure 13.11 

The Format Chart Area dialog box pops up. 

10. Make sure the Fill option on the left is selected.

11. Click on the Gradient Fill  radio button.

Once you click on Gradient Fill, the Gradient Fill options appear in the section below.  It 

also pre-fills a type of popular gradient fill option. 

12. Click on the Preset colors button and choose Fog (it should be the

last button on the second row), and click Close.
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Figure 13.12 

The chart is now formatted with a Fog style background.  Let’s do a little more 

formatting. 

13. Right-click on the Chart Title and choose Font…

14. Choose Bold Italic under Font Style.

15. Click OK.

16. In the same manner, change the Vertical and Horizontal titles (Sales and

Year) to have a font size of 12.

17. The chart should appear like Figure 13.13

Figure 13.13 



Section III:  Advanced Excel 2010 Charts, Graphics, and Objects  13

  368 

Now your chart looks much nicer.  Some people, like me, prefer simple charts with little 

or no formatting or colors.  I prefer that because I print in black and white, and black and 

white printers don’t show colors very well. 

Positioning a Chart 

Positioning or moving a chart is easy – just click and drag it. 

1. Make sure the chart is deselected by clicking anywhere outside of the

chart.

2. Click and hold anywhere in the blank space and drag the chart where the

upper left corner of the chart is positioned at the upper left corner of Cell

A9.

3. Drag the right middle sizing handle of the chart and drag the right edge of

the chart to be in line with the right edge of Column F.

4. Adjust the bottom of the chart to be at the bottom of Row 23.

5. Deselect the chart.
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Figure 13.14 

The chart should now be positioned under the table with the sales data.  Keep in mind 

that the data in the table is tied directly to the columns in the chart, so if you change the 

data in the table, the chart will automatically update.  

Sparklines 

One of the new features of Excel 2010 is sparklines.  A sparkline is a small, simple chart 

that shows only one data set displayed as a line, column or win/loss chart and is 

contained in one cell.  A line or column sparkline is a compact version of a line or 

column chart, and a win/loss sparkline shows whether a single cell’s value is positive 

(win), negative (loss) or a zero (a tie).  Let’s add a line and column sparkline  

1. Select Cells B4 through F4.

2. On the Insert tab, Sparklines group, click on the Line icon.

3. In the Create Sparklines dialog box, the cursor should be blinking in

the Location Range box.
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4. Click on Cell G4 and click OK.

5. Use the same procedure to create a Column sparkline for Cells B5

through F5 in Cell G5.

Figure 13.15 

Now that I see the Column sparkline, I don’t like it, so let’s change it to a Line sparkline. 

6. With Cell G5 selected, click on the Line icon in the Type group of the

Sparkline Tools Design contextual tab.

Figure 13.16 

One note on sparklines – sparklines are a cool new tool, but if you find yourself using too 

many sparklines, consider using a regular chart.  Use sparklines sparingly. 

Add a Trendline 

While looking at our chart, enhanced by the sparklines, it looks like sales are going up 

each year.  What do you think sales will do in 2011 or 2012 if they stay at the same rate 

of growth?  We can use a trendline to show us.  A trendline is a graphical representation 

of trends in a data series, such as sales over a period of years. 

1. Select the chart.

2. On the Layout tab, click on the Trendline button in the Analysis group.

3. Click on Linear Trendline.

4. In the Add Trendline dialog box, choose North and click OK.
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Figure 13.17 

Figure 13.18 

When using a Trendline, most people use a Linear type.  That is because most people 

really don’t understand the other types (Exponential or Two Period Moving Average).  In 

this exercise, we want to forecast a linear trend over two periods, so we can use the 

Linear Forecast Trendline. 

5. Click on the Undo button (to remove the first Trendline we created).

6. Create a Trendline using the Linear Forecast Trendline option for the

North and South.

7. Select the chart area and reposition it to where the legend is completely to

the right of the chart area.

8. Deselect the chart.
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Figure 13.19 

The trendlines show that the North’s sales are increasing, but the rate of growth for the 

South is significantly faster.  It looks like they should intersect at about the Year 2013. 

Tip:  Check out the various icons in the Chart Tools Design tab, 

particularly those in the Type, Data, and Chart Layout groups.  These 

tools can greatly speed up chart development. 

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 13, Section 1 of 2 
option and complete the review questions.

Pie Charts 

Another chart type that is very useful is a pie chart.  Companies love to use pie charts to 

view the distribution of sales, assets, or a host of other business measures.   

1. Click on the Pie tab.
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Figure 13.20 

This is a simple table that represents 2010 sales in each state. 

2. With your cursor on any cell within the chart, click on the Insert tab, then

click on the Pie icon in the Charts group.

3. Choose the first option (Pie).

Figure 13.21 

Excel automatically inserts a Pie chart.  As with the Column chart (or any other chart), 

we need to do some formatting to the automatic chart Excel gave us.  We’ll rename the 

title of the chart to 2010 Sales by State and make the sections of the pie chart more 

readable. 

4. Click on the 10 Sales chart title and rename it 2010 Sales by State.

5. On the Layout tab, click on the Data Labels button and choose More

Data Label Options…
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Figure 13.22 

6. With Label Options selected on the left, in the Label Contains group,

click on the Category Name and Percentage boxes, and uncheck the

Value box.

7. In the Label Position group, click the Outside End radio button.

8. Click Close.

9. Click on the legend box to the right and delete it.
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Figure 13.23 

With the percentages under each state in the Pie chart, you really don’t need the Legend 

so you can get rid of it. 

10. Save and close the file.

PivotChart Reports 

Since you are now an expert with PivotTables, you can create a chart using a PivotTable 

as the data behind the chart and make it interactive.  This is called a PivotChart report.  

It’s easy to do, and you build the chart while you’re building the PivotTable.  Let’s try 

one. 

1. Open the file C:\ExcelCEO\Excel 2010\Chapter13\Sales_Summary.xlsx.

2. Save the file as C:\ExcelCEO\Excel 2010\Chapter13\

mySales_Summary.xlsx. 
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Figure 13.24 

This is basically the same table format that you used to create a PivotTable in Chapters 

11 and 12.  In creating a PivotChart, you will build the PivotTable and the chart will 

automatically be built as you build the PivotTable. 

3. On the Insert tab, click on the drop down arrow under PivotTable and

choose PivotChart.

4. Click OK to accept the default values when creating the PivotTable.

5. Format the PivotTable to show Years in columns, Regions in rows and

Sales as the data.

6. Format the data as Number, zero decimal places.

7. Rename each column 2008 Sales, 2009 Sales and 2010 Sales.

8. Reposition the chart to where you can see all of the PivotTable.

9. Take off the Grand Totals for Columns and Grand Totals for Rows.

10. Select the PivotChart.

Your screen should look similar to this: 
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Figure 13.25 

At this point, you can click on the chart and format it just like any other chart.  The main 

difference is that the data in the chart is tied to a PivotTable.  And in the PivotTable Field 

List, the Column Labels section is replaced with Legend Fields (Series), and the Row 

Labels section is replaced with Axis Fields (Categories).  But the chart doesn’t tell us too 

much, does it?  Let’s rearrange the PivotTable to have it show sales by state instead of by 

region. 

11. Take out Region in the Axis Fields (Category) section and replace it with

State.

12. Reposition the chart to where it is under the PivotTable.
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Figure 13.26 

Clearly, PA has the largest amount of annual sales, with DC and MD running neck and 

neck for second and third places. 

13. Save and close the file.

PivotCharts are a very convenient way to create and manipulate charts in a fast and 

effective manner.  Just remember that you can double-click and right-click just about 

anything you want to change.  Use the Design and Layout tabs that come with chart 

development.  And always remember that you can click the Undo to correct your 

mistakes. 

SmartArt Graphics 

Do you remember how we created a flowchart by using objects in the Insert tab?  Excel 

has similar, preformatted charts that are accessible by using the SmartArt functionality.  

In SmartArt, there are many types of diagrams that can be useful to an organization.  You 

can access these objects from the Insert tab. 

1. Open a blank spreadsheet and save it as mySmartArt.xlsx in the

C:\ClineSys\Excel 2010\Chapter13 folder.

2. On Sheet1, click on the Insert tab, and click on the SmartArt icon.
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Figure 13.27 

The Choose a SmartArt Graphic dialog box appears.  As you can see, there are many 

types of SmartArt objects from which to choose.  Feel free to click on each one to see 

what it does, and play around with each if you think it would be useful to your 

organization.  For the next exercise, we’ll use the Organization Chart object in the 

Hierarchy section. 

3. Click on Hierarchy in the left section of the dialog box, then click on

Organization Chart (the first object) in the middle section, and click OK.

Figure 13.28 
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You use the SmartArt objects just like charts or other objects.  The sizing handles on the 

corners and middle of the outside edges of the chart make it easy to resize and position 

the chart exactly how you want it.  We will now create an organization chart. 

4. With the first box (on top) selected, type President in the Type your text here

box on the left.

Figure 13.29 

Notice that as you type, the sizes of all the boxes changes to accommodate the text. 

5. Click on the box under President and type President Assistant.

6. In the lower three boxes, type Vice President of Sales; Vice President of

Purchasing; Vice President of Operations.

7. Click outside the Organization Chart to deselect it.

8. Take off the gridlines on the spreadsheet by clicking on the File tab, click on

Options, click on the Advanced section, and uncheck the Show Gridlines box in

the Display options for this worksheet: section.

9. Click OK.
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Figure 13.30 

Now let’s add some more levels. 

10. Right-click on the Vice President of Operations box, point to Add

Shape, and choose Add Shape Below.

Notice that all the objects in the entire box become smaller.  That is because Excel had to 

add the new box into the area defined by the organization chart.  To make the boxes 

larger or smaller, simply adjust the outside edges of the chart itself. 

11. In the new box, type Director, Accounting.

12. Below Director, Accounting, add an assistant box called Director,

Accounting Assistant.

You should get the picture now.  You should be able to complete the rest of the chart on 

your own. 

13. Under Director, Accounting, create a box for Manager, General

Ledger.

14. Create another box under Director, Accounting called Manager,

Accounting Systems.

15. Drag the Manager, Accounting Systems box over to the left to be on the

same level as Manager, General Ledger.

16. Resize the President box to be larger than the others (our president has a

real big ego).

17. Resize the organization chart as you work on it to fit all of the text boxes,

then click outside the diagram to deselect it.

Your diagram should now look something like this: 
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Figure 13.31 

18. Save the file

Many people use costly programs to create these types of charts, but I really like Excel’s 

built-in tools. 

Importing Objects 

To finish up the chapter, let’s talk a little about importing objects to and exporting 

objects from an Excel file.  In this first example, we’ll import a slide from a PowerPoint 

presentation into a blank Excel spreadsheet. 

1. Click on Sheet2 of the mySmartArt.xlsx file.

2. On the Insert tab, click on the Object button in the Text group.
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Figure 13.32 

The Object dialog box appears.  

3. Click on the Create from File tab, and click the Browse button.

4. Navigate to the C:\ExcelCEO\Excel 2010\Chapter13 folder, click on 
AnnualReportCover.pptx and click Insert.

5. In the Object dialog box, click on the Link to file check box and click 
OK. 
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Figure 13.33 

Figure 13.34 

The object appears on the spreadsheet.  Notice that the function box reads: 
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=PowerPoint.Show.12|'C:\ExcelCEO\Excel 2010\Chapter13\ 

AnnualReportCover.pptx'!''''.   

This means that the object is linked to the Excel file.  To edit the object in PowerPoint, 

just use your right-click friend. 

6. With the linked object selected, right-click on the object, point to

Presentation Object and click Edit.

PowerPoint opens up to the file you linked to.  To edit the object in Excel, you must open 

the PowerPoint file first, save it, then it will be updated in the spreadsheet. 

7. When PowerPoint opens up, change the Years from 2010 to 2009, save

and close the PowerPoint file (Make sure to save the PowerPoint file as

its original name, AnnualReportCover).

Figure 13.35 

The object in the spreadsheet is now updated for 2009. 

8. Save and close the file.

Embedding Objects 

In the last exercise, you linked a PowerPoint slide (or object) to an Excel file.  One 

advantage on linking a file is that when the source file changes, the linked object changes 

as well.  A disadvantage is that the location of the source file may change, or the linked 

file may be sent to another person who doesn’t have the same source file in their system 

or they don’t have access to it.  When this happens, the link will not work.  To overcome 
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this issue, you can embed an object.  An embedded object stays with the file it was 

embedded to.  You can embed objects to another Microsoft Office program just as easily 

as you can import them to Excel.  The only difference in the procedure to link an object 

and to embed an object is when you embed an object, don’t check the “Link to file” 

checkbox in the Object dialog box, as illustrated in Figure 13.30.  As long as you don’t 

have space or size considerations, embedding an object can many times be a better 

alternative to linking an object. 

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 13, Section 2 of 2 
option and complete the review questions. 

Conclusion 

In this chapter, you learned how to work with charts.  You created and edited a basic 

chart.  You learned how to reposition or move a chart to another part of the spreadsheet.  

You learned how to create a Sparkline.  You added a trendline to show the direction the 

data is moving on a chart.  You created a pie chart and explored PivotCharts.  You 

learned how to use Excel’s SmartArt functionality by creating and modifying an 

organizational chart diagram.  Finally, you learned how to import objects to and export 

objects from Excel. 

Chapter Exam 

To take the examination for this chapter, you must have successfully completed the 

examination for the previous chapter.  You can now go to www.ExcelCEO.com, click 

on Sign In, log in and take the exam.  Make sure that you take the exam on the 

same computer that you completed the sample files on, as some of the questions on the 

exam may refer to some of the completed examples. 

http://www.ExcelCEO.com/
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CHAPTER FOURTEEN –ANALYSIS TOOLS 

In this chapter, you will: 

 Use Goal Seek and Solver.

 Calculate Descriptive Statistics using Data Analysis.

 Perform Conditional Formatting.

 Use Data Bars.

 Turn the Full Screen functionality off and on.

 Create a Hyperlink.
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When I was learning to program web pages, I decided to create a project of my own.  

Since I am a family history novice, I set out to write a genealogy program on the Internet.  

After about a year of part-time programming, I showed it to my sister-in-law, an avid 

genealogist.  All I had programmed was the functionality – I hadn’t made it look good 

yet.  Her response was kind of “ho-hum” and she was obviously not thrilled with it.  I 

took a couple of weeks to put in some graphics, some colors and images and showed it to 

her again.  When she saw it, her eyes lit up and said, “This is GREAT!”  I hadn’t touched

the functionality, but colors and a little cleanup work, with solid functionality basics, sold 

the project much better.  I enjoy creating tools that are easy for inexperienced end-users 

to navigate through and manipulate.  Typically, the easier a spreadsheet is to use, the 

harder it is to develop.  One tool that is easy to use and allows you to arrive at an answer 

very quickly is called Goal Seek.  We’ll begin this chapter by discussing Goal Seek. 

Goal Seek 

Goal Seek is a tool sometimes called a “what-if analysis.”  When you know the desired 

result of a single formula but not the input value, and the formula needs to determine the 

result, you can use Goal Seek. When using Goal Seek, Excel changes the value in one 

cell potentially hundreds of times until the formula returns the result you want. 

Let’s try an example.  

1. Open the file C:\ExcelCEO\Excel 2010\Chapter14\2010_Forecast.xlsx.

2. Save as C:\ExcelCEO\Excel 2010\Chapter14\my2010_Forecast.xlsx. 
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Figure 14.1 

This is a simple file that calculates the Net Income for one store.  In this file, the Mattress 

Sales are hard-coded, as are the Fixed Expenses.  Pillow sales are estimated at 10% of 

Mattress Sales, and the formula in Cell B4 reflects that assumption.  The Variable 

Expenses are estimated as a percentage of Total Revenue.  Your manager has asked you 

to find out what level of sales we should have in order to have Net Income of $125,000.  

Right now, Net Income is at $104,000, $21,000 off from where it needs to be.  Let’s 

increase Mattress Sales by $50,000 and see what the Net Income figure changes to. 

3. Change Cell B3 (Mattress Sales) to $300,000.

Net Income changes to $138,100.  We would probably spend quite a bit of time playing 

around with the Mattress Sales number to reach an exact $125,000, but Goal Seek will 

help us in one step. 

4. On the Data tab, click on What-If Analysis in the Data Tools group and

choose Goal Seek…
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Figure 14.2 

5. Change the Set cell: box to B20 (which is Net Income).

6. Type 125000 in the To value: box

7. Type B3 (or choose Cell B3 with your mouse) in the By changing cell:

box.

8. Click OK.

Here we are telling Excel to make Net Income $125,000 by changing the Mattress Sales 

cell. 

Figure 14.3 

Excel runs through a few iterations, as we would do by manually changing the Mattress 

Sales cell, but Excel does it a lot faster than we can. 

9. Click OK in the Goal Seek Status dialog box.
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Figure 14.4 

The result is that Mattress Sales need to be $280,792 in order to have Net Income of 

exactly $125,000. Notice that the exact amount changed in Cell B3 is 

$280,791.788856305, so Excel had to go through a bunch of iterations to arrive at that 

exact figure. 

10. Save and close C:\ExcelCEO\Excel 2010\Chapter14\my2010_Forecast.xlsx.

Solver 

Goal Seek is a great tool if you want to find a solution based on changing one variable, 

but what it there are multiple inputs in your analysis that could change?  For that, Excel 

provides a nifty tool called Solver.  Solver does not come with the standard installation of 

Excel, so when you launch Solver, you may be prompted to install it.  You must go 

through the installation of Solver to continue with the exercise. 

In this next example, you have a charitable opportunity.  Area management has been 

asked to donate mattresses that are slated to be discontinued to a local homeless shelter.  

Nitey-Nite should give away as many mattresses to the shelter as possible without going 

over a retail price of $10,000 in total.  The schedule in the next file we will work with 
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shows the item number, manufacturer, description and retail price of each item that could 

be donated.  Your job is to find out the maximum number of each item that could be 

donated without going over the $10,000 budget. 

One advantage to using Solver is that it allows you to use constraints.  A constraint is 

simply a limitation placed on Solver.  For example, one constraint in our analysis is that 

the budget, or total retail price of the mattresses donated, cannot exceed $10,000.  

Another constraint placed on us by management is that we must give away at least two of 

each mattress type.  You can have more than two constraints when using Solver, as you 

will see in this next exercise.  In fact, to get the best analysis, you should input as many 

constraints as necessary to make the analysis as reliable as possible.  Let’s first make sure 

that Solver is installed and then set up the analysis. 

1. Open the file at C:\ExcelCEO\Excel 2010\Chapter14\Solver.xlsx.

2. Save as C:\ExcelCEO\Excel 2010\Chapter14\mySolver.xlsx 

If the Solver button does not appear in the Analysis group of the Data tab, you need to 

install it.  To do so, follow Steps 3 – 7 below.  If you already have it, skip to Step 8. 

3. Click on the File tab and click on the Options button at the bottom of the

screen (the Excel Options dialog box appears)

4. Click on the Add-Ins option on the left side of the screen.
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Figure 14.5 

You should see Solver Add-in listed in the list of add-ins.  If you don’t see it, Solver was 

not installed with your version of Excel, and you will have to obtain a version of Excel 

that has this add-in. 

5. Click on Solver Add-in.

6. Make sure Excel Add-ins is chosen in the Manage: box at the bottom of

the Excel Options dialog box and click Go.
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Figure 14.6 

7. In the Add-Ins dialog box, check the Solver Add-in box and click OK.

After you load Solver, it will be available on the Analysis group of the Data tab. 

Figure 14.7 

Let’s talk a little more about constraints.  We’ve already mentioned two constraints, but 

there are more.  The goal here is to give away as many mattresses as possible while 

working within the budget we have.  Let’s list all of the constraints for this analysis. 
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 The budget for this opportunity is $10,000.

 We must give away all of the Daisey mattresses (we have a total of four in

stock).

 The only cells we can change are the number of items to donate (Cells G2

through G6).

 The minimum number of mattresses to donate per item is two, except for

the Daisey series, which we will give away all four.

 The maximum number of each mattress item to donate is five.

 The number of mattresses (Cells G2 through G6) should be integers (no

fractions, like 2.6 mattresses).

With these constraints in mind, let’s set up Solver to do the analysis. 

8. Click on the Solver… button on the Analysis group on the Data tab.



Section III:  Advanced Excel 2010 Analysis Tools  14

  396 

Figure 14.8 

9. In the Solver Parameters dialog box, set the Set Objective to $G$7.

10. Make sure the Max radio button on the Equal To: line is chosen, as we

want to donate as many mattresses as possible.

11. Click in the By Changing Variable Cells box and choose Cells G2

through G6.

12. Click the Add button to add a constraint.
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Figure 14.9 

This is the box where you will add all the constraints. 

13. In the Cell Reference box, choose Cell H7.

14. Make the Operator box display “<=”.

15. In the Constraint box, choose Cell B10.

This constraint sets a maximum dollar amount of mattresses to give away, or $10,000. 

Figure 14.10 

16. Click the Add button to add another constraint.

You should be able to input the remaining constraints yourself. 

17. Using the Add Constraint box, add all of the constraints previously

discussed.

18. Once you have added all constraints, click the OK button.

19. Check your parameters with Figure 14.11.
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Figure 14.11 

20. Click the Solve button in the Solver Parameters box.
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Figure 14.12 

And after a few seconds, Solver goes through a whole bunch of iterations, trying different 

values in Cells G2 through G6 and comes up with the highest solution for the number of 

mattresses to be donated.  Now, as of the writing of this chapter, there was still a problem 

with Solver’s integer constraints in Excel 2010.  As you can see in the example, Cell G3 

returned a value of 3.621870883, which should not happen.  When I asked Microsoft 

about it, they said that it was a problem which they will attempt to fix in future versions 

of Excel 2010.  Realistically, you should change the number in Cell G3 to 3 which will 

return 22 mattresses to donate at a total retail price of $9,528.00.  At this point you can 

save this analysis as a scenario, cancel out of it, keep the solution or restore the original 

values. 

21. Make sure the Keep Solver Solution radio button is selected and click 
OK.

22. Save and close the file.

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 14, Section 1 of 2 
option and complete the review questions. 



Section III:  Advanced Excel 2010 Analysis Tools  14

  400 

Descriptive Statistics 

Another handy tool that Excel has is Descriptive Statistics.  Descriptive statistics allows 

you to run a series of statistical analyses on a set of numbers without having to write each 

formula.  This is not a feature I use often; however, real geeky people like to use it to 

display a set of statistical numbers that analyzes the entire dataset.  This is not a tool that 

comes with the standard installation of Excel, so you may have to install it to do this next 

exercise. 

1. Open the May_Sales.xlsx file at C:\ExcelCEO\Excel 2010\Chapter14\.

2. Save the file in the same folder as myMay_Sales.xlsx. 

If the Data Analysis button does not appear in the Analysis group of the Data tab, you 

need to install it.  To do so, follow Steps 3 – 7 below.  If you already have it, skip to Step 

8. 

3. Click on the File tab and click on the Options button at the bottom of the

Excel Options dialog box.

4. Click on the Add-Ins option on the left side of the screen.

5. Make sure Excel Add-ins is chosen in the Manage: box at the bottom of

the Excel Options dialog box and click Go.

6. Check the Analysis Toolpak check box and click OK.

7. Follow the directions to install Data Analysis.

After you load Data Analysis, it will be available on the Analysis group of the Data tab. 

Figure 14.13 

This file is a simple file with daily sales for one month.  We want to perform a 

comprehensive statistical analysis on the data in the file, and we’ll do it using Descriptive 

Analysis. 
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8. Click on the Data Analysis button in the Analysis group of the Data tab.

Figure 14.14 

9. In the Data Analysis dialog box, select Descriptive Statistics and click

OK.

10. In the Descriptive Statistics dialog box, select the Input range B2 to

B32.

11. Make sure the Columns radio button in the Grouped By option is

checked and that the New Worksheet Ply radio button in the Output

options is selected.

12. Check the Summary statistics check box.

Figure 14.15 
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13. Click OK.

You should get a new worksheet in the May_Sales file that looks like Figure 14.16. 

Figure 14.16 

Again, I don’t use this feature much because I don’t typically do some of these in-depth 

types of statistics, but it may come in handy when you have a manager who thrives on 

statistical analysis, like actuaries and statisticians.  By the way, do you know the 

difference between an actuary and an accountant?  An actuary doesn’t have the 

personality to be an accountant!  (with apologies to actuaries, but it is funny!) 

14. Save and close the file.

Conditional Formatting 

The next topic is Conditional Formatting.  I have seen conditional formatting used 

extensively on spreadsheets where the user wanted to make numbers that meet certain 

criteria stand out. 

1. Open the file C:\ExcelCEO\Excel 2010\Chapter14\Sales_2010.xlsx.

2. Save the file as C:\ExcelCEO\Excel 2010\Chapter14\mySales_2010.xlsx. 
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Figure 14.17 

This file is similar to a file we did in Chapter 10.  The Sales tab contains a database for 

sales for each location by month in 2010.  It also contains the Budget, Budget_%, 

Store_Type and Bonus fields.  The Budget_%, Store_Type and Bonus fields contain 

calculations.  You learned how to do all of these calculations in previous chapters, so I’m 

not going to review them here.  The Assumptions tab contains the assumptions (Budget 

% for all types, and the type values based on Budget).  Your assignment in this chapter is 

to make this spreadsheet easier to read and use. 

Conditional Formatting is creating a format in a cell (like font style or background color) 

whose value meets a certain criteria.  Let’s suppose that you want to identify all of the 

stores that did not earn a sales bonus.  You also want to highlight all of the stores whose 

manager made over $2,000 in bonus for any given month.  With a report like that, it 

would be very easy for management to scan down the list of stores in the Sales tab and 

quickly see who is performing and who is not.  For those who did not earn a bonus, let’s 

format all cells that are equal to zero with a bright yellow background with bold red font. 



Section III:  Advanced Excel 2010 Analysis Tools  14

  404 

3. On the Sales tab, click on Cell K2.

4. On the Home tab in the Styles group, click on the Conditional

Formatting button.

When you click on the Conditional Formatting button, a number of different options 

appear.  In Excel 2003, Microsoft allowed you to set the formatting of the font and cell 

background color in Conditional Formatting.  In Excel 2007 and 2010, there are 

numerous additional options available, far too many for me to review in this exercise.  As 

you go through this exercise, explore other options you see that may more suitably fit 

your needs or style.  For this exercise, we will identify all of the cells in the Bonus 

column that have a 0 with a yellow background with bold red font.  Bonuses of $2,000 or 

more will be displayed with a green bold text. 

5. On the Conditional Formatting menu, place your cursor over Highlight

Cells Rules and choose Equal To.

Figure 14.18 

The Equal To dialog box pops up.  If you click on the drop down menu on the right side 

of the dialog box, you will see that a yellow background with bold red text is not an 

available option, so you’ll have to create that custom option. 

6. Click on the drop down menu on the right side of the text box, choose

Custom Format… and click OK.
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Figure 14.19 

7. With the Font tab selected, click on the drop down menu under Color and

choose Red.

8. Under Font style, click on Bold.

9. Click on the Fill tab, choose Yellow and click OK.

10. Click OK in the Equal To dialog box.

11. Use the Format Painter icon to copy the format in Cell K2 to all of the

cells beneath it (or copy the formula to all cells below)
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Figure 14.20 

Now you see that all of the cells that contain a zero (i.e., no bonus is paid) are formatted 

as bold red text with a yellow.  We also want to format all cells with a value of $2,000 or 

more with a bold, green, italicized font.  However, there is no standard option in the 

Highlight Cells Rules for Greater Than or Equal To, so we’ll have to create a custom 

format.  Let’s do that now. 

1. Select the range K2:K349.

2. Click on the Conditional Formatting button, point to Highlight Cells

Rules, and click on More Rules…
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Figure 14.21 

The New Formatting Rule dialog box opens.  This is the dialog box in which you will 

create the new rule. 

3. Make sure the Format only cells that contain option is selected.

4. In the Edit the Rule Description section, make sure Cell Value appears in the

first box, change the second box to greater than or equal to and type 2000 in the

third box.

5. Click the Format… button.

6. In the Format Cells dialog box, click on the Font tab, and choose Green color,

and Bold Italic font style.

7. Click OK in both dialog boxes.
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Figure 14.22 

All of the formatting you applied now appears.  Note that we applied two styles of 

conditional formatting to these cells.  You can see all of the formatting you applied by 

looking at the Conditional Formatting Rules Manager dialog box. 

8. Click on Conditional Formatting, and then on Manage Rules…

9. If necessary, click on the Show formatting rules for: drop down menu and

choose This Worksheet.

Figure 14.23 
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In the Conditional Formatting Rules Manager, you can see all of the formats that are 

applied in the current selection, on this worksheet, or on other worksheets in the 

workbook.  In this example, we have three conditional formatting rules, when we really 

only have two.  The second rule should be applied to the range $K$2:$K$349, so let’s fix 

that and delete the third rule. 

10. Change the second rule‟s range to be $K$2:$K$349.

11. Click on the third rule, click the Delete Rule button and click OK.

Let’s explore one more type of Conditional Formatting: Data Bars.  Data Bars were 

introduced in Excel 2007, and Microsoft made some minor but necessary changes to Data 

Bars in Excel 2010.  A Data Bar is simply solid or gradient shading behind a number.  In 

Excel 2007, the length of the shading represented each number’s position relative to other 

numbers in the data set.  In Excel 2010, Data Bars compare values between the numbers 

based on their distance from zero.   

First, we’ll sort the table. 

1. Click on Cell B4 and click the Sort Smallest to Largest icon on the Data

tab.

2. Right-click on Cell C4, point to Sort, and click on Sort Smallest to

Largest.

You did this to sort the table in preparation for this next exercise. 

3. Select Cells G2:G349.

4. On the Home tab, Styles group, click on Conditional Formatting, point

to Data Bars, and choose the Green Data Bar under Solid Fill.

5. Click anywhere outside the selection.
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Figure 14.24 

Take some time to explore the other options available in Conditional Formatting.  

Management really likes to see a report in color with the different colors that make values 

stand out. 

Full Screen 

I sometimes don’t know who of my users has Excel knowledge and who doesn’t.  

Therefore, I try to make the applications as easy and dummy-proof as I can.  One way of 

doing this is to hide the tabs and menus so the user is forced to use the commands on the 

spreadsheet.  This can be accomplished in one easy step – by changing the view of the 

spreadsheet to a full screen. 

1. Click on the Assumptions tab.

2. Click on the View tab and click the Full Screen button in the Workbook

Views group.
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Figure 14.25 

The Office Ribbon, Name Box and Formula Bar are now hidden, and the only thing that 

appears is the title bar.  To bring back the normal view, right-click anywhere in the 

spreadsheet and choose Close Full Screen. 

3. Right-click anywhere in the spreadsheet and choose Close Full Screen.

Trick:  There are two other ways you can hide sheets.  You can go into

Excel Options, click on Advanced and uncheck the Show Sheet Tabs
option which will hide all sheet tabs in the workbook.  You can also right-

click on any sheet tab and choose Hide.

Hyperlinks 

Believe it or not, there are some users that don’t know you can click on the tabs at the 

bottom of the sheet to access other sheets.  Sometimes, I don’t want them to have that 

capability, so I have the option of hiding the sheet(s).  With the tabs hidden, the user still 

needs a way to navigate from one sheet to another.  In this case, I like to use Hyperlinks 

or a macro contained in a Command button.  In this chapter, we’ll look at Hyperlinks.  

We’ll review Macros and Command Buttons in Chapter 16. 

In the next exercise, we will insert a Hyperlink that takes the user from the Assumptions 

tab to the Sales tab. 

1. On the Assumptions tab, insert two rows above Row 1.

2. In Cell A1, type:  Sales

3. Right-click on Cell A1 and choose Hyperlink.
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Figure 14.26 

The Insert Hyperlink dialog box appears. 

4. Click on the ScreenTip… button.

5. In the Set Hyperlink ScreenTip dialog box, type:  Go to the Sales tab.

6. Click OK.

Figure 14.27 

7. Under the Link to: heading, choose the Place in this Document option.
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Figure 14.28 

8. Under Type the cell reference, type:  K1

9. Under Cell Reference, choose Sales.

10. Click OK.

When you hold your mouse over the hyperlink, the screentip “Go to the Sales tab” 

appears.  When you click on the hyperlink, it will automatically go to Cell K1 of the 

Sales tab.  

Figure 14.29 

11. In the Sales tab, insert two rows above Row 1 and insert a Hyperlink that

sends the user to the Assumptions tab, Cell A3.

To edit a hyperlink, simply place your cursor of the linked text, right-click and choose 

Edit Hyperlink.  The Edit hyperlink dialog box will pop up which is identical to the Insert 

Hyperlink dialog box.  All you have to do is make the modifications and click OK. 
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12. Save and close the file.

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 14, Section 2 of 2 
option and complete the review questions.

Conclusion 

In this chapter, you learned how to change parameters to get a desired result by using 

Goal Seek and Solver.  You used Data Analysis to calculate Descriptive Statistics.  You 

learned how to work with Conditional Formatting, how to turn the Full Screen off and on, 

and you created Data Bars.  Finally, you created a hyperlink that helped to move users 

from one place on the spreadsheet to another. 

Chapter Exam 

To take the examination for this chapter, you must have successfully completed the 

examination for the previous chapter.  You can now go to www.ExcelCEO.com, click 

on Sign In, log in and take the exam.  Make sure that you take the exam on the 

same computer that you completed the sample files on, as some of the questions on the 

exam may refer to some of the completed examples. 

http://www.ExcelCEO.com/
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CHAPTER FIFTEEN – GRAPHICS, PROTECTION, AND SHARING 

In this chapter, you will: 

 Create graphics using Paint.

 Work with Protection.

 Share a workbook and track changes.

 Merge and compare workbooks.

 Consolidate data from multiple files.
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Graphics Using Paint 

To begin this chapter, let’s talk a little bit about graphics.  A graphic is simply an image 

that you can use in your documents to give it a little variety and pizzazz, and they can be 

easy to create.  I like using a program called Paint to create graphics.  Paint is a simple 

program that comes standard in all Windows packages.  I like it because it’s very easy to 

use and most of the graphic type work I do is very simple.  My artistic ability is limited to 

drawing a straight line with a ruler, and I usually mess that up.  You can use the graphic, 

usually saved as a .jpg file, in Excel, Access, Word, HTML and in a host of other tools.  

Let’s create a graphic using Excel’s WordArt and Paint. 

1. Open a new workbook in Excel.

2. Click on the Insert tab, click on WordArt in the Text group, and choose

the first “A” in the second row (Fill – Blue, Transparent Accent 1,

Outline – Accent 1).

3. Replace Your Text Here with Nitey-Nite Mattresses

4. Make the font size 20.

5. Leave the default style Calibri (Body).

6. On the Format tab of the Drawing Tools contextual tab, click on the Text

Effects button of the WordArt Styles group.

7. Place your cursor over Transform, scroll down and hover your cursor

over the Double Wave 1 icon, and click.

8. Click anywhere outside the graphic.

You should get a graphic that looks like Figure 15.1. 

Figure 15.1 

9. Open Paint (click on Start, All Programs, Accessories, Paint).
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Figure 15.2 

10. Go back to Excel, make sure the graphic is selected (handle bars will

appear around the graphic) and copy the graphic ([Ctrl]+c).

11. Toggle over to Paint and paste it ([Ctrl]+v).

12. Resize the graphic in Paint (using the blue handle at the bottom right) to

look like Figure 15.3.

Figure 15.3 

13. Save the Paint file as C:\ExcelCEO\Excel 2010\Chapter15\logo.jpg.

14. Close Paint.

15. Close the blank Excel file without saving it. 

Now you have a logo that you can use in your reports.  Let’s place the graphic in a file. 
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16. Open the mySales_2010.xlsx file in the C:\ExcelCEO\Excel

2010\Chapter14 folder.

17. Save the file with the same name in the C:\ExcelCEO\Excel

2010\Chapter15 folder.

18. Click on Cell G1 on the Assumptions tab.

19. Click on the Insert tab, choose Picture, navigate to C:\ExcelCEO\Excel 2010

\Chapter15\logo.jpg, click on the logo file and click Insert.

20. Click anywhere outside the logo to deselect it. 

Figure 15.4 
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Figure 15.5 

With the image on the spreadsheet, you can now drag it to any place in the document you 

wish.  Pretty easy, huh? 

Protection 

Once you have a spreadsheet designed just the way you want it, you need to protect it.  

In the Sarbanes-Oxley awareness world in which we live, it is vitally important to protect 

the formulas and analyses in your spreadsheets.  One great way of protecting your 

spreadsheet is by using the Protection tools available under the Tools option. 

1. While on the Assumptions tab of the file, click on the Review tab, then

click on the Protect Sheet button in the Changes group.
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Figure 15.6 

The Protect Sheet dialog box appears.  There are multiple items you can protect or leave 

unprotected.  For this exercise, we want to protect the entire spreadsheet.  Note that this 

action protects only the spreadsheet you are currently on.  To protect the entire 

workbook, use the Protect Workbook from the Review tab. 

2. In the Password to unprotect sheet box, type:  abc  and click OK.

3. Retype the abc password in the Confirm Password dialog box and click

OK.

Now if you try to change anything on the spreadsheet, you will get a message telling you 

it is protected.  This works great if you want to protect the entire spreadsheet, but what if 

you want to allow the user the ability to change selected cells in the spreadsheet?  In the 

next example, we want users to be able to change the values in certain cells in Columns 

B, C and E, but nothing else.  To do this, we first have to unprotect the sheet. 

4. Click on the Unprotect Sheet button in the Changes group of the Review tab.

Figure 15.7 

5. Type abc in the Unprotect Sheet dialog box and click OK.

6. On the Assumptions tab, select the cell ranges B4-C9, B13-C18, B22-

C27 and E4-E6 (i.e., all of the cells that you could possibly change).
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Figure 15.8 

7. Click on the Allow Users to Edit Ranges button.

Figure 15.9 

8. In the Allow Users to Edit Ranges dialog box, click New…
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Figure 15.10 

9. Leave Range1 as the title of the named range, do not enter a password in

the range password box, and click OK.

Figure 15.11 

10. Click Protect Sheet… in the Allow Users to Edit ranges dialog box.

11. Use the abc password in each of the next two dialog boxes.

12. Now Password Protect the entire Sales tab with the same password.

Now you have a file that your users can manipulate without the worry of anyone 

changing the formulas. 

You can also lock and hide cells in the Format Cells dialog box.  A locked cell cannot be 

changed when protection is turn on, and a hidden cell hides the formulas in a spreadsheet. 
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Figure 15.12 

The exercises we just completed were designed to teach you how to protect data within 

an Excel file.  You can also protect the entire file. 

13. On the File tab, click on Save As.

14. Click on the Tools option inside the Save As dialog box and click on the

General Options option.

Figure 15.13 
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15. In the Password to open box, type 123 and click OK.

Figure 15.14 

16. Type 123 in the Confirm Password dialog box.

17. Click Save to save the mySales_2010.xlsx file and click Yes in the confirmation

dialog box.

Passwords 

A few words of caution about passwords:  DO NOT FORGET THE PASSWORD.  In the 

past, if you forgot the password, you could not get it open again.  However, in today’s 

tech-savvy world, there are a number of applications you can buy off the Internet to 

recover a lost password.  But it would be a lot easier on yourself to just not forget the 

password, or at least write it down somewhere.  Remember that Excel passwords are case 

sensitive, so typing ABC will not work to open our file.  If you use password protection 

in an Excel 2010 or 2007 file and allow users to edit a range, it will not work in some 

earlier versions of Excel.   

The best passwords consist of a lot of characters and will contain upper and lower case 

characters, as well as numbers and special characters.  Typically, the longer the 

password, the harder it is to hack into it.  I like to create a file, paper or electronic, with 

all of my user IDs and passwords in it.  There are so many applications out there where 

you have to use a user ID and password to sign on, and many of them require the user IDs 

and passwords be set up in a certain way.  There is no guarantee that your standard user 

ID or password you use for everything will work in all applications – in fact, it most 

likely won’t.  Therefore, it’s a good idea to keep those user IDs and passwords 

documented and in a safe place. 

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 15, Section 1 of 2 
option and complete the review questions. 
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Sharing a Workbook 

When a user opens a standard Excel file, they typically open it with exclusive rights, 

meaning that no one else can make changes to it while they have it open.  However, 

sometimes it is necessary for more than one person to work with the same spreadsheet at 

the same time.  This presents a problem, as most workbooks are set up where only one 

person at a time can work on it.  To solve this issue, you can turn on Excel’s sharing 

capability.  When a workbook is shared, multiple users can use it at the same time.  The 

owner of the workbook can then review and track the changes made and accept or reject 

the changes he/she wants. 

1. Click on the Share Workbook button in the Changes group of the

Review tab.

Figure 15.15 

2. Check the Allow changes by more than one user at the same time check

box, and click the Advanced tab.
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Figure 15.16 

There are many settings on the Advanced tab, but the two that are most used concern 

keeping history and conflicting changes.  I typically keep these default settings. 

3. Leave the default settings and click OK.

4. Save the file.

Figure 15.17 

5. Click OK in the Caution dialog box and close the file.
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Tracking Changes to a Shared Workbook 

Excel allows you to track and review changes that you made and changes that others have 

made to a shared file.  In this next exercise, you will open the Sales_2010_Changes.xlsx 

file and work with it to see how changes are captured in a shared file. 

1. Open the Sales_2010_Changes.xlsx file at C:\ExcelCEO\Excel 2010

\Chapter15.

2. Save the file as C:\ExcelCEO\Excel

2010\Chapter15\mySales_2010_Changes.xlsx. 

Figure 15.18 

In this exercise, you will pretend your name is Joe Smith.  Whenever Joe logs on to his 

computer, his computer name is Joe Smith. 

3. Click on the File tab and choose Options.

4. In the General section of the Excel Options dialog box, change the

computer name to Joe Smith and click OK.

You are now operating your computer as if you were Joe Smith.  Now you will turn on 

the tracking changes functionality. 
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5. In the Changes group of the Review tab, click on the Track Changes

button and choose Highlight Changes…

Figure 15.19 

6. Click the Track changes while editing... checkbox and click OK.

7. Click OK in the warning dialog box that appears.

Notice that the name of the file at the top of the title bar appears as 

mySales_2010_Changes  [Shared].  The [Shared] indicates that the sharing 

functionality is turned on. 

8. In the spreadsheet, change Cell B8 to 130%, Cell B9 to 150%, Cell E5 to

80,000 and Cell E6 to 120,000.

When you make a change to a cell, a thin blue line surrounds the cell and Excel creates a 

flag in the upper left corner of the cell.  This is type of comment.  When you hold your 

cursor over the cell, the comment box appears telling you who made the last change and 

what that changes were. 

9. Save the file, but don‟t close it yet.

10. Change the computer name (Steps 3 and 4) back to your computer name.

11. In the spreadsheet, change Cell E5 to 75,000 and Cell E6 to 115,000.

12. Save the file.

13. In the Changes group of the Review tab, click on Track Changes, then choose

Highlight Changes…
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Figure 15.19 

The Highlight Changes dialog box appears.  It is in this box where you will define what 

changes are tracked by whom and where.  You can also choose where to review the 

changes -- either on the screen or on a new sheet. 

14. In addition to the default settings as shown in Figure 15.19, check the List

changes on a new sheet box and click OK.

The Highlight Changes dialog box disappears.  Additionally, a new tab called History 

was created in the file.  This new tab records the changes that were made by others since 

you last saved it.  If you click on the History tab, you will see that four changes were 

made by Joe Smith and two changes were made by you.  You will have the chance in this 

exercise to accept or reject those changes.   

15. Click on the Track Changes button from the Changes group, then click on the

Accept/Reject Changes button.

Figure 15.20 

16. Click OK in the next dialog box.
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Figure 15.21 

These next few dialog boxes walk you through all of the changes that have been made to 

the workbook.  In these dialog boxes, you can accept or reject changes made to the file.  

In this first dialog box, you see that there were 6 changes made to the file.  For the first 

change, Joe Smith changed Cell B8 from 150% to 130%.  Joe Smith is the User Name of 

the computer that made the change.  Typically, people use their own name as their 

computer’s User Name.  That value is OK with us, so let’s keep Joe’s 130% number. 

17. Click Accept.

Figure 15.22 

Once you click Accept, it changes the worksheet to accept the new figure and then goes 

to the next change.  Let’s accept the second change that Joe Smith did as well. 

18. On the change for Cell B9, click Accept.
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Figure 15.23 

The next dialog box is a little different.  This cell has been changed more than once, and 

all of the changes are listed in the dialog box.  We see that Cell E5’s original value was 

70,000, then Joe Smith changed it to 80,000, then ClineSys (or your computer name) 

changed it to 75,000.  Since we control the file, we also control which changes to accept 

or reject.  In this case, we’ll accept the 75,000 number. 

19. Click on the 75,000 line and click Accept.

Figure 15.24 

20. In the last dialog box for the changes to Cell E6, click on the 110,000

original value line and click Accept.
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Figure 15.25 

All of the changed figures are now incorporated into the new file. 

21. Save and close the file.

Consolidating Data 

Many times, you will get data from different people, and you need to put all of the data in 

one place.  In our next example, you will open three files that contain data for three 

months and consolidate the data in another file for the quarter.  This process is called 

data consolidation.  I personally don’t use data consolidation much.  I prefer to load all 

of the data into one table and create a PivotTable to do my analysis.  However, there are 

many people who use data consolidation, so we’ll do an example of it.  If it works for 

you, then use it. 

1. Click on the Open icon, and navigate to C:\ExcelCEO\Excel

2010\Chapter15.

2. Click on the Q1_Sales.xlsx file, hold down the [Ctrl] key, and click on the 
Jan_Sales.xlsx, Feb_Sales.xlsx and Mar_Sales.xlsx files and click Open 
to open all files simultaneously. 
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3. Active the Q1_Sales.xlsx file.

Figure 15.26 

The Q1_Sales.xlsx file will hold the summed results of the Jan, Feb, and Mar files. 

4. Click on Cell D2 and click the Consolidate button from the Data Tools

group on the Data tab.

Figure 15.27 
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The Consolidate dialog box appears.  In this dialog box, you will define the ranges you 

want to consolidate. 

5. Make sure the selected function is Sum.

6. With your cursor in the Reference box, toggle over to the Jan_Sales file

(to activate it), select Cells D2 through F30 in the Jan_Sales file, and

click Add.

Figure 15.28 

7. Perform the same procedure to add the range D2 to F30 in the Feb and

Mar files into the All references section of the Consolidate dialog box.

Figure 15.29 
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8. After the Consolidate dialog box looks like Figure 15.29, click OK.

Figure 15.30 

The data from all three files is now consolidated into one file.  One rule that you must 

remember is that the data must be in the same format and in the same order in all data 

sources when you perform a data consolidation procedure.  For that reason, I prefer to 

copy/import the data into a PivotTable.  In a PivotTable, you have much more control in 

manipulating the data. 

9. Save the file as C:\ExcelCEO\Excel 2010\Chapter15\myQ1_Sales.xlsx

and close it (leaving the other three files open).

Linking Data 

Let me show you another way to consolidate data – linking files.  If you prefer to use the 

keyboard instead of the mouse, this may be a preferable alternative.  In this exercise, we 

will link the data in all three files into the myQ1_Sales file by simply clicking on the 

data. 

1. Open the Q1_Sales.xlsx file again.

2. Click on Cell D2, type the “=” key, toggle over to the Jan_Sales file, click

on Cell D2 of the Jan_Sales file, press the [F4] key three times and press

[Enter].
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Figure 15.31 

The formula in Cell D2 in the Q1_Sales file should now look Figure 15.31.  Pressing the 

[F4] key should make the formula a relative reference to Cell D2 in the Jan_Sales file.  

We need to make that cell a relative reference as we will be copying the cell soon.  Now 

all we have to do is to add in February and March to the same cell.   

3. Click in the Formula Bar to the right of the formula, type the “+” key,

click on Cell D2 of the Feb_Sales file, make it a relative reference, type

the “+” key again, click on Cell D2 of the Mar_Sales file, make it a

relative reference, and press [Enter].

4. Make all of the D2 references be relative values.

Figure 15.32 

5. Copy the formula down to all cells below then copy the formula to the

Warranty Sales and Delivery Sales columns.
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Figure 15.33 

All of your data is now consolidated in one file. 

6. Save the file as myQ1_Sales_Link.xlsx, and close all four files.

7. Open the myQ1_Sales_Link.xlsx file again.

Look at the formula in the formula bar now.  It should read: 

='C:\ExcelCEO\Excel 

2010\Chapter15\[Jan_Sales.xlsx]January'!E2+'C:\ExcelCEO
\Excel 2010\Chapter15\[Feb_Sales.xlsx]February'!E2+'C:

\ExcelCEO\Excel 2010\Chapter15\[Mar_Sales.xlsx]March'!E2 

This formula now displays the full path of the linked files.  I’ve seen many files like this 

where these links are set up and then someone moves or deletes the supporting files.  

When that happens, you will see an error message like this: 
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Figure 15.34 

The data will be the same as it was the last time you saved it, but you may want to save 

the original values but get rid of the links.  That’s real easy to do using the Edit Links 

dialog box.  In the Connections group of the Data tab, you should now see the Edit Links 

icon activated.  With this link, you can manage links to external Excel files. 

8. Click on the Edit Links icon in the Connections group of the Data tab.

Figure 15.35 

Using this dialog box, you can update the values, change the source, open the source, 

break the link(s) or check the status.  In this case, we want to break the link. 

9. With the Feb_Sales.xlsx link selected, hold down the [Ctrl] key, click on

the Jan_Sales.xlsx and the Mar_Sales.xlsx links, and click on the Break

Link button.

Figure 15.36 

10. Click on the Break Links button.
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11. Click on the Close button in the Edit Links dialog box.

The links are now broken and all of the data remains intact, but it is not linked to any 

source. 

12. Close the myQ1_Sales_Link.xlsx file.

Review Questions: It is now time to complete the hands-on Review
Questions. Log on to www.ExcelCEO.com with your Email and Password,
click on the Excel 2010 Review Questions, Chapter 15, Section 2 of 2
option and complete the review questions.

Conclusion 

In this chapter, you created graphics using Paint and you learned how to work with 

Excel’s protection features.  You learned how to share a workbook with multiple users 

and track the changes the users made.  Finally, you consolidated similar data from 

multiple files into one file using two different methods. 

Chapter Exam 

To take the examination for this chapter, you must have successfully completed 

the examination for the previous chapter.  You can now go to www.ExcelCEO.com,

click on Sign In, log in and take the exam.  Make sure that you take the exam on 

the same computer that you completed the sample files on, as some of the questions on 

the exam may refer to some of the completed examples. 

http://www.ExcelCEO.com/
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CHAPTER SIXTEEN – MACROS AND THE DEVELOPER TAB 

In this chapter, you will: 

 Apply macro security.

 Use VBA (Visual Basic for Applications).

 Create, edit, run and delete a macro.

 Use Relative References in macros.

 Use the Step Into functionality in macros.

 Use Shortcut Keys in macros.

 Create and use Command Buttons.

 Add macros to the Quick Access Toolbar.

 Create and use Spinner Buttons.

 Create and use Check Boxes.
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Macros 

The first thing I want to discuss in this chapter is Macros.  A macro is simply a mini-

program that executes a task.  Anytime you have a task that is repeated over and over 

again, a macro may be in order.  Excel provides a great way to create and run macros.  I 

want to caution you, however.  It is my belief that macros can be over-used.  Anytime 

you find yourself creating a lot of macros in a spreadsheet, you should step back and 

consider if Excel is the right tool for the project.  If you are continuously updating a 

report, you may want to think about putting that report in Access or on the Internet where 

it can be more easily automated and data can be more easily refreshed.  One of my best 

Excel students is very interested in doing EVERYTHING with Excel, but his projects 

have progressed to a point where they really need to be in a database.  He can write 

macros and VBA code “till the cows come home” but misses the point when it comes to 

report functionality. 

Macro Security 

Before we open a file that contains macros, let’s discuss Macro Security.  Excel 2010 has 

a number of file types that determine whether or not a macro can be run on the file.  The 

following table illustrates the different types of files. 

File Extension Description 
.xlsx Macro disabled Excel workbook 

.xlsm Macro enabled Excel workbook 

.xltx Macro disabled Excel template 

.xltxm Macro enabled Excel template 

Macros can be run only on Excel files that are saved as Excel enabled workbooks.  In the 

exercises in this chapter, we will concentrate on the .xlsm file type of Excel workbook.  

For here on out, when I refer to a macro enabled workbook, I mean macro enabled 

workbook or template.  When you first open an Excel enabled workbook, you may get a 

message telling you that the macros have been disabled. 

1. Open the file at C:\ExcelCEO\Excel 2010\Chapter16\Macro.xlsm.
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Figure 16.1 

This security warning means that your security settings have been set to disable some or 

all macros in the workbook.  When you click on the Enable Content button, you will 

enable the macros for that specific workbook. 

2. Click on the Enable Content button.

Figure 16.2 

The Security Warning goes away, and the macros are enabled for this workbook only.  

To permanently change the settings for all workbooks you open, you need to go to the 

Macro Security Settings.  When you open a workbook that has macros in it, a new tab 

along the top of the Office Ribbon called Developer should appear.  If you do not see the 

Developer tab, open the Options dialog box (under the File tab), click on Customize 

Ribbon, and check the “Developer” box.  Let’s do that now. 

3. If you don‟t see the Developer tab in the Office Ribbon, click on the File

tab, click on Options, click on Customize Ribbon, then check the

Developer box in the right section of the Excel Options dialog box.
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Figure 16.3 

4. Click OK.

The Developer tab now appears at the top of the Office Ribbon.  Let’s now view your 

macro settings.   

5. Open the Excel Options dialog box, click on Trust Center, click on

Trust Center Settings…, and click on Macro Settings.
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Figure 16.4 

I like to keep this setting on Disable all macros with notification.  There are some 

unethical people out there that like to write macros that will harm your computer.  

Microsoft can’t catch all of the harmful macros which can be easily written.  Macros can 

be written to execute whenever the file is opened, so to be safe, I like to disable all 

macros until I can review the file to determine if it is safe.  Before you enable the macros, 

you should know who the file is being sent from and you should be certain that person 

wouldn’t send you a file with potentially harmful macros in it.  For this reason, you 

should NEVER set the Macro Security Setting to Enable All Macros. 

6. Make sure the security level is set to Disable all macros with

notification and click OK in both dialog boxes.

7. Close the file (without saving it).

With that introduction, let’s explore some simple macros. 

1. Open the file C:\ExcelCEO\Excel 2010\Chapter16\Sales_2010.xlsm.

2. Click the Enable Content button. 
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3. Save it as C:\ExcelCEO\Excel 2010\Chapter16\mySales_2010.xlsm

(make sure you save it as a Macro-enabled workbook in the Save As

dialog box)

Figure 16.5 

This file calculates Store Manager bonuses for all stores.  The Assumptions tab allows 

you to change the assumptions and see what the bonus calculates at.  It is essentially the 

same file you used in Chapter 15. 

VBA 

Macros in Excel are written in a language called VBA (Visual Basic for Applications).  

The macro that is already created on this file does some formatting changes, like bold and 

italicize some of the cells in the spreadsheet.  Although generally you don’t need to know 

how to program with VBA to write macros, it does help to be exposed to it.  But before 

we get too deep into macros, let’s open up the code to see how it looks. 
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4. On the View tab in the Macros group, click on the drop down arrow

below Macros and choose View Macros.

Figure 16.6 

In the Macro dialog box, you can choose to run the macro, run it in steps (Step Into), edit 

it, delete it, and/or assign it a shortcut key (the Options button).  Let’s look at the VBA 

code behind the macro. 

5. In the Macro dialog box, make sure the FormatCells macro is selected,

and click the Edit button.



Section III:  Advanced Excel 2010 Macros and the Developer Tab  16

  448 

Figure 16.7 

Remember, you don’t have to know how to write VBA code, but it does help to become 

somewhat familiar with the code screen as you’ll see in an exercise later.  You can 

probably read the code and figure out what the macro is supposed to do.  VBA is written 

with mostly English words and you can learn how to write the code with little training.  

This macro selects a few cells, bolds and italicizes them, then selects the range E11 – F11 

and bolds that range. 

6. Close the Microsoft Visual Basic screen.

Running a Macro 

You now return to the spreadsheet.  To see how the macro works, let’s run it. 

7. Click on the Macros button and choose Run in the Macro dialog box.
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Figure 16.8 

And just like that, the macro selected certain cells and formatted them with bold and/or 

italics.  After you run the macro, notice that the Undo button is not available, so if you 

run the macro, you have to manually undo the changes or close out of the file and reopen 

it.  We want to start over on our macro lesson, so let’s close the file without saving it and 

reopen it. 

8. Close the mySales_2010.xlsm file without saving it and reopen it.

9. Enable the macros.

Shortcut Keys 

I hate to admit it, but it really is kind of a pain to run the macro, isn’t it?  You have to go 

into the View tab, click on View Macros, then run it.  Inexperienced users would have a 

hard time remembering how to do that.  Therefore, Excel made it easier to run a macro by 

using shortcut keys.  A shortcut key is the keyboard shortcut to run the macro.  Let’s 

create a shortcut key to run this macro. 
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1. Click on the Macros drop down menu, choose View Macros, make sure

FormatCells is selected and click the Options… button.

Figure 16.9 

The Macro Options dialog box appears.  In this screen, you can assign almost any key as 

the shortcut key.  The macro runs when you press [Ctrl] and the shortcut key.  The only 

thing you need to remember is that you shouldn’t assign a standard shortcut key, like 

[Ctrl]+c to copy or [Ctrl]+f to find.  Let’s assign a shortcut key of a to this macro. 

2. In the Macro Options dialog box, type the letter a (lower case) in the

Shortcut key box and click OK.

3. Close out of the Macro dialog box.

4. Press [Ctrl]+a to run the macro.

Step Into 

If you blinked, you may not have seen it, but the macro ran.  You can tell it ran because 

some of the cells changed their formatting and the range E11 through F11 is now 

selected.  Sometimes when you run a macro, Excel returns an ugly error message.  

Unfortunately, it doesn’t tell you exactly what the problem is.  In these cases, you will 

want to run each step of the macro until you figure out where the problem is.  The Macro 

dialog box allows you to run the macro in steps by using the Step Into option.  Let’s try 

it. 

5. Undo all of the bolding and italics.

6. Press [Alt]+[F8] (the shortcut key to open the Macro dialog box).

7. Make sure FormatCells is selected and click the Step Into button.

8. Rearrange the windows to make it look like Figure 16.10.
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Figure 16.10 

Notice that the text Sub FormatCells() is highlighted in yellow with a right arrow to the 

left of the text.  The current step the macro is on is always highlighted in yellow.  This 

means that this is the step that will execute next.  All this step tells you is that we’re about 

to run the macro.  To go to the next step, press the [F8] key. 

9. Press the [F8] key.
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Figure 16.11 

The first few lines that begin with an apostrophe are comments.  VBA skips over these 

lines.  This is how you can type any comment to document what the code is doing.  It is a 

good idea to document as much of your code as you can with comments like these. 

The first step in the macro is to select the range.  This is reflected in the VBA code as 

highlighted in yellow. 

10. Press the [F8] key over and over to step through each of the steps while

watching the results in the Excel spreadsheet in the background.

Once you get to the last step, close the Microsoft Visual Basic screen. 

11. Once the steps have completed and there are no more yellow highlighted

lines, close the Microsoft Visual Basic screen.

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 16, Section 1 of 2 
option and complete the review questions.



Section III:  Advanced Excel 2010 Macros and the Developer Tab  16

  453 

Create a Macro 

For me, the easiest way in Excel to create a macro is to use the macro recorder.  The 

recorder is just that – functionality you use to record your actions and save them.  In the 

next exercise, you will create a macro that adjusts the column widths after the formatting 

changes you did in the FormatCells macro.  The command is very simple to do – just 

select all columns and double-click on the column lines. 

1. With the Assumptions tab selected, click on the Macros drop down menu

in the View tab and make sure the Relative Reference icon button is not

selected (it will be highlighted if it is selected).  If it is highlighted, click on

it to deselect it.

2. Click on Record Macro…

The Record Macro dialog box opens. 

Figure 16.12 

Note that when you click on the Macros drop down menu, you will see an option called 

Relative Reference that can be turned off and on.  When the Relative Reference button is 

not selected (i.e., not highlighted), the macro actions are recorded at the cell’s actual 

address (like Cell A4).  When it is selected, it records the macro in reference to the 

position of the cursor.  For example, let’s suppose you had recorded a macro that began at 

Cell A1 and moved the cursor down two cells to Cell A3 with the Relative Reference not 

selected.  Before running the macro, you moved your cursor to Cell B1.  When you run 

the macro, Excel would go directly to Cell A3.  If the Relative Reference button was 

selected, it would go down two cells from Cell B1 to Cell B3.   

3. In the Record Macro dialog box, replace Macro1 in the Macro name:

box with AdjColumns
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4. In the Shortcut key: box, type a lower case letter “s”.

Figure 16.13 

5. Leave all other boxes with the default values and click OK.

Figure 16.14 

On the bottom left corner of your screen next to the Ready text, you should see a small 

blue box.  Hold your cursor over the box and you will see a screentip that reads “A macro 

is currently recording.  Click to stop recording.”  Every keystroke and action made with 

the mouse is now being recorded.  Excel is converting all of the keystrokes and clicks in 

VBA code and is saved in the macro.  Let’s record our first macro then stop it.  All we 

want this macro to do is to select the entire spreadsheet and adjust the column widths. 

6. Select the entire spreadsheet by clicking on the gray box in the upper left

section of the spreadsheet where the columns meet the rows.

7. Double-click on any column line to auto adjust all columns.

8. Click on Cell F11 of the Assumptions tab and click the Stop Recording

button.
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The Stop Recording button disappears, but in the background you have a recorded macro.  

Let’s try out the macro by using the shortcut key you defined. 

9. Make sure you are on the Assumptions tab.

10. Adjust Column E to be 20.00 (145 pixels) and click on Cell A4.

11. Press [Ctrl]+s.

In a split second, you can see the screen blip and the width of Column E is adjusted, and 

your cursor moves to Cell F11.  This indicates the macro is working. 

Editing a Macro 

To format our spreadsheet, the user has to run two macros, the FormatCells and 

AdjColumns macros.  Do you think we could combine them into one macro?  Sure we 

can.  There are two ways to do it.  First, you could create a third macro that runs the first 

two macros.  Even though it’s easy to do, I don’t like to do that, as you end up with three 

macros when you should have just one.  I prefer the second method, which is to copy the 

VBA code from one macro and paste it into the other.  Let’s do that now.  In this next 

exercise, you will copy the AdjColumns macro code into the FormatCells macro. 

1. Open the Macro dialog box.

2. Select the AdjColumns macro and click the Edit button.

Figure 16.15 

The VBA Editor opens up. 
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3. Select the three lines in black that make up the text of the macro

(Cells.Select through Range(“F11”).Select) and copy the text into

memory.

4. Close the VBA Editor screen.

5. Open the Macro dialog box again, select the FormatCells macro and

click the Edit button.

6. Go to the last line of the macro, just before the End Sub statement, and

paste the text from the AdjColumns macro.

Figure 16.16 

7. Close the VBA Editor screen.

8. Make sure the “a” shortcut is still valid.  (Sometimes VBA resets the

shortcut to nothing when changes are made to the macro.)

9. Adjust the column width of Column E to be something much larger than it

currently is, unbold the bolded cells, and press [Ctrl]+a to run the

FormatCells macro.

As you will see, the width of Column E is now shorter and all of the cells in the 

FormatCells macro have changed their formatting.  This is the evidence you needed to 

confirm that both macros are now combined into one.  Now that they are combined, you 

don’t need the AdjColumns macro. 

10. Open up the Macro dialog box, click on the AdjColumns macro, and

click the Delete button.

11. Click Yes to confirm the deletion of the macro.
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Figure 16.17 

12. Save the file.

One problem with the way we currently have our spreadsheet set up is that the user has to 

remember to use [Ctrl]+a to run the macro.  We could type the instructions somewhere on 

the Assumptions page, but that could take up a lot of space.  One way to make it bone 

stupid simple is to use a Command Button.  I really like Command Buttons, and since 

this is my course, we’ll do some now. 

Command Buttons 

You are probably already familiar with a Command Button.  A Command Button is a 

button that does something when you click on it.  There are many examples of Command 

Buttons on almost every Internet page.  You can create Command Buttons in Excel, 

Access, HTML, and many other programs.  When you open a macro-enabled workbook, 

you see the Enable Content button, which is an example of a Command Button.  In our 

example, we’ll create a command button that executes the FormatCells macro.  

Command Buttons, as well as other tools we’ll use later in this chapter, are contained in 

the Developer tab. 

1. While on the Assumptions tab, click on the Developer tab.

2. In the Controls group, click on the Insert icon.

3. Click on the Button (Form Control) icon . 

4. With your mouse, draw a rectangle at about Cell E13 below the Total

Bonus row and release.

When you release the mouse, the Assign Macro dialog box pops up. 
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Figure 16.18 

5. Select FormatCells in the Macro name: box and click OK.

Excel creates a button that looks like this: 

Figure 16.19 

6. While the Command Button is selected (i.e., handles appear around it),

select the text  Button 1  inside the button and replace it with  Format

Cells

7. Click the [Esc] key to exit out of the button Design mode.

To edit the button, move it around, reassign the macro or resize it, simply right-click on 

the button and either choose an option from the list or click [Esc].  If you left click the 

button, it will execute the macro that you assigned to it 

8. Right-click on the Format Cells command button, press [Esc], and

position your cursor over the button‟s shaded area where the cursor turns

to a four arrow symbol.

9. Drag the button just to the right of the Nitey-Nite graphic and release.

10. Click anywhere outside of the button (to exit out of design mode).
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Figure 16.20 

11. Adjust the width of Column E and click on the Format Cells command

button to test the macro.

12. Save the file.

Macros in the Quick Access Toolbar 

Another way to store a macro in your spreadsheet is to put it in the Quick Access 

Toolbar.  This comes in particularly handy when you have lots of macros and you want to 

organize them in an easy-to-use fashion.  In this next example, we’ll put the FormatCells 

macro in the Quick Access Toolbar. 

1. Click on the Customize Quick Access Toolbar drop down arrow and

choose More Commands…

The Excel Options dialog box appears, and the Customize section of the dialog box is 

activated. 

2. Make sure the Choose commands from: box is set to Popular

Commands.

3. Scroll to the bottom of the list and click on View Macros.

4. Click Add>>

The View Macros object is moved over to the section that displays all of the icons 

currently available in the Quick Access Toolbar. 

5. Click on the Choose commands from drop down menu and choose

Macros.
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Figure 16.21 

6. Click on the FormatCells macro and click Add>>

7. Click on the FormatCells macro in the right section and click the Modify

button at the bottom of the section.

The Modify Button dialog box appears. 
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Figure 16.22 

8. Click on the button in the second row that looks like a painter‟s palette

and click OK to close the Modify Button dialog box, then click OK again

to close the Excel Options dialog box.

You have now assigned that image to the FormatCells macro.  Whenever you want to use 

that macro, simply click on that image. 

9. Click on the palette icon to run the FormatCells macro and make sure it

works.

Spin Buttons 

Another object from the Developer tab that I use a lot is the Spin Button, sometimes 

called a Spin Box or Spinner Button.  Users, particularly upper management, like to see 

what happens with the bottom line with each unit change in a variable.  At Nitey-Nite 

Mattresses, there is an on-going argument over the entry point at which management 

wants to pay bonuses.  Some management people say that each store must reach 100% 

before making a bonus.  Others say you can make more sales if the entry point is more 

lenient, like at 90%, and yet other hard-core individuals believe 100% is the minimum 

acceptable to keep your job and that the bonus entry point should be at about 110%.  

With a Spin Button, you can create an analysis to show them the end result (Total Bonus 

Payable) with every percentage point change in the entry point without having to type in 

each assumption.  It’s so simple to use that even upper management people who have 

little experience with Excel can use it and they LOVE it!  Let’s create a Spin Button. 
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1. Make sure you are on the Assumptions tab of the mySales_2010.xlsx file

and click on the Insert button of the Controls group of the Developer tab.

2. In the Form Controls box, click on the Spin Button . 

3. Draw a vertically shaped rectangle box on the right side of Cells F14 and

F15 and release.

4. Right-click on the Spin Button and choose Format Control…

The Format Control dialog box appears. 

Figure 16.23 

5. Click on the Control tab.

6. Click inside the Cell link: box then click on Cell F14 (you may have to

move the dialog box out of the way to click on Cell F14) and click OK.

7. Click outside the Spin Button to take it out of design mode.

8. Click on the up and down arrows of the spinner button and you will see

the value in Cell F14 go up and down accordingly.

With the spin button set up, all we have to do is write a formula using the number in Cell 

F14 to calculate the change in the entry point.  If you look at the values in Cells B15 and 

B24, you will see that all of the percentages are based on the value in Cell B6, which is 

currently set to 100%.  We want to write a formula that will take the number in Cell B6 

up and down by one percentage point.  Notice that the spin button’s value in Cell F14 can 
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go up a lot but stops at 0 when clicking the down arrow.  It would seem that we can’t go 

below zero, but we can change around some assumptions in the dialog box that will solve 

that issue. 

9. Right-click on the Spin Button and choose Format Control…

10. Change the Current Value to 100, leave the Minimum Value at 0,

change the Maximum value to 200, leave the Incremental change at 1

(you can‟t go below 0 on the Incremental value – that‟s why we have to

write a formula), click OK and exit out of the Spin Button‟s design mode.

The value in Cell F14 changes to 100.  Click on the up and down arrows of the Spin 

Button and you will see that you can go up to 200 and down to 0. 

11. Replace the value in Cell B6 with this formula:  =F14/100.

12. Hide the contents of Cell F14 (use a Custom format of ;;; in the Format

Cells dialog box).

13. Type  Entry Point  in Cell E14.

14. In Cell E15, type  =F14/100   and format it as Percent, zero decimal

places.

15. Take the Entry Point down to 95% using the Spin Button.

Figure 16.24 

The Total Bonus becomes $317,496.  Notice that the % of Budget numbers are all based 

on the Entry Point in Cell B6.  With every click on the Spin Button, there is 

instantaneously a new Total Bonus value. 
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Check Boxes 

The next object in the Developer tab I think is very useful is the check box.  If you’ve 

spent any time in computer programs or on the Internet, you’re probably already familiar 

with check boxes.  A check box is used when you want the user to simply check and 

uncheck an assumption, or in other words, turn an assumption off and on.  In our 

example, let’s assume there are discussions with upper management as to whether or not 

Paper stores should be eligible for a bonus, as they are smaller stores that don’t contribute 

much to the bottom line of the company.  We will create a check box to include them as 

eligible for a bonus when checked or uncheck it if they are not eligible and see the 

difference in the Total Bonus.  Let’s do it. 

1. In Cell E17, type:  Include Paper

2. Click on the Check Box icon  in Form Controls. 

3. With your cursor, draw a small box in the middle of Cell F17.

You should get something similar to the following: 

Figure 16.25 

4. Delete the text to the immediate right of the check box inside the shaded

area.

5. Right-click on the check box and choose Format Control…

6. On the Control tab, click inside the Cell link: box.

7. Click on Cell F17 on the spreadsheet or type F17.
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Figure 16.26 

8. Leave all default values and click OK.

9. Exit out of the check box design mode.

Check and uncheck the check box.  You will see that Cell F17 returns TRUE when it is 

checked and FALSE when it is unchecked. 

10. Make sure the check box is unchecked.

11. Format Cell F17 (the cell, not the check box) as hidden.

12. Resize Column E if necessary.

13. Go to the Sales page.

14. Insert a column between the Store_Type and Bonus fields.  The new

column should be Column K.  Name it Include.

15. In Cell K5, write a formula that says if the Store_Type is not Paper,

return a Y, else, if Cell F17 on the Assumptions page is TRUE, then

return a Y, else, return N.

16. Copy the formula down to all cells below.
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Figure 16.27 

Notice that in my formula, I did not hard code in the word “Paper”.  I referred to Cell F5 

on the Assumptions tab.  This way, if Nitey-Nite every decided to change the names 

Paper, Scissors, Rock to Bronze, Silver, Gold (or something similar), all they would have 

to do is make the change on the Assumptions page and all of the formulas would continue 

to work. 

17. Edit the formula in Cell L5 to return 0 if the Include column is N.

18. Copy the new formula down to all cells below.

The new formula in Cell L5 should be as follows: 

=IF(K5="N",0,IF(J5=Assumptions!$F$5,VLOOKUP(MATCH(I5,Assumptions!$

B$5:$B$10,1),Assumptions!$A$5:$C$10,3,FALSE)*G5,IF(J5=Assumptions!$F$

6,VLOOKUP(MATCH(I5,Assumptions!$B$14:$B$19,1),Assumptions!$A$14:$

C$19,3,FALSE)*G5,VLOOKUP(MATCH(I5,Assumptions!$B$23:$B$28,1),Ass

umptions!$A$23:$C$28,3,FALSE)*G5))) 

The only real change to the formula is “IF(K5=0,”N”,0, “, and adding an ending 

parenthesis at the end. 

19. Go to the Assumptions page.

20. Check and uncheck the check box.

You should see that the Total Bonus is $317,496 when it is checked and $198,556 when 

it is unchecked.  You now have a fully functional application that will allow management 

to change almost any assumption in the Sales program.  Trust me, management and 

clients LOVE this kind of analysis.  It gives them the opportunity to make any change 

they want and immediately see the results. 
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21. Save and close the file.

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 16, Section 2 of 2 
option and complete the review questions.

Conclusion 

In this chapter, you learned about macro security and why you should be cautious about 

receiving files containing macros from others.  We reviewed the VBA (Visual Basic for 

Applications) programming language, which is the language behind macros.  You learned 

how to create, edit, run, step into and delete a macro, as well as how to work with relative 

references as it applies to macros.  You learned about shortcut keys and created a shortcut 

key within a macro.  You added a macro to the Quick Access Toolbar and finally you 

created a Command Button, a Spin Button and a Check Box using Form Controls. 

Chapter Exam 

To take the examination for this chapter, you must have successfully completed 

the examination for the previous chapter.  You can now go to www.ExcelCEO.com, 

click on Sign In, log in and take the exam.  Make sure that you take the exam on 

the same computer that you completed the sample files on, as some of the questions on 

the exam may refer to some of the completed examples. 

http://www.ExcelCEO.com/
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CHAPTER SEVENTEEN – THE WEB AND NEW 2010 FEATURES 

In this chapter, you will: 

 Create a simple HTML page using NotePad.

 Save an Excel file as an HTML file.

 Create a Web Query.

 Format a Table.

 Delete records in a table but not in the worksheet.

 Work with advanced Date filtering.

 Create a Background in a spreadsheet.
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Working with the Web 

One enhancement that was made in more recent versions of Excel is its capability of 

saving documents to the World Wide Web (Web).  When a document is saved on the 

Web, it can be viewable to everyone or just to people that you allow access to it.  One of 

the great points about saving documents to the web is the distribution of the document or 

report.  Once it is on the Web, all you have to do is tell people where it is at, usually by 

sending them a link in an email, and they can click on the link to access it.  Even though 

you can make an Excel file itself available via the Web, that is sometimes not a good 

idea, particularly if that person is accessing the Web using a dial up or wireless 

connection.  Sometimes large files can take a lot of time to open.  Additionally, the user 

would have to have Excel installed on their computer in order to view it.  However, as 

many people in a business environment share files, we’ll review how to post Excel files 

on the web in this chapter. 

To make an Excel file viewable on a browser (like Microsoft Internet Explorer), it is 

necessary to save the file in some type of browser-viewable format.  The basic format for 

viewing documents on the web is in an HTML format.  HTML stands for Hypertext 

Markup Language.  An HTML file is a page that is programmed to make it readable for a 

browser.  Although programming HTML is beyond the scope of this course, it would be 

helpful to know at least some basics. 

Create a Simple HTML Page 

An HTML file is programmed with tags which tell the browser how to display its 

contents.  HTML is not a programming language per se but a markup language, and is 

very easy to learn how to code.  You don’t even need any special software to program it – 

just open Notepad or Word and start programming.  Let’s create a simple HTML file 

using NotePad. 

1. Open a blank NotePad file (Start, All Programs, Accessories, NotePad).

2. In the NotePad file, type the text as shown in Figure 17.1.

3. Save the file as C:\ExcelCEO\Excel 2010\Chapter17\hello.html. (Make 
sure to save the file name as hello.html and the Save as type of All Files.) 

Figure 17.1 
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In this file, there are five lines of code.  The text surrounded by the “<” and “>” signs are 

called tags.  Tags are the basics behind HTML files.  There is only one required tag in an 

HTML file.  That tag is the <HTML> tag, which tells the browser that this is an HTML 

page.  All other tags are optional.  The last tag, </HTML>, tells the browser it is the end 

of the HTML page.  The <BODY> tag begins what is contained in the body of the page, 

and the </BODY> tag ends the <BODY> tag, or ends the body of the page.  You must 

save an HTML file with the extension .htm or .html. 

4. Open your Internet browser.

5. Click on File, Open…, click on the Browse button, navigate to

C:\ClineSys\Excel 2010\Chapter17\hello.html and open the file.

Figure 17.2 

Again, this is a very simple HTML page that is viewable currently only by you since it is 

on your computer’s hard drive.  If you want the whole world to see it, you would have to 

copy the file on to a web server, which is simply a computer that is connected to the web.  

At this point, you can start changing some of the text and tags to make it more useful, 

meaningful or just pretty it up. 

6. In the NotePad file, add the <B> and </B> tags around the word Hello.



Section III:  Advanced Excel 2010 The Web and New 2010 Features 17

  472 

7. Save the NotePad file.

Figure 17.3 

The <B> and </B> tags tell the browser to display a bold format starting with the letter H 

in Hello and end the bold after the letter o.  To see how it looks on your browser, just 

click the Refresh icon after you save the NotePad file.  You can also use the <STRONG> 

tag to bold text. 

8. Click the Refresh icon on your browser.

Figure 17.4 



Section III:  Advanced Excel 2010 The Web and New 2010 Features 17

  473 

Now you see that the word Hello is in a bold format.  It is beyond the scope of this course 

to give a complete lesson on creating HTML files, but learning to write HTML is 

essential if you want to learn web development, and it is relatively easy to learn. 

9. Close your Internet browser and NotePad.

Save as Single File Web Page 

There are many types of web pages that can be created for the web.  Other types of web 

pages include ASP, ASPX (or ASP.Net), PHP, JSP, and CFM, just to name a few.  In this 

next exercise, you will open an Excel file and save the file as a web page.  When you 

save an Excel file as a single web page using Excel’s publishing tools, it is created with 

an mht (MHTML, or Microsoft HTML) extension.  Creating this kind of file is not much 

more than clicking File, Save As… and choose a save as format.  Let’s do it. 

1. In Excel, open the Q1_Sales.xlsx file located at C:/ClineSys/Excel

2010/Chapter17.

Figure 17.5 

This is a simple file we’ve worked with before.  It contains three tabs:  January, February, 

and March.  Each tab contains sales data by store and merchandise type. 

2. Click on the File tab, Save As.

3. In the Save As dialog box, click on the Save as type drop down menu and

choose Single File Web Page.

4. Make sure the Entire Workbook radio button is selected.

5. Click Save.
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6. Click Yes in the warning dialog box, as all we‟re trying to do is create a

static web page.

It may not look like anything happened, but you just saved the file as a web page 

viewable via your browser. 

7. Open Internet Explorer (or your own Internet browser).

8. Click File, Open…, navigate to C:\ExcelCEO\Excel 
2010\Chapter17\Q1_Sales.mht and open the file. 



Section III:  Advanced Excel 2010 The Web and New 2010 Features 17

  475 

Figure 17.6 

9. Close the ActiveX Security message in yellow.

You should see something like Figure 17.6.  Depending on your browser, you may see a 

warning message telling you that the browser restricted access to the file.  Since it is on 

your computer and no one else sees it, it is OK to allow access to it.   
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10. Click on the February tab at the bottom left of your screen to see the

numbers change to February data.

A note on Web reporting:  Microsoft is moving away from allowing users to share their 

Excel files and making them interactive, meaning allowing users to update the data, via 

the Web.  Creating a web page from an Excel file like we just did is simply putting the 

data in a read-only format.  If you are interested in sharing data over the web and 

allowing users to interact with the data in reports that sort, filter, and update data, I 

suggest you explore other web tools such as Microsoft SharePoint Services or ASP.Net, 

There are also some good non-Microsoft tools that have that functionality, like PHP, JSP 

and ColdFusion.  If you want to simply report numbers in a formatted report that is 

printable (i.e., the headers and footer appear on each page and you can control the 

margins) but cannot update, add or delete records in a database, I suggest using tools like 

MacroMedia’s Business Objects (Crystal Reports) or my favorite Microsoft SQL Server 

Reporting Services.  A discussion of these tools is beyond the scope of this course.  

However, if you complete the Excel course AND the subsequent Access course, you will 

be adequately prepared to start learning to use any one of these tools. 

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 17, Section 1 of 2 
option and complete the review questions. 

11. Close your browser and close the Q1_Sales.mht file.

Create a Web Query 

While there is an enormous amount of data on the Web, it doesn’t do you any good 

unless you can access it and manipulate it in a way that is meaningful to you.  Excel has 

the capability of creating a web query by letting you copy the data on a web page and 

pasting it into an Excel spreadsheet.  Once you paste it into the spreadsheet, a Paste 

Options button will appear that allows you to create and save the query so you can run it 

over and over again (assuming the data changes).  Let’s create a web query on a simple 

web page I built. 

1. Open a blank Excel spreadsheet, then open Internet Explorer (or your 
own browser).

2. Type this address into the address bar of your browser:

www.ExcelCEO.com/dates.asp. 
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Figure 17.17 

3. With your mouse, select the entire table in the browser window, copy it,

toggle over to the blank Excel spreadsheet and paste the contents into

Cell A1 of the blank spreadsheet.

Figure 17.18 
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The table is pasted onto the spreadsheet and the Paste Options button appears at the lower 

right corner of the table. 

4. Click the Paste Options button.

Figure 17.19 

5. Click on the Refreshable Web Query… option.
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Figure 17.20 

The New Web Query dialog box appears.  

6. Click on the arrow pointing to the table (to select the table) and click the

Import button.

The web query is created.  To refresh the data in the spreadsheet, just right-click 

anywhere on the table in Excel and choose Refresh. 

7. Right-click anywhere in the table and choose Refresh.

Figure 17.21 
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The data will change according to the time on the webpage’s server (it is in United States 

Eastern time).  The great thing about this kind of query is that you can set it up to pull 

data from any site you have permission to on the Web, and you don’t have to continually 

go to the web site to copy the data.  Just refresh the Excel file and your data is updated in 

real time.  How about using this for some stock quotes? 

8. Save the file as C:\ExcelCEO\Excel 2010\Chapter17\myWebQuery.xlsx

and close it.

More New Stuff in Excel 2007 and 2010 

To conclude this chapter, let’s look at some of the miscellaneous new things that have 

built into Excel 2007 and 2010.  I chose to include some of the new things incorporated 

into Excel 2007 as well because I realize some people may be upgrading from Excel 

2003 straight to Excel 2010.  Most of these enhancements came out with the release of 

Excel 2007, and I will note those things that are specific to 2010.  There is already a list 

of new items for Excel 2010 in the Introduction section of this course, and I encourage 

you to review that list again now that you are coming to the end of the course.  Let’s start 

off this discussion reviewing Excel 2010 Tables. 

Excel 2010 Tables 

1. Open the file at C:\ExcelCEO\Excel 2010\Chapter17\New2010.xlsx.

2. Save the file as C:\ExcelCEO\Excel 2010\Chapter17\myNew2010.xlsx.

3. Click Enable Content. 

Figure 17.22 

The Tickets tab is an import from an Access database of records (sales) for each store.  It 

also contains another table of data off to the right that we’ll use in a few minutes.  When 

records are imported from an Access database, Excel sets up the record set and formats it 

as a table.  This is important to understand because a table in Excel 2010 has additional 
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features as compared with a simple record set of data.  You can also define a table by 

using the Format as Table functionality in the Home tab.  Let’s do that. 

4. Click on Cell A1 (or any cell in the table).

5. On the Home tab in the Styles group, click on the Format as Table

button.

6. Choose Table Style Medium 2.

Figure 17.23 

The data table is now formatted with a new, lighter style.  Let’s write a VLOOKUP() 

function that looks up the Store Number based on the Store ID. 

7. In Cell J1, type Store_No.

As Column J is a column adjacent to the data table, Excel automatically recognizes the 

column as part of the data table and applies the Medium 2 formatting to it. 

8. In Cell J2, write a VLOOKUP() formula that looks up the Store_No on

Store_ID based on the lookup table to the right of the data table.  When

writing the formula, choose the Cell A2 with your mouse or with the

arrow keys (do not type A2 in the formula).
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Figure 17.24 

Notice how the formula reflects the name of the data table (Excel automatically named 

the table when we formatted it) and a reference to the Store_ID field instead of the A2 

reference.  Additionally, Excel assumes you will apply that formula to all cells beneath it, 

so it populated all cells in the data table for you.  Let’s assume that the boss told us to 

delete Rows 7 and 8 in the data table.  We could encounter a problem doing that because 

of the lookup table to the right of the data table.  If you delete Rows 7 and 8 in the data 

table, it will delete Store_IDs 6 and 7 in the lookup table.  Excel 2007 and 2010 has a 

new feature that allows you delete rows and columns in the data table without affecting 

any other tables beside or beneath it. 

9. With your mouse, select Cells A7 and A8.

10. On the Home tab in the Cells group, click on the drop down arrow on the

Delete button

Figure 17.25 

11. Click on Delete Table Rows.

When you clicked on Delete Table Rows, Excel deleted the rows in the table, but not in 

the lookup table to the right.  You can delete rows and columns from tables using this 

new functionality. 
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Zoom In and Zoom Out 

Another nifty feature in Excel 2007 and 2010 is the Zoom functionality.  Zoom In and 

Zoom Out buttons are located at the bottom right of your screen.  You can click these 

buttons to see larger and smaller views of the spreadsheet. 

Figure 17.26 

1. Click on the Zoom Out button until you can see all columns in both the

data and lookup tables.

2. Click on the Zoom In button until the data table columns take up your

entire screen.

3. Return the view of the data table to 100%.

4. Click on the 100% image.

Figure 17.27 

The Zoom dialog box appears.  Using this dialog box, you can customize the size of the 

data to any size you want.  The Zoom features are MUCH easier than playing around 

with the display in Control Panel to adjust the size of your screen. 

5. Cancel out of the Zoom dialog box.

Filtering on Dates 

Excel 2007 and 2010 has added in a new feature that makes it easier to filter on dates.  

This functionality is available whenever the data in a column is formatted as a date, and 

Filter is turned on. 
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1. If the Filter is not turned on in the data table, turn it on.

2. Click on the drop down arrow next to Sale_Date.

Figure 17.28 

Notice the  boxes next to each year.  You can click on the  boxes to filter for specific 

years, months and/or days. 

3. Uncheck the 2008, 2009 and 2011 check boxes.

4. Click on the  box next to 2010 and deselect all boxes except for

January, February and March and click OK.
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Figure 17.29 

The data table is now filtered for data in the first quarter of 2010. 

Background 

Have you ever seen a Word document that has a “watermark” on it?  These are 

documents that usually have something like “Draft” or “Tentative” pasted as a 

background so the user of the report knows that it is not a final document.  You can 

include such a background in an Excel 2010 spreadsheet as well.  I created a simple 

“Draft” jpg file with WordArt and included it in the Chapter17 folder.  Let’s use that as a 

background. 

1. Click on the Bonus_Summary tab of the myNew2010.xlsx file.

2. Click on the Page Layout tab.

3. In the Sheet Options group, deselect the View box under Gridlines.

4. Click on the Background button in the Page Setup group.

5. In the Sheet Background dialog box, navigate to the C:\ExcelCEO
\Excel 10\Chapter17 folder and double-click on the draft.jpg file. 
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Figure 17.30 

Notice that the background repeats in all columns and rows of the spreadsheet. 

6. Save and close the file.

Microsoft has gone to great lengths to try to improve Excel.  As you continue to use 

Excel 2010, take some time to play around with features that pop up on the right-click 

menu, or button in the ribbon that you haven’t used before.   

Review Questions: It is now time to complete the hands-on Review 
Questions. Log on to www.ExcelCEO.com with your Email and Password, 
click on the Excel 2010 Review Questions, Chapter 17, Section 2 of 2 
option and complete the review questions. 

Conclusion 

In this chapter, you created a simple HTML page by using NotePad.  You learned how to 

save an Excel file as a web file to make it readable on a browser.  You saved an Excel file 

as an XML file and created a web query.  You also explored some of the new features of 

Excel 2007 and 2010, like working with tables and filtering on dates.  You deleted rows 

in a data table without deleting the data in another table on the same spreadsheet.  You 

finised the chapter by including a background in your file so that users of the file would 

know it is still in Draft mode. 
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Chapter Exam 

To take the examination for this chapter, you must have successfully completed 

the examination for the previous chapter.  You can now go to www.ExcelCEO.com, 

click on Sign In, log in and take the exam.  Make sure that you take the exam on 

the same computer that you completed the sample files on, as some of the questions on 

the exam may refer to some of the completed examples. 

http://www.ExcelCEO.com/
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 SECTION IV:  THE EXCEL 2010 MASTER 

It is this section of the course that goes beyond the traditional Excel learning.  This last 

chapter of the course is hard.  In fact, it is by far the hardest chapter in the entire course.  

But the knowledge that you will gain by completing this chapter is unparalleled in the 

market today.  If you can complete this chapter, you are truly an Excel Master, and upon 

completion, I will send you an Excel Master Certification to prove to the world how good 

you really are. 

If you have completed ALL of the exercises in the previous chapters, you are now ready 

to start the Excel 2010 Comprehensive Project.  I previously asked you to complete all of 

the exercises because the tasks I will ask you to do in the Comprehensive Project contain 

Beginning, Intermediate and Advanced features you should have learned throughout the 

course.  I have had students in the past who completed through Chapters 1 – 17 by just 

getting by and barely passing the tests.  These students picked up a number of tricks, but 

they didn’t master Excel enough to be able to complete the Comprehensive Project and 

the last exam.  Some of them just gave up.  Others went back and worked the exercises 

they skipped over.  I hope you have completed all of the exercises up to this point and I 

encourage you to continue on. 

The Comprehensive Project is a project where I will give you basic instructions on how 

to complete it, but I will not give you the details on how to complete the tasks like I have 

before.  Actually, I don’t care how you get the right answer, as long as you get it.  In that 

sense, the project is much more like an actual project you will get on the job.  All of the 

questions on the Chapter 18 exam are based on the completed project, so it is imperative 

that you complete it exactly as I explain it.  To further assist you, I will give you some 

check figures along the way just to make sure you are on the right path. 

As I have stated many times in this course, I believe the three most important things an 

Excel user should know are 1) how to write a nested IF() statement; 2) how to create and 

use PivotTables and 3) how to use a VLOOKUP() function.  With those three pieces of 

knowledge, you can do almost unlimited analyses in Excel.  The Comprehensive Project 

will test your ability to follow simple and complex logic using all three of these tools, as 

well as using other functions and formula-writing skills learned in this course.  With that 

said, let’s get started, and GOOD LUCK! 
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THE COMPREHENSIVE PROJECT 

In this chapter, you will: 

 Complete the Comprehensive Project.
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The Comprehensive Project 

The data for the Comprehensive Project will come from the file located 

at C:\ExcelCEO\Excel 2010\Chapter18\Comp_Project.xlsx.

1. Open the Comp_Project.xlsx file located at C:\ExcelCEO
\Excel 2010\Chapter18\Comp_Project.xlsx.

2. Save the file in the same folder as myComp_Project.xlsx.

This file contains three tabs of data.  The format of this data is probably very similar to 

databases you will find at your own company.  The first tab is called Stores.  It contains 

information about each store.  We’ve used this data in other exercises, so you should be 

familiar with the data and the format.  As you will learn when you take the Access 

course, each table in a database should contain a Primary Key.  A Primary Key is a field 

of data in a table that serves as a unique identifier for each record.  For programming 

purposes, it is typically better for the primary key to be a number field instead of a text 

field.  Using a number field as a primary key generally improves the speed when 

querying the tables.  In the Stores tab, the Store_ID is the primary key field. 

Let me take some time to explain how the Stores table is set up.  All of the fields in the 

table are probably self-explanatory, except for the Parent_ID field.  The Parent_ID field 

records the rollup structure of all stores in the organization.  In relational databases, you 

will become familiar with a parent/child relationship, and this is a good example of 

how that relationship works.  Take for example Store_ID 12, which is Store_No 1019, 

Nitey-Nite Alameda.  This store is located in Baltimore, Maryland.  You can also see the 

store’s address, city, state, ZIP Code, phone number, and area in square feet.  It would be 

easy to query or filter for Store No 1019, or even for all stores in the city of Baltimore, or 

the state of Maryland, or any other city or state.  However, Nitey-Nite’s stores are also 

organized in regions, namely, the Northern and Southern Regions.  The organization of 

stores in regions is maintained in the Parent_ID field.  For Store No 1019, you see that 

the Parent_ID is 21.  The Parent_ID of 21 is the “parent”, or one level higher, than 

Store_ID 12.  If you look down the Store_ID field, you will see that Store_ID 21 is Store 

No R02, which is the Southern Region.  Store_ID 21’s “parent” is Store_ID 1, which is 

the Home Office.   

Using the Store_ID in this manner, a database programmer can maintain several levels of 

structures with just two fields called the parent and child fields.  This could also be 

accomplished by maintaining a separate field for each level, and that usually works best 

when working with a flat file like Excel.  Most relational databases are set up using a 

parent/child structure, also referred to as a hierarchical structure.  It is important for 

you to understand a parent/child relationship or hierarchical structure for database 

programming, and in the Comprehensive Project you will turn the various parent/child 

fields into a flat file as it is easier to work with in Excel. 

The second tab is called Accounts.  It represents a simple chart of accounts, and includes 

the Account_ID, Level, Rollup_ID, Account and Acct_Desc fields.  The Account_ID 
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field is the primary key for this table.  This table is another example of a parent/child 

relationship.  For example, Account 190-3: Employee Discounts has an Account_ID of 

1043 and a Rollup_ID (or parent ID) of 1007.  The programmer included a field called 

Level simply to make the table easier to read and understand the rollup levels.  Account 

ID 1007 is Discounts, which rolls up to Rollup_ID 1002, Revenue, which rolls up to Net 

Income.  Level 4, therefore, is at the lowest level of the account structure, and level 1 is 

the highest level, Net Income.  In actuality, companies usually have more than four rollup 

levels, but I created this simple table to show you theoretically how hierarchical files 

work. 

The third tab, Finl_Data, is the meat of the file.  The data in this tab is kind of scary when 

you first look at it, but it becomes easier to understand when you grasp the concept of 

parent/child relationships and Primary Keys.  The first field in the Finl_Data tab is 

Month.  That one is easy to understand.  The Month is simply the month in which the 

transaction occurred.  As you can see, the first record occurred in Month 08, or August.   

The second field, Store_ID, gets more complicated, but not to worry -- we can work 

through it.  This field refers to the Store_ID field in the Stores tab.  When creating a 

database, it is usually a good idea to name parent/child fields with the same names in the 

tables they relate to.  Sometimes that is feasible and sometimes not.  It is good practice to 

try to do so whenever possible.  The first record in the Finl_Data tab has a Store_ID of 

30. Store_ID 30 in the Stores tab is Store No 1060: Nitey-Nite Elamin in Baltimore, MD.

All you have to do is to write a VLOOKUP() formula to pull in the right data.

The third field, Acct_ID, refers to the Account_ID field in the Accounts tab.  The first 

record in the Finl_Data tab has an Acct_ID of 1021, which is Account 103-4: Double Fair 

in the Accounts tab. 

The next three columns in the Finl_Data tab, Amt_2010, Amt_2009 and Amt_2008 are 

the dollar amounts of each month, store and account activity.  Based on the references 

that we’ve discussed, that first record in the Finl_Data tab tells us that Store No 1060 

(Store ID 30) had amounts $4,631, $10,004, and $2,809 in August of 2010, 2009 and 

2008, respectively.  The tables also tell us that Store No 1060 rolls up to the Southern 

Region which rolls up to the Home Office, and that Account 103-4 rolls up to Mattress 

Revenue, which rolls up to Revenue which rolls up to Net Income.  That’s a lot of 

information contained in very few fields of data. 

The last column in the table is Bgt_2010.  You will populate that field with budget 

numbers towards the end of the Comprehensive Project. 

I hope you can now grasp the concept of relational databases and parent/child or 

hierarchical structures.  You have become an expert in writing formulas, including 

VLOOKUP() and many other useful functions.  In the following steps, I will ask you to 

create a budget for each store at Nitey-Nite Mattresses, record that budget in a table, and 

analyze the company’s performance based on that budget.  If you have not completed all 

of the exercises in this course, this will not be an easy project, and most likely it will be 
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impossible.  Again, I will not give you step-by-step instructions on how to complete the 

project, but I will give you general guidance and leave it up to you to decide on how it is 

to be accomplished.   

In the following exercises, you will be creating a lot of formulas and PivotTables.  Try 

not to hard-code anything, as the exam questions require you to change some of the data 

and assumptions that are dependent on those formulas.  With that said, let’s get started. 

1. Copy the Finl_Data tab and rename the new tab myFinl_Data.

2. Insert a column in the myFinl_Data tab to the right of Store_ID and call

that column Store.

3. Populate the Store field with a concatenated VLOOKUP() formula that

looks up the Store No followed by a space, a dash, a space, then the name

of the store, based on the Store_ID field and the data in the Stores tab.

4. Insert a column between Month and Store_ID and call it City.

5. Write a VLOOKUP() formula that brings in the name of the city.

6. Insert a column between Month and City and call it Region.

7. Populate that field with the name of the Region for each record (Tip:  The

Northern and Southern Region offices roll up to the Home Office, NOT

into their own regions).

8. Insert a column between Acct_ID and Amt_2010 and call it Account.

9. Write a formula that shows the Account, followed by a colon and a space,

then the Acct_Desc based on the Acct_ID and the Accounts tab

(example: 101-1: King Best).

10. Insert two columns between the Acct_ID and Account columns.  Call the

new fields Lvl3_ID and Lvl3_Acct.  This is the first rollup level of

accounts.

11. Write formulas that look up the Level 3 Acct_ID and Acct_Desc in the

Accounts tab (like Mattress Revenue or Variable Expenses).

Figure 18.1 
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Format and spot-check your file with Figure 18.1. 

12. Insert two columns between Acct_ID and Lvl3_ID.  Call the new fields

Lvl2_ID and Lvl2_Acct.

13. Write a formula that looks up the Lvl2_ ID and Lvl2_Acct in the

Accounts tab (Hint: It will be either Expenses or Revenue).

Figure 18.2 

14. Create tabs that contain the Budget numbers as per the following

instructions.

BUDGET RULES 

REVENUE 

Revenue Budgets at Nitey-Nite are simple.  They are calculated by first taking the 

average of the previous two years (in this case, the two previous years are 2008 and 

2009).  You then calculate the percent achievement of the previous year and apply that 

growth rate (with a cap and a floor) to the average revenue.  Discount budgets are a little 

more complex, but doable. 

Mattress Revenue Budget 

a) Create a PivotTable based on the myFinl_Data tab.  Name the new tab

Bgt_Mattress.

In the following steps, you will create a number of calculated fields.  Do all of the 

calculated fields within the PivotTable, except where indicated to do them outside the 

PivotTable. 

b) Use Lvl3_Acct as a Report Filter and set it to Mattress Revenue.

c) Bring in the Store field as a Row Label.
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d) In a calculated field, calculate the average of 2009 and 2008 Revenue by

store.  Call the formula Avg_Amt.  Name that field Avg Mattress Rev in

the PivotTable.

e) In another calculated field, calculate the percent of 2009 Revenue

(Amt_2009) divided by 2008 Revenue (Amt_2008) by store.  Call the

calculated field Pct_2008.  In the PivotTable, name the field Pct of 2008.

f) Create another field called Bgt_Pct.  For stores with a Pct of 2008 over

120%, return 120%; for stores under 100%, return 100%; and for all other

stores, return the actual percent.  In this formula, use a nested IF()

statement.  In the PivotTable, call that field Budget Percent.

g) In another calculated field, multiply the Bgt_Pct by the Avg_Amt column,

rounded to the nearest thousand.  Name the calculation Annual_Bgt.  In

the PivotTable, call it Annual Budget.

h) Create another calculated field called Mo_Bgt.  The Monthly Budget

number is Annual_Bgt divided by 12.

i) Format all columns appropriately and sort by Store.

Figure 18.3 

Check your Mattress Budget numbers with Figure 18.3.  

Pillow and Other Revenue 

Calculating the Pillow and Other Revenue budgets uses the same theory as the Mattress 

Revenue Bgt except use the Pillow and Other Revenue numbers.  Therefore, you can 

copy the Bgt_Mattress tab twice and rename the new tabs Bgt_Pillow and Bgt_Other.  

Change the Lvl3_Acct Page Header and column names appropriately. 
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Figure 18.4 

Figure 18.5 

Discounts 

a) Copy the Bgt_Mattress tab and rename the copy Bgt_Discounts.

b) In the Bgt_Discounts PivotTable, take out all existing amount and calculated

fields and bring in the Avg_Amt field as the only data item.

c) Pivot the Lvl3_Acct Report Filter to be in columns containing only Mattress

Revenue, Pillow Revenue, Other Revenue and Discounts fields in that order

(Hint: To change the order of a field, right-click on the field and point to Move.

You can also click and drag it to its new location).

d) Change the Sum of Avg_Amt field to be Avg Rev and format it appropriately.
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e) Create the Discount % field as (Discounts / Sum of (Mattress Revenue + Pillow

Revenue + Other Revenue)) less 0.5%.  Do this and the following calculations

outside the PivotTable.

f) Each store’s Annual Discount Bgt is calculated by using the sum of (Annual

Mattress Bgt plus Annual Pillow Bgt plus Annual Other Bgt) multiplied by the

Discount %, rounded to the nearest thousand.  (Hint:  Use the Budget numbers,

not Revenue.)

g) Create the Monthly Discount Bgt field.

Figure 18.6 

Note:  When you create calculations on a PivotTable outside of the 

PivotTable, be careful! If you use the arrow keys to scroll over to a data 

item or the cursor to click on a data item, you will get a 

=GETPIVOTDATA()  function that will not copy down properly.  To 

overcome this, you have to manually type the cell reference in the formula 

instead of scrolling over to the cell. 

EXPENSES 

Note:  All actual and budgeted expense numbers will typically carry a minus (“-“) sign. 

Fixed Expenses 

The Fixed Expenses budget for all stores is calculated by taking the average of the 2008 

and 2009 Fixed Expenses increased by 3%, rounded to the nearest thousand. 

a) Copy the Bgt_Mattress tab and name the new tab Bgt_FixedExp.

b) Change the Report Filter to Fixed Expenses and take out all data fields except for the

Avg Mattress Rev field and rename it Avg Fixed Expenses in the PivotTable.

c) Calculate the Fixed Expenses budget in a calculated field according to the instructions

above. (Note: There will be a fixed expense budget for the Home Office, and Northern

and Southern Region offices.)
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Figure 18.7 

Variable Expenses 

a) Create a new PivotTable based on the myFinl_Data tab.  Call the new tab

Bgt_VarExp.

b) Calculate the Variable Expense ratio for each store (Variable Expenses / Total

Revenue (including Discounts) ) for 2008 and 2009 separately.

c) Management tells us that the budget for variable expenses are more representative

in 2009 than they were in 2008, so assign a 75% weight to the 2009 ratio and a

25% weight to the 2008 ratio.

d) The Variable Expense Budget ratio is one percentage point less than the

summation of the two ratios calculated in Step c, and is applied to the total

budgets (except fixed expenses), rounded to the nearest thousand.  (Note:  Many

of these calculations can be done outside of the PivotTable.)

e) Make sure your PivotTable ties with Figure 18.8.

Figure 18.8 
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For budgeting purposes, management wants to assign the monthly budget amounts for 

each category (mattress, pillow, other, discounts, fixed and variable expenses) to ONE 

account within each category, as illustrated in the table in Step 15. 

15. In the myFinl_Data tab, populate the monthly calculated budget numbers

for each store in each month to the following accounts under the

Bgt_2010 column as follows:

Budget Category Account

Mattress Revenue 101-1

Pillow Revenue 111-1

Other Revenue 120-1

Discounts  190-4

Fixed Expenses 308-0

Variable Expenses 201-1

Hint: You will have to use a nested IF() statement to make this work

correctly.  If done correctly, most accounts will show a zero.  Only the

accounts above will be populated with budget numbers.

Figure 18.9 

Make sure to keep the VLOOKUP() formulas intact, as you will be changing some of the 

assumptions in the Budget Rules when you are taking the exam.  You will need to refresh 

the various PivotTables to get the correct answers flowing through. 

16. Create a PivotTable based on the myFinl_Data tab that summarizes the

Lvl2_Desc column and the Amt_2010 and Bgt_2010 columns.  Make the

Revenue numbers appear first in the PivotTable.  Create a formula in the

PivotTable that calculates the percent of budget and call it act_pct_bgt.

Format the numbers appropriately.  Your numbers should match Figure

18.10.  Name the new tab Actual_Budget.
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Figure 18.10 

I anticipate you will spend quite a bit of time getting the project to this point.  If you get 

stuck, search the ClineSys on-line FAQ page for help. 

17. Remove the Lvl2_Desc field from the PivotTable and bring in City and

Store as Row Labels.  (This essentially brings in Net Income).  Hide the

detail for the Store field.

Figure 18.11 

Why does Jersey City have negative net numbers? 

18. Expand Jersey City to see all locations under it.
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Figure 18.12 

It looked strange because the Home Office and Northern and Southern Regional office 

numbers were included in Jersey City.  When you analyze the performance of the entire 

company, it is probably necessary to include those “overhead” type numbers, but in this 

analysis we want to look at only the operating stores, so let’s take out the overhead 

numbers. 

19. Deselect the Home Office, Northern Region and Southern Region from

the Stores field and hide the Store detail again.

Figure 18.13 

20. Modify the PivotTable to remove the City, 2010 Budget and Pct of

Budget fields.
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21. Bring in Month as a Column label.

22. Check to make sure your numbers match with Figure 18.13.

Figure 18.14 

23. Save and close the file.

You need to make absolutely sure that the numbers in your file match with the numbers 

throughout the Comprehensive Project.  You will be using this Comprehensive Project 

file to answer all the questions in the final exam, so it’s essential you start off with the 

right file.  Again, if the numbers are not matching and you don’t know why, rework it 

following each instruction exactly. 

One more piece of advice:  When you are taking the last exam, note that the questions are 

not cumulative, meaning you have to reset the file to its original state each time you 

answer a question. 

Conclusion 

In this chapter, you completed the Comprehensive Project.  The primary objective of the 

Comprehensive Project was to test your ability and understanding of PivotTables, using 

VLOOKUP() functions and writing formulas using nested functions.  

In this course, I have taught you the tools that are most helpful in business situations.  All 

of the tools require you to use a certain degree of logic, and I’ve attempted to teach you 

those thought patterns as well.  However, I cannot anticipate all of the situations that you 

will encounter.  You will have to depend on your own creativity and ingenuity to solve 

those issues. 
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Remember that your education does not stop here.  There are many different areas of 

Excel you can explore, like VBA (Visual Basic for Programming, the programming 

language Excel uses) and discovering other functions.  Continue to learn.  Buy other 

books, search the Internet, do everything you can to expand your Excel knowledge 

(especially buying the new releases of the ClineSys courses) and you will quickly be 

regarded as the Excel Expert of your office.   

By going through this course, you’ve learned the basics and advanced basics.  From here 

on out, you can use a reference book to research most of your questions.  Another good 

source for researching Excel issues is the Internet.  I have found answers to many of my 

questions by going to the Internet and researching what others have done.  Whenever I 

think that someone must have had my same problem, usually they have. 

Chapter Exam 

To take the examination for this chapter, you must have successfully completed 

the examination for the previous chapter.  You can now go to www.ExcelCEO.com,

click on Sign In, log in and take the exam.  Make sure that you take the exam on 

the same computer that you completed the Comprehensive Project on, as all of the 

questions in this exam refer to the completed project. 

http://www.ExcelCEO.com/
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